
 
 



Installation 
 

どうぞ、ご覧ください。Quickstart Guide そして/または、Installation Guide 

 

About This Manual 
このマニュアルは、Help メニュー、または [F1] にございます。Pyramixと共に自動的にインストールさ

れております。Pyramix 5.0 におけるすべての標準構成と機能を包括的に表したものです。 

 

Navigation 

 
この中にございます、すべての Contents、Index エントリ、および Cross-references はハイパーリ

ンクとなっております。すなわち、それらをクリックすれば、関連するアイテムまでジャンプします。 

 

VERY IMPORTANT! 

 
Pyramix のすべての特徴と機能をさらに完全に理解していただくために、他の Pyramix ガイドを参照して

いただくことを、私たちは強く推薦します。 
 
HOWEVER, 

 
ほとんどの人々は、読まなければならなくなるまでマニュアルを読みません。 

Quickstart Guide は、あなたの(ほとんど)即時の満足感を達成するでしょう。! 

Quickstart Guide は、あなたに Pyramix Virtual Studio Version 5.0 をご案内します。そして、シンプル

なセットアップで、録音、オ－ディオの取り込み、シンプルな編集、ミキシング、CDレコ－ディングを導

きます。 

 

Important Note: 

 
Pyramix は非常に強力なワークステーションであるだけではありません。 

また、特にユーザインタフェースにおいて、高レベルな構成が可能なものとなっております。 

このマニュアルのスクリ－ンショットは、デフォルトインタフェースで示されています。 

Pyramix メニューかツールバーで見つけることができないなら、それは、マニュアルで論じられているか、

示されています。または、何か異なった形で表されています。どうぞ次へ進みましょう。: 



Settings > All Settings > Desktop Layout そして関連するタブウィンドウを調べてください。 

 

Commands Reference 

 
Pyramix と共に自動的にインストールされて Help メニューで利用可能です。このドキュメントはデフォ

ルト Keyboard Shortcuts と共に Pyramix で利用可能なすべてのコマンドを示しています。 

 

Pyramix Guides 

 

Quickstart Guide 

 
Pyramix と共に自動的にインストールされて Help メニューで利用可能です。このドキュメントは、新し

いユーザが素早くよい結果を得られるよう意図されています。また、それは、既存の Pyramix ユーザに 

Pyramix 5.0 の新機能を紹介することも目的としております。 

 

Other Pyramix Guides 

 
ここに示されている他のガイドは、Pyramix ソフトウェアと共にインストールされます。そして/または、 

Merging Technologies ウェブサイトより自由にダウンロ－ド可能になっております。 

 

http://www.merging.com 

 

Installation Guide 

 
Quickstart Guide の Installation チャプタ－の拡張バージョンです。 

 

Virtual Transport Guide 

 
これは、Virtual Transport のリファレンスガイドです。 

 

Pyramix Applications Guides 

 
これらのガイドは、Pyramix ユーザにとって、役に立つリソースであることを目指しております。 

それら、特定の用途に Pyramix を使用するためのセットアップの例、実際的なヒント、および注意点を含

んでいます。; 

 

http://www.merging.com


Music Recording, Editing と Mastering(開発における) 

SACD Production Guide 

Sound for Picture(開発における) 

Radio Production(開発における) 

Theatre Play out(開発における) 

 

Guides for Pyramix Optional Features 
 

オプショナル機能のドキュメンテーションを PDF フォーマットにて提供しています。或るものは、

Pyramix ソフトウェアで自動的にインストールされます。以下から他のものも、自由にダウンロードでき

るでしょう。: 

http://www.merging.com 

Assumptions 
 

この User Manual と他の Pyramix ガイドは、あなたが PCs、Windows 専門用語、および概念に、完全

に精通していると仮定しています。PC が新品なら、Pyramix Virtual Studio をインストールする前に、

マシンが正しく働いているかを確実に確かめてからにしてください。 

 

Conventions 

 

Conventions used in this manual: 
 
Pyramix スクリーンとメニューで表示されたネ－ムは、太字で示されています。たとえば、Information 

& Settings   メニューとサブメニューの選択はこのように示されています。: 

View > Tracks > Show all Tracks 

 

以下に、この表示の意味を述べております。: 

View プルダウンメニューへ進んで、トラックスサブメニューまでマウスダウンしてください。そして、

Show all Tracks を選んでください。 

すべての Pyramix の設定が階層構造で集められています。Selecting Settings > All Settings は、左手

パネルの中にフォルダーとファイルのツリ－を含む Pyramix Settings ウィンドウを開きます。 

 

ダイアログボックスが数 Pages を持っているところでは、タブは、ページをめくるのに使用されます。 

タブのページ選択はこのように示されています。: 

Settings > Keyboard Shortcut Editor : Clips 

以下に、この表示の意味を述べております。: 

http://www.merging.com


Settings のプルダウンメニュ－に進んでください。Keyboard Shortcut Editor を選択して、Clips Tab 

の上をクリックしてください。 

Keyboard Shortcuts はこのように表示しております。: [Shift Alt R] の意味は、Shift と Alt キ－ を押し

たままで、R を押す。 

 

Important Information 
重要情報はこのように示されています。: 

 

以下に 注意 してください。: CD イメ－ジを制作する場合は、ミキサ－アウトプットをステレオに

しなければ なりません。Two モノではいけません。 

 

Pyramix Virtual Studio Overview 

 

Pyramix Virtual Studio はハ－ドディスクレコ－ディング、編集、デジタルオーディオミキシング、エ

フェクトプロセッシング、マシンコントロ－ル、ビデオ、および CD-R マスタリングを統括したパワフル、

かつ、フレキシブルな Digital Audio Workstation (DAW) でございます。 

Pyramix ソフトウェアは、Merging Technologies Mykerinos ハードウェアプラットフォームで走り

ます。それぞれの Mykerinos ボードは、24 ビットのディジタルオーディオの最大 128 チャンネル、64 レ

コーディング、および 64 の再生をカバ－しております。これらの128 チャンネルへの外部のアクセスは、

Mykerinos ボードへの物理的なインプットとアウトプットの選択により決定されます。 

 

マルチボードでは、Pyramix ワークステーションは、24 ビットのディジタルオーディオの最大 128 チャ

ンネル、64 レコーディング、および 64 の再生をカバ－しております。 

 
これらのインプットとアウトプットへの外部アクセスは、あなたのドーターボードの選択で決定します。 
ADAT ドーターボードが、通常の、HDTDM (64bus) モードで機能し続けている間、XDTDM (128 bus) 

モードで使用するとき、インプットにそれを使用できませんし、それは、Optical Output B にコピーされ

ている同じ 8 アウトプットがある Optical Output A を通して 8つのアウトプットができるだけであるこ

とに注意しておいてください。 

 
WARNING! ADAT Daughterboard は、使用の前に XDTDM モードへの変更を必要とします。 

これをしない場合、データの損失をもたらすかもしれません。どうぞ、Merging Technologies Sales 

Partner に連絡して、モードアレンジをしてください。 

 
 



Program Window 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Pyramix Program Window 

 

プログラムがスタ－トするとき、Merging Technologies プログラムウィンドウによるメイン Pyramix 

Virtual Studio は現れます。それは下に、Transportバーとステ－タス情報と共に先頭の向こう側に格納

可能な Toolbars を持っています。従来の Windows コントロールボックスでこのメインウィンドウをリサ

イズ、移動、最小にするか、または最大にすることができます。 

 
 
 
 
 
 
 
 
 



Project Window 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Pyramix Project Window 

 

Pyramix Project ウィンドウはメインウィンドウによっていつも完全に囲まれています。 

Project ウィンドウは、Project が開く場合にだけ存在していて、新しい Project が始動するとき、自動

的に現れます。メインウィンドウの中で Project ウィンドウをリサイズ、移動、最小、または最大にする

ことができます。Project ウィンドウを十分に大きくすると、2 個の別々のパネルが現れます。: 

トップにある Project Editing Panel は、Composition のグラフィックを示している Timeline を含ん

でいます。スクリーンの下のセクションは Project Management Panel です。 

パネルの境界は、マウスで掴み、上に、下に動かせます。各パネルに割り当てられたスペースを変えます。 

 

Status Bar 

 
Pyramix Window の一番下は、Status bar を表示しています。: 

 

 



Free Disk 

 
レコーディングに選択したディスクの残っている時間です。 

 
Nudge 

 
現在選択されている、ナッジの設定です。 

 
Playback Buffer Meter 

 
Playback バッファの現在のグラフ表示です。 

 
DSP 

 
DSP (または、CPU)負荷と、Samples と Millisecond で、Input からOutput への Latency を表示してい

ます。 

TimeCode 

 

Current Frame Rate と Reference Source です。 

 

•  選択された Reference Source が利用可能であるなら、Led は Green になります。 

 
•  選択された Reference Source が利用不可であるなら、Led は Red でフラッシュします。 

 
•  Pull-Up, Pull-Down または Varispeed 設定が、無効な Frame Rate を作り出している場合は、Red 

 で表示されるでしょう。 

 

Audio 

 

Current Frame Rate と Sync Source です。 

 

•  選択された Sync Source が利用可能であるなら、Led は Green になりロックされます。 

 

•  選択された Sync Source が利用不可であり、システムがInternalをデフォルトとした場合、Led は 

                        Red になります。 

 



•  選択された Sync Source が利用可能ですが、異なった Sample Rate であった場合、Led は Red で 

  フラッシュします。 

 

Dual Monitors 

デフォルトでは、Timeline の下に Tab Windows が置かれ、スクリーンは水平に分割されております。 

Dual Monitor セットアップを使用した場合、あなたは、メインプロジェクトウィンドウを垂直に分割した

いと思っているのではないでしょうか。左画面に Timeline を表示し、Tab Windows が右にあり、同時に、

より多くのトラックを表示することができます。 

Settings > All Settings > Application > Timeline Layout ページの Display Timeline on the 

Left of Tab Windows のラヂオボタンをチェックしてください。この変更は、次に Project を開いたと

きに効きます。 

 

Project Editing Panel 
デフォルトでは、先頭の Project Editing Panel には、多くの格納可能なツールバーを持っています。 

TimeCode のレジスタボックスとその下のTimescale バーと Timeline トラックディスプレィです。 

これは、オーディオ編集の多くに使用されます。オーディオ Tracks の制作、増加、または削除され、オ

ーディオ clips を編集、移動、コピー、または貼りつけることができます。Input Channels のナンバー

が、新しい Project の Mixer 構成に従い、Project Editing Panel は自動的にオーディオ Tracks の同

じナンバーから始まります。 

 

Project Management Panel 
 

Project Management Panel は、Project を管理、ナビゲート、変更するための多くのツールがありま

す。この Panel の下のツール Tabs の一つをシングルクリックすると、Panel の中に、そのウィンドウを

開きます。ダブルクリックすると、ウィンドウはフロ－ティングで開きます。フロ－ティングウィンドウ

の Tab か、その Caption Bar をダブルクリックすると、ウィンドウはパネルに戻されます。 

 

プルダウンメニューからもまた、タブウィンドウ機能にアクセス可能です。 

 

Tab ウィンドウのいずれか、または、すべてを Project のために示し、または隠して、個々に移動、メイ

ン Program ウィンドウの外に移動させることができます。 

 
 



TimeCode Entry 
 

TimeCode の値は Increment / Decrement ボタンにより変更することができます。或いは数字キーで入

力するか、テンキーにより入力することもできます。OK ボタンか、ENTER キーにより、入力値を決定

します。このフィールドは、ブロック毎に現在の値を上書きしながら、右から左へ入力されます。 

 
これにより、フレームや秒の値を分や時間を再入力することなく簡単に入力できます。 

 

タイムコード表示をクリックし、赤色の I -ビームカーソルを入れます。同時に外枠は緑色になります。入

力は Hours: Minutes : Seconds : Frames の順に入れなければなりません。従って、10 時、9 秒、15 フ

レームを入力するには:1 0 0 0 0 9 1 5 と入力していきます。秒だけを入力する場合は: 9 1 5 と入力し、

ENTER キーを押します。しかし、10:27:10:15 を10:27:09:15 に変更するには、0 9 1 5 と入力しENTER 

しなければなりません。入力エラーを避ける為に、常に最初の 0 を入力するようにしてください。 
 
 
 
 

TimeCode Register 

 

Arithmetic TimeCode Entry 

 
現在の TimeCode 値には、相対値を入力する加算,減算ができます。Enter キーの代わりに、メインキー

の - (Minus) 若しくは + (Plus) を入力するか、CONTROL ＋ テンキーの Minus 若しくは、CONTROL

＋ テンキーの Plus を入力することでこのモードとなります。 
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Tracks and Track Groups 

 

Tracks 

各 Project は、オーディオ Clips を置ける或いは録音できる、ユーザーが決定した数のオーディオ Tracks

を持っています。クリップは Blocks として Track 上に現われます。Track は水平方向に、Time Scale

バーの下に存在します。また、Track 数は垂直方向に積み重ねられていきます。 

 

各 Track の左端には、Header パネルと呼ばれる数種のコントロールとインフォメーション ディスプレイ

があります。どうぞご覧ください。: Track Header Panel 17 ページ 

 

数種の操作は、選択した Track にのみ、行われます。Track は、Header 部を左クリックすることにより

選択され、選択された Track はシャドーがかかります。Trackを選択する場合、間違って Track のボタ

ンを押し、Trackの状態を変更 しないように してください。Track Name の部分は、Track の選択を

するためにクリックする良いポイントです。 
 

Adding Tracks 

 
デフォルトでは、Mixer で決められた Input Channels と同じ数の Tracks が作られています。 

しかしながら、Tracks は、簡単に加えたり減らしたりすることができます。 
 

Creating tracks via paste 

 
クリップが Media Management か Library から TimeLine の空白の領域にドラッグ、ドロップ、コピー、

ペーストされるなら、トラックが全く存在していない部分で、十分な数のトラックは、クリップのチャネ

ル数に適応する最後の既存のトラックの下に、制作されるでしょう。 

 

Create New Tracks 

 
新しいトラックは現在選択されたトラックの下に作られます。トラックが選択されていない場合は、現在

あるトラックの一番下に作られます。Tracks を Timeline に追加するには、Tracks > New Audio 

Track を選択してください。（もしくは、トラック ヘッダーのブランクの部分を右クリックし、コンテク



スト メニューから New Audio Track を選びます。） 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Create New Tracks dialog 

 

Create only Tracks: / Create Strips and Tracks: 
 
Mono トラックを単純に追加するには、Create only Tracks のラジオ ボタンにチェックを入れ、作りた

いトラックの数を Number of Tracks のデータ エントリー ボックスに入力し、OK をクリックします。

トラックは Audio というデフォルトの名前と 1 からの昇順の番号がつけられて作成されます。 

 

Mixer のストリップも同時に作りたい場合は、Create Strips and Tracks のラジオ ボタンにチェック

を入れ、作りたい Strips の数を Number of Strips のデータ エントリー ボックスに入力し、OK をクリ

ックします。現在 Pyramix は、4 つのカテゴリーの Strip をサポートしています。デフォルトは、Mono



です。他のタイプのストリップは、Strips Type のドロップ ダウン リストにより選択できます。 
 
 
 
 
 
 
 
 
 
 
 
 
 

Create New Tracks dialog - Strips Type 

 
あなたが Mono 以外を選択すると、トラックのナンバーは、選ばれたストリップタイプに合うように制作

されるでしょう。 

文字がチャネル割付けを示し、ストリップのインプットとアウトプットは'タグ付けをされるでしょう'。 

それは、Strips Channels Type ドロップダウン リストでの選択によります。 

 
 
 
 
 
 
 
 
 
 
 

Create New Tracks dialog - Strips Channels Type 

 
フォーマットは、選択された Strip Type により、異なって提供されます。 

6チャンネルの例が、上に示されています。更なる例として、MS を選択した場合、<No Type> は唯一の

利用可能な選択です。そして、ストリップの I/O は、Centre and Width のための C と W でタグ付けをさ



れます。よって道理にかなったフォーマットであるということです。 

 

Track Types 

 

すべてのトラックは、シングル チャンネルでございます。しかし、Strip Channels Type フォーマットで

制作されたとき、確実に、自動的にリンクされます。: Automation, Solo, Mute, Monitor モード, Record 

モード, Waveform ディスプレイ。 

 

Naming and Numbering 
 

 

 

 

 

 
 
 
 
 
 
 

Create New Tracks dialog - Name 

 
あなたが、どんなに多くの Tracks と Strips を作ると決めたとしても、それらは、自動的にネ－ミング、

付番されます。 

 

No Increment オプションが選ばれていると、制作されたトラックはすべてが同じ名前を持つでしょう。 

言い換えれば、何でも Prefix に入力出来ます｡ : テキストエントリィボックスとノ－ナンバ－。 

 

Increment by Track オプションが選ばれているなら、それぞれ、個々のトラックは Prefix に入れられ

たテキストを使用してネ－ミングされるでしょう。: テキストエントリィボックスとノ－ナンバ－。 

例えば、あなたが、人呼んで Atom と入力し、L-C-R-Ls-Rs-Lfe フォーマットの 5.1 GP ストリップを加

えるなら、6 トラックが増やされます。Increment starts at（ Incrementが以下のように始まるなら） : ナ

ンバーが人呼んで 33 と設定されますと、その後、すべてのトラックネ－ムは Strip ネ－ムと同様に Atom 

33 になるでしょう。 



Increment by Track/Strip オプションが上記の例で選択されるなら、トラックは、Atom 33, Atom 34 

から Atom 38 とネ－ミングされるでしょう。そして、Strip は Atom とネ－ミングされるでしょう。 

 

Tracks Grouping 
 

これらには 3 つのオプションがございます。: 

 

 

 

 

 

 

 

 

 

Create New Tracks dialog - Grouping 

 
Don’t Group Tracks は新しいトラックをアングル－プにしたままにします。 

 

Group all Tracks together はシングルグル－プの中に全ての新しいトラックをグル－プにします。 

 

Group Tracks per Strips はストリップへアサインされたトラックをグル－プにします。例えば、2 つの 

5.1 ストリップへアサインされた 12 Tracks は 2 つの 6 トラックとしてグル－プにされるでしょう｡ 

 

Deleting Tracks 
 

Single Track 
 

Track を削除するには、まず最初に、削除する Track を選択してください。 

Project ウィンドウのプルダウンメニューより Tracks > Delete を選択してください。 

それに置かれた Track とすべての clips が、削除されるでしょう。Clip か、ポインタだけが削除されます

が、オリジナルの Media File はそのままであることを心に留めておいてください。 

 

 

 



Multiple tracks 
 

また、あなたは、Delete の代わりに Delete to Last を選択することによって、選択されたトラックから

最後の(最も上のナンバ－)までのすべてのトラックを削除できます。 

また、あなたは、Track Header を右クリックしても、加えるか、削除できます。 

 

Routing Tracks to / from the Mixer 

 

Mixer を作ったとき、Pyramix は Mixer Input Strips (channels) と同数の Tracks を自動的に作ります。 

Connect automatically as many inputs and outputs as possible がチェックされれば、Pyramix 

は、自動的に、それに対応する Mixer チャンネルインプットにそれぞれの Track のアウトプットのコネ

クトを試みるでしょう。つまり、Track 1 のアウトプットが、Mixer チャンネルインプットに、Track 2 が 

Mixer チャンネル 2 に。 

同様に、Pyramix は、自動的にそれぞれの Mixer チャンネルアウトプットと対応する Track インプット

のコネクトを試みるでしょう。つまり、Mixer チャンネル 1 のアウトプットが Track 1 のインプットへ、

Mixer channel 2 が Track 2 へ。etc. 

 

ユーザ－は容易にこれらのデフォルト Track I/O 指定を変えることができます。こちらもご覧ください。: 

Adding Strips 185 ぺ－ジ 

 

Virtual Tracks 

 

バ－チャルトラックは、既存トラックの別の "mirror"「鏡」です。それは、同じアウトプットル－ティン

グを持ち、既存のトラックと同じクリップを含んでいますが、別々のトラックとして Project Editor に現

れます。 

 

以下に注意してください。: Virtual トラックは、ノン－オーバラッピングクリップを含んでいます。

－ バ－チャルトラックのすなわち各クリップは、関連するバ－チャルトラックのクリップに重ねるこ

とができません。しかしながら、まだ、全く同じトラックのクリップをクロスフェ－ドさせることが

できます。 

クリップを想像する目的に Virtual トラックを使用できます。それには、同じミキサーに送られるに

もかかわらず、エディタの別々のトラックに現れる論理的な理由があるかもしれません。 

典型的な使用の例は、シングルトラックのいくつかのオートメーションカーブのディスプレイを考慮

するためにバ－チャルトラックを制作します。 



Track Header Panel 
 
Track Header Panel は多くのボタンと情報フィールドを含んでいます。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Track Header Panel 

 
このスクリーンショットはさまざまな状態の Track Headers を表示しております。 

 
    大きくて、太字のナンバーは Track ナンバーです。 

 
    pale green box はアウトプットが割り当てられた Mixer Strip Channel のナンバーを表示

しています。このアイコンをクリックすると、利用可能であるすべての Mixer Strip Channels 

                                          からの選択リストがポップアップします。 

                                         そして、pale green box がダッシュを表示していると、どんな Mixer Strip Channel も選択 

                                         さず、レコード、再生は可能ではありません。 

 
    pale green block がセカンドナンバーを表示していれば、それは、ナンバーに加えた文字か文

字タグであり、Mixer Strip はマルチチャネルタイプです。そして、文字はトラックがどのチャ 



                                         ンネルにアサインされているかを示しております。（この例は、Strip 8 Lfe であります。 

 

    Input source -ナンバーは選択されたレコ－ドインプットを示しています。 

                                         このエリアがダッシュを示していれば、どんなレコ－ドインプットも選択されていません。また、 

                                          直接 Mixer Console ウィンドウにて、設定ができます。 

 
    Track Name エリアをクリックすると、テキスト入力ボックスが開きます。 

                                        トラックネ－ムをタイプできます。トラックネ－ムはデフォルトでは、Mono, Stereo または、 

                                          Audio です。 

 

     View Automation Off - Automation データ オーバレイはトラックに表示されません。 

 
     View Automation On - Automation データ オーバレイはトラックに表示されます。 

 
オートメーションアイコンを右クリックすると、Automation Overlay コンテキストメニューがポップア

ップします。表示には、オプションがあります。 

 
    Mute アイコンはここに示しているように、Track Output を Un-Muted との間で切り換えま

す。 

     そして、同様に、Track Output Muted. 

 

     Solo アイコンは、ここに示しているように Track Output を Solo off の間で切り換えます。 

 

     ここに示しておりますように、Solo on になります。 

 

The Record icon has three possible states. 
 
アイコンを左クリックすると、Record Safe と Record Ready が、順番に切り変わります。 

AutoPunch Ready は、ALT key を押さえながらアイコンを左クリックすると、有効、または不可にな

ります。 

 
    Record Safe - 録音できません。 

 
 
    Record Ready - レコ－ディングは、トランスポ－ト Master Record ボタンが押すと始まっ

て、Stop ボタンを押す、または Play ボタンを押すと終わります。 



    Autopunch Ready - 設定された Record In ポイントに達っすると、録音を始め、Record 

Out ポイントで終わります。 

 

Record アイコンを右クリックすると、Settings Window が開きます。そこには、選択した Project > 

Record ぺ－ジがあります。 

 

また、Monitor アイコンには、3 つの種類があります。 

 

以下に 注意 してください。: インプットとアウトプットの両方が接続されたときだけ、これらのアイコ

ンはアクティブです。 

 

アイコンを左クリックして、切り換えます。 

 

    Auto - モニタリングはインプットとレプロの間で自動的に関連する Mixer channel インプッ 

                                        トを切り換えます。働きは Auto-monitoring の設定によります。Settings > All Settings >  

                                          Application > Playback/Record ページにあります。 

European Monitoring (停止すると、すべてのトラックが INPUT に変わります。) OR US 

Monitoring (停止すると、Record Ready トラックのみ、 INPUT に変わります。) 

 

     Repro – 結合した Mixer channel はいつもトラック再生から与えられます。 

 

Input – 結合した Mixer channel はいつもトラックの選択した Input ソ－スから与えられま

す。 

     Expand Track Group - トラックが Group メンバでないなら、灰色になります。 

 

Collapse Track Group - トラックが Group メンバの場合、目に見える Expand Track 

Group の状態を代えます。 

 

The Waveform icon has three possible states. 
 

     Display Waveform – デフォルトでは、白色でウエ－ブフォ－ムが描かれたオレンジ色のブロ 

                                          ックで clips が表示されています。 

 

     Display Blocks - デフォルトでは、ウエ－ブフォ－ムなしでオレンジ色のブロックで clips が 

                                          表示されています。 

 



.        Display Envelope - デフォルトでは、白色でウエ－ブフォ－ムが描かれたオレンジ色のブロ 

                                         ックで clips が表示されています。さらに、そこには、シンプル クリック、ドラッグでゲイン 

                                          の調整ができる黒色ラインが追加されております。 

                                          Ctrl key を押すと、エンベロープのための描画ツールが可能になります。また、これは 

                                           Automation curves に供給されます。 

 

     Peak Meter - Peak Meter が Track Header の極右に見えておるなら、クリツクすると隠れ、 

                                          見えていないならその場所をクリックしてください。 

 

    Always Visible off – いつも見えています。 

 
    Always Visible on – このボタンを押すと、可能であるときはいつも、トラックは Timeline 画

面にとどまっているでしょう。 

 
     Playlist は、このメニュ－を開きます。 

 

 
 
 
 

Playlist popup menu 

どうぞ、ご覧ください。: 

 

各 Track Header で、それに重なり合う数字の書いた pale green box に気付くでしょう。(適切なアサ

イン Tag ) ;そして、それに重なり合う数字の書いた pale red box に気付くでしょう。 

pale green box が Track アウトプットにアサインされたミキサーチャネル番号を示している(適切であ

るなら Tag 付けのある。) pale red box は物理的なインプットかミキサーチャンネルに送られ、Track イ

ンプットにル－ティングされる Internal Return Bus を示しています。 

 

Track Input または、Output のアサインを変えるには、対応する Track インプットかアウトプットボッ

クスをクリックしてください。そして、対応するポップアップリストから適切な Mixer チャンネルまたは、

Input ナンバーを選んでください。 

以下に注意してください。: アウトプット指定を異なった Mixer channel に変えますと、ストリップに

あります選択済みのインプットと Input も換わります。 

Track Header で Input のアサインを変えるなら、この変化はストリップに反映いたします。そして、逆

もまた同様です。 



Track インプットとアウトプットがアサインされていないなら、その Track に対応するボックスはナンバ

ーの代わりにダッシュになります。 

 

同じ Mixer チャンネルに多くのトラックをアサインできます。したがって、Mixer に入る前に、それらは

サブミックスされます。これで、Mixer チャンネルの数より多くのトラックをプレーします。 

 

同じ物理的インプットから多くのトラックに送ることができます。 

 

Track Record Modes 

 

各 Track には、トライステート Record Ready トグル・ボタンがあります。それは、Track Information 

and Setup Area の Track 自身の左に位置しています。 

 

ヒント: トラックア－ミングボタンの上を右クリックします。さすれは、ただちに Project > Record ペ

ージの Settings > All Settings ウィンドウが開きます。 

 

Play 
 

Track Header の Green Dot は、Record Safe モードを示しています。Tracks が新たに作られたとき、

これがデフォルトです。この状態では、録音できません。 

 

Record Ready (Manual) 
 

Green Dot を一度クリックしてください。Record Ready モードに切り変わります。Red Dot に変わ

り、示されます。Transport Strip か Transport window  の Master Record ボタンが押されますと、

ただちに Record モードに移ります。 

 

Record Punch In (Auto) 
 

Red DotをAlt-ClickするとRecord Punch In モードに切り替わります。これは、2 red vertical lines 

の Red Dot flanked によって示されます。このモードにおいて、Master Record ボタンが Transport 

Strip または、Transport window で押されますと、現在の Mark In ポイントに達するまで、Track は 

Play モードのままでステイするでしょう。その後、Track は Record モードに移行するでしょう。 

現在の Mark Out ポイントのところに来るまで、Record モードのままです。 

 



Tracks Tab Window 
 

Track Tab Window は、情報とファンクション選択フィールドを含んでいるシングルトラックと各カラム

についての情報を各列のテーブルに示しています。新しいトラックは制作、または削除できます。そして、

トラックのオ－ダ－は変更可能です。すべてのトラックパラメータが、アクセス可能であって、修正でき

ます。 

 

 

 

 

 

 

 

 

 

 

 

Tracks Tab floating Window 

 

新しいトラックは、Tab Window の最初のラインをクリックして増やせます。そして、ふさわしいネ－ム

をタイプし、Enter します。 

 

選択して、Delete key を押すことによって、トラックスを削除できます。 

 

トラックを選択して、ドラッグすることによって、Tracks のオ－ダ－を変えることができます。Name フ

ィールドの極左のシンボルをクリックして、希望の列にドラッグしてください。 

 

 

 

 

 

Tracks Tab pop-up 
 

いくつかのトラックの上、または、すべてのトラック(選択がない)の上を右クリックすると、このコンテ

キストメニューを表示します。: 



 

 

 

 

 
 
 
 

Tracks Tab pop-up 

 
Increment Tracks Name : それぞれの選択したトラックネ－ムの後に、増加ナンバーを加えます。 

                                                                                                                                既存のナンバーを考慮に入れております。 

 
Repeat & Increment Tracks Name : 最初に選択したトラックネ－ムを選択の残りにコピーします。そ 

                                                                                                                                して増加ナンバーを加えます。 

Copy Tracks Name :    選択がないなら、選択したトラックネ－ム、または、すべてをコピーしま

す。 

Paste Tracks Name :   以前に選択したトラックネ－ムを現在の選択トラックにペーストします。 

                             
Import Tracks Name :   テキストファイルからの選択したネ－ムでないなら、選択したトラック、 

                                                                                                                                または、すべてのトラックをリネ－ムします。 

 

Export Tracks Name :   テキストファイルへの選択がない場合、選択したトラック、または、すべ 

                                                                                                                                てのトラックをセ－ブします。 
 

Making Settings Changes to Multiple Tracks 

 
トラック設定の変更は、複数選択でも行うことができます。Ctrl を押してトラックをクリックで、加える

か、減じるか、または Shift を押してトラックの隣接の範囲を選択してください。 

 

Changing Repro or Input connections 
 

カラムフィールドをクリックすると、可能になっている接続リストをドロップダウンします。必要な接続

を強調表示して、それを選択してください。 

 

選択したトラックの範囲で、リストからのコネクションの選択は、すべてのトラックが同じ接続へアサイ



ンします。Alt を押したまま選択すると、昇順に接続されます。 

 

Track Column Fields 
 

Name 

 

Track のネ－ムです。このフィールドでは、最大 29 文字しか書けないように目に見えますが、それより

長い文字も書けます。フィールドをクリックするか、F2 で、新しいネ－ムを入れてください。 

 

Repro Connection 

 

どの Mixer Input Strip (適切であろう Channel )がトラックに接続されているか示します。 

このカラムフィールドをクリックすると、利用可能なすべての Mixer Input ストリップ( Channels )をリ

ストボックスの下側にドロップダウンします。 

左の Strip ナンバーは、かっこの Strip Name が書いてある Channel Tag に従います。 

 

Input Connection 

 

どの Input がトラックに送られているか示しております。このカラムフィールドでクリックすると、可能

なすべての物理的インプットと Internal Return Busses のリストボックスが下にドロップダウンします。 

 

Group 

 

(もしあればですが。)トラックがどの Track Group に属しているかを示しています。(以下を見てくださ

い。) Clicking in this column field は可能になっている Track Groups があるリストボックスをドロ

ップダウンします。 

 

Solo 

 
YES なら、トラックはソロ(独奏)になります。 このカラムフィールドをクリックすると、YES とブラン

クで順番に切り変わります。 

 
Mute 

 
YES なら、トラックはミュートになります。このカラムフィールドをクリックすると、YES とブランク

で順番に切り変わります。 



Record Ready 

 

現在、録音が実行可能状態であることを示しています。このカラムフィールドをクリックすると、3 項目あ

るリストボックスをドロップダウンします。こちらです。Safe, Record Ready と Auto-Punch 

 
Monitoring 

 
現在のモニターモードを示しています。このカラムフィールドをクリックすると、3 項目あるリストボック

スをドロップダウンします。こちらです。Auto, Input と Repro 

 

Hidden 

 
YES なら、トラックは、Timeline にありませんが、正常に作動し続けています。このカラムフィールド

をクリックすると、YES とブランクで順番に切り変わります。 

 
Always Visible 

 
YES なら、トラックは、(十分なスペースがあれば)常にスクリ－ン上にあります。それは、他のトラック

をスクロールしているときでさえ見えます。 

 
Collapsed 

 
YES なら、トラックは、現在崩壊している Track Group のメンバになります。(以下を見てください。) 

 
Display Mode 

 
現在の Clip Display Mode の形態を示しています。このカラムフィールドをクリックすると、3 項目ある

リストボックスをドロップダウンします。こちらです。  Block, Waveform or Envelope 

 

Show Automation 

 
YES なら、オ－トメ－ション エンヴェロープが表示されます。このカラムフィールドをクリックすると、

YES とブランクで順番に切り変わります。 
 
Show Peak-Meter 

 



YES なら、Peak Meter は、Track Header に表示されます。このカラムフィールドをクリックすると、

YES とブランクで順番に切り変わります。 
 
Size 

 
現在のトラックディスプレィの Height (ピクセルで)を表示します。このフィールドをクリックすると 24

～511 の数値の入力が可能になります。 

 

Background Color 

 
クリップの背景色を表示します。空白なら、色はデフォルトに設定されます。このフィールドをクリック

するとカラ－ピッカーがポップアップします。Standard を選択するとデフォルトに復元いたします。 

 

Waveform Color 

 

クリップの Waveform の色を表示します。空白なら、色はデフォルトに設定されます。このフィールドを

クリックするとカラ－ピッカーがポップアップします。Standard を選択するとデフォルトに復元いたし

ます。 

 
Recording Media Folder 
 
新しい録音がどこに保存されるかを Media Folder に示しています。このカラムフィールドをクリックす

ると、マウントされているすべての Media Folders のリストをポップアップします。 

 

Track Groups 

 
Track Groups は、ネ－ムの意味を含有するものとしてトラックと能率を増進する有用な他の方法をリン

クする多くの論理機能を可能にします。トラックグループはユーザがマニュピュレイト可能なものとして

制作できます。Track Groups はデフォルトで、同時に 1トラック以上の Recording または Rendering オ

ペレーションの場合に作られます。 

 

Track Groups Tab Window 
 

情報を含む各々列になったテーブルを開きます。それは、シングル トラック グル－プと情報と機能選択フ

ィールド含んだ各カラムです。 



 

 

 

 

Tracks Groups Tab floating Window 

 

最初の 2 列が、新しく制作された Track Groups を可能にします。そして、Name フィールドをクリック

して既存のものの複製を可能にします。 

 

新しい Track Group の制作のために、Click here to add a new Track Group の上をクリックしてく

ださい。テキスト入力ボックスは Name を取り替えます。適切な名前を入力してください。そして、Enter 

を押してください。新しいトラック グループはリストの底に現れます。 

 

既存のトラック グループの複製のために、あなたが複製を望む Track Group をクリックして、次に、Click 

here to duplicate a Track Group をクリックして、Track Group を複製してください。テキスト入力

ボックスは、Click here to duplicate a Track Group を取り替えます。適切な名前を入力してくださ

い。そして、Enter を押してください。複製化 Track Group はあなたがまさにちょうどコピーした Track 

Group の下の列に現れます。その後列はテーブルの下側に移動いたします。Track Group エントリは、

Name フィールド極左にあるシンボルをクリックして、希望の列にドラッギングすることによって、リロ

ケーションできます。 
 
トラックが a Track Group にアサインされた場合、a スモ－ル グループ トラックは最初にアサインされ

たトラックの上の Timeline にただちに示されます。 

 
Track Groups は、Track Group track header のちいさな [-] または [+] をクリックすることによって崩

壊/拡張が可能です。 

 

Track Group Column Fields 
 

Name 

 
Track Group のネ－ムであります。このフィ－ルドでは 29 文字が限界のように思われるかもしれません

が、もっと長くても大丈夫です。フィ－ルドをクリックするか、F2 でもネ－ムのエディットが可能です。 

 

Type 

 



このカラムフィールドをクリックすると、リストボックスがドロップダウンします。そのリストボックス

には、Free, Source または、Destination の選択があります。 

 
Free は、General purpose Track Groups を制作するのに使用されます。 

Source は、グルーピング Tracks が Source/Destination モデルの Sources であるために使用されます。 

Destination は、グルーピング Tracks が Source/Destination モデルの Destinations であるために使用

されます。 

 

Collapsed 

 
Track Groups を潰すことができます。よって、グループのトラック、たった 1 つだけ表示します。 

Yes をセットすると、選択されたトラックのみと、Timeline の Collapsed Display フィールドが表示さ

れた中に示されます。このフィールドには、同じ機能があります。Track Group header のちいさな [-] ま

たは、[+] です。 

 

もしも、シングル トラックが選択されるなら、グループは拡張されます。 

 

Collapsed Display 

 

このカラムフィールドをクリックしますと、グル－プ内のすべてのネ－ムを含むリスト ボックスをドロッ

プダウンします。選択された名前は、表示が潰されているとき、どのトラックが表示されるかを決定いた

します。 

The rest of the fields 
 

他のすべてのカラムフィールドは、チェックした場合、Yes と表示するか、ブランクのどちらかを切り替

えます。以下で説明する本機能は、フィールドを Yes と設定した場合に適用されます。 

 

Keep Cursor 

 

The Group はカ－ソルの配置を ‘remembers’ 記憶します。そして、トラックの 1 つが選択されるた

びにそれを復元します。 

 

Free Zoom 

 
グループには、それ自身のズーミング因子を持ちます。一般のズーミング因子に依存しません。 

 



Free Markers 

 
Track Groups はそれら自身のマーカー リストを持つことができます。Track Group Scale の上に表示さ

れ、もしも、Track Group Scale が隠されていたとしても、メイン TimeCode Scale に表示されます。 

(以下をご覧ください。) 

 

Markers Locked 

 

Markers をロックします。特定の Group のためにです。Free Markers は ON でなければなりません。 

 

No Selection 

 

グループのトラック上に配置されたクリップをクリックすると、なんにも選択されません。カーソルはシ

ンプルにマウスがクリックされる位置に置かれます。Q キーを押さえたままでクリックすると、クリップ

がこれらのトラックで選択されるのを容認します。 

 

Auto Solo 

 
このグル－プのどのトラックが選択されたとしても、グル－プ全体は自動的に Solo になります。 

 
Auto Mute 

 
トラックの 1 つが選択されないかぎり、グル－プ全体は自動的にミュートされます。 
 
Auto Record Ready 

 
このグル－プのトラックが選択されたとき、グル－プ全体は、Record Ready モードに移行します。 
 
Auto Collapse 

 
グル－プのトラックがなんにも選択されなければ、グループは、シングル トラックを表示するために自動

的に潰されます。このトラックが選択されたとき、グル－プ全体は拡張されます。 

 
Auto Hide 

 
グル－プのトラックがなんにも選択されなければ、グループのすべてのトラックは、自動的に隠されます。 



グループのどのようなトラックも選択されれば、グループ全体が示されます。 

 
Exclusive Show 

 
グループのどのようなトラックも選択されれば、グループのパ－トでないすべてのトラックは、隠されま

す。これは Display 用の Solo と同じような物です。 

 
Show Scale 

 
Free Markers モードで、Track Group が Free Zoom と Markers にあるなら、TimeCode の独立して

いるスケールの見せる/隠すを切り替えます。OFF の場合、この Group の Tracks のいずれかが選択され

れば、Timeline のメインな Scale に Scale と Markers を表示します。 

 

Selection 

 
Yes と説定した場合、このオプションは、グループのすべてのトラックに拡張される Track Group の中

でのどのような選択も確実にします。Selection は後方への互換性のためにデフォルトでは不可にされて

います。 

 
Tab Window の他のすべてのカラム (Solo, Mute, Record, Monitoring, Display, Show/Hide, Size, 

Color, Sync, Automation Display) は、Track Header の中で、または、グループにより作用される

Tracks Tab ウィンドウでのパラメータの説定を決めます。すなわち、これらのパラメータは、グループ

の個々のトラックを変更する場合は、グループ全体の中で変更されます。 
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Media Management 

 

Housekeeping 

 

Windows の階層ファイルシステムでは、混乱をきたしたり、ファイルをあらゆる場所に書いたりしてしま

います。複雑なオーディオプロジェクトでは、1000 個以上の謎めいた名前ファイルを作り出します。従っ

て、非常に几帳面なユーザーでも、トラック上の全てのファイルを管理するのは悪夢のようなことでしょ

う。 

Pyramix では、Media Drives / Folders と Libraries というコンセプトを使用して混乱を防ぎます。 

Media Management は簡単な方法で階層構造を使用するユーザーが混乱することを防ぎます。 

 

Audition Play 
 

Media Management ウィンドウの中の Master Clips と Library ウィンドウのオーディオ・オブジェクト

は、Monitor から MONO にダウンミックスされたものをオーディション(試聴)できます。セレクトした

オブジェクトをツールバー内の Play (Spaceキー) とStop (Escキー) でオーディションできます。オブジ

ェクトをダブルクリックすることでもプレイバックが開始されます。 

 

Media Folders 
 

Media Folders は、Media Files が入った Windows のフォルダー、もしくはドライブです。Pyramix 

は、Media Files にアクセスするためには、これら Media Folders を Mount（マウント）しなければな

りません。マウントするとメディアは Master Clips として表示されます。 

内在するオーディオ・ファイルは Mono，インターリーブ・Stereo，Multichannel Media・ファイルな

ど、ファイルはどれも 1 つの Master Clips の様に表示され、扱うことができます。 
 

これらは、ファイル・フォーマット，サンプリング周波数，ビット数にかかわらず、ドラッグ＆ドロップ

もしくはコピーでダイレクトに、Timeline もしくは User library に入れることができます。 

 

Media Target Settings 
 



Project > New もしくは、Project > New From Template でプロジェクトを作成したときに、Media 

Folder は作られるか設定されます。                            

Project Information : Project Media Folder, Record : Target settings の Media Folder, 

Project > Render : Target Settings の Media Folder, Project > Mix Down : Target Settings 

の Media Folder など、全て同じメディア・フォルダーを指します。 これらターゲットは後からでも変

更が可能で、それぞれ別のフォルダーにすることもできます。 

 

Libraries 

 

Pyramix はプロジェクトの管理をきちんと行えるようライブラリーを使用します。Libraries はプロジェ

クトのマテリアルを論理グループとして扱えるようにします。しかし、Libraries は同じ Windows のデ

ィレクトリーには置かれません。これは Pyramix の動作環境により決まります。Library は、タイプの違

うメディア・オブジェクトのポインターを含んだデータベースで、作業を素早く直感的にできるようにな

っています。 

 

Shelves 
 

ライブラリーの Shelf はサブフォルダーです。ライブラリー中にはいくつでも Shelves を作成できます。

また、Shelves の中に Shelves を作成することもできます。 

 

 

 

 

 

 

 

 

 

 

 

Libraries - Shelves 

 

Project Libraries 
 

新しい Project を作成すると、2 つの Project Libraries が作成されます。 



Composition Library 
 

全ての Project は各々個別の読取専用の Composition Library を持っています。このライブラリーには、

Project の Timeline 上( EDL に現れる)に置かれた Master Clip が含まれています。従ってタイムライ

ン上にクリップが置かれていない場合、Composition Library は空になります。 

ユーザー・ライブラリーには、Project の Master Clips と Compositions が含まれています。       
 

Default Library 
 

新しく作成された Project には、Default Library (‘project name’.pmx) と名前のついた空の User 

Library が作られます。これはハウスキーピングに利用でき、プロジェクトで管理されます。 

 

Global Libraries 
 

Project Libraries はその Project のみから利用することができますが、Global Libraries は全てのプロ

ジェクトで利用できます。これは効果音など、複数のユーザーが同じ素材にアクセスする必要がある場合

などに有効です。 

 

User Libraries 
 

Master Clips は、ちょうど Compositions にドラッグできるように、clip の管理やグルーピングなど

のために Media Folders から User Libraries にドラッグすることができます。 

Clips や Selections は、User ライブラリーにも Global ライブラリーにもコピー、ペーストできます。

Library の中のアイテムは別のライブラリーやシェルフ、Timeline にドラッグ＆ドロップや、Cut, Copy , 

Paste できます。 

 

User Libraries は個々の clips を保存できません。Compositions 全体や、複数 Tracks に渡り選択し

た範囲(Regions)の Compositions はライブラリーに置くことができます。 そのためには、まず 1 つ

以上の clips や Composition をセレクトし、Shift - Alt keys を同時に押しながら Timeline から 

Library にドラッグするか、Shift - Alt keys を同時に押しながら Overview パネルから User Library 

に Composition 全体をドラッグします。 

 

User Libraries は Master Clips, Compositions, Mixer Snapshots, Plug-in Snapshots, Fade 

Settings, etc….を置くことができます。各 Project は無制限の数のコンテンツを持った User Libraries

を無制限の数、開くことができます。 

 



N.B. ご注意ねがいます。 Pyramix の User Libraries には、Clip や選択範囲の Composition (Region)、

全体の Composition について、特別な違いはありません。どれもが User Library や現在存在している 

Composition に加えることができます。これはとてもパワフルです。どのアイテムでも Timeline から 

User Library にコピーでき、Part of ‘composition name’ というラベルが自動的につけられます。 

 

Automation in libraries 
 

Edit > Enable Automation Cut/Copy/Paste がイネーブルになっている場合、オートメーション・デ

ータも同時にライブラリーに入ります。 

 

Library Maintenance 
 

コピーやバックアップ、フォルダーの移動などによりメディアが本来あったパスから移動された場合、

Libraries は、迷子になったメディアをそのメディアが入っているフォルダーをマウントし、 

Global Libraries タブの Drive > Update Media Paths を選択することでアップデートします。 

 

Practical Media Management 

 

The Media Menu 
このメニューには、Media に関するコマンドがほぼ入っています。 

 

Search Media  Query (質問)ぺ－ジを表示した、the Media Search Tool(メディア検索ツール) 

を開きます。 

 

 

 

 

 

 

 

 

 

 

 

Media Search Tool - Query page 



検索を開始する前に、1 つの Library か複数の Libraries か、Media Folder か Folders を 

 LibrariesとMedia Folders ページで選択しなければなりません。 

 

Query Page 

 

Query ページには、Simple と Advanced Queries の 2 つのチョイスがあります。 

 

Simple Query 

 

シンプル・サーチは文字や単語を大文字小文字の区別無しに検索します。Search only the Name or File 

Name field（名前かファイルネームのみを探す）か、Search all text fields（テキストを探す）のチョ

イスがラジオボタンであります。1つ以上のワードに入力することにより、Or all words（若しくは）と

AND all words (かつ)のチョイスが可能です。例えば、Car Mercedes Door を OR all words で検索

すると、これら 3 つの単語が含まれたファイルを検索してきます。 また、AND all wordsで検索すると、

3 つの単語全てが含まれたファイルを検索してきます。これらの単語の順序は関係ありません。 

 

Advanced Query 

 

アドバンスト・サーチは、Media Management や Library Tab にあるオプションと同様のオプションを

持った検索です。どうぞご覧ください。:  Search 44 ぺ－ジ 

 

Libraries Page 
 

ここではどの Library(s) を検索するかを決めます。 

 

•  開いている全ての Libraries 

 

•  全ての Pyramix Projects と/または、Libraries のリスト 

 

•  Pyramix Projects と Libraries が入っているフォルダー・リスト 

 

ライブラリーは検索するために開く必要はありません。 

 

Media Folders Page 
 

Libraries ページと同様、Media Folders ページでは、どの Media Folders を検索するか決められます。 



•  全ての Mount された Folders 

 

•  メディアを持ったフォルダーのリスト全て 

QuickMount Library に書かれている全てのフォルダーを検索します。QuickMount がない場合は、

Open each file and search all metadata（全てのファイルを開き、全てのメタデータを検索）するか、

Search only file names（ファイルネームのみを検索）のチョイスができます。 

 

Search Results 

 

検索結果は、フローティング Library ウィンドウに表示されます。そして、検索結果のコンテンツは他の

User Library と同様に扱うことができます。 

 

Mount Referenced Media Project で使用されていてマウントされていないメディアを全てマウント

します。 

 

Auto-Mount Media 選択されていると、Project に関連つけられている Offline ライブラリーを

参照して Media が全て自動的にマウントされます。 

 

Select Online Clips 現在マウントされている Timeline 上の Clips をセレクトします。 

 

Select Offline Clips 現在マウントされていない Timeline 上の Clips を選択します。 

 

Select Used Media Project で使用されているメディアをフローティング Media Manager ウ

ィンドウ上に表示します。 

 

Select Media present on Project Default Folder 

                                                                                                                             セレクトした Project の Default フォルダーに入っている Media をフロー 

                                                                                                                              ティングComposition Library ウィンドウ中に表示します。 

 

Select Media NOT present on Project Default Folder 

                                                                                                                             セレクトした Project の Default フォルダーに入って いない Media をフ 

                                                                                                                             ローティングComposition Library ウィンドウ中に表示します。 
 

Collect Media to current Project Default Folder 

                                                                                                                             プロジェクトで使用されているメディア・ファイルをコピーします。 

                                                                                                                             この機能は別のマシンにディスクを移すときやネットワークを使用してい 



                                                                                                                             るときに有益な機能です。 

 

Clean-Up Media Choose a Media Folder to Clean-Up（どのメディア・フォルダーをク

リーンアップするか）のウィンドウが開きます。Media Folder を指定して 

OK をクリックすると、Project に関連付けられていないメディアがセレク 

                                                                                                                             トされたフォルダーから消去されます。 

 

Media Management and Libraries Tab Windows 
 

Media Management Tab Window は、外観や操作も Document・ライブラリーや Global・ライブラ

リーによく似ています。しかし、Menus や Toolbars は機能の違いにより異なっています。 
 

Media Browser 
 

Media Management ウィンドウは Mounted Media Folders の中で動作でき、ローカルまたはネッ

トワーク・ストレージの Media Browser として操作します。 

 
 

 

 

 

 

 

 

 

 

Media Management Tab floating Window 

 

Mounted Media Folders は“ Explorer ”に似た Tree によりブラウズできます。 

Media Browser で表示されていると、一時的にマウントでき、オーディションしたり、タイムラインに置

くことができます。 

 

Document and Global Libraries 
 

Document ライブラリーと Global Libraries には、実際には違いがありません。違いは管理で、複雑なプ

ロジェクト管理を助け、大きなファシリティーで使用する場合のセキュリティーを行います。Global とし



て作成した場合は、全てのプロジェクトで、Document Library のウィンドウから開き操作ができます。

同様に、Document Library ウィンドウは Global Libraries ウィンドウで開くことも可能です。 デフ

ォルトの Project ライブラリーは、Project と共に作成されます。これは、Project の Media Files のサブ

フォルダーにある .PMX プロジェクト ファイルを開くことで、Global Libraries ウィンドウとして開く

ことができます。 

 

 

 

 

 

 

 

 

 

 

 

Document Libraries Tab floating Window 

 

左の欄は、プロジェクトの Libraries と Shelves を表示しています。セレクトした Library と Shelf の

コンテンツは、右の欄にコラム内の情報と共に表示されます。シェルフはライブラリーのアイテムとして

下に表示されます。左の欄で、+ か - をクリックすることで Libraries と Shelves を開いたり閉じたりし

て表示させることができます。 

 

ライブラリーでは右の欄の内容を左の Library/Shelf ツリ－に Drag & Drop することができます。 

 

Tools and Menus 

 

Library とMedia Management Window のメニューは、使用できる機能を全て備えています。おおくは

キーボード ショートカットを持っており、セレクトした機能は直接 Library WindowのToolbar から操作

できます。 
 

The Trimmer 
 

すべての Library と Media Management Windows には、Composition/Media Trimmer がございま

す。: 



 

 

 

 

 

 

Trimmer は、Trimmer > Show のメニュ－アイテムで見せる/隠すの選択ができます。 

リスト画面でハイライトされた (選択された)オブジェクトは、トリマーで自動的に開らきます。 

それぞれのトラックの左にある小さな四角は、トリマーでの再生のために、選択/非選択を表します。 

 

以下の方法で、Media, Clips または Compositionsを整えることができます。: 

 

•  Double-click: ダブルクリックするポイントから、Monitoring Section を通してオブジェクトを再 

                    生します。 

•  Click & Drag: タイムライン、または、適切に整えられた他のライブラリーにオブジェクトをドラッ 

                    グしてください。( In ポイントから、Out ポイント。リスト画面からそれをドラッグすると、トリム 

                    されていないものを取ります｡) 

 

•  Shift + Click: Trim In ポイントを説定します。後ほど、シンプルにそれをクリックすることによっ

て、ポイントを変更できます。 

 

•  Control + Click: Trim Out ポイントを説定します。後ほど、シンプルにそれをクリックすることに 

  よって、ポイントを変更できます。 

 

•  Control + Shift + Click: Sync Point ポイントを説定します。後ほど、シンプルにそれをクリック 

         することによって、ポイントを変更できます。 

 

•  Shift + Alt + Click: Trim In ポイントを説定します。そしてその位置から再生します。 

 

•  Control + Alt + Click: Trim Out ポイントを説定します。そしてその位置から再生します。 

 

•  Control + Shift + Alt + Click: Sync Point ポイントを説定します。そしてその位置から再生しま 

                     す。 

•  Control + Double-Click: Trim In と Trim Out と Sync Points をリセットいたします。 

 

 



Trim In, Trim Out and Sync P 
 

Trim In, Trim Out および Sync Points は、Library ( Project または、Global ) に保存された 

Compositions と MasterClips のために保存されます。しかし、Media Management Window のマウン

トされた Media のための次の Mount か Refresh までです。 

 

Compatibility 
 

Media Trimmerは、Trim In, Trim Out および Sync Points がセットされるのを容認していますので、現

在のライブラリーの中にセ－ブされることを示しています。   メニューオプション:  Library > Save 

Library As 4.x は、ライブラリーを最高の互換性のために、バージョン 4.x.との互換性があるフォーマッ

トへセ－ブされるべきであることを指し示しております。 

 

Library Menus 
 

Edit, View および Trimmer メニューは、Library と Media Management ウィンドウがほとんど同じで

す。以下の Tools and Menus で詳細を見ることができます。例外には注意が必要です。 

 

Library Menu 
 

Library メニューは、新しい Libraries と Shelves の制作、既存のもの開かれて、セーブするのを容認

します。 

ライブラリーを開いたとき、Masterclips/Compositions によって使用されるメディアは、マウントさ

れないかもしれません。(例えば、リム－バブルディスク。) Mount Referenced Media は自動的に、こ

れらのメディアが見つけられた最新の位置にマウントされます。 

 

New Library    新しいユ－ザ－ライブラリーを作ります。 

 

Open Library   既存のユ－ザ－ライブラリーを開きます。 

 

Save Library As  新しいネ－ムで、現在のライブラリーのコピーを保存するか、新しい場所に保存し 

                                                                                         ます。 

Save Library as 4.x最高の互換性のために現在のライブラリーのコピーを Pyramix 4.x フォーマットで 

                                                                                          保存します。 

Close Library   現在のライブラリーを閉じます。 

 



Mount Referenced Media    自動的に、現在のプロジェクトのメディアが見つけられた最新の位 

                                                                                                                                                             置にマウントします。 

Update Referenced Media Paths ライブラリーをアップデートするために、すべての関係するメディ 

                                                                                                                                                             ア フォルダをマウントします。次に、このメニューアイテムを選択 

                                                                                                                                                             します。 

Import OMF library (Avid Bin)  インポ－トするライブラリーのロケ－トのために File Browser を 

                                                                                                                                                              開きます。 

 

Export to Akai DD Series    Export する Akai DD Series window を開きます。 

 

New Shelf    現在のライブラリ－か、Shelf で新しい Shelf (フォルダー)を加えます。 

 

Open Shelf    選択/ハイライトした Shelf を開きます。 

 

Up One Level   1 階層、上のレベルに右手パネルディスプレイを移動させます。 

 

Properties    選択したオブジェクトのプロパティ ボックスをポップアップします。 

 

Edit Menu 
 

Cut         パネルからオブジェクトをカットします。(安全のために、Media Management  

                                                                                               Tab では不可。)ぺ－ストされないと、削除されます。 

 

Copy       オブジェクトをコピ－します。 

 

Paste       オブジェクトをペ－ストします。(Media Management Tab では不可。) 

 

Paste with Media  ターゲットオブジェクトが保存される場所に、関連する Media ファイルと共にペ 

                                                                                             －ストします。 

 

 

Rename      オブジェクトをリネ－ムします。 

 

Open/Audition/Viewハイライト(選択)した Clip、または、Trimmer の Composition (Libraries only) を 

                                                                                              開きます。その後再生を始めます。ハイライト(選択)した Shelf を開きます。 

 



Audition      Trimmer のハイライト(選択)したマスタ－クリップ (Media Management only) 

                                                                                              を開きます。その後再生を始めます。 

 

Stop Audition    再生を止め、最初の位置にカ－ソルを戻します。 

 

Place       Place ダイヤログを開きます。: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Edit menu Place dialog 

 

 

ここで選択した規則に則り、選択したオブジェクトを Timeline 上に配置します。 

 

選択したトラックのタイムラインに選択したオブジェクトを配置します。Sync Point  の Playhead 

Cursor の位置、そうでなければ、Sync Point は、In Point に説定されています。 

 

Placement Tool  オブジェクトの配置のために、Placement Tool を開きます。 

 

Send       選択したオブジェクト (Libraries only) を、電子メールの添付ファイルで送ります。 

 

Consolidate    Consolidate ダイヤログを開きます｡(Libraries only) 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Libraries Edit menu Consolidate dialog 

 

Consolidate 機能は選択されたオブジェクトの中にメディアセグメントの選択的バックアップを作りま

す。すなわち、コンポジションでクリップによって参照をつけられるあらゆるメディアファイル全体をバ

ックアップする代わりに、Consolidate は、Composition のクリップセグメントによって、参照される

メディアファイルのそれらの部分だけバックアップします。 

 

Handles オプションを使用することで、クリップの境界を超えてエキストラメディアを加えることがで 

きます。これはハンドルの長さのリミットの中で、Composition の更なる操作を容認します。 

 

どうぞ、こちらもご覧下さい。:  Consolidating Projects 282 ペ－ジ 



Delete Media    選択した Master Clip と関連する MediaFiles  (Media Management only) を削 

                                                                                       除します。 

 

重要 !      Delete Media は、その言葉そのものであります。このコマンド: 

                                                                                       PERMANENTLY REMOVES AUDIO 

永遠にオ－ディオを削除してしまいます。(そして、ドライブから関連する Waveform ファイル。) 

 

Select All     右手パネルの全てのオブジェクトを選択します。(Ctrl Click はここのオブジェクト 

                                                                                       の選択を切り替えます。) 

 

Invert Selection  選択されたオブジェクトは選択をはずされて、選ばれていないオブジェクトは選択さ 

                                                                                       れます。 

 

Search 
 

Search        Search ダイヤログを開きます。 

 

 

 

 

 

 

 

 

 

 

Library Search dialog 

 

このダイヤログは、フィルタを使用することで特殊標目記入を検索いたします。 

 

Field   コンボボックスは、どれが検索の基礎として使用するかを、すべてのフィールドをリストに 

して示しています。 

 

Not    このボタンを押すと、照会は、パラメータに一致しないライブラリーで、あらゆるエントリ 

を見つけます。 

 



Method  フィルタ－パラメ－タの選択です。: 

 

Value   値は、リストにタイプでき、選択できます。リストは、選択した Field のライブラリーにす 

                                                       べての値を表示します。 

 

Recursive チェックすると、検索はライブラリーのサブフォルダーまでおよびます。 

 

Copy search result in library 

                                                       チェックすると、検索基準にマッチするすべてのアイテムが、自体に従って指定されたシェ 

                                                       ルフで、Search Results という新しいライブラリーに加えられます。 

                                                       例えば、Name contains ‘D’ in D:¥Pyramix¥Media 

 

左サイドの 2 つのコンボボックスは、一層の 2 つのフィルタが、AND / OR の選択で付加されることを容

認します。 

 

View Menu 
 

View メニューは、情報がどのように表示されるかを決定します。 

 

Toolbar   Toolbar のオンオフを変えます。 

 

Status Bar  Status バ－のオンオフを変えます。 

 

Large    大きなアイコンで表示します。 

 

Small    小さなアイコンで表示します。 

 

Lis     リストにて表示します。 

 

Detail    詳細なリストにて表示します。 

 

Filter    作動させれば、以下のフィルタ－パラメタ説定に従って Window 右手パネルにアイテム 

                                                                  を 表示します。 

 

Filter Options (このダイヤログは、Edit > Search と同じオプションを提供します。)  

 



Options   2 つの Tabs、General と Columns の Library Settings ダイヤログボックスを開きま 

                                                                   す。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Document Libraries View menu Options General and Columns panes 

 

デフォルトの General タブは、シェルフを開く選択を提供しています。 

それは、新しいフレームか Opening シェルフの親と Library Tab Window の右手パネルで表示している 

同じフレームと Columns タブコントロールの親です。表示されたカラムとオ－ダ－はすべてカスタマイ

ズ可能です。 

 

New Window  Library か Media Management Window の別のインスタンスを開きます。 

 

Refresh     リフレッシュします。 

 

Trimmer Menu 
 

Show      Trimmer のショウ/ハイドの切り替えです。 

 

Show 1 Track  Trimmer に表示されたオブジェクトの最初のトラックだけが表されます。 

 

このオプションが選択されれば、Up と down は、どのようなトラックも表示可能な Trimmer トラック デ

ィスプレイの左手に現れます。 



Show Track Details  選択した Media file の各トラックのために以下の情報を表示します。: 

•  Track Name 

 

•  Track Number 

 

•   Track Type     (left, Right, Center etc.) 

 

•  Track File Name  (Media が One File Per Track モ－ドで録音された場合。) 

 

Auto-Show   適切なオブジェクト タイプがハイライトされると、(選択された)Trimmer は自動的 

に表示されます。 

Auto-Generate Waveform  Waveforms は自動的に描かれます。 

 

Media Folder Menu 
 

Mount Media Folder   Pyramix メディア ファイリング システムを、視認可能にいたします。 

 

Unmount Media Folder Pyramix ファイリング システムから、削除します。 

 

Refresh Media Folder  Explorer Windows と同様に作業をリフレッシュします。そして、Media 

Management Window が開いた後に加えられたファイルを作ります。 

 

Create Offline/Reference Library    どうぞ、ご覧ください。:  Creating Offline/Reference 

 Libraries 63 ページ 

Create Quick Mount Libraries      どうぞ、ご覧ください。:  Quick Mount 59 ページ 

 

Open Folder      選択したドライブとディレクトリのために Media Management Library を

開きます。メディアディレクトリのネ－ムをダブルクリックするのと、同じ

効果があります。 

Up One Level      ファイル階層のレベルを 1 つ上げます。 

 

Mounting Rules     Mounting Rules ダイヤログを開きます。これで、ユーザは特別な規則を

適用できます。同じ'ユニーク'識別子を含むファイルのマウントするのを試

みる場合です。(以下を見てください。)  

 

Properties       Media Folder の属性を表示するインフォ ボックスをポップアップします。 



Edit, View and Trimmer Menus 
 

Edit, View および Trimmer メニューは Library と Media Management ウィンドウとほとんど同じで

す。詳細は、上の Tools and Menus にあります。例外にお気を付けください。 

 

Convert Menu 

Quick Import 

 

Pyramix Media Drive または、Folder へインポ－トされたどのようなサポ－トされたフォーマットのサ

ウンド ファイルも可能です。オリジナルフォーマットはもとより Pyramix へコンバ－トされたネイティブ 

PMF フォーマットも可能です。 

 

以下に 注意 してください。: サポ－トされたフォーマット ファイルは、Pyramix での作業にコン

バ－トはいりません。究極の救い主なのであります。 

 

Quick Export  Pyramix Master Clips が多くのオプションでサポートされたファイル形式のどれか 

                                                                                 でエクスポートされるのを可能にします。 

 

 

 

 

 

 

 

 

 

 

Quick Export - Export Media: Dialog 

 

One file per track  チェックすると、マルチチャンネル Master Clips は、クリップの各チャンネルの

ためにシングルファイルとしてエクスポートされます。 

 

Simple file numbering (.1, .2, .3, ...) 

チェックすると、ファイルは、付番されます。(_##001##_, _##002##_, …の

代わりに(.1, .2, .3, …) 

 



Flatten track numbers   チェックすると、たとえば、1, 2, 7, 8 の代わりに 1, 2, 3, 4 と付番され 

                                                                                                                                        ます。 

Unique filename extension チェックすると、ユニーク ファイル ネ－ム拡張を加算します。 

 

Quick Convert >      1 つ以上の Media ファイルのさまざまな方法での変換を可能にします。 

                                                                                                                                        (以下を見てください。) 

Reverse          選択をリバ－ス再生します。 

 

Export XML Description   Media Descriptions を XMLファイルでエクスポートします。メディア 

                                                                                                                                         の範囲を選択して、Convert > Export XML Description を選んでく 

                                                                                                                                         ださい。 

 

Convert - Quick Convert sub-menu 
 

 

 

 

 

 

 

 

 

 

Media Management Convert - Quick Convert sub- menu 

 

Output Dialog 

 

 

 

 

 

 

 

 

Samplerate Converter dialog 

これらのすべてのオプションがニューメディアファイルをディスクに作り出します。 



どの変換オプションが選ばれているのか、選択したプロセスを反映するタイトルのダイアログボックスを

ポップアップします。新しいネ－ムが選ばれたか、または既存のものは新しい接尾辞でキ－プされるか、

どちらかです。一挙に複数ファイルを処理するのがお望みでしたら、Add Suffix ボタンを選択しなけれ

ばなりません。複数ファイルが選択され、このオプションが選ばれると、OK All ボタンは利用可能です。 

Keep Original File Format チェックボックスは、その言葉のままです。Properties...ボタンは、特定

の変換タイプのダイアログボックスを開きます。(以下を見てください。) 

 

Quick Convert Process Properties Dialogs 
 

Resampler Properties 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Resampler Properties dialog 

 



このモジュールは初めに ±0.1 % のプルダウン/アップのオ－ディオ変換を照準としております。 

しかし、デスティネイションの長さと最終的な長さの間で、率を定義するいくつかの可能な方法がありま

す。(フレ－ムレイト、サンプルレイト、パ－セントでピッチとレイシォ。) 

 

ピッチが変更されるので、Time Stretch オペレーションとはプロセスが異なっています。 

Input と Output ファイルは、同じサンプルレイトですが、アウトプットファイルの長さは、以下のように

なります。(初期 length ) x (表示された比率) 

 

別の設定、Quality は、処理のオーバサンプリングプロセスの分解能に影響があります。 

 

このモジュールは MPEX のように Media Manager の 'Quick convert' リストで、Project メニュ－と 

'Surround Encoder' (Project > Surround Processing) として利用可能です。 

 

以下のグラフは、THD & Noise における 3つ の Quality 設定の効果のインディケ－ションを表したもの

です。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Resampler quality setting effect on THD & Noise 

 

 

:Samplerate Converter Properties 

 



 

 

 

 

 

 

 

 

 

 

Samplerate Converter Properties dialog 

 

Output Sampling Rate [Hz] は、ラジオボタンをクリックすることによってサンプルレイトを選択しま

す。 

Conversion Quality は、クオリティ－を選択します。Very high はすばらしい変換ですが、少し時間が

かかります。 

 

Prosoniq MPEX3 Properties 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Prosoniq MPEX3 Properties dialog 



4 Stretch と Pitch オプションから必要な変換を選択してください。 

Quality Mode と Formant Type コンボボックスから適切な選択をして MPEX3 Settings を最適化し

てください。 

 

Quality Mode   Single Instrument Fast 

                                                                                              Single Instrument Best 

                                                                                              Polyphonic Fast 

                                                                                              Polyphonic Good 

                                                                                              Polyphonic Best 

 

Formant Type   Sung Voice 

Spoken Voice 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

TimeZone Basic Properties dialog 

 

希望の変更の Scaling を選択してボックスの中に長さのパ－セントを入力するか、スライダを動かしてく

ださい。 

Quality スライダは High Quality と Fast 処理の説定です。 

 

Stereo Processing を Enabled にすると処理するチャンネルの選択が現れます。 

 



TimeZone Properties - Presets 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

TimeZone Presets Properties dialog 

 

ドロップダウンリストは、様々な音のタイプにふさわしいアルゴリズムプリセットの選択があります。 

 

TimeZone Properties - Advanced 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

TimeZone Advanced Properties dialog 

 



Blocklength は、処理で使用するブロックの長さを決めます。32 と 2048 の間の値をテキストボックス

の入れるか、またはスライダで決めてください。 

 

Crossfading は、スライダでブロック間のクロスフェ－ドの長さを変えます。 

 

Energy Detection が、Enable の場合、スレッシュホ－ルド レベルの説定ができます。-70dB から 0dB 

の値をテキストボックスに入れるか、またはスライダで説定します。 

 

これらのパラメータは音量と音のキャラに影響します。そして特定の音素材にふさわしい、こまやかなチ

ュ－ニングができます。 

 

Normalize Properties 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Normalize Properties dialog 

 

Level dBfs 

 

新しいファイルの最大レベル設定に 4プリセットの選択、または、スライダを使用してください。 

 

Group Normalize 

 



チェックすると、どのようなクリップグル－プのピ－クレベルも最大まで上げられ、他のクリップもそれ

に比例します。 

DC Removal    チェックすると、D.C.オフセットが除かれます。 

 

Prosoniq MPEX2 Properties 

 

 

 

 

 

 

 

 

 

 

 

 

 

Prosoniq MPEX2 Properties dialog 

4 Stretch と Pitch オプションから必要な変換を選択してください。 

 

Wordlength Converter Properties 
 

 

 

 

 

 

 

 

 

 

 

 

 

Wordlength Converter Properties dialog 



Destination Wordlength 

 

ラジオボタンを押して、ワードレングスを選択してください。 

 

Noise Shaping 

 

Noise Shaping のクオリティ－を選択してください。ハイクオリティ－はよい結果をもたらしますが、処

理時間が増えます。 

 

Dithering をチェックすると、ディザ－が供給されます。 

 

SACD Menu 
 

 

 

 

 

Media Management SACD menu 

DST Encoder   DST の Edited Master をエンコードします。 

 

 

 

 

 

 

 

 

DST Encoder dialog 

 

DST Estimator は、 Edited Master の DST エンコーディングを推測します。オ－ディオ素材の機能と

してファイルのリダクションレイトの表示グラフがあります。 

 

Media Browser Menu 
 

Reconnect Media references while browsing は、簡単な検索でブラウズしている間、Pyramix が、

開いているプロジェクトのなくなったメディアの自動的な再リンクの試みをするのを容



認します。より迅速なブラウシングのために、このオプションを不可にできます。 

 

Mount Currently Displayed Media Folder は、Media Browser に表示されている Media Folder の

簡単なマウントを容認します。 (通常、適切なフォルダ－が見つかります。) 

 

Media Browser は、Quick Mount ライブラリーを使用します。これは、いついかなる時も、ブラウジン

グ スピ－ドを上げます。フォルダを頻繁にブラウズするのに、Quick Mount ライブラリーの制作は、頼り

になります。  どうぞ、ご覧下さい。:  Quick Mount 59 ペ－ジ 

 

Managing Media Folders 

 

 

 

 

 

 

Choose a media folder to mount dialog 

 

このダイヤログを開く、いくつかの方法があります。 

Media Management Tab Window から、Media Folder > Mount Media Folder または、Media 

Driveを右クリック、または右手パネルの Media Folder エントリ－、そして様々な Pyramix  Windows の 

Media Folder コンボボックスの New エントリ－です。 

 

テキストボックスは、完全なパスが入れられるのを容認します。Media Folder または、Drive がドロップ

ダウンリストから選択されます。代わりに、テキストボックスにネ－ムをタイプして、新しい Media Folder 

を制作できます。新しいフォルダは、ツリ－の中にある今のものの下に作られます。 

 

Permanent Mount 
チェックすると、選ばれたフォルダーは、将来の Projects のスタ－トアップ時にマウントされます。 

(音響効果ライブラリーなどに役に立つ場合がございます。) 

 

Quick Mount 
Quick Mount ボックスチェックすると、システムは、フォルダのメディアファイルのすべての解析の代

わりに 'QuickMount' ライブラリーをロ－ドします。(以下を見てください。) 

 



Recursive 

チェックすると、選択したフォルダのサブ フォルダもマウントされます。 

 

Reset Recent Mounted Folders List 
ドロップ ダウン リストをきれいにクリアします。リストはリストが最後にクリアされて以来のマウントさ

れているすべてのフォルダーを含んでいます。 

 

Browse... 
Browse for Folder ダイアログボックスを開きます。ロ－カルマシ－ンのどんな Windows ドライブ、フ

ォルダ、またはマウントのために選択したネットワークの向こう側のマシ－ンでも可能であります。 

 

Mount 
選択した Media Drive または Folder をマウントします。新しい Folder の制作のために、テキスト入力ボ

ックスにネ－ムをタイプして、Mount をクリックしてください。 

 

(あなたが現在のパスツリ－と別に、どこかで新しいフォルダーを作りたいとします。それには、ドロップ

ダウンリストか、望むディレクトリへナビゲートするブラウザで、フルパスをタイプします。次にパスの

後のテキスト入力ボックスに新しいネ－ムを足してください。) Mount a media folder インフォメーシ

ョンボックスが現れます。: 

 

 

 

 

 

 

 

 

Mount a media folder info box 

 

Yes をクリックして新しいフォルダを作ります。No は、オペレ－ションをキャンセルします。 

 

Quick Mount 
 

Quick Mount モードは、デフォルトです。 

正常にフォルダがマウントされれば、'__QuickMount.pml' と呼ばれるライブラリ－が作られ、オリジナ

ルフォルダにストアされます。これは、プロジェクトオ－プン時のメディアファイルマウントタイムを、 



ドラマチックに短縮いたします。 

 

以下に 注意 してください。: 二重下線は、ファイルネ－ムの欠くことのできない部位です。 

 

Quick Mount ライブラリーが見つけられないなら、標準のマウントは実行されます。Quick Mount ライ

ブラリーは、将来の Quick Mounts が行われるのを可能にするために作られます。 

 

Quick Mount ライブラリーは、次回マウントされた時に、自動的に刷新されます。それは、Media Folder 

が変更された場合です。 

Quick Mount ライブラリーは、刷新されません。このケ－スは、Media Folders が移動、リネ－ムまた

は、Drive レタ－(ネ－ム)が変更された場合です。 

 

メニュ－オプションの、Media Folder > Create Quick Mount libraries は、与えられたドライブ、フ

ォルダかネットワークパスのためにすべての Quick Mount ライブラリーを再帰的に作ります。(通常、サ

ーバ全体で、夜通し行われます。) 

 

新しいメディア ファイルが、前の 'Quick Mounted' フォルダへ/より、付加/削除された場合、Quick Mount 

ライブラリーは、Media Manager > Refresh の選択で、マニュアル アップデ－トが可能です。 

 

Settings > All Settings Application > Location ページにある、Use Quick Mount whenever 

possible チェック ボックスがチェックされた場合、アプリケ－ションが始まれば、パーマネントリ－ マ

ウンテッド フォルダは、自動的に 'Quick Mounted' になります。 

 

Mounting Rules 

 

このダヤログは、与えられたフォルダの BWF か Wave ファイルの解析に供給されるさまざまなル－ルを 

容認します。Pyramix は常に、Media Manager で表示されるシングル マルチ トラック メディアの部分

である複数のモノファイルをグル－プにするトライをしております。したがって、A 1-2 または A 1-8, ま

たは A 1-2, 7-8, などの形態で付番されたマルチトラックのシングル アイテムとしてマルチ モノ ファイ

ルは現れます。さもなくば、それぞれのモノラルファイルに関して別々のエントリがあります。または、

マルチトラック 'set' の部分ではありません。BWFファイルの場合、これを成し遂げるのに、Pyramix は 

BWF ヘッダーを見ます。そして、いくつかのル－ルがある Unique Identifier として Originator 

Reference フィールドを使用します。そのル－ルは、EBU 編成と様々なメーカーの間に採用されたいく

つかのコンベンションにより決定されたものなのであります。 

 



時折これらのル－ルに従わないいくつかのファイルが現れるものです。 

したがって、Pyramix Media Manager はこれらのファイルを適切にマウントしない場合があります。 

いくつかのファイル失ってしまうか、マルチトラックメディアのいくつかのトラックは、なくなってしま

います。Pyramix Media Manager はその時これらのコンフリクトを検出します。フォルダはマウントさ

れて、このような問題について、ユーザに知らせます。 

そして、Media Manager > Drive > Mounting Rules メニューアイテム行くようにうながします。 

Mounting Rules ダイヤログはさまざまな異なったル－ルを容認します。そのル－ルは、このことのため

に、またはすべてのファイルが適切にマウントされるようこれらの Media Folders に供給されます。 

コンフリクトが検出されたフォルダは Red で表されます。 

特別な Mounting Rule が適用されたフォルダは Dark Green で表されます。 

Mounting Rules ダイヤログは、Media Management Tabウィンドウにあります。 

Media Folder メニュー :  Media Folder > Mounting Rules 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Mounting Rules dialog 



Rules の説明は、上の Mounting Rules ダイヤログにあります。 

 

Offline / Reference Libraries 

 

ネ－ムが Offline/Reference Libraries を示すことは、非常に長いプロジェクトのトラックのキープと永

久にオンラインでないかもしれないメディアの上の素材に有用です。 

Offline ライブラリーは、Media Management Tab Window を選択して作られます。 

 

Media Folder > Create Offline/Reference Library. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Create Offline/Reference Library dialog 

 

下の選択により、すべてマウントしたメディアを新しいライブラリーから参照します。 

 

Original Media 

 

Only selected Media Drives/Folders 

or 

All mounted Media folders 

and 

Offline Library 

 



新しいライブラリーは、Original Media の選ばれた位置に現れるすべてのメディアどちらかの参照を含

むことができます。: 

Add all Media 

または、以下の選択により、他のライブラリーにおける既に現れている現在のメディアを無視するオプシ

ョンがあります。: 

Filter Media already present in other libraries 

 

Creating Offline/Reference Libraries 
 

以下の方法で使用されれば、Offline Librariesは、非常に長いプロジェクト ライブラリーや、例えば効果

音ライブラリーなどのマネ－ジングにもの凄くパワフルな体系付けのツ－ルを提供します。 

 

Mount The Media 

 

Media Management Tab Window であなたのオーディオファイルを含むすべてのフォルダ、ディスク

をマウントしてください。( LibraryLoader, mTools または、他のソ－スと共に剥ぎ取られる。) 

我々は、力強く訴えます。これらのファイルは、PMF または、BWF (Broadcast Wave Format) である

べきなのであります。両者共長い説明フィ－ルドを持ち、類の無い識別子とタイムスタンプが内在してお

ります。 

 

以下に 注意 してください。: ファイルを剥ぎ取っての作業は、たぶん Copyright との密接な関係

がありましょう。どうぞ、他人の素材をコピーする場合は、どのような制限であろうとも確実に従っ

てください。 

 

Create An Initial Library 

 

Media Folder > Create Offline/Reference Library にて Media Management Tab Window Menu 

項目を選択し、All mounted Media folders と Add all Media を選んでください。 

 

これはあなたのすべてのオーディオファイルに参照をつける初期のライブラリーを制作するでしょう。 

すべてのファイル/ディスクはその後アンマウントにされます。 

 

ライブラリーは再編成、フォルダを作り、アイテムの複製、など、など、早速に可能です。 

 

あなたは検索をすることができます。(照会)または、あなたの Offline / Reference ライブラリーをフィル

タリングできます。 



Project > Auto-mount Media がオンの場合、各回のアイテムは適切なオ－ディオファイルの Timeline

にドラッグされて自動的にマウントします。または、Project > Mount Referenced Media を呼び出し

てマニュアルでなされます。 

 

Updating Libraries - Orphaned Entries 

 

オリジナルのオーディオファイルが移動され、または再編成されるなら、すべてのフォルダをただ一度だ

けマウントして、あなたのライブラリーをロ－ドして、Update Referenced Media Paths メニュ－コ

マンドでライブラリーを呼び出してください。 

 

Updating Libraries - Adding new files 

 

新しいオーディオファイルがあなたのメディアディスクに加えられるなら、シンプルにマウントしてくだ

さい。すべてのあなたのライブラリーをロ－ドして、上の“Create An Initial Library” のように、進ん

でください。しかし、オプションを選択してください。 

 

Filter Media already present in other libraries 

 

これは、フレッシュに付加された参照のみを含んでいる新しいライブラリー作ります。これらの新しいア

イテムは、すでにある Offline ライブラリーにコピ－/移動できます。 
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Transport and Navigation 

 

Navigation 

Pyramix Virtual Studio は 1 つの Project を取り囲みナビゲートする多くの方法を提供しております。 

 

Time Scale Bars 
 

Main TimeCode Scale Bar 
 

Project Editing Panel の先頭の近くに、タイムコード番号がある水平なグレーのエリアがあります。 

これが、Main TimeCode Scale Bar であります。トラックヘッダ－の左上に、タイムレンジ、または、 

Timeline ウィンドウの目に見える長さが表示されています。 

 

Project Editing Panel の中で Playhead Cursor を移動させる最も簡単な方法は、Time Scale Bar

に沿ってお好きな場所にマウスを置いて、左クリックしてください。 

Playhead はすぐに、新しい所定の位置に移動するでしょう。 

 

あなたは、また、Playhead Cursor を左クリックして、このバーに沿ってそれをドラッグすることがで

きます。 

Context Menu 
左手、Header、Time Scale Bar のエリアで、クリックします。コンテキストメニューがポップアップし

ます。(小さな + サインは、クリックすると何かがあります。) 

 

 

 

 

 

 

 

 

Main TimeCode Scale context menu 



最初の 5 つのエントリが、Main TimeCode Scale のためにディスプレイモ－ドの選択を提供します。: 

•   Frames 

 

•   Samples 

 

•   [ms] 

 

•   CD frames 

 

•   Display as CD Time 

残っている 3 つのエントリが Main TimeCode Scale の下で新しい Scale バーを加えます。 

•   Alternate TimeCode Scale 

 

•   Feet Scale 

 

•   Bars & Beats Scale 

 

Alternate Time Scale Bar 
 

あなたは、Time Scale Bar をセットアップできます。コンテキストメニューをとおして、または、View 

> Scales / Toolbars > Alternate TimeCode Scale で。もういちど、コンテキストメニューがありま

す。これには、Main TimeCode Scale コンテキストメニューと同じエントリが 1 つの付加的なエントリ

と共であります。:  

•   Alternate TimeCode Scale Settings 

これを選ぶと、Alternate Scales ダイヤログがポップアップします。: 

 

 

 

 

 

 

 

 

 

 

Alternate Scale Settings dialog 



Scale Setting 

 

Scale Setting コンボボックスは、ディスプレイレゾリュ－ションの選択があります。 

 

 

 

 

 

 

 

 

 

 

 

Alternate Scale Settings TimeCode Resolution combo box 

 

Stretch Scale to match Main Scale Frames  (以下を見てください。) 

 

Origin in Main Scale 

 

Offset の設定とストアができます。たとえば、バ－ジョニング時、すなわち、同じ画像に、いくつかの音

のバージョンを作ります。 

Alternate Frame Type for Frame Resolution コンボボックスには、レゾリュ－ションのフレ－ムタ

イプの選択があります。 

 

 

 

 

 

 

 

 

 

 

 

Alternate Frame Type for Frame Resolution combo box 



View > Scales / Toolbars > Alternate TimeCode Scale Settings もまた、以下の選択より、

Alternate Scale のためのTimeCode Resolution の選択が可能になります。 

 

•   Frames 

 

•   Samples 

 

•   [ms] 

 

•   CD Frames 

 

Resolution を Frames へセットすると、Alternate Frame Rate は選択することができます。 

Alternate Frame Rate が選択されれば、Stretch Scale to match Main Scale Frames のチェック

ボックスは、もはや Main Scale と同じ時間流動を表示しない Alternate Scale を容認します。(1 Second 

= 1 Second)  代わりに、それは個々の Frames の長さにマッチします。(1 Frame = 1 Frame) 

この場合、時間は両方のスケールで同じではありません。そして、これは、例えば、24 フレームのイベン

トと 25 フレームのイベントでの比較を可能にします。Origin in Main Scale のオプションは、Main 

Scale と Alternate Scale の間で設定されるオフセットを可能にします。 

 

Film Feet Scale Bar 
 

他のスケール バーに似た、ヘッダ－エリアをクリックすると、Feet Settings 付加的オプションの専択が

ある、コンテキストメニューがポップアップします。これは、Feet Settings ダイヤログです。: 

 

 

 

 

 

 

 

 

 

 

 

 

Feet Settings dialog 



Foot Type 

 

ラジオボタンは、16mm フィート (40 フレ－ム ユニット)と 35mm フィート(16 フレ－ム ユニット)の選

択があります。 

 

Frame Type 

 

コンボ ボックスには、フレ－ム レ－トの選択があります。: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Frame Type combo box 

 

デフォルトは、All Settings > Formats & Sync > Frequencies で選択したフォ－マットです。 

あなたは、ノンリニア編集ワークフローのコンテキストで他の 1つ を必要とするかもしれません。 

 

Bars & Beats Scale Bar 
 

他の Scale Bars を使用するために、ヘッダー エリアをクリックすると、見せる/隠す、の切り替えがある

コンテキストメニューがポップアップします。そして Feet と Bars & Beats Scale バ－のプラス  2 つの

付加的オプションがあります。  Bars & Beats Settings と Tempo Map 

Tempo Map オプションは、Bars & Beats Scale Bar の下に現在の Tempo Map が表示されておりま

す。 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Bars & Beats Settings dialog 

 

Midi Files Import / Export 
 

Load 

 

Save 

 

両ボタンは、ファイルのロ－ドとセ－ブのロケ－ションをナビゲ－トする、Browser Window を開きます。 

 

以下に 注意 してください。: 現在は、タイプ 2 の MIDI ファイルがインポ－トされた場合、テンポ マ

ップとトラック 1 の拍子記号のみがインポ－トされます。 

 

 



Resolution 

 

Per Quarter Note (4部音符)のレゾリュ－ションクロックをセットしてください。PPQ. コンボボックス

で、192 から 49152 まで選択できます。 

 

Bars & Beats 

 

Offset   Bars & Beats スケ－ルのオフセットは、メイン Time Scale からスタ－トします。値は、

TimeCode レジスタでタイプする方法とナッジ アップ ダウンの増減ボタンで可能です。 

 

Store    Bars & Beats スケ－ルのオフセットは、Playhead Cursor の位置からスタ－トします。 

 

以下に 注意 してください。: オフセットは、ネガティブまたは、ポジティブにもできます。 

 

Time Signature and Bars 

 

左下のパネルは、[ソング] の中に現れる小節のブロックリストを表示しています。以下の設定は、リスト

の中の現在選択されたエントリに適用されます。 

 

Time Signature  Time Signature をセットするコンボボックスを使用します。何分の何拍子。 

 

Number of Bars  値をタイプするか、コンボボックス ドロップダウンリストから Infinite を選択して 

ください。 

Snap Grid     コンボボックスは、Off の選択か、Note と 1/64 Note の間の値を提供します。 

 

Add Bars 
                                    

クリックすると、リストの上に新しい小節を増やします。 

 

Remove Bars 
 

リストから選択したものを削除します。 

 

Metronome 

 

Metronome Settings... 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Metronome Settings dialog 

 

Tempo 

 

右下のパネルには、[ソング] の中に現れる、決められた Tempos を表示しています。 

 

BPM, Frames & Perfs, Smoothing, Start および Endフィ－ルドより、ハイライトされた Tempo に

反映されます。 

 

BPM         ドロップダウンリストテンポを選びます。1BPM ステップの上下のボタンで増 

                                                                                                             減させるか、直接ボックスに値をタイプしてください。 

 



Frames & Perfs    フィルムコンポ－ザ－によって使用された Tempo を定義する代替方法です。 

それは 24フレーム/秒、8パ－フォレ－ションに再分割された各フレーム、また 

はパ－フォレ－ションに基ずいています。したがって、24.0 の値は 60BPM の 

 Tempo になります。Perfs は小数として入力されます。たとえば、12.7.間違

った入力は丸め込まれます。 

 

Smoothing      Note と 1/64（またはOFF）までの値が可能です。 

 

Start         Tempo のスタ－ト位置は、タイプにより入力できます。 

 

End         Tempo の最終位置は、タイプにより入力できます。 

 

インフォメ－ションパネルは、決定したすべての Tempos を表示します。 

 

Add Tempo 

新しい Tempo を加えます。 

 

Remove Tempo 

リストから Tempo を削除します。（選択ハイライトさせて。） 

 

Fixed or Moving Playhead Cursor 
 

Playhead Cursor の、 Timeline の移動は静止可能です。（選択してください。:  View > Fixed Cursor 

while playing ）または、Timeline が静止している間、移動を可能にすることができます。そして、ス

クリ－ンの端に達したとき、‘Paging’（ペ－ジをめくる）します。（ 選択してください。:  View > Free 

Cursor while playing ） 

 

3 つめのオプションは、Cursor Auto-Return after playing です。これが別の選択肢で選択された場合、

Playhead Cursor は Stop のときに Play の始まりの位置に戻されます。 

 

Playhead Position 
 

View > Fixed Cursor while playing が選択された場合、Fixed Cursor Settings セクションの、

Settings > All Settings > Application > Playback/Record の中に設定ができます。 

コンボボックスは、1/10th と 1/2 of Screen の間の選択があります。 

 



Composition Information and Settings Toolbar. 
 

 

 

 

 

 

 

 

Composition Information and Settings Toolbar 

 

Time Scale Bar(s) の上と、Project Editing Panel Toolbar(s) の下は、TimeCode Toolbar です。 

 

これは多くの Icons そして、増減矢印がある TimeCode レジスタ ボックスを含んでいます。 

 

左から順に。; 

 

Playhead Cursor  - 今の位置です。 

 

Mark In 

 

Mark Out 

 

Mark In to Mark Out 

 

Selection In 

 

Selection Out 

 

Selection In to Out 

 

すべてのレジスタが TimeCode のダイレクトキーボード入力を受け付けます。 

 

Mark In to Mark Out か、Selection In to Selection Out レジスタに入力したとき、In の値は、Out が

調整されている間、フィックスされたままになります。 

 



レジスタの横のアイコンをクリックすると、以下のように Timeline の Composition の見え方が変化し

ます。Cursor をクリックすると、トラックディスプレィの真中にある Cursor がある現在の Cursor ポ

ジションへの Timeline 見え方が移動します。同様に、Mark In, Mark Out, Selection In または、

Selection Out ボタンをクリックすると、現在の Mark In, Mark Out, Selection In または、Selection 

Out マーカーポジションの表示を真中にします。Mark In to Mark Out または、Selection In to 

Selection Out アイコンをクリックすると、Mark Inと Mark Out の間、または選択したエリアのディス

プレィを真中にします。ズーム機能は、トラックディスプレィをエリアいっぱいに変化させます。 

 

Markers 

マ－カ－は、まさしく TimeLine トラックディスプレィの上の Markers Track の中に表示されています。 

Pyramix には、いくつかのタイプの Marker があります。 

 

CD や、SACD Markers についての情報は、どうぞ、こちらをご覧ください。:  CD Markers 289 ペ

－ジと SACD Production Guide です。 

 

 

Markers 

 

Cursor & Markers メニュー、Toolbarr と keyboard ショートカットは、Markers の配置の方法と、ロ

ケ－ティングなどの使用法を提供しています。 

メニューエントリはそれ自身が説明になっております。 

 

どうぞ、ご覧ください。:  Cursors & Marks 475 ペ－ジ 

 

 

Markers Tab Window 
 

Markersも勿論、Markers Tab Window の中や、中に加えたり、マネージメントできます。 

 



 

 

 

 

 

 

 

 

 

 

 

Markers Tab Window 

 

48 までの Markers は、ショートカットキーと連結でき、ハ－ドウエア コントローラーへのマップができ

ます。Markers の異ったリストは、Track Group の選択、Markers Tab Window のメイン Project 

Markers List により編集が可能です。Marker が別の Marker の前または後に移動するなら、影響を受け

るマーカーは自動的にリナンバされます。 

 

最初に、Name Field ‘Click here to add a new Marker’ のエントリをクリックすると、新しい Marker 

は、00:00:00:00 で加えられます。不断のとおりこの値を編集できます。 

 

Markers のカラーは選択可能です。Color フィールドをクリックすると、利用できるカラーのリストボッ

クスをドロップダウンします。 

 

Double-clicking on a Marker’s Name Field は、Playhead Cursor を Marker へジャンプさせます。 

 

Double-click with CTRL は、マ－カ－ TimeCode から再生します。 

 

Double-click with SHIFT は、最初の Preroll でマ－カ－ TimeCode から再生します。これは、CD マ

－カ－でも同じです。 

右クリックによって開いたメニュ－は、Groups または Projects の間を Cut / Copy / Paste するための

マ－カ－を可能にすることができます。 

 

Markers Linking 
 

Markers Linking ドロップダウンリストメニューは、Markers Tab Window のトップにあります。 



 

 

 

 

 

 

 

 

ここでなされた選択は、トラック編集の機能を決定します。 

 

Markers Independent  (マーカーはスケールにロックされます。) 

 

Linked to Any Track   (マーカーはどのようなトラックオペレイションにも従います。) 

 

Linked to Tracks without Group(マーカーはグル－プメンバでない、どのようなトラックのオペレイ 

                                                                                                                          ションにも従います。) 

Linked to ‘Effects’, ‘Music’, ‘Foley’ etc.(マーカーはここでグル－プにされた、どのようなトラックの 

                                                                                                                          オペレイションにも従います。) 

Jog / Shuttle 

Scrub Using the Middle Mouse Button 
 

カーソルが Timescale エリアにあれば、マウス中ボタンのホ－ルドダウンによってオ－ディオは、スクラ

ブできます。そしてカーソルを左に動かして逆さにスクラブ、右に動かして前方へスクラブできます。 

現在のプレーカーソル位置から移動した距離は、相対的な再生スピードを決定します。 

プレーカーソルがマウス ポインタ ポジション達したとき、またはマウス中ボタンの指を上げたとき、再生

は止まります。 

 

Shuttle 
 

トランスポ－トは、最大 8 倍速でオーディオアウトプットを往復できます。 

 

Jog Settings 
 

Jog / Scrub パラメータはこちらで設定できます。Settings > All Settings > Application > Jog / 

Chase 



Auto Jog on move 

 

Jog/Shuttle フォイ－ル のフィジカル コントロ－ラが可能になり、このボックスをチェックした場合、ジ

ョグ フォイ－ルは、自動的に、ジョグ モ－ドになります。 

 

Auto-Solo Selection 

 

こちらをチェックした場合、トラックまたは選択したトラックは、ジョグ モ－ドになっていれば、自動的

に、ソロになります。 

 

Speed ceiling 
 

4 Radio Buttons は、1X, 2X, 4X か 8X 名目上のプレースピードの選択があります。 

 

Sensitivity 

 

ボックスにタイプされた値は(秒で)、秒数を決定します。トランスポ－トは、取り付けられたフィジカル ジ

ョグ ホイールの回転単位で移動します。 

 

Smoothing Filter 
 

ボックスにタイプされた値(ビデオフレームの)は、適用されるスム－ジングの度合いを決定します。 

 

Flywheel Inertia 

 

スライダはジョギングのフライフォイル効果を変更します。 

 

Transient response accelerator 

 

スライダはジョギングのレスポンスを変更します。一番極端で、一番スム－ズなオ－ディオと位置決めの

最大精度での間です。すなわち、もう片方で同期。 

 

Mouse Scrubbing Settings 
 

2 つのスクラブ モ－ドがございます。Analog Tape Mode と Repeat Loop Mode 

希望するボックスにチェックを入れてください。 



Repeat Loop Mode のル－プの長さは、基礎となるサンプリング周波数に関係します。よって、ル－プ

の長さは、44.1, 88.2 および 176.4 kHz で 116mS、48, 96 および 192 kHz で 106ms です。 

 

Limit to speed ceiling が選択されれば、マウススクラビングは、Jog Settings セクションでの Speed 

Ceiling 設定の限界になります。Silent locate が選択されれば、いくらスクラブ、またはジョギングして

も音は鳴りません。 

 

Scrub Settings 

Audio Quality 

 

2 つの Radio Buttons は、スクラブされたオ－ディオの Standard と Improved クオリティの間での選

択です。Improved がデフォルトです。 

 

高品質のスクラビングはプロセッサに非常に強烈です。よって Improved モ－ドは、Max simultaneous 

tracks デ－タ エントリ ボックスにて提供されています。デフォルトは、6 です。 

同時に最大数以上のトラックが再生された場合、スクラブは、安全を保持するために、自動的にスタンダ

ードモードに戻るでしょう。 

 

Transport Controls 

は、一番頻繁に使用される Transport Controls を集合させております。 

Chase と Capture Offset ボタン、および Counter トランスポ－ト ステイタス ディスプレイです。 

 

 

Transport Bar 

左から、コントロールは以下の通りです。: 

 

カウンタは、Active Machine の位置とトランスポ－トモ－ドを表示しています。 

 

このカウンタは、Record モ－ドになっております。 

 

Rewind ボタンは、後方に加速して Active Machine を移動します。 

 

Play Selection ボタンは、Active Machine が Internal Machine (Pyramix) になってい 

る場合、選択(ハイライト)したエリアを再生します。 

 



Play ボタンは、Active Machine を前方へ、ノ－マルスピ－ドで再生します。 

再生後のプレスは、再生を Pauses し、次は Restarts です。 

 

Record ボタンは、Active Machine を Record モ－ドにします。 

 

Fast Forward ボタンは、Active Machine を前方へ加速して移動します。 

 

Stop ボタンは、再生をストップさせます。 

 

Loop Play トグル ボタンは、Active Machine を Loop Play Mode へ移行させます。 

In と Out の間を連続して再生します。 

 

Shuttle Control スライダは、を前方へ(右)、後方へ(左)、最大 2 X の再生 

速度で往復させます。Composition を通して往復しますのですべての 

 Tracks のオ－ディオを Scrub します。 

 

コンボボックスは、今、どのマシ－ンがコントロ－ルされているか選択しま 

す。確実に直接 Pyramix Composition Play Head をコントロ－ルする 

ためにリストから Internal を選択してください。外部のデバイスでは有り 

ません。(すなわち、RS-422 Sony 9-pin P2 にコントロ－ルされるマシ－ 

ン。) 

Chase トグル ボタンがアクティブの場合、有効なタイム コ－ドが、選択された TimeCode イ 

ンプットポ－トより検出されたとき、Active Machine だけが再生します。 

 

Controllers Online / Offline ボタンです。(Green = Online Red = Offline) 外部のハー 

ドウェアの On と Off ラインを切り替えます。 

 

この右側には、Floating Tool Palettes が ‘Docked’ (格納)できるエリアがあります。デフォルトでは、こ

こには、格納された Automation Toolbar があります。 

 

Synchronizer 
 

Pyramix は、外部の TimeCode ソ－スをスレ－ブとしてチェイスします。そして、TimeCode をチェイ

スする能力のある外部マシンは、スレ－ブとして Pyramix に従うことができます。しかしながら、はるか

に満足できる方法は、Pyramix をマスタとして働かせることです。 

 



Synchronizer Option 
 

Chase Synchronizer オプションをお持ちであれば、Pyramix により外部マシンはシンクロ可能です。 

各々のマシンパネルは、Chase ボタンがあります。それが生きているとき、Pyramix は外部マシンをイン

タ－ナル TimeCode でシンクロするためにコントロ－ルします。 

トランスポ－トコマンドを送り、TimeCodeを比較して、それは内部のTimeCodeと共に受信されます。 

(どんなオフセットも受け入れます。) 

 

Transport Control Panel 
 

Transport Control Panel ボタンを押す、または [Alt T] 、または、View > Windows / 
Tools > Transport の選択により、フロ－ティングの Transport Window が開きます。デ

ィスプレィには、全ての可能となっているマシンの個々のボタンセットやインディケータがあり

ます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Transport Control Panel floating Window 



以下に 注意 してください。: この Window は、各々インスト－ルされたマシンのためのトランスポ

－トコントロ－ルの設定を含みます。そしてトップにある Internal Transport (Pyramix) を可能

にします。パネル底には、ハードウェアに作用するコントロ－ルがあります。 

 

Important (重要です。) ! マシンの設置と設定はの詳細は、こちらです。どうぞご覧ください。: 

Machine 438 ペ－ジ 

 

Internal / External Machine panels - Common Features 
 

Main Counter 

 

各々のマシンのメインパネルにあるカウンタ－は、マシンの現在地と、Transport と Record の状態を表

示しています。 

 

 

 

 

ステ－タス ディスプレィにオフセットが供給されれば、TimeCode レジスタは紫色になります。: 

 

 

 

 

 

録音中は、メイン カウンタ－が赤く変わります。 

 

 

 

 

 

Edit/Record In/Out 
隣同士のレジスタの Set In と Set Out は、現在のマシンポジションを入力します。 

 

 

 

 

 



TimeCode の値は直接タイプするか、 Panel Registers の増/減ボタンでアジャスト可能です。 

GoTo in と GoTo out は、それぞれ In と Out ポイントにマシンをロケ－トします。 

 

 In と Out ポイントは、Internal Machine がメインのためにセットします。赤色の In と緑色の Out のマ

－カ－はの Pyramix TimeLine の 中に置きます。 

 

Chase, Offset register, Capture Offset and Delta 

 

 

 

 

ボタンは、マシンが Chase Mode で明かりを灯します。(以下を見てください。) 

Offset Register は、現在のオフセット値を表示します。 

 

オフセットは、この     Offset Capture ボタンでキャプチャできます。このボタンは、Offset が

セットされたときに灯されます。 

Offset の値は、直接レジスタの中にタイプでき、増/減ボタンで調整できます。 

 

以下に 注意 してください。: ポジティブ Offset Value は、マシンの Offset を後方に、ネガティブ 

Offset は、前方にします。例えば、外部の VCR からの画像をソ－スにする場合、画像は音の 3 秒前

に到着しています。この場合、3 秒のポジティブオフセットをビデオマシンの External Transport 
       コントロールパネルに入力してください。 

 

Delta は、マシンのあるべき位置と、実際にある所で現在の異なった値(エラー)を表示しています。 

 

Locate 

                                          

Locate ボタンを押すと、Goto Timecode ダイヤログがポップアップします。 

 

 

 

 

 

 

 

 



レジスタは、マシンの現在の TimeCode ポジション値を表示し、ハイライトしています。タイプ入力準備

可能です。値は増/減ボタンで調整できます。レジスタで、OK ボタンをクリックし、マシンに TimeCode 

の値を送り、ダイヤログを閉じてください。 

 

勿論、Preroll の値もセットできます。この値は保有されます。そして、次回ダイヤログを Machine コン

トロールパネルから開いたとき、現れます｡ 

 

以下に 注意 してください。 : Chase Mode で、マシンから呼び出された場合、Goto TimeCode 

は、まったく効果が有りません。 

 

Internal Machine panel - Specific Features 

Transport Controls 

 

 

 

 

Internal Machine パネルは、いくつかの Transport Control Bar と同じトランスポ－ト コントロールが

あります。 

 

Rewind ボタンは、Composition の間の Play Head を後方へ加速したスピ－ドで移動させま 

す。 

Play Selection ボタンは、選択した(ハイライトした)エリアを再生します。 

 

Play ボタンは、Play Head の位置より通常の速度で Composition を再生します。 

その後のプレスは再生を Pause、次は Restarts します。 

 

Record ボタンは、Pyramix を Record モ－ドにします。録音のために以前ア－ミングされた 

                                   トラック上に、ディスクへの新しい録音を作ります。Play Head は、録音中、前方へノ－マル 

                                    Play スピ－ドで移動します。 

Fast Forward ボタンは、押さえつづけている間は、Composition の間の Play Head を前方

へ加速したスピ－ドで移動させます。 

 

Stop ボタンは、再生をストップさせます。 

 

Goto Timecode ダイヤログをポップアップします。 

上記の Internal / External Machine panels - Common Features をご覧ください。 



Loop Play トグル ボタンは、Pyramix をループ プレイモ－ドに移行させます。選択の始めから 

終わりまで、連続して再生します。 

 

Freeze ボタンは、すべての External Machines をストップさせます。以下の Freeze Mode を 

見てください。 

Active Machine として、Internal Machine (Pyramix) をセットします。以下の Active  

Machine を見てください。 

 

TimeCode Registers 

 

 

 

 

L レジスタは、LTC フィジカル インプットから送られて来た External TimeCode の値を表示しています。 

 

V レジスタは、Composite Video フィジカル インプットから送られて来た External TimeCode の値を

表示しています。 

X Register は、ソ－スセットから送られて来た External TimeCode の値を表示しています。 

External TC Reader セクションの Settings > All Settings > Hardware > TimeCode ペ－ジ 

 

External Machine panel - Specific Features 
 

Transport Controls 

 

 

 

 

Rewind ボタンは、後方へ加速したスピ－ドで External Machine を動かします。 

 

- 1 Frame ボタンは、1 回押すたびに 1 フレ－ム後方へ External Machine をナッジします。 

 

Play ボタンは Play モードで External Machine を始動します。 

 

+ 1 Frame ボタンは、1 回押すたびに 1 フレ－ム前方へ External Machine をナッジします。 

 

 



Fast Forward ボタンは、前方へ加速したスピ－ドで External Machine を動かします。 

 

Stop ボタンは、External Machine へ Stop コマンドを送ります。 

 

Goto Timecode ダイヤログをポップアップします。 

  上記の Internal / External Machine panels - Common Features をご覧ください。 

 

Active Machine として、External  Machine をセットします。以下のActive Machine を見 

てください。 

 

Record and Edit controls 

 

 

 

始めの 9 ボタンは、1-8 のオ－ディオトラックのア－ムと録音のためのビデオです。 

 

Record ボタンは、External Machine での録音を着手、表示します。 

 

External Machine での録音を禁止します。 

 

Preview Edit は、編集のプレビュウを始めます。 

External Machine は(どんなチェイスマシンも)、マイナスプリロ－ルの In ポイントから再生 

へ移行します。録音のためにすべてのア－ミングされたトラック上のアウトプットは、 In ポイ 

                                   ントでの再生からダイレクトへ切り替わります。Out ポイントで再生のためにバックします。 

 

Auto Edit は編集に着手します。External Machine (どのようなチェイスしているマシンで 

も) は、 In ポイントからプラス プリロ－ルで再生に移行します。そしてすべてのア－ミングさ 

                                   れたトラックは、In ポイントでパンチインされます。そして、マシン モニタ アウトプットもそ 

                                   れに従い、 Out ポイントでリプレイのために、巻き戻しされます。マシンは、 Out ポイントプ 

                                   ラスポストロ－ルで Stop します。 

 

Review Edit は、まさに実行した Auto Edit の見直しに着手します。External Machine (ど 

のようなチェイスしているマシンでも) は、 In ポイントからプラス プリロ－ルで再生に移行し 

                                   ます。再生は Out ポイントプラス ポストロ－ルまでです。 

 

 



以下に 注意 してください。:  マシンの Pre と Post roll は、ダイヤログで設定されます。Settings 
> All Settings > Remote Control > Machine ペ－ジでマシンを選択して、Properties の

上をクリックしてください。より詳細な設定は、Sony 9-Pin Protocol Configuration 
(Machine) ダイヤログで設定されます。Machine properties ダイヤログの Properties ボタ

ンをクリックしてください。 

 

どうぞこちらもご覧下さい。:  Machine Properties 439 ペ－ジ 

 

Chase Mode 
 

それぞれの Machine には Chase ボタンがあります。    Settings > All Settings > Application 

> Jog/Chase ペ－ジに Hard, Soft と Vari Chase の選択があります。Chase Mode が作動されると、

Internal Machine は、LTC, VITC,選択された External Machine か、Virtual Transport にチェイスで

きます。それらの選択は、Settings > All Settings > Hardware > TimeCode ペ－ジのTimeCode 

Source と、 Ext. TC Source コンボ ボックスにあります。 

 

Hard  Hard Chase がアクティブのとき、有効な TimeCode が、選択された TimeCode インプット 

                                          ポ－トで検出されると、Pyramix は再生のみします。入力された TimeCode にジャンプがあれ 

                                          ば、Pyramix は新しい TimeCode に合わせます。再シンクし、新しい TimeCode の位置より 

                                          再生します。タイムコ－ドにドロップ アウトがあれば、Pyramix は、自身のインタ－ナル 

                                           TimeCode で 1 フレ－ムより走ります。有効な TimeCode が検出されなければ、再生は止まり 

                                          ます。 

 

Soft   Soft Chase がアクティブのとき、有効な TimeCode が、選択された TimeCode インプット ポ 

－トで検出されると、Pyramix は再生のみします。入力された TimeCode にジャンプがあれば、 

Pyramix は新しい TimeCode に合わせません。しかしながら、入ってくる TimeCode の位置 

からのオフセットで再生を続けます。Pyramix は、自身のインタ－ナル TimeCode で 1 フレ－ 

ムより走り続けます。有効な TimeCode が検出されなければ、再生は止まります。 

 

Vari  Vari Chase がアクティブのとき、Pyramix は Varispeed になります。すなわち、サンプルレ 

                                         イトを変更して、外部の TimeCode の変動に続きます。(後方へ前方へ、スロ－ダウン、加速、 

                                         ノ－マル再生または、リバ－ス再生、最高8倍速再生)でのプレイバックです。(録音中では有り 

                                         ません。) 

 

Freeze Mode 
 



Internal Machine にも Freeze ボタンがあります。    このボタンがアクティブの場合、ここで表

示しているように、すべての External Machines は、それらの場所に残ります。アクティブにされたとき

のポイントは、メモリ－の中に保存されます。アクティブの間は、自由に使用でき、移動可能です。この

ボタンがキャンセルされたとき、Pyramix  Playhead Cursor はアクティブにされたポイントまでジャン

プします。そして、フルコントロールは、復元します。 

本機能は、よく使用されております。たとえば、シンクのアウトのポジションに使用できます。言われる

ところの、車のドアのバタンという物音です。詳細な説明は、どうぞ、こちらをご覧ください。:  Using 

Freeze Mode 372 ペ－ジ 

 

Active Machine 
 

各々の Machine’s Panel には、Ctrl ボタン      があります。Active Machine としてセットしま

す。Active Machine は、キ－ボ－ド ショウトカットでマッピングされた Active Machine のフルインプ

ットを受け入れます。そして、Transport Control Bar とすべての利用可能な Remote Controllers の

インプットも受け入れます。 

 

Transport Control Bar の Machineコンボ ボックスは、アクティブ マシンを表示しています。インスト

－ルされたマシンと可能にされたマシンの切り替えのために使用可能です。代わりに現在のエンゲ－ジさ

れたマシンを通して切り替えができます。 Machines > Active Machine > Toggle machines 

 

Auto-chase 
 

すべてのエンゲ－ジ マシンが、Auto-Chase にセットされ、Ctrl がマシンの間で切り替わったとき、

Active Machine は Chase モードから自動的に取り出されます。そして、以前の Active Machine は

Chase モードに入ります。外部のマシンのためにアクティブにするにはこのメニュ－ セッティングを可

能にします。: 

Machines > External Machine > Auto-Chase 

そして、インタ－ナル マシンの Auto-Chase をアクティブにするには、このメニュ－ セッティングを可

能にします。: 

Machines > Internal machine > Auto-Chase 

 

Controllers Section 
 

Controllers Online/Offline 
 

Controllers ボタン    が赤色に灯されれば、コネクトされた、Controllers は、Offline にセットさ



れます。再びボタンを押せば、    Online に切り替わります。 

 

Offline では、メインテナンスか、ハウスキーピング操作が進行している間、External Commands を

Pyramix へ全く送ることが出来ません。 

 

Mix-down, Generating a CD image または、どのような Surround encoding 操作の間であっても、 

Pyramix は、自動的に全てのコントロ－ラの操作を確実に行うためにオフラインにセットします。 

オペレーションはうかつに割り込みをされることは有りません。そして、ノンリアルタイム処理の間、モ

ーターフェーダ運動の悪化を避けるためです。 

 

Jog Wheel Mode 

 

このボタンは、または、Jog, Shtl, Loop, Nav または、Off の選択からハードウェア Jog Wheel Mode

を選択します。多くのコントロ－ラは、これらの機能に関係する、または、それらをマップ可能にするど

ちらかの選択ボタンがあります。 

 

Shuttle スライダは、Transport Control Panel 使用時に便利です。 

 

Zooming and Panning 

 

Project Editing Panel には、2 つのズ－ム機能があります。:水平または、Time Scale ズ－ミング; 

および垂直または、Track Height ズ－ミングです。 

 

Time Scale Zoom and Pan 
 

View Toolbar のアイコンは、現在の Play Head location でズ－ムイン、アウトをします。 

 

Toolbar の Fit in window [Alt 1] アイコンは、水平スケ－ルを、小さな縁の Project Editing  

Panel の横の選択したエリアに合わせるよう自動的に調整します。 

 

Previous zoom [Alt 2] アイコンは、水平スケ－ルを、以前のサイズに戻します。 

 

 

Zoom In [Alt 3] と 

 



Zoom Out [Alt 4] 

 

 

Alt キーを押したまま、Composition の選択したエリアをクリックして左右にドラッグすると、そのエリ

アを水平にズ－ムします。 

 

同様に、Composition のエリアは、クリック、ドラッグにより選択できます。 

Tracks の下の Scrollbar は、Timeline の左右にパンします。 

 

Track Height Zoom 
 

 

 

 

Project Editing Panel の左下にある 1, 2, 4, 8, 16 と A ボタンは、自動的に垂直に Track サイズを計測

します。従いまして1, 2, 4, 8, 16 または、All Tracks (縦のスペ－スがある限り) は、Project Editing 

Panel に割り当てられた縦のスペースにうまくはめ込まれます。 

 

これらのボタン横の水平 Scrollbar は、Track の高さの連続した調節を可能にします。 

 

Scroll Wheel 
 

スクロールホイールがある 3 ボタンのマウスの使用は大変便利です。 

 

Scroll     Project Editing Panel に表示されたトラックを縦にスクロールします。 

 

Scroll + Ctrl  Timeline をスクロールします。 

 

Scroll + Alt   Timeline タイムスケ－ルをズ－ムします。 

 

 

 

 

 

 



The Overview 
 

 

 

 

 

 

 

 

 

 

 

 

 

Overview Tab page 

 

Project Management Panel Overview Tab は、Project Editing Panel の全体をナビゲ－トする力強い、

シンプルな方法を提供します。 

Overview は、Composition 全体、すべての clips の位置関係をグラフにて表しております。 

陰影のついたグレーのボックスは、Project Editing Panel に表示された Composition のある部分の位

置、ズ－ムレンジを示しています。Clips は、Timeline 上のバックグラウンドと同色で四角い箱で表示さ

れています。 

 

Overview のどこでもいいですからクリックしますと、そのポイントにある Project Editing Panel ディ

スプレイを真中にします。 

陰影のついたグレーのボックスをクリック、ドラッグして水平ズ－ムの変化なしに Project Editing Panel 

で表示された Composition のセクションを動かしてください。Project Editing Panel のズ－ムレンジは、

Overview の陰影のついたグレーのボックスの端をドラッグして調整できます。別の方法は、Alt キ－を

押して希望のズ－ムレンジをクリック、ドラッグしてください。Project Editing Panel でまさにダイレク

トにできます。 
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Recording and Acquisition 
 

Getting Audio into Pyramix Virtual Studio 

 

まず最初にオ－ディオを Pyramix に取り入れる 2 つの基本的な方法があります。:あなたはプログラムに直

接オ－ディオを録音することができます。または、すでにコンピュ－タ－に存在するオ－ディオファイル

を取り込むことができます。 
 

こちらもご覧ください。： Digitizing Sessions 99 ペ－ジ 

 

Check Sync 
 

オ－ディオをレコ－ディングする前に、Pyramix をチェックしてください。オ－ディオソ－スはあなたの

意図に従って同期します。 

 

I/O Status Window 
 

Sync: xxxxx セクションをクリックすることによって、 I/O ステータスウィンドウを開けることができ

ます。(メインのピラミックスウインドウの右下にあります。) ( XXX’s は現在のシンクソ－スです。) 

 

このウインドウは Pyramix の入力と同期に関する情報を表示しています。 

 

               

                         I/O Status window 

 

 

 

 

 

 

 

I/O Status window 



Input sources 
 

赤と緑のライトで可能な入力ソ－スを表示します。 

緑は、デジタル信号の(このインプットのサンプルレイトは、現在のクロックソースと一致とは限らない)

プレゼンスを示します。赤信号がオンの状態で、Pyramix は完全にロックアップされています。 

 

Default Clock Source 

 

もし、Pyramix が外部のクロックソ－スにセットアップされている場合、本体のクロックは使えません。

Internal クロックに切り代える必要があります。 この場合、Internal の赤いライトはオンになり、そして、

クロックソ－スに対応している赤いライトも点滅します。 

 

Sampling Rate Mismatch 

 

Pyramix が外部のクロックソ－スにロックされて、Virtual Studio Mixer で設定されたサンプリングレイ

トがクロックソ－スのサンプリングレイトに合っていませんと、クロックソ－スに対応している緑のライ

トはオンになりますが、赤いライトは、サンプリングレイトミスマッチを示して点滅します。 

 

File Format and Disk Limitations 
 
File Size Limitations 
 

SD2、WAV または BWF ファイルが 32 bit の場合 (31 available bits)、最大 2 GB に制限されます。32 

bit の AIFファイルは 4GB に制限されます。必ず覚えておいてください。 

レコ－ディングや、またこれらのファイルのエキスポ－ト、特にハイサンプリングレ－トマルチ－トラッ

クのファイルで作業する場合は、2GB/4GB が限界になります。 

 

それと比較して、Pyramix の PMF 64 bit ファイルは、実際には限のないサイズのファイルを作ることが

できます。つまり、シングルファイルから高いサンプリングレイトでの大きなマルチトラックプロジェク

トまで作ることができます。 

                                                         

Hard Drive Limitations 
 

(hard drives, memory cards etc.) の記録ユニットは、PMFファイルであっても大きいファイルを書きこ

む場合は、2GB/4GB* 限界に直面します。FAT 32 や HFS などの、32 bit の古いファイルシステムを使用

する場合でも、同様です。                  



しかし、より早くの限界は、IDE ATA/ATAPIドライブでは、およそ137GB で現れます。 

これは 48 bitsではなく、当初の28 bit 仕様のATAでは、システム(ドライバ－、コントロ－ラ、そして/ま

たは、古い Windows バ－ジョン)の一部によって引き起こされる場合があります。  

通常は、Bios/Drivers/OS を新たにインスト－ル、またはアップデ－トすることによって解決されるでし

よう。   

 

* 公式の限界は 4GB ですが、重大なトラブルはおよそ 2 GB で現れる場合があります。 

 

Pyramix audio file format                  
 

録音に別のファイル形式を使用する理由がない場合、私たちは、デフォルトの. PMF ファイル形式を使用

するのを強くお勧めます。 これは多くのキ－領域における最高のパフォ－マンスを見せます。      

: 詳細に関しては、Optimizing Pyramix をご覧ください。 381 ペ－ジ             

 

Recording Audio into a Pyramix Virtual Studio Project 
 
新しい Project を始動するか、または既存のファィルを開いてください。そして、お望みのサンプルレ－

ト、シンクソ－スを設定します。次に、録音と同じ数の Tracks の Mixer チャンネルを構成してください。          

                                                

オ－ディオの取り込みを始める前に、適切なレコード設定をチェックするか、選択をしてください。            

Settings > All Settings > Project > Record  ぺ－ジを開いてください。             

(代わりに、キ－ボ－ドショ－トカットCtrl – f.Record Tab をクリック。) 設定のためのぺ－ジが現れま

す。; Destination Drive (Media File folder)、Resolution (ビットデプス、またはワ－ドレングス)、

および Format (ファイルタイプ) 前項でもふれたように、とくに異なったファィル フォ－マットで制作

を望まれないかぎり、デフォルトPMF フォ－マットを使用するのをお勧めます。 

 

以下に 注意 してください。: これらの設定は、Mix-down と Render の設定とは、完全に独立し 

ています。            

 

Track Record Modes                               

 

各 Track には、Track の左に 3 つの機能を持つ Record Ready トグル ボタンと Track Information 

and Setup Area があります。                                          

 

Tip:トラック設定ボタンを右クリックで Record ぺ－ジ上の Settings > Project  が開きます。    

                                                



Play                                          

         

Track が新たに作られた場合、Track Header の Green Dot はRecord Safe モ－ドで、 

                                                              デフォルトを示しています。 この状態では録音は出来ません。                     

 

Record Ready (Manual) 
 

Record Ready モ－ドに切り換えるために、一度 Green Dot をClick してください。 

 Red Dot に変わります。 

 Transport Strip またはTransport window の中の Master Record ボタンを押せば 

 ただちに録音を始められます。 

 

Record Punch In (Auto) 
 

Alt-Click で Record Punch In モ－ドに変わります。 これは Red Dotflanked by 2 

red vertical lines ( 2 つの赤いラインで囲まれた)によって示されます。                

        Transport Strip または Transport window の中にある Master Record ボタンを 

                                                                     押したとき、このモ－ドでは Mark In のポイントまで Play モ－ドのままです。そのポイ

ントから Record モ－ドに移行します。Mark Out のポイントに到達するまで Record 

モ－ドのままです。 

 

After Recording 
                                                

Settings > All Settings > Project> Record ぺ－ジでの設定により、次の新しい録音は処理されます。 

どうぞご覧ください。: Record 404 ぺ－ジ    

録音の終了時、またはトランスポ－トが止まったとき、Record Name ダイヤログが現れて Prompt for 

name after recording ボックスはチェックされます。 

 

       

Record Name dialog 

 

 

Record Name dialog 

 

レコ－ディング ネ－ムをタイプしてください。(または、デフォルトを残してください。) 次に、3 つの選

択ボタンから 1つを選択してください。 



AutoPunch Mode 
 

AutoPunch when Chasing TimeCode 
 

もしトラックが Auto-Punch モ－ドに設定されると、(Alt+Click on Rec Ready ボタン) システムは、

Mark In ポイントでパンチインを開始し、Mark Out ポイントでパンチアウトします。(TC にロックした

後で。)                                          

Mark In が現在の位置(後にある Mark Out )の前にあると、システムはロックし、すぐに録音を開始し、

アンロックするとき、録音を止めます。 

 

Recording from a tape with Discontinuous TimeCode 

 

Pyramix Auto Punch Mode はシンプルなオペレ－ションで実行します。 

Place the Mark In at 00:00:00:00 and Mark Out at 23:59:59:24 (ニュ－プロジェクトのためのデフォ

ルト値) 

LTC Out をテ－プマシンから Pyramix に接続してください。 

Chase モ－ドを HARD CHASE に設定してください。 

テ－プを巻き戻してください。 

テ－プマシンで Play を押してください。 

 

TC が止まるか、またはジャンプしてしまった場合、Pyramix はストップします。そして､正確な TC が現

れると再びロックして、新しいクリップのレコ－ディングを開始します。 

それぞれのメディアはテ－プの中に書き込まれたタイムコードのそれぞれの連続したセクションに作られ

ます。 

 

Importing Audio Files into Pyramix Virtual Studio 

 

Composition の中で、異なったビットデプス ( word lengths )を伴もなった、異なったファイル同士を結

合させることができます。 

簡単に、Timeline のなかに必要な素材を Media Drive や Media Folder または drag-and-drop によっ

て Mount できます。 

また、異なったサンプルレイトのファイルを自由に結合できます。 

   以下に 注意 してください。: 現在のプロジェクトに異なったサンプルレイトのクリップを

持っていると、クリップは'間違った速度‘で再生します。96kHz のプロジェクトでは、

48kHz のクリップは二倍のスピ－ドになってしまいます。 



どんな素材でもこれでは違いが明白ですが、(たとえば 44.1kHz - 48kHz )ではサウンド

エフェクトのひとつとして、もしくはそれほど大きな違和感を感じることはないでしょう。         

 

Mounting Media Folders 
 

多くのオ－ディオファイルが、既に Windows ディレクトリか、フォルダに存在している場合、Pyramix 

Media Folder としてマウントするのはとても簡単です。 

いったんマウントすると、サポ－トしているファイルはその Project で利用可能になります。      

 

1.  New Project を始動してください。Open または既存のプロジェクトを開いてください。 

 

2.  Media ウインドウを開くために Project Management パネルの Media Management のTab を 

                            クリックするか、またはダブルクリックして、アクティブウィンドウとして開いてください。 

 

3.  Select Media Folder > Mount Media Folder これにより、Choose a media folder to 

 Mount ダイアログボックスが開きます。 

 

4.  Browse... ボタンをクリックしてください、次に、あなたがインポ－トするオ－ディオファイルを 

 含む Windows ディレクトリへナビゲ－トしてください。 

 

5.  OK ボタンをクリックして、Media Folder として Windows ディレクトリにマウントしてくださ 

 い。サポ－トされた全てのオ－ディオファイルが、Pyramix によって検索でき、Project で利用可 能 

 になるでしょう。 

 Recursive ボックスの中をチェックすることは、Pyramix がル－トの場合と同様に選択したフォ 

 ルダのサブ-ディレクトリの中を見ることを意味します。 

  Permanentmount ボックスの中をチェックすることは、Pyramix が、アプリケ－ションの実行中 

 は常に、フォルダのマウントを試みていることを意味します。 

 言い換えればそれはすべての Projects で利用可能になります。 

 Quick Mount ボックスの中をチェックすることは、'__QuickMountLocal.pml' と呼ばれる特別 

 なライブラリ－を作ります。また、局所的にフォルダにアクセスするか、ネットワ－クを介してア 

 クセスするか、どちらかに依存する、'__QuickMountRemote.pml' と呼ばれる特別なライブラ 

 リ－を作り、オリジナルフォルダにストアします。これによりプロジェクトを開いたとき、メディ 

 アファイルをマウントする時間を劇的に短縮できます。 

                                              

                                              

                                              



Sample Rate Conversion 
 

Media File のサンプリングレイトが現在の Project と異なっている部分は、Pyramix は非常に簡単な方

法で、Media File のサンプリングレイトを変換します。 

 

1.  Master Clipファイルかメインの Media Management window の中にあるファイルを選択して 

ください。 

 

2.  Convert >Quick Convert > Samplerate Converter を選択してください。 

 これで、Samplerate Converter ダイアログボックスが現れます。 

 ラジオボタンが  2 つのテキストエントリ－の選択を提供し、ファイルのための New name か既存 

 のファイル名を Add Suffix します。 

 チェックボックスは Keep Original File Format を選択します。そうでなければ、そのファイル 

 はサンプルレイトの変換の場合と同じように PMF フォ－マットに変換されます。 

 

3.  Properties を選択すると、Samplerate Converter Properties のダイアログボックスが開きま 

 す。Output Sampling Rate [Hz] のラジオボタンをクリックして、目標となるサンプリング周波 数 

 を選んでください。Conversion Quality は Very High のオプションの High をデフォルトと し 

 ます。OK をクリックして、ダイヤログを閉じてください。 

 

4.  Samplerate Converter ダイアログボックスの中のOK を選んで、変換を始めてください。 

                    複数のファイルを変換するときには OK を選んで、一度に各々のパラメタを変える可能性があるフ 

                    ァイルをコンバ－トするか、もし step 2 で Add Suffix を選択しますと、一度の操作 OK all で全 

                    てのファイルをコンバ－トできます。 

 

 

 

 

 

 

 

 

 

 

                                        Convert Media Files dialog 

 



以下に 注意 してください。: サンプリング周波数変換では、ビットデプス( word length )は変え

られません。ビットデプス、またはノ－マライジングの変換オプションは、サブ-メニュ－のConvert 
  > Quick Convert > によりアクセスできます。 

 

Digitizing Sessions 
 

Digitizing Session は、効率的にオ－ディオの素材を Pyramix に取り込むための Pyramix Project の

特別なセッションです。素材の取り込みに Digitizing Session を使用する利点は、後のプレ－スメント

のためにオ－ディオMedia Files を参照し、Master Clips に直接特定の Library を作ることができ、保

存ができるということです。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

                                 Digitizing Session Project Window 



Manual Digitizing 
 

1.  Media セクションでは、取り込んだファイルを保存する適切な Media Folder を選んでください。 

以前に作成された Library の中にこれらの Master Clip の参照と同時に Media Files に保存する

場合は、Libraryドロップ-ダウンリストからその Library を選択してください。 

 

2.  Data セクションでは、保存しているオ－ディオファイルの適切な Resolution (ビットデプスか 

                            word length)と Format (ファイルの種類)を選んでください。 

Check One File per track ON は、ステレオソ－スの twoファイルス、5.1 サラウンドの six ファ 

イルスなど、録音した個々のファイルを生成します。 

 

3.  Input ラジオボタンのマトリクスで、録音する各々の Input を ON にしてください。 

                         また、適切に SampleRate, Input Format、および Sync Source を設定してください。 

 

4.   New Take Name をタイプして、取り入れたファイルにファイル名を書いてください。 

 Auto Increment Take Name がチェックされると、その後のすべてのテイクが、個々のテイクに 

複数形を伴った'seed 種子'として the New Take Name フィ－ルドの中に、タイプした名前で 

表されます。例えば、New Take Name として'ボ－カル'Enter Auto Increment Take Name ボ 

ックスをチェックして、次にもう数秒録音、それからまた数秒録音して停止。 

最初のテイクは'Vocal' 2  番目のテイクは'Vocal 2’と呼ばれるでしょう。 

 

5.  あなたは、 Mixer を通して入って来るオ－ディオを、モニタ－できます。ディスプレイされている 

                           Mixer の Show/Hide Mixer アイコンをクリックし、適切なレベルにセットしてください。 

 

6.  ソ－スとしてどんな外部のマシンも使用できます。しかし、Pyramix がコントロ－ルできるマシン 

                          を使用するほうが、はるかに便利です。Machineドロップ-ダウンリストからマシンを選択できま 

                           す。リストの下にコントロ－ルパネルが現れます。 

 

7. ソ－ステ－プにある必要な素材をロケ－トしてください。 

 

8. 赤い Record ボタンをクリックすると録音し始めます。Stop、Pause または Cancel ボタンが押 

                          されるまで、録音を続けます。 

 

9. Stop ボタンを押して、録音を止めてください。 

 

10.  Audit ボタンを押せば、直前に録音した音が聞けます。 



11.  目標のMedia Folder に録音した音をセ－ブするために Accept ボタンを押すか、Cancel ボタンを 

                           押して、録音を削除してください。 

 

Autoconforming 
 

1.  Pyramix は CMX format 上の EDL (Edit Decision List) で選択的にオ－ディオを録音することが 

                           できます。 

 

2.  9-ピンのコントロ－ルにより、ソ－スマシンが正しく動くよう、セットアップに従ってください。 

 

3.  Load EDL ボタンをクリックしてください、そして、あなたがオ－ディオをロ－ドする EDL にナ 

ビゲ－トしてください。 

 

4.  リストが既に Reel オ－ダ－にないなら、Optimize ボタンをクリックしてください。 

これにより、リ－ルの交換、スプ－ルを最小限にして、オ－ディオはデジタル化され、分類される

でしょう。すべての重複編集が 1 つにまとめられます。 

 

5.  リストの最初のリ－ルをロ－ドして Capture ボタンをクリックしてください。そうすれば、 

                            Pyramix は自動的にソ－スマシンをコントロ－ルするでしょう。リ－ルの中にある、必要とされる 

オ－ディオは全てデジタル化されるでしょう。 

 

6.  すべての必要とされるオ－ディオがデジタル化されて、リ－ルを換えてください。 

 

あなたが、オ－ディオがリストの特定の編集作業が利用できないことを知っていて、また特定の編集作業

だけをデジタル化するのでしたら、Capture をクリックする前に、ファイルされた Status の中の関連あ

るエントリ－のチェック ボックスのチェックをはずしてください。 

ファイルされた Status には、編集されたクリップが、いつ取り込まれたかを示しています。 

 

Enable All 
 

キャプチャ－するために Status Field ですべてのボックスにチェックをいれます。 

 

Disable All 
 

Status Field の、すべてのボックスのチェックを外します。すなわち、編集はキャプチャ－のための選択

をされません。 



Reset Status 

 

Status Field のチェック ボックスを元にもどします。 

 

Export Report 
 

キャプチャ－されたものと、そうされない詳細な編集を.rtf ファイルとしてエキスポ－トします。 

 

Handles 

 

編集のそれぞれの両端に余分にキャプチャ－されたオ－ディオをセットします。 

これは、編集作業をより自由にしますが、いくつかの事情により問題を引き起こすかもしれません。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



                                            6 

                                     Editing 
 

Editing in the Timeline 
 

Timeline はオーディオ clips を編集する場所です。フェ－ドアップ、ダウン、そしてモノ、ステレオまた

はマルチチャンネルのデジタルオーディオ Composition を行います。 

あなたが Project を開くとすぐに、Timeline を含む Project Editing Panel が現れます。 

 

Fade Editor は Timeline のパラメタを見ながら調整できる、簡潔な別の方法です。 

 

Clips and Compositions 
 

Clips in a Composition 

 
Media Drive か Library にある clips のように、Composition の clips は、ただオリジナルのオーディ

オの Media File へのポインタです。 

 

Composition の clipで実行されたどんなパフォ－マンスも、持ち込まれたオリジナルオ－ディオ

MediaFile、そしてまた Media Folder や Library の中の Master Clip には全たく影響をおよぼしませ

ん。Project Editing Panel では、１つの clip を短くする、2 clips に分ける、また移動、レベルコント

ロ－ル、消去、等など、すべての編集動作は、Composition 作業に のみ に影響するだけです。 

 

いったん Composition に置かれると、各クリップはデフォルトで、それを指すメディアファイルの

Waveform を表示します。ユーザは、Waveform ディスプレイを可能、または無効にできます。 

 

 

 

 

 

 

 



Anatomy of a Clip 
 

多くの Edit Commands はクリップ全体よりも、クリップのある部分に対するコマンドです。 

 

 

 

                                  Features of a Clip in the Timeline 

 

Clip がいったん選択されると、Trim Handles は操作している clip の両端に現れます。 

見にくい場合、つかむのが難しい場合は、アクセスしやすくなるまで、両方の軸で画像を徐々に拡大して

いってください。各 Trim Handle は 3 Control Points から成ります。 

Clip の左側の Control Points は clip の始まりを調整します。そして、右側の Control Points は終わ

りの調整をます。 

Clip を短く、または、引き伸ばす場合は、中央の Control Point をクリック、またはドラッグオンして clip

のヘッドかテールを動かしてください。 

Clip のオリジナルのオーディオ Media File の範囲であれば、これらを引き伸ばすことができます。 

View >Show Media を選択してください。 

未使用のオーディオ(もしあれば)は、波形がグレ－になって見えます。 

 

Head 
 

Track のクリップの始まりを Head と呼びます。 

Head はメディアファイルの実際の始まりを表すものか、そうでないか、分かりません。そのクリップは

メディアファイル全体の、ある一部分を指しているからです。 

 

Tail 
 

Track のクリップの終わりを Tail と呼びます。Tail はメディアファイルの実際の終わりを表すものか、そ



うでないか、分かりません。そのクリップはメディアファイル全体のある一部分を指しているからです。 

 

Sync Point 
 

Sync Point はクリップの中にある内部基準点です。 

Sync Point はクリップの中のハンドルをドラッグすると動いてしまいますが、動くまでクリップの始まり

をデフォルトとします。 

Clips > Set Sync Point to Cursor を選択することによって Play Cursor のポジションに瞬時に移動

できます。 

 

Trim Handle 
 

Trim Handle はクリップが選択されたクリップの両端で利用可能な中央のハンドルです。 

このハンドルは、クリップを利用可能なメディアの限界まで短く、または、引き伸ばすのに使用されます。

(クリップの内へ、外へ) ハンドルをドラッグしてください。 

 

Fade Handles 
 

Fade Handles は選択されたクリップの両端で利用可能な上下にあるハンドルです。 

ハンドルはクリップの始まり、クリップの終わりでフェードを作成するのに使用されます。 

フェードを作成か、調整するには、トリムハンドルの一つをドラッグしてください。 

トップハンドルがクリップのフェ－ドを整え、そしてアンダ－ハンドルはクリップの内か外へフェ－ドを

調整します。 

もし、Top Handle を CTRLキ－を押しながら使えば、隣接しているクリップに作られた左右対称クロス

フェ－ドは選択したクリップのオリジナルエンドポイントの中心に置かれます。 

隣接しているクリップが存在していない場合、選択されたクリップのデュレイションを維持している間、

フェードのデュレイションを伸ばすか、縮めます。 

 

Waveform Display 
 

クリップはクリップネ－ムを持ったひとつのブロックとして現れるか、参照メディアのオ－ディオウエ－

ブフォ－ムで表すことができます。 

 

Clip Name 
 

禁止されないかぎり、クリップの名前は示されます。                      



View > Waveform Display > Hide Clip Name when Waveform Shown 

 

Clip Gain 
 

クリップの総合的な Gain を示しています。デシベルでこの値を表示します。 

 

Gain は Clips > Clip Gain の選択により調整できます。Gain ウインドウが現れます。 

Region を選択すると、選択したすべてのクリップの Gain が変わります。 

 

Locking Clips 
 
Clips > Lock を選択してください。これにより編集、ドラッグにより、クリップが置き換えられるのを

防げます。それがアンロックされるまで、ロックされたクリップは別のトラックに移動できません。 

Clips > Unlock 

単純に同期のロスを防ぎたいのであれば、Clips > Lock Horizontal Drag を選択してください。 

                           

Grouping Clips 
 

複数の clips をGroup にするために、同じ、異なった Tracks に関係なく、Group にしたい clips を選

択してください。さあ、選びましよう。Clips > Group 

Group の中のどんな clip も、選択、コピー、削除、または移動するときと同様に、Group のすべての clips 

は、選択、コピー、削除、または移動します。 

 

一旦、Grouped clips にしたものを、アングル－プにするには、個別に処理する必要があります。 

Group を選択して Clips >Ungroup を選んでください。 

 

Groups は重ね合わせることができます。言い換えれば、別のグループの中にそのひとつがあるかも知れ

ません。例えば、ステレオまたはマルチチャンネルの clip は、単純にはモノclips の集まりです。 

ステレオかマルチ-チャンネル clips は他のグループと同様に個々のモノラルのクリップとしてアングル

－プにされるかもしれません。 

 

 

 

 

 

 



Gain Window 
 
 

Gain ウィンドウは、ゲインを今、設定するものです。 

        ゲインの量はストリップ上方のボックスの中にタイプします。もしくはフェ－ダ－をク

リック、ドラッグしてセットします。 

 

             チェックすると Mute しますが、ゲインの量は保持します。 

 

Sel.ボックス(Selection)。チェックされると、ゲインの変化は全体適用される

でしょう。(default is checked) 

 

Rel. ボックス ( Relative )ここをチェックすると and クリップのひと組はグ

ル－プかされ、ゲインは前のレベルと相対的に変化します。 

 
どのボックスもチェックされない場合、どんなゲイン変化も最後に右クリックさ 

れたクリップに適用されるだけです。(他のものが選ばれても) 

OK ボタンは、Gain ウィンドウで選択された全ての変更後、ウインドウを閉じ 

ます。Cancel ボタンは、Gain ウィンドウで選択された全ての変更を取り消し 

Gain Window      てウインドウを閉じます。 

 

Clip and Selection Editing 
 

マスタ－クリップは、 (トラックス、いくつマスタ－クリップに含まれているかに依りますますが)トラッ

クまたは編集できるブロックとして表示されています。クリップはトリミング、スプリット、クロスフェ

－ドなど他の多くのオペレ－ションをメディアファイルに影響を与えることなく行うことができます。 

全体のメディアファィルからひとつのクリップを参照する各々の例や、完全に基礎となっているMedia 

File が目に見えるまで、クリップについてもう少し明らかにするために Trim Handles を使用することに

よっていつでも"opened up"(開らくことができる)ようになります。 

トランスポ－トがプレーしている間、Timeline の中ででクリップをドラッグすることができます。 

 

 

 

 

 



Clip Properties 
                                                                       

Clips > Properties は選択したクリップの Properties ウィンドウを開きます。 

複数のクリップが選択されれば、最初のクリップの Properties ウィンドウがオープンします。 

 

Selection Window 

 

Renaming Clips 
 

Clips > Properties Selection Window ここで、クリップをリネ－ムできます。 

Pyramix は論理的、規則的な方法でクリップのリネ－ムを、より便利に行います。 

 



Clips Rename は、Rename Clips ダイアログをひらきます。: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

                              Rename Clips Dialog 

 

ユーザテキスト、自動的に作り出したデータまたは両方の組合せからどちらからも Clip Name を構成でき

ます。ダイアログボックスは多くの部分が自身で書き込むところです。 

Rename Clips ダイアログが開かれたとき、オ－トナンバリング機能はクリップが選択されたところに関

連しています。 

 

Selection Tab Window 

Selection Tab Window グル－プは、テーブルの中の Selection Properties, Clip Properties および、 

Media Properties フィ－ルドと共にあります。 

 

Selection Properties  か Properties  Menu アイテムを閉じたときに、この Tab Window が表示されま

す。Tab Window 部が隠されたなら、Selection Tab Window は、それが確実に目に見えるようドックか



ら出ます。変更することが出来るパラメータは、 ‘>’ sign. Click on the ‘>’ sign のマ－クか、交換、編集

したパラメ－タの上にマ－クします。 

 

Selection and Clip Modifiable Fields 
 
Name 

 

このフィールドはコンポジションの中に現れるようにクリップの名前を示しています。 

また、Show Text にクリップを設定するとき、クリップボックスの中に名前を表示するでしょ

う。 

 

Comment 
 

このフィールドはクリップに関するユーザコメントを示します。 

また、ここに表示された情報は、EDL Tab ウィンドウの Comment フィールドに示されるでしょう。 

 

Level 
 

両方で、利用可能です。 

フェ－ダ－、レベルの数値エントリ－ボックス、2 個のチェックボックス(Sel.ection andRel.ative)があ

るウインドウをポップアップしてください。 

もし Sel にチェックを入れた場合、どんなゲイン変化もあなたが最後に右クリックしたクリップに適用さ

れるだけです(デフォルトを選んだ場合)。 

もしRel にチェックを入れた場合、クリップの一組をグル－プにし、ゲインの変化はすでにあるレベルと

相対的なものになります。 

 

あなたが、パ－トゲインの中の“selection” の > をクリックすれば、全体の選択に供給されます。あなたが

“clip” パ－トでクリックするなら、ゲインはあなたがクリックしたマウスの下になったクリップにのみ供給

されます。 

 

例えば、3 個のクリップが、選択されたとします。-1 dB の1 番目と、-2 dB の2 番目と-3 dB の3 番目です。 

あなたはすべての選択されたクリップのゲインを1 dB ずつ増やそうとしています。 

Rel をチェックしてください。フェーダ、または、数値ボックスの中に1 dB を加えてください。 

これで、1番目、2番目、3番目はそれぞれ、0 dB, -1 dB, -2 dB となります。 

 

Phase Invert 



(Phase inverted) 逆にされたフェ－ズの No と Yes の切り替えです。 

 

Mute 
 

(Muted) ミュ－トの No と Yes の切り替えです。 

 

Auto Deglitching 

 

None, Follow General Settings の選択支のあるリストボックスをドロップダウンするか、0.5[mS] 

刻みの 1.0 [mS] と 5.0 [mS] 間のフェ－ドセッティングをドロップダウンしてください。 

この特徴は急いでカット編集を行うとき、マニュアルで短いフェードを作る面倒を避けます。 

既にフェードを持っていないどんなクリップにも、小さなレベルの傾斜(小さなフェ－ド)は、始めと終わ

りのクリックを避けるために自動的に供給されます。フェードが前もって行われているどんなクリップも 

Auto-Deglitching の特徴的機能はバイパスになります。 

 

以下に 注意 してください。: the global Automatic -Deglitching value は Settings > 
All Settings > Application> Playback/Record ぺ－ジの Automatic Deglitchingセク

ションの中にセットされています。 

 

Clip Information Only Fields 
 

上に表にされた修正できるフィールドは別として、clip はまた、以下の情報フィールドを示しています。: 

 

Length 

 

これは選択されたクリップセグメントの全長を示しています。 

 

Media Offset 
 

このフィールドは選択されたクリップセグメントの始まりが全体の Master Clip の始まりから相殺される

量を示しています。 

 

Original TimeCode 

 

このフィールドは、オリジナルのTimeCode がクリップのヘッドへ、スタンプするのを示しています。 

 



Peak Level 
 

このフィールドはクリップの中のすべてのサンプルで達した最高レベル(Decibels Full Scale)を示して

います。このことはクリップのために作りだされた Waveform ディスプレイがどれによって作り出さるか、

されたのかを示されるだけです。 

 

Media Information Only Fields 
 

Name 

 

オーディオメディアのオリジナルの省略名を示しています。 

 

Format 
 

PMF, Wave 等のメディアフォ－マットを示しています。 

 

Sample Rate 

Word Length 

Length 

 

クリップによって参照されたメディアファイルの全体の長さを示しています。 

 

Original TimeCode 

Tracks 

 

メディアが元々録られたトラックを示しています。 

 

Peak 
 

このフイ－ルドはメディアファイルに含まれる全てのサンプルにより到達した最高レベル(in Decibels 

Full Scale)を示しています。 

 

Author 

 

ファイルがいつ作成されたかをログインしたユーザに示しています。 

 



File Name 

 

ユニ－クな認識票と拡張を含むフルメディアファイルネ－ムを示しています。 

 

File Location 

 

フルウインドウズパスをメディアファイルに示しています。 

 

File Size 

 

バイトで表現されるファイルサイズを示しています。 

 

File Creation Date 
Scene 
Take 
Tape 
Notes 
UBITS 
 
Media Track Information Only Fields 
 
Track Number 

 

メディアファイルの中のトラック番号を示しています。したがってステレオファイルには、2 つのトラック

のための A1と A 2 があるでしょう。 

 

File Name 

 

ユニ－クな認識票と拡張を含むフルメディアファイルネ－ムを示しています。 

 

以下に 注意 してください。: Clip, Media そして Media Track セクションの中に見える値は

Timeline の中でクリックされたトラックに反映されます。 

幾つかの、マルチチャンネル、クリップを含む場所は Timeline の中の個々のアイテムをクリックす

るとクリックされた最後のアイテムに反映される情報を更新します。 

Selection Tab Window は選択が変更されたとき、自動的に更新されます。したがって、そのままにして

おけます。 



Selections and Region Selections 
 

Selection Operations 
 

クリップかリージョンが選択された場合にだけ、数多くの Pyramix 編集作業を行うことができます。 

 

Timelineで素材を選択する 2 つの方法があります。 Clips  全体と Regions です。 

 

Clip Selection 

 

クリップの中をクリックして、選択します。(カラーは、暗くなります。そして、Handles が現れます。) 

クリップ全体の編集作業の準備ができています。 

Shift キーを押さえて、他のクリップをクリックすると、それらを選択に加えます。 

クリップが他のクリップとグル－プ化されると、グループ丸ごとの選択になるでしょう。 

シングルクリップを選択するために、最初に、クリップをアングループにして、希望のクリップを選択し

てください。 

 

Region Selection 

 

Region Selection はComposition の選択された領域(エリア)です。Region は多くのトラックの多く

のクリップか、シングルクリップの一部しか含むことができません。それは、より暗いグレーの長方形エ

リアにワン Tracks 以上として示されます。グループの中でクリップを選択するとき、Region は自動的

に全体のグループに拡張されます。Shift key を押しながら選択すると、これを避けることができます。 

クリックして、マウスで向こう側の 1 つ以上の Tracks をドラッグすることによって、Region を作るこ

とができます。 

 

もちろん、キーボードショートカットは、Regions を作るために存在しています、そして、これはリージ

ョンをマークする最も役に立つ方法の1つです。 

Region インポイントマ－クの Pyramix デフォルトの方法は、リ－ジョンアウトポイントマ－クを押す

ことです。[キーボードの上に: これは現在選択されたトラックで Play Head Cursor location の右、す

べてを選択します。] 

現在の Play Head Cursor 位置の左、すべてを選択すれば、過去のインポイントマークは更新されます。 

Region がこの様にいったん決められると、Ctrl +Shift +Cursor UP か DOWN arrows を使用するこ

とによって、それを拡張するか、またより多くのトラックを越えて(成長)ができます。 

Ctrl +Alt +Shift +Cursor UPかDOWN 縮小。(標準の Pyramix キーボードショートカットが指定され



ていると仮定します。) 

 

キーボードショートカットを使用して、Timeline をプレーするか、マウスで操作している間、Regions 

は直接的に(on-the-fly) 容易に作ることができます。Numerical Keypad をトランスポ－トコントロ－ル 

ショ－トカットで使用すると、これは特に能率的です。 

 

Dragging Clips into a Composition 
 

あなたの Composition にオーディオ clip を置く最も簡単な方法は、Media Folder または、Library か

らドラッグすることです。 

 

Media Folder : からドラッグするために。 

 

1.  Media Management Tabをクリックして、Media Management  tab ウィンドウを開けてくだ 

 さい。 

 

2.   マウントした Media Folder か、サブ フォルダの上をダブルクリックして、開いてください。 

Master Clips はそのウィンドウの右側にすべて表示されるでしょう。 

 

3.   左クリックとホ－ルドで Master Clipを選択してください。 Master Clip を Track へドラッグ 

                              してください。Track 上の任意のポイントで、どんな Track でもそれを置くことができます。         

 

Library からオブジェクトをドラッグする手段は、MediaDrives のために概略化されたものと仮想的に

同じです。しかしながら、Project Management Panel で Global Libraries または、Document 

Libraries Tabs を使用して必要な Library にアクセスしてください。 

 

Copy and Paste 
 

別の方法でオブジェクトを Composition の中に入れる場合は、それらをコピーして、ぺ－ストしてくだ

さい。 

 

1.   Media Folder か Library でオブジェクトを選択してください。 

 

2.   Master Clip で右クリックしてください、そして、ポップアップから Copy を選んでください。 



3.  Master Clip の始まりを貼りたいところに Play Head Cursor を置いてください。 

 

4.  clip を置きたい Track の上を右クリックしてください、そして、ポップアップから Paste to 

Cursor を選んでください。オブジェクトの始まりは、右クリックした Track の Play Head に置 

                              かれるでしょう。 

                              あるいはまた、単にトラックのマウスをクリック、そして clip が始まって欲しい時は、マウスの右 

                              をクリックしてください。そして、Paste を選んで、マウスカーソルを置いたところにクリップを 

                               挿入してください。 

 

Selecting a Clip 
 

Composition のどのようなクリップもクリックして、選択してください。選択を示すため、カラーが変わ

ります。 

Shift-click により同時に、多数のクリップを選択できます。 

 

Simple Copy and Paste 
 

1. clip を左クリックして、選択してください。 

 

2. ポップアップから Copy を右クリックして、選んでください。(メニュ－Edit > Copy かCtrl + C) 

 

3. あなたが Master Clip の始まりを貼りたいところに Play Head Cursor を置いてください。 

 

4. あなたが clipを置きたい Track を右クリックしてください、そして、ポップアップから Paste to 

                   Cursor を選んでください。 (メニユーEdit > Paste to CursorかCtrl + V) clip の始まりはあなた 

                   が右クリックした Track の Play Head に置かれるでしょう。 

                  あるいはまた、単にトラックにマウスカーソルを置いてください、clip が始動して欲しいときに、右 

                  クリックして Paste を選んで、あなたがマウスカーソルを置いた clip を挿入してください。 

 

Selecting a Region 
 

リージョンを選択するために、選択したいリージョンの片方の端をクリックしてください。そして、選択

したいリージョンのもう一方の端までカーソルをドラッグしてください。 

リージョンは、1 個以上のクリップを含むことができて、複数トラックに達するかもしれません。 

また、選択されたリージョンはトラックのクリップが存在していないエリアを含むかもしれません。 

不連続なリージョンは選択できません。 



Clip Selection Behavior 
 

リストに従い、これは異なった変更キーによる選択されたクリップに対して様々な働きを示します。 

 

When a Clip is selected: 

No Modifier Key 
 

キ－変更がいなければ、標準の Edit Mode でクリップを操作できます。 

 

CTRL Key Modifier (Auto Crossfade Mode) 
 

クリック、ドラッグする前、クリップが選択されて、隣同士のクリップをオ－バ－ラップ、動かしている

ときに CTRL key を押してホ－ルドするとクロスフェ－ドを自動的に作られます。 

マウスカ－ソルは Auto Crossfade Mode の関係を示すために、その上に X を備えたハンドとして変化し

ます。 

 

 

 

Auto Crossfade Mode 

CTRL Key Modifier Option (Layering Mode) 
 

CTRLクロスフェ－ドモ－ドで CTRL Key が開放されるなら(マウス左ボタンを保持している間) 

Layering Mode がエンタ－されます。このモードは、クリップが重ね合わせられるのを示します。 

(結果は技術的に、ゼロ・レングスフェードのクロスフェ－ドです。) 

 

 

Layering Mode 

CTRL SHIFT Key Modifier (Slip Media Mode) 
 

クリップが選択され、CTRL と SHIFT キーを押すと、クリップのオーディオ内容は時間を滑るでしょう。 

メディアは利用できる範囲で滑ります。 

 

CTRL ALT Key Modifier (Slip Clip Mode) 
クリップが選択され、CTRL と SHIFT キーを押すと、クリップの In とOut ポイントはその時間内にメデ



ィアの残っている間の時間を一緒に滑るでしょう。メディアの中で「ウィンドウ」を移動させると考えて

ください。 

 

ALT SHIFT Key Modifier 
 

クリップが選択され、CTRL と SHIFT キーを押すと、クリップは新しい Composition として Library 

に加えられます。 

 

以下に 注意 してください。: クリップがTimeLine の中でどちらか一方が、Layering か 

 Auto-Crossfade Modes または Library か、 Media Management から移動し重なり合え

ば、クリップカラーは一時赤色に変化します。これは新しいクリップや、動かされることによって消 

される、右側スクリ－ンに隠れたクリップで、特に役立ちます。 

 

Auto-Crossfade By Default 
 

編集モードのデフォルトとして Auto Crossfade / Layering を設定できます。これは上で説明された機

能を逆にします。 

このモードの場合、CTRL キーを押すと、Edit モ－ドが可能になります。 

 

Edit > Auto-Crossfade を選択し Settings > All Settings > Editing の中の Auto-Crossfade by 

Default - Control key for Drag & Drop ボックスをチェックすることによって、このモ－ドは可能にな

ります。 

 

 

Clip Fade Commands 
 

Fade In 

 

Fade Out 

 

X Fade       Clips メニューでのこれらの 3 つのエントリが、似ているサブメニューにすべて 

                                                                                                     につながります: 

 

 



 

 

 

 

 

 

Crossfade sub-menu 

 

New         フェ－ドを作成します。(Fade In)始まリ、(Fade Out)終わり、(X Fade)クリッ 

プの重複。 

 

Edit         Fade In か FadeOut が選択された場合、サブメニュ－が開き、 Fade Editor が

現れます。リージョンを、既存のクロスフェードの向こう側に範囲を限定した場

合にのみ、Cross Fade サブメニュ－から Fade Editor を開いてください。 

(どうぞご覧ください。: Fade Editor Tab Window 139 ぺ－ジ) 

 

Default        クリップが選択され、クリップのスタ－トかエンドどちらかを含んで範囲が限定

された場合、Fade In or Out > Default > Complete は長さや Default Fade 

 In または Out の形状を回復させ、それを選択の中に供給します。 

Default > Curve Only は、カ－ブの形状のみ回復させます。         

クリップの上に範囲が限定され、クロスフェ－ドされたクリップ X Fade 

 > Default Complete か、Curve Onlyどちらかは Default Crossfade の長さ、 

形状を回復、供給し、または、それぞれにのみ形成します。          

 

Standard       Sub-menu はフェードタイプを選択します。 

 

                                                                                                     Power Linear 

                                                                                                     Tension Linear 

                                                                                                     dB Linear 

                                                                                                     Cosine 

                                                                                                     Root Cosine 

 

Editing Modes 
Editing Modes は Markers Header の中にあります。 

Remove、Insert または Snap モードが他のクリップにリップリングをもたらすなら、すなわち、シンク



の損失、Editing Modes は、Red の中の編集コマンドの幾つかの Insert モードとRemove モードの設

定により、Timeline のクリップを削除するか、またはぺ－ストコマンドどちらかが、異なって作用するこ

とを示しています。 

 

Edit Modes Context Menu 
 

Markers をクリックすると Edit Modes のコンテキストメニュ－がポップアップします。 

 

 

 

 

 

 

 

 

 

 

 

Edit Modes Context Menu 

 

Auto-Ripple   このオプションをチェックすると (enabled)、Insert か Remove 操作全てが、トラ

ックの残りをシフトさせます。 

 

Overwrite    チェックされると、既存のクリップを重ね合わせて置かれたどんなクリップにも、2 

                                                                                 つが重なるそのクリップに上書されます。 

 

Insert Track   チェックされると、トラックに置かれたどんなクリップも、そこに挿入されるでしょ 

                                                                                 う。そしてクリップがインサ－トされた長さによって、トラックの右にある他の素材 

                                                                                 をすぐにシフトさせます。 

 

Remove     チェックされると、選択された素材すべて Timeline から取り除かれます。 

                                                                                  他の何もかもが、完全なままで、同じ場所です。 

Remove and Ripple 

                                                                                チェックされると、選択された素材すべて Timeline から取り除かれます。 

                                                                                 取り除かれた素材により、出来たスペ－スの左へ、右の(後) 他の何もかもが左へのリ 

ップル (シフト、移行する)します。 



Don’t Snap   スナップモードをセットしません。このモードはトラックに置かれたオブジェクトの 

                                                                                 動きに影響しません。 

 

Head to End   このモードによって、トラックに置かれたどんなクリップの始まりも、新しいクリッ 

                                                                                プのヘッドを最後のクリップの端 (tail)まで隣接させて、最後のクリップの端まで ス 

                                                                                 ナップされるでしょう。 

 

Tail to Beginningこのモードによってトラックに置かれたどんなクリップも、最初のクリップのヘッド 

                                                                                 に新しいクリップのテールを隣接させて、最初のクリップの始まりまでスナップされ 

                                                                                 るでしょう。 

 

Head to Nearest このモードで、トラックに置かれたどんなクリップも、トラックの最も近い編集ポイ 

                                                                                 ントかマークにクリップのヘッドをスナップします。 

                                                                                 これは、Play Head Cursor、Mark In、Mark Out、Named Markers、または 

                                                                                 CD Marks と同様に、クリップの、ヘッド、テールを含んでいます。 

                                                                                  Insert Mode セッティングによって、クリップと、クリップはふれあいます。 

 

Snap to Original TimeCode  このモードで、トラックに置かれたどんなクリップも、クリップのオ 

                                                                                 リジナルの TimeCode によって表された時間位置にスナップするでしょう。 

                                                                                  Insert Mode セッティングによって、クリップと、クリップはふれあいます。 

 

Splitting Clips and Regions 
 

Splitting a Selection 
 
Splitting Clips 

 

Edit > Split (または、Ctrl + T)は、それ(them それら)を分割するカーソル位置に選択したクリップの

編集をマ－クします。リージョンがクリップかクリップの中に選択された場合、このコマンドを使用する

ことによって、Split 分割 (edited) されます。 

現在、オリジナルの clip(s) のそれぞれのスプリット部分は、新しい、独立した clip になります。 

 

Splitting Regions 
 

Play Cursor がクリップ全体よりむしろ選択された Region の上に置かれて、次に Edit > Split コマンド

を選ぶと、Playhead Cursor ではなく、選択領域の両端にある周囲の素材から Region を分割するでしょ



う。 

Region がいったん clip にマークされると、Region をクリックすると編集に移ります。 

(Edit > Splitメニュ－コマンドでも同じです)。これはリージョン境界で clip か clips を分割します。複

数 Tracks にわたり Region があるなら、Edits は Region の中のすべてのトラックスで作られます。 

 

Cutter 
 

C キーを押さえると、マウスポインタはカッターに変化します。どこでも、クリックすればどこでも、Edits 

(cuts) 編集 (カット)をします。 

同じ位置のさまざまなクリップの編集カットをするには、カッティングの前にそれらのクリップを選択し

てください。 

 

Duplicate Selection 
 

D キーを押さえながら、選択したものをクリック、新拠点にドラッギングすると選択された素材をコピー

して、コピーを移します。 

F キーを押さえながら、選択したものをクリック、別のトラックにドラッギングすると、同じ時間軸にロ

ックされてコピーを移します。(複数トラックを選択すると、複数トラック複製されます。) 

 

Moving a Selection 
 

単純にクリップをクリックして、同じトラック、べつのトラックの任意のポジションに移動させてくださ

い。1 つの Region が選択されると、それをクリックすると、それは周囲の素材から分割されるでしょう。 

その結果、出来た別々のクリップを別の場所かトラックにドラッグできます。 

Alt, Shift と Ctrl キ－を同時に押したままクリップを新しいトラックへドラッグすると同じ時間軸にクリッ

プを移すことができます。 

 

Adjusting a Region Selection 
 

リージョンのエッジ(始まりか、終わり)に Arrow Cursor を置いてください。 

すぐに、カーソルは、クリックとドラッギングで Region の調整を示す形になります。 

あなたはエッジをリージョンのもう一方の範囲をこえてドラッグすることができます。 

それは、新しい選択リージョンがちょうど元のリージョンが終わった(または、始まった)ところで確実に

始まります。(または、終わります)。また、これはリージョンの先頭とボトムエッジに適用されます。 

例えば、追加されたトラックを含む、1トラックのリ－ジョンのアップダウンが出来ます。 

 



Jog-Wheel Editing 
多くの編集動作が、外部のハードウェアコントローラーでジョグホイールを使用することでまかなえます。 

まず最初に、Clip かグループを選択してください、そして、次に、以下から希望の Jog-Wheel Editing 

Mode を選択してください。: 

 

Edit > Jog-Wheel Editing > Move 

Trim In 

Trim Out 

Trim Fade Out 

Tim Fade In 

Trim Fade In Symmetrically 

Trim Fade Out Symmetrically 

Trim Sync Point 

Slip In 

Slip Out 

Slide Media 

さあ、シンプルにジョグホイ－ルを動かしてみましょう。Move, Trim, Slip または、Slide the clip(s) 

Spacebar または、Enter を押し、変更を確かにしましょう。Esc はキャンセルです。 

 

Playlists 
Playlists は、いくつかのトラックの内容の種種のバリエーションを容易に保存でき、容易に保存されたバ

ージョンをリコ－ルします。 

Playlists はネ－ムを書き、また書き換えができます。Playlists は、バージョンを保ったトラックリストを

示します。 

Playlist Tab Window のTrack Group か1つ以上のTracks を選択することによって、あなたは出来る: 

 

•   これらのトラックのために新しい空の Playlist を作成してください。 

•   現在の内容のコピーを含むトラックのために新しい Playlist を作成してください。 

 

あなたは次も出来る: 

 

•   Record Ready モードで、全てのトラックの新しい空の Playlist を作成してください。 

•   現在の内容のコピーを含む Record Ready 中の、すべてのトラックために新しいプレイリストを 

                              作成してください。 



Playlist アイコンの上を Double-clicking すると、トラックの内容をバージョンを持った参照に置き換えま

す。 

Modification(修正)は別の1つをリコ－ルし、最後にリコールされた Playlist、の最後に Playlist によって

参照されたトラック上に、変更をアップデートします。 

Settings > All Settings > Project > Record のオプションのチェックにより Playlists セクションの

中に、それぞれの録音、録音されたトラックのために自動的に新しい Playlist は作られます。 

それぞれの Track ヘッダーの上に表示された Playlist アイコンは、以下を可能にします。: 

 

•    空の Playlist の新規作成は Record Ready Mode の中の、Group のすべてのTracks か Stripま

たは選択されたトラックそれぞれに当てられます。 

•    コピ－Playlist の作成は Record Ready Mode の中の、Group のすべてのTracks か Stripまた

は選択されたトラックそれぞれに当てられます。 

•    プレイリストをリコールします。Playlists の 1 つのリストはリコールするために選択されたトラ

ックを参照します。 

•    トラックの現在の内容に Playlist にMerging (融合)します。Playlists の 1 つのリストはリコー

ルするために選択されたトラックを参照します。 

 

Edit Command highlights: 
 

更なる Editing コマンドは、メイン Edit メニューにあります。どうぞご覧ください。: Edit 452 ぺ－ジ      

 

Undo      Pyramix はすべての編集作業と操作をキ－プし、必要なら、それらを元に戻すこと 

                                                                                       ができるよう、アンドゥ が可能です。このメニューアイテムは最後の操作の名前を 

                                                                                       示しています。このオペレ－ション アンドゥ のために、単にUndo (operation)メニ 

                                                                                       ューのアイテムをクリックしてください。そうすれば、記載されたオペレ－ションは 

                                                                                       元に戻されます。アイテムが元に戻されるときはいつも、それはすぐに、最新のアイ 

                                                                                       テムとして Redoリストの中に現れます。 

 

Undo History   Pyramix は最新の編集作業とオペレイションをキ－プし、サブメニューでそれらが 

                                                                                       みられます。最新のリストをトップに、古いリストをボトムに置いています。 

                                                                                       オペレーションの全体のブロックを元に戻すために、最も古いオペレーションのす 

                                                                                       べての名前をクリックしてください。(リストの中のそのポイントからリストの冒頭 

                                                                                      まで)をアンドゥします。リストの中の次のオペレーションの名前は次の Undo アイ 

                                                                                       テムとして示されるでしょう、そして、元に戻されたすべてのアイテムが、すぐに、 

                                                                                       Redo History リストに加えられます。アンドゥ ヒストリ－のサイズは、32ステッ 



   プがデフォルトです。しかし、All Settings > Settings > Application> General 

                                                                                     ぺ－ジで調整できます。 

 

Redo       オペレーションがこのメニューで「Undo」コマンドを使用して元に戻された場合、 

                                                                                       最新の元に戻されたオペレーションはここに示されます。Redo オペレーションは 

                                                                                       Edit > Redo をクリックしてください。 

                                                                                       アイテムが Redone であるときは、ただちに最新のアイテムとしてこのメニューの 

                                                                                       Undoリストの中に現れます。 

                                                                                       Pyramix で行われた次の編集オペレーションは、古いオペレーションと矛盾を引き 

                                                                                        起こす場合があるので、このアイテムを一掃します。したがって Redo は無効にな 

                                                                                       ります。 

 

Redo History   Pyramix は元に戻された最新のオペレーションのトラックをキ－プして、ここ、 

                                                                                       Redo History サブメニューでそれらを示しています。Redo へのオペレーション 

                                                                                       全体のブロックでは、最も古いオペレーションと Redone された時間まで(リスト 

                                                                                       の中のそのポイントからリストのトップ冒頭まで)すべての名前をクリックします。 

                                                                                      リストの中の次のオペレーションの名前は次の Redo メニューアイテムとして示 

                                                                                      されます。そして、Redone されたすべてのアイテムがすぐに、Undo History リ 

                                                                                       ストに加えられます。 

                                                                                       古いオペレーションと矛盾を引き起こす場合があるので、Pyramix で行われた次の 

                                                                                       編集オペレーションは、このリストを一掃するでしょう。したがって、Redoリス 

                                                                                       トを無効にします。 

Delete       このコマンドは選択したクリップかリージョンを削除します。選択が削除されたと 

                                                                                       き、その時の Remove モード設定に従って、トラックの他の素材に作用します。 

 

Cut       プロジェクトの選択された部分をカットして、それを Clipboard に置きます。Cut 

                                                                                      が選択されたとき Remove モード設定に従って、トラックの他の素材に作用しま 

                                                                                       す。 

Copy       プロジェクトから現在の選択をコピーして、それを Clipboard に置きます。 

Paste> 

Paste to Cursor  Playhead Cursor のポジションに Clipboard の内容をインサート。 

                                                                                       Clipboard の内容が Pasteされた時に、Insert モード設定に従って、トラックの他 

                                                                                       の素材に作用します。 

 

Paste Tail to Cursor Playhead Cursor の位置にすなわち、Clipboard の最後の内容を挿入します。 

                                                                                       Clipboard の内容が Pasteされたときに、Insert モード設定に従って、トラックの 



                                                                                       他の素材に作用します。 

 

Paste Sync Point to Cursor最初のシンクポイントがある Clipboard の内容を現在の Playhead 

                                                                                        Cursor の位置へインサ－トします。 

                                                                                        最初のシンクポイントがあるところに、ぺ－ストされた素材は、始め、終りか、ま 

                                                                                        たは現在の Playhead Cursor Position にまたがるかもしれません。 

                                                                                        Clipboard の内容が Paste されたときに、Insert モード設定に従って、トラックの 

                                                                                         他の素材に作用します。 

 

Paste & Place    より多くのプレ－スメントオプションがある Placement Tool を開いてください。 

                                                                                        どうぞご覧下さい。:  The Placement Tool 132 ペ－ジ 

 

Paste to Original TC Clipboard に 1 つのクリップがあるなら、クリップのオリジナルのTimeCode * 

                                                                                        に、これを挿入してください。 

 

Paste to original TimeCode クリップの異った Works そして Range Selections Clipboard に 1 つ 

                                                                                        のクリップを含んでいると、これはオリジナルのタイムコ－ドにぺ－ストされます。 

                                                                                        Clipboard が 1個以上のクリップか、クリップの選択、複数クリップを含んでいる 

                                                                                        場合、これは上書きされるクリップが全くない場所の次のトラックで選択された始 

                                                                                        めの位置に、タイムコ－ドがぺ－ストされます。 

 

Paste to End of Selection  Clipboard の内容の始まりを選択された位置の終わりに挿入します。 

 

Fill Selection   このコマンドは Clipboard  内容を選択されたクリップかリージョンの代わりに用い 

                                                                                       るでしょう。 

 

Replace Selection このコマンドは Clipboard  内容を選択されたクリップかリージョンの代わりに用い 

                                                                                       るでしょう。そして、長さが違うクリップであれば、それらに続いてリップルします。 

 

Loop Selection  このコマンドはトラックのシンクを換えずに、Clipboard 内容のループを選択した 

                                                                                       クリップか、リージョンの代わりに用いるでしょう。与えられたスペースに合うよ 

                                                                                      うにエフェクトを拡張する大変役に立ちます。 

 

Fit Selection   このコマンドはTimeline の上の指定されたリ－ジョンに適合する挿入されたクリッ 

                                                                                       プを示します。これには Timezone Time compression/Expansion plug-in が必要 

                                                                                       です。 



Delete and Ripple Selection を Delete すると全てのトラックを Ripple(シフト)させます。 

 

Cut and Ripple  Clipboard の上に Selection を Cut しプレ－スすれば全てのトラックを Ripple 

                                                                                      (シフト)させます。 

 

Paste and Ripple Clipboard の内容を、今ある Playhead Cursor のポジションにインサ－とすると、 

                                                                                        全てのトラックを Ripple(シフト) させます。 

 

Insert Silence   選択した中に静寂 (blank space)を挿入すると、全てのトラックを Ripple(シフト) 

                                                                                       させます。 

Delete and Join  選択された Clip/Selection を削除して、クリップの端をリップル(シフト)します。 

 

Cut and Join   現在選択した Clip/Selection を Clipboard にカット、そしてセーブすると、クリッ 

                                                                                       プの端をリップル(シフト)します。 

 

Delete and Ripple to Black 選択したクリップ/選択を Delete すれば、接合またはクロスフェ－ドさ 

                                                                                        れたクリップを、直後に全てリップル(シフト)します。 

 

Cut and Ripple to Black 選択したクリップ/選択を Cuts、セ－ブすれば、接合またはクロスフェ－ド 

                                                                                       された Clipを、直後に全てリップル(シフト)します。 

 

Stretch       Stretch plug-in プラグインダイアログを開きます。 

 

 

 

 

 

 

 

 

 

 

 

Stretch dialog 

Increment と Decrement ボタンは、選択したIn ポイント、Out ポイントまたは Length の調整を示しま

す。ストレッチか圧縮の Ratio はパーセンテージによって表示されます。 



OK ボタンをクリックすると、プロセスは始まります。アボートを Cancel してください。 

以下の選択により、利用可能なオ－サライズキーによって、Time Stretch アルゴリズムを選択できます。: 

All Settings > Application > Editing : Time Stretch Tool : Selected コンボボックス 

 

以下の選択により、アルゴリズムの設定を作ることができます。 

All Settings > Application > Time Stretch > ‘Plug-in name’ Settings 

 

Normalize         Normalize ダイアログを開いてください。 

 

 

 

 

 

 

 

 

 

 

 

Normalize dialog 

 

Maximum Level は、増/減ボタンをタイプするか、または使用することによって、セットができます。 

以下により、プロセスが供給されます。: 

 

• Normalize each clip individually 

 

• Normalize clips according to the selection peak 

 

OK をクリックすると、プロセスは始まります。 

選択した Clip か Clips の、最も高いピークの位置を見つけて、次に、クリップの総合ゲインが増強されま

す。指定された最大のレベルになります。 

他のすべての選択された Clips が、同じゲイン量により個別に処理されるか、またはレベルが上げられま

す。 

 

Normalize clips according to the selection peak モ－ドでは、以下のボックスがチェックしてくだ

さい。: 



 

•   Current Clips Gain 値を使用して、ピークレベルを計算してください。(チェックを外されると、 

前のゲイン値は無視されます。) 

 

そして: 

 

選択した MaxPeak は、クリップのレベルを使用することで計算されるでしょう: 

 

MaxPeak = Max(peak + Level) 

 

Delta Gain To Apply = Desired Maximum Level - MaxPeak 

 

そして、それぞれのクリップの選択: 

 

Level = Level + Delta Gain To Apply 

 

以下に注意してください。: Normalize each clip individually が選択されればこのチェッ

クボックスは灰色になります。 

 

Normalize Example : 
 

Maximum Level = -0.3 dB and “Use Current Clips Gain values to compute peak levels 

(previous gain values will be ignored if unchecked)” が選択された場合: 

 

 

 

 

 

 

 

 

 

 

 

Consolidate         Consolidate Project ダイアログボックスを開いてください。 

                                                                                                                                            どうぞご覧ください。: Consolidating Projects 282 ぺ－ジ      



Waveform          Waveform sub-menu(サブメニュ－)を読んでください。: 

 

 

 

 

Waveform sub-menu 

 

Follow Track    Track 全体をクリップは、表示します。 

 

Force Waveform  クリップは総合的なTrack 設定にかかわらず Waveform を表示します。 

 

Force Name     クリップは総合的なTrack  設定にかかわらず Clip Name を表示します。 

 

Auto Silence Removal 
 

Edit > Automatic Silence Removal 

 

Automatic Silence Removalは、Selection のスキャンにより、作動し、また、スレッシュホ－ルド レ

ヴェルを下落させ、Automatic Silence Removal dialog の中の、設定された‘Minimal Sound’と

‘Silence’ の基準レヴェルを満たすどちらかの、リージョンを除去し、自動的により小さくクリップを編集

します。 

 

 

 

 

 

 

 

 

 

 

                  Automatic Silence Removal dialog 

以下に 注意 してください。: 本機能はメディアファイルの非--破壊です。それは、ハードドライブ

から実際のオーディオを削除することによって編集するのではなく、より小さい Clip に解体し、編集

します。 



Threshold [dB] 
 

このフィールドは、dB により、クリップの素材が取り除かれるスレシュホ－ルドレヴェルを測定します。 

 

Minimal Silence [ms] / Minimal Sound [ms] 
 

スレシュホールド以下の削除される素材による無音とサウンドの最も短い時間をセットします。 

何らかのオーディオ素材(例えば、スピーチ)は非常に短いギャップを含んでいます。 

これらのすべてを取り除くなら、オーディオは「みじん切り」になります。 

スピ－チに関しては、通常ブレ－クがあって、言葉またはセンテンスの間の小さなすきまを取り去ること 

は実最しません。あるオーディオ素材はスレシュホールドの下の部分に非常に短い束の間のピークを持っ 

ているかもしれません。これらの短い間隔、すべてがクリップとして作成されたなら、結末はたぶんオリ 

ジナルより悪く聞こえるでしょう。 

 

最小の設定は10 msです、そして、最大は 5000 msです。(5 seconds) 

Fade Out [ms] / Fade In [ms] 
Automatic Silence Removalオペレーションによって作成されたすべての新しいクリップに適用され

るオ－トマチック Fade OutとFade In の長さを設定します。 

5 ms と500 ms の間には、設定のためのレンジがあります。(1/2 second) 

パラメータを設定した後、OK をクリックしてください。 

このプロセスは、トラックに、新たに一緒に作成されたクリップの間にギャップを残すか、接合するか、

またはリップル(シフト)するかを決定する現在の Remove Mode を根拠にします。 

 

Automatic Silence Removal cannot be executed on cross-faded Clips. 
(クロスフェ－ドされたクリップでは、オ－トマチック サイレンス リム－バルは実行できません)。 

 

EDL Tab Window 
EDL (Edit Decision List) Window はTimeline のグラフィカルな同じ情報とFade Editor の内容、そして、

数値の表示です。ここで行われた変更は、Timeline に反映されます、逆も同様に、リストの大部分は編集

可能であり、またそのテキストか TimeCodeフィールドのクリップに関する情報を示しています。 

これは、見ながら編集する代りの方法です。フィールドを編集するために、カーソルを作るためにクリッ

クするか、フィールドのテキストの向こう側にドラッギングして、選択してください。次に、ノ－マルテ

キストエントリにより、希望の情報をタイプしてください。 

Edit Decision List Panel の利用できるフィールドは以下の通りです。: 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Absolute Sources in EDL View 
 

Settings > All Settings > Application > Time LineLayout ぺ－ジの View Sources in EDL View 

をチェックした場合、オリジナルの Source In, Source OutとSync Pointタイムは EDL View の中の 

Absolute Timeで示されています。 

絶対時間は、オ－ディオキャプチャ－でレコ－ドされ、入力された TimeCodeです。 

このモードが無効にされるとき、キャプチャ－されたクリップの TimeCode のデフォルト開始時刻が無効

になります。00:00:00:00 

 

The Placement Tool 
Placement Tool は非常にフレキシブルなペーストオプションでが、オプションの最も重要なオペレーシ

ョンは Edit メニューの 1 つのコマンドとして直接利用可能です。 

これらのすべてのコマンドをキーボードキーにマップするか、マクロの中で含めることができます。 

多くの場合、これははるかに効率的です。 

Paste アクションの幾つかの異なったオプションは Edit、またはポップアップメニューより選択できます。

それらは、何かぺ－ストしたり、トラックの上にあるカ－ソルを右クリックしたときに現れます。 

すなわち、Paste to Cursor 

 



 

 

 

 

 

 

 

 

 

 

 

 

Placement tool floating Window 

 

Paste & Place を選択して Placement Tool ウインドウを開いてください。ぺ－ストオプションの上を

右クリック、または Edit メニュ－よりEdit > Paste Place を選んでください。 

Placement Tool ウィンドウで、ユーザは非常に強力でフレキシブルに clip の位置決めをカスタム設計

できます。 

 

ボタンのレイアウトは標準キーボード数値パッドに対応しています。(テンキ－) 

 

ウインドウの点灯され、並んだボタンの中で、Paste Place 操作を選択してください。 

 

例えば、あなたはポップアップリストから選ばれた Destination Track の上にタイプされた Time Code 

の位置にあるクリップの Sync Point を Send として選ぶことができます。 

または、あなたは Play Cursor へ、クリップのTail をSend することができます。 

位置決めのあらゆる入れ替えが可能です。選択したすべての操作は、あなたが Do It! を選ぶ前にテキスト

としてウィンドウの右下隅に選択の結果を表示するでしょう! 

 

決定するため、Insert Mode を忘れずに選んでください。新しい clip がトラックの上に置かれれば、周 

りの clips はアジャストされるでしょう。 

 

 

Source - Destination Editing 

 



Concept 
 

Source - Destination Editing はビューイングの強力なメソッドです。そして、多重編集、複数トラック、

その中のワントラック、または(ディ－ル)テイクの編集の強力なメソッドです。 

Special Source and Destination Track Groups は、複数のTimelinesを同時に表示します。 

Source and destination Timelineそれぞれは、自身、Playhead をズ－ムさせます。 

' Collapse'(崩壊)の特徴を得ることによって、48トラックの源泉素材を編集するのはモノラルまたはス

テレオを編集するのとほとんど同じくらい簡単です。 

 

Source – Destination 編集はブロードキャストと DTMアプリケーションでも非常に役に立ちます。 

Pyramix は、あなたが望む多くのクリップエディタを持つことができます。 

いくつかのトラックを作成、それらをグル－プに、そして、ひとつのSourceとして、グループに設定して

ください。 

‘always visible’としてトラック、トラックスの Clip Editor をセットしてください。 

(Tracks Tab Window の中にそれぞれの Clip Editor は、コンポジションの上にあります。それがまさに 

それです。) 

 

あなたのコンポジションに Destination グループが全くなければ、そのトラックの Mark In/Mark Out 

の図で表わされた位置に Source Group/Clip Editor のGates の間のセクションを送り出します。 

 

Setting up a Source - Destination Environment 
 

Templates 
 

最も迅速で最も簡単な方法の Source – Destination 編集は、Templates の 1つを使用することです。 

最もあなたの要件にマッチするものを選んでください、今後の使用のためにお好みの Template として変

更、セ－ブしてください。 

 

Starting from Scratch 
 

Track Groups ウィンドウの中では、多くの Source グループの制作と同じように、編集の換わりの素材

バ－ジョンがあり、Source としてそれらのタイプを選択することができます。 

 

Tip(ヒント) : Group を組んでください。Source としてタイプを選択してください。そして、Source グ

ループの必要な数を持つまで Tracks > Duplicate Selected Track Group を何度でも選んでください。 

 



編集を望む多くの(一般には 1つだけ) Destination groups を制作してください。そして Destination と

してそれらのタイプを選択してください。 

 

編集作業と同じくらい各ソースのために、多くの Tracks を作成してください、そして、それぞれに Group 

を組んでください。 

 

Keep Cursor, Free Zoom, Auto-Solo そしてNo Selection これらのグル－プをセットしてください。 

 

Tracks メニュ－の "Auto Select Tracks" オプションを選択してください。 

Tracks > Auto Select Tracks 

 

Source - Destination Toolbar を見てください。View > Scales > Toolbars > Source - Destination 

 

次の方法で Source - Destination Editing はすぐに始められます。 

 

Source and Destination Groups には、特別なマ－カ－があります。セット可能な Gate In とGate Out 

です。それらは、ナッジされて、オーディションされます。: 

メニュ－で選択された Track Group から Cursor へ選択された Track Group Gate In/Out を設定してく

ださい。   Cursor &Marks > Gate In/Out to Cursor 

 

Gate を取り外すために、再び同じ位置にそれセットします。 

 

マウスでクリックして、移動させることによって、Gatesをドラッグできます。 

 

Gate colors: 
 

デフォルトでは、Gates は Grey で表示されます。 

 

White の部分は、Source Gates の次の編集オペレーションのため選択を表示します。 

 

Black の部分は、Destination Gates の次の編集オペレーションのため選択を表示します。 

 

次の編集オペレーションのための Source and Destination Gates は選択されたグループ Gates である

か、もしくはグループが全く選択されないなら、最終のグル－プが、Gates が set/ removed/ modified さ

れた最後に選択されます。 

 



3 ポイント編集では、Grey の中にある、1 個のゲートだけを持つグループのなくなってしまった「仮想」

のゲ－トを表示します。 

 

選択した Track Group Gate In/Out に Cursor をセットしてください。 

 

Cursor & Marks > Show Gate In/Out 

 

メニュー選択によるTrack Group Gate In/Out をナッジしてください。 

 

Cursor & Marks > Nudge Gates > Nudge Gate In/Out to Left/Right. 

 

各々のナッジオペレ－ションは自動的に試聴できます。そのセッティングは Settings > All Settings >  

Application > Editing ぺ－ジの 'Audition after Nudge' にあります。 

 

Audition はメニュ－セレクションの中にある、Machines > Internal Machine > Audition > Audition 

Gate In/Out Pre/Audition/Post の Track Group Gate In/Out Pre/Through/Post を選択してく

ださい。 

Gate In と Gate Out の間のスペ－スは Selection > Select between Gates メニュ－の中を選択して

ください。それぞれ選択したグル－プの Gate In と Gate Out のポジションは表示できます。 

そして Source-Destination Toolbar により、マニュアルで変更できます。 

(すでに表示されている場合は、View > Scales > Toolbars > Source-Destination) 

 

一度 Gates In とOut がセットされます。 

Source – Destination オペレ－ションは、Source Track Groupか、最後の Source Track Group どち

らかにより使用できます。そしてある人の Gates がセットされている Destination Track Group か、最

後の Destination Track Group のどちらかをセットができています。 

Source and Destination Gate In とGate Out は、両方ともセット、または、取り外すことができます。 

 

(同じポジションのある、それら 2 つのセッティングにより)Source – Destination 編集作業の組み合わせ 

は以下のテーブルの中に述べられています。 

 

Gates がセットされているとき、Edit メニューで以下の Source-Destination オペレーションが利用可能

です。: 

•   Auto-Edit Source to Destination 

 

•   Overwrite Source to Destination 



•   Insert Source to Destination 

 

•   Replace Source to Destination 

 

•   Fit Source to Destination 

 

Source に1 Gate しかない場合、その時、リ－ジョンは、編集オペレーションが実行される Gate 下のク

リップの末端(または、シングル Gate Out の場合の先端)を自動的にアジャストできます。 

これは、メニューアイテムを選ぶことによって、利用可能です: 

 

Edit > Source – Destination Settings > Limit 1 Gate Sources to End/Beginning of clip. 

 

Source に 2 Gatesセットあり、Destination に1 Gateセットある場合、Destination オペレーションへ

の Auto-Edit Source の働きは、メニューアイテムを選ぶことによって、Overwrite か Insert を選択でき

ます: 

 

Edit > Source- Destination Settings > 3 Gates Auto-Edit does Overwrite/Insert 

 

メニュ－ アイテム: 

 

Edit > Source - Destination Settings > Auto Set Destination Gate In after Edit 

 

Destination Gate In が、どんな Source-Destination オペレーションの後にも、前の Destination Out 

ポイントにセットできることを示します。 

また、new Gate In は自動的に Destination の中心に置かれます。 

 

メニュ－ アイテム Edit > Source - Destination Settings > Auto Set Destination Gate In  

after Edit は、どんな Source-Destination オペレ－ションの後でも自動的に Destination Track Group 

が選択されることを示しています。 

 

Auto-Ripple モ－ド(次ページのテーブルの中に、それら自身の上書き/リップルモードがあります)の個々

の働きは、しかしながら Edit > Auto-Crossfade メニュ－の Auto-Crossfade セッティングに従います。 

 

 

 

 



Keyboard Shortcuts 
 

ほとんどの Source Destination オペレ－ションは Keyboard Shortcuts として利用できます。 

 

2,3 and 4 Point Edits 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



7 
Fade Editor 

Fade Editor Tab Window 
 

Pyramix Fade Editor はフェードとクロスフェイド制作のためのいくつかのメソッドを提供します。 

ディスプレイ上の適切なポイントをクリックして、ドラッグするか、セットのフェーダとボタンを使用す

るか、または直接数値データを入力することによって、グラフィカルにフェードを作ることができます。 

ユーザに定義されたフェードの形とフェードのライブラリーと共に、オ－ディショニングオプションのセ

ット全体は提供されます。 

 

Fade Editor は選択のためのメイン Editor にいつもフェードを表示します。 

クリックポイントへの最も近いフェードが自動的に選択されます。: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fade Editor Tab floating Window 



Toolbar 

Contains these buttons: これらのボタンがあります。 

 

Accept & Close Editor (Fade Editor を閉じてください。そしてチェンジしたままで。事実

上、‘OK’ボタン) 

 

Restore & Close Editor (Fade Editorを開くか、または新しいフェード、キャンセルボタン

を選択する前の状態に、フェードを復元します) 

 

Undo last fade change 

 

Select/Edit Previous Fade 

 

Select/Edit Next Fade 

 

Zoom around the current Fade (Reset Zoom) 

 

Zoom In 

 

Zoom Out 

 

Xify (標準のPower X fadeに現在のフェードをリセットします。) 

 

Show/Hide Faders & Control Section 

 

Show/Hide Parameters & Options Section 

 

Audition whole X Fade with Pre-Roll and Post-Roll set before and after the X Fade 

boundaries 

 

Audition whole X Fade with Pre-Roll and Post-Roll set around the Reference Point 

 

Audition Fade Out up to its End with Curve 

 

Audition Fade Out up to its End without Curve 



Audition after the End of Fade Out 

 

Audition Fade Out up to the Reference Point with Curve 

 

Audition Fade Out up to the Reference Point without Curve 

 

Audition after the End of Fade Out from the Reference Point 

 

Audition Fade Out without stopping at its End 

 

Audition Fade In from its Start with Curve 

 

Audition Fade from its Start without Curve 

 

Audition before Start of Fade In 

 

Audition Fade In from the Reference Point with Curve 

 

Audition Fade from the Reference Point without Curve 

 

Audition before Start of Fade In from the Reference Point 

 

Audition Fade In before its Start 

 

The Graphical Display 
Consists of the following elements: 以下の要素が含まれています。 

 

•    TimeCode スケ－ルは、Zoom レンジの左の上に表示されます。 

 

•    Reference Point は編集ポイントか(X) Fade の中央デフォルトにセットされます。 

                                                                        このマ－カ－は、TimeCode Scale をクリックすることによって移動でき、Auditioning (上を見 

                                    る)かAuto-Center (下を見る)への Reference (参照) Pointです。 

 

•  すべてのトラックか選択したトラックを 表示できます。(Parameters & Options の下を見て 

                                    ください。) 



•    それぞれのトラックディスプレイ左側に、切り換え Edit On/Off セレクタといっしょに、クリッ 

                                                                          プの Track ネ－ムは示されています。 

 

•    Vertical Scrollbar はもしあれば隠れたトラックを通してナビゲートします。 

 

•    Horizontal Scrollbar は Fade 位置の前後にナビゲートします。 

 

•    カーブとして送受信のクリップフェードを表示します。 

 

•  Fade Position は、Fade エリアの中でクリック、ドラッギングすることによって、動かせます。 

                 (カ－ソルはハンドにかわります。) 

 

•  Fade エリアの左か右側をクリック、ドラッギングよって、Fade Length を変えることができ 

                 ます。  (カ－ソルは <|> に代ります。) 

 

•  クリップのメディアは、Fade エリアの外でクリック、ドラッギングよって、動かせます。(カ－ 

                  ソルはテ－プリ－ルを持ったハンドに変わります。) 

 

•    Fade black ボックスの Bezier Control Point Handles をクリック、ドラッギングよって、Fade 

                                       Curvesを変更できます。 

 

The Faders & Control Section 

 

以下のコントロ－ルとディスプレイを持っています。: 

 

•    Fader セクションの Fade Safe チェックボックスは、チェックされると) 編集作業の間、右に 

                                      続くフェ－ドの、その左の部分を無傷のままキ－プします。これは、Fade シンクロニゼイショ 

                                      ンをクリ－ンに保っている間、Auto-Ripple が Auto-Ripple なしで使用されるのを可能にしま 

 す。 

 

•    Force Safe ボックスがチェックされた場合、Fade Editor はそれぞれの編集作業の後、強制的 

                                      に Fade Safe にします。 

 

•    Six Memory Set とシックス Memory Recall ボタンが、Fade Editor はすべての設定を保存 

                                      して、リコ－ルします。リコールするパラメータが保存されるときだけ、リコールするボタンは 



                                       付番されます。 

 

•    Gain Faders Nudge ボタン と Fade Out & Fade In の Manual Entry Value Box(dB) 

 

•    Intercept と Asymmetry フェダ－、Nudge ボタンとManual Entry Value Box(dB) 

 

•    Length フェダ－、Nudge ボタン と Manual Entry Value Box(ミリセカンドの中、セカンド 

                                      の中の数値エントリの後、s をタイプしてください。) 

 

•  Fade Out & In の長さは Link ボタンをクリックすることによってリンクすることができます。 

 

•    Media Positionフェ－ダ－、Nudge ボタンと Manual Entry 

 

•     Fade In のための Value ボックス(ミリセカンドの中、セカンドの中の数値エントリの後、s を 

                                      タイプしてください。) 

 

Parameters & Options Section 
 

このテ－ブルの中のパラメタとオプションは、> をクリックすることにより修正されるでしょう。 

 

これらはセクションとフィ－ルドです。: 

 

Control 
 

•  Link Length(上を見てください。) 

 

•  Mirror Length(上を見てください。) 

 

•  Link Position(上を見てください。) 

 

•  Fade Safe(上を見てください。) 

 

Display 
 
•  表示されたトラックス(Shown Tracks)はこれらの選択を提供します: 



•  All tracks 

 

•  Follow TimeLine Display 

 

•  Choice of tracks TimeLine の中で選択されたトラックのナンバ－は、利用可能な選択をコ 

                       ントロ－ルします。4トラックが選択されると、1, 2, 3,または、4トラックのオプションがある 

             でしょう。 

 

•     Auto-Center あるオペレーションの後に Fade か Reference Point の周りのディスプレイ 

                                            の自動再調整を可能にします。 

 

•  None 

 

•  Fade 

 

•  Reference Point 

 

•     Zoom, 以下の 1つが可能です。: 

 

•  Free, Zoom Reset、In、および Out だけに従います。 

 

•   Auto-Zoom,いくつかのオペレ－ションの後、現在の Fade のまわりを自動的に Zoom します。 

 

•   Auto-Zoom / Free,現在の Fade のまわりを自動的に Zoom します。しかし唯一、Fade 

                                     Editor にエンタ－した場合にだけ、Zoom は Freeです。 

 

•   Timeline, Timeline Zoom ファクタ－に従ってください。 

 

•  User の選択は、Zoom Presets に限定されます。(メニュ－をみてください。View > Zoom) 

 

Audition 
 

•  Pre-Roll は Settings > All Settings Application Playback/Record の選択により限定されま 

                        す。 

 

•  Post-Roll は Settings > All Settings Application Playback/Record の選択により限定され 



                       ます。 

 

•  Solo,編集したトラックが再生中のとき On、Off の制作トラックもまた全て再生されます。 

 

•  Loop, Stop が押されるまで全てオ－ディションはくりかえされます。 

 

•   Speed,ノ－マルスピ－ドの100%, 50% そして 25% での再生スピ－ドを選択します。 

 

•   Audition after Nudge,どんなパラメ－タのナッジの後、自動で Fade を再生します。 

 

Memory 
 
•  Set, 制作のための一時的な 6 つの Fades をセ－ブします。 

 

•  Recall, 一時的にセ－ブされた 6 つの Fades をリコ－ルします。 

 

X Presets / Out Presets / In Presets 
 

•  Load Curve,選択された中から Curve SHAPE を、1 つだけロ－ドします。 

 

•  Default 

 

•  Power 

 

•  Linear 

 

•  dB 

 

•  Cosine 

 

•  Root-Cosine 

 

•  Any User-defined curves 

 

•   Load Preset, 選択された中から、Fade を 1 つロ－ドします。 

 



•  Default Fade 

 

•  Save X Fade か Save Fade ポップ-アップダイアログボックスを新しく開きます。(以下を見てく 

                        ださい。) 

 

Save X Fade 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

                                                  Save X Fade dialog 

 

X Fade Name box の中にカーソルがある状態で、ダイアログボックスは開きます。 

ドロップダウンリスト使用の上書きのために新しいプリセットまたは既存の選択の名前をタイプしてくだ

さい。適切なオプションを選んでください。そして、OK をクリックするか、プリセットをセ-ブするため

に Enter キ－を打ってください。 

 

Apply Mode Options 
 

リコールされると Fade の方法に作用する多くのオプションを提供します。 

 

Curve Only 
 
このボックスがチェックされれば、曲線形状(カーブシェイプ)だけが、既存のクロスフェイドデュレ－シ

ョンに、オーバラッピングしているトラックにリコールされて、適用されるでしょう。 

チェックしないままでは、始め、終わり、および基準点となる元のデュレ－ションと位置もまた、既存の



クロスフェイドに適用されるでしょう。 

 
Preserve Fade In Attack 
 

リコールされると、フェードはクリップのエッジに比例して左に並べられるでしょう。 

 

Center 

 

リコールされると、フェードはクリップのエッジに比例して中心に置かれるでしょう。 

 

Preserve Fade Out Release 

 

リコールされると、フェードはクリップのエッジに比例して右に並べられるでしょう。 

 

Save Fade 
 

  

 

 

 

 

 

 

 

 

 

 

 

 

Save Fade dialog 

 

Fade Name box の中にカーソルがある状態で、ダイアログボックスは開きます。 

ドロップダウンリスト使用の上書きのために新しいプリセットまたは既存の選択の名前をタイプしてくだ

さい。適切なオプションを選んでください。そして、OK をクリックするか、プリセットをセ-ブするため

に Enter キ－を打ってください。 

 



Apply Mode Options 
 

リコールされると、Fade の方法に作用する多くのオプションを提供します。 

 

Preserve Attack or Release 
 

Center 
 

Preserve Length 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



8 
Mixer 

Overview 
 

Pyramix Mixer は非常に強力なツールキットに発展いたしました。 

 

高範囲にわたるコンポーネント、ルーティング、およびオートメーションの実現性は混乱の潜在的な源で

あるかもしれません。しかし、基本原理は単純で論理的です。 

 

信号はボトムでミキサ－ストリップに入ります。様々なコントロ－ル制御を経て、それらがバスや複数の

バスに送られ、ストリップの先頭で処理します。 

水平に並んだ、バスとバス信号の合計は、先頭でバスマスタストリップにまとめられ、出力のためのマス

タフェーダと他のコントロ－ルを経て下げられます。 

 

もし、Pyramix を初めて使用するのであれば、慣れ親しむのが、よりシンプルな方法です。ミキサーテン

プレートの 1 つを使用してください。  

たとえば、Mix 08 X 02 (Stereo) 

 

 

Mixer Pages 
 

Mixer ユ－ザーインタ－フェ－スは、機能をまとめた 5 つのぺ－ジに並べられています。 

 

メインの Mix ! ぺ－ジで多くの時間は費やされるでしょう。 

 

他のぺ－ジの、Automation, Configure, Route そして Organize, Mix ! のトグルは、スクリ－ンの

右上にあるボタンによりアクセスできます。 

 

 

 

 

 



Configure Page 
 

 

Mixer Configure Page 

 

Configure ページでは、各変更の後に再構築なしで、複数の変更をミキサーにするかもしれません。 

あなたがページを終了するときにのみ、ミキサーの再構築は生じます。 

 

以下に 注意 してください。: 多くのエフェクトを含む大きなミキサ－の再構築は相当の時間

を要します。 

 

バスを表示させるために、Strips とBusses の間のセパレータバーをクリック、ドラッグしてください。 

スクロールバーは、オフ-スクリーンのストリップへアクセスさせます。 

 

Direct Outputs 
 

Direct Out 接続はデフォルトでは、ディスエイブル(不可)です。Configuration ページでストリップを

選択、クリックによって可能にできます。DO: Off ボックスが DO: On を表示していればそれは不可にな

ります。代りの Direct Out は、Strip Header のクリックによりRoute ページでセットできます。 



Channel は、HDTDM か XDTDM バスのどんな出力も Direct Out に送ることができます。 

Direct Out は、Pre または、Post Fader に送ることができます。 

Mixer I/O セクションの中の、DO: Post のトグルをクリックしてください。 

Direct Out は、常に Post Effects です。マルチチャンネルの場合は、ボックスの中の DO をクリックし

てください。: ボックスは、Set Direct Out リストをポップ-アップいたします。 

 

 

 

 

 

 

 

 

Set Direct Out 

必要なチャンネルをハイライトしてください。 

これは、Mixer Route ページで割り当てられた論理的な出力か、Mix ページの DO XLR アイコンをクリ

ックすることによって、供給されます。 

 

Selecting Strips 
 

ストリップの先頭のラベルをクリックすることによって、ストリップを選択できます。 

選択を示してオレンジ色に変わります。 

選択は従来の方法です。: 

SHIFT を押しながら、2番目のストリップをクリックすると間のすべてのストリップが選択されます。 

Ctrl キーをホ－ルドダウンしながらクリックすることによって、ストリップを加え、または間引きするこ

とが可能です。 

Ctrl + A は、全てのストリップを選択します。Select コンテキストメニュ－を用いタイプによっても選択

できます。 

 

 

Strip and Bus operations 
 

いったん選択されると、再編成のためにストリップをドラッグ、ドロップできます。 

他のストリップオペレ－ションは、Topology と Display コンテキストメニュ－ボタンを利用します。 

各々のボタンはオプションのリストをポップアップします。: 

 



 

 

 

 

 

 

 

 

 

 

 

 

+ - Context menus 

Add Strip - Mono, Stereo, MS, GPS と Group は、適切なオプションのダイアログをポップアップし

ます。: 

 

 

 

 

 

 

 

 

Add General Purpose Input Strip(s) dialog 

Add Bus - Mono Mix Stereo Mix Surround Mix and Aux も同様です。: 

 

 

 

 

 

 

 

 

 

 

Add Surround Mix Bus(es) dialog 



設定(pan, gain etc.)とエフェクトを含んでいて、Duplicate Strip(s)は、選択されたストリップの右に

ストリップのコピーを増やします。 

 

Select は、ミキサ－構成スピ－ドアップのための選択枝です。 

 

All Strips      All Buses 

All Mono Strips    All Stereo Strips 

All GPS Strips    All Group Strips 

 

Productivity Shortcuts 
 

Ctrl + A  All Strips の選択   DELete  all selected strips の消去 

 

ミキサ－の新しい指定の位置に選択した Strips をドラッグすることができます。Strip panel の端をヒット

すれば、スクリーンは水平にスクロールします。Strip のトグルを Double-clicking します。崩壊/非崩壊

の状態にされます。ストリップネ－ムはネームボックスの中をクリック、タイプしてください。Tab は、

次のストリップボックスネ－ムを右へ、SHIFT + Tab は次のストリップボックスネ－ムを左へ動かします。 

 

Effect Management 
 

Effects の上をクリックします。>> Effectsセクションを拡張します。 

 

Configure Page - Effects section 



これはストリップとバスに関するエフェクトマネ－ジメントのいくつかのメソッドを提供します。 

 

Configure: Effects Buttons 
 

Add        オプションのサブ-メニュ－をポップアップします。 

 

 

 

 

Add On Selected Strips..  Add On All Strips..   Add On All Buses.. 

 

同一のタイトルは別として、それぞれ、これらの 3 つのオプションは、Add Effect On XXX ダイアログ

を開きます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

Add Effects On Selected Strips dialog 

以下に 注意 してください。: 異なったタイプのエフェクトはカラ－が変わります。VS3 はグレ－、

DirectX はオレンジ、および VST はレッド。また、エフェクトが Strips ディスプレイのコンテナ

に表示されているとき、これらのカラ－は使用されます。 

 

Remove       オプションのサブ-メニュ－へポップ-アップ: 

 

 

 

 



Remove Selected Effects.. 

Remove From Selected Strips.. 

Remove All From All Strips.. 

Remove All From All Buses.. 

 

Move Up      リストの中の選択したエフェクトを立ち上げます。 

 

Move Down     リストの中の選択したエフェクトを落とします。 

 

Effects Section Containers 
 

それぞれのストリップの Effectsセクションは以下のプラグインタイプ、上から、VS3、DirectX および

VST の 3 つのコンテナ部に分割されます。 

各コンテナの Click to Add ボタンのクリックにより、タイプによりサブ-グル－プ化された関連フォーマ

ットでの利用可能なプラグインのリストがポップ-アップされます。例えば Dynamics, Restoration etc. 

Strip にプラグインをインストールするためにエントリをクリックして、リストから選択してください。 

Strip または Bus に、多くのエフェクトがあるとき、コンテナは、それらに順応するために拡張します。 

 

インスト－ルされたエフェクトを動かすために、left-Click の drag and drop か、Strip か Bus に同じ大

きさ、同じタイプのエフェクトをコピーするために、Ctrl + drag and drop、またはストリップにあるエ

フェクトタイプコンテナ内のエフェクトの順序を選択できます。 

1 つのエフェクト選択されていて、2 つ目を SHIFT + Clicking すると、最初と最後に選択されたエフェク

トの間に全てのエフェクトを選択します。Ctrl + Click により選択を加えます。 

 

インストールされたプラグインを右クリックすると、コンテキストメニューをポップアップします。例え

ば:  

 

 

 

 

 

 

 

 

 

Effect context popup 



Insert before (effect clicked on)  同じタイプのエフェクトのリストをドロップダウンすると、今の 

                                                                                                                                                                エフェクトの前にインサ－トできます。 

Replace (effect clicked on)    同じタイプのエフェクトのリストをドロップダウンすると、今の 

                                                                                                                                                                エフェクトをリプレ－スできます。インストールされたエフェク 

                                                                                                                                                                トを Double-Clicking すると、同じことをします。 

Remove (effect clicked on)    Strip か Bus から今のエフェクトをアンインストールします。 

 

Copy Selected (Effect type) Effects to selected strips 示すとおり。エフェクトを選択する前また 

                                                                                                                                                                は後に、タ－ゲットになるストリップを選択できます。 

Copy Selected (Effect type) to All Strips 示すとおり。 

Remove All (Effect type) Effects  Strip から今のタイプのエフェクトを取り去ります。               

Remove All Effects       今の Strip からすべてのタイプのエフェクトを取り去ります。 

 

Copy All Effects to All Strips   今の Strip にインスト－ルされた全てのエフェクトを他の全ての 

                                                                                                                                                                 Strips にコピ－します。 

Copy All Effects to Selected Strips 今の Strip にインスト－ルされた全てのエフェクトを選択した 

                                                                                                                                                                 Strips にコピ－します。 

 

Organize Page 
 

ここで、Mixer Presets とセッティングのマネ－ジメントができます: 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

Mixer Organize Page 



Presets 
 

Storing and Recalling Mixer Presets 

 

現在のユーザか、他のすべてのユーザのために、Mixer Presets をユーザフォルダーで取っておくか、ま

たは、メイン Mixer Presetsリストに加えることができます。 

 

Default Mixer 
 

現在の Mixer セットアップをデフォルトMixerとしてセ－ブするには Store Default を選んでください。 

 

Storing New Mixer Presets 
 

利用可能な Mixer プリセットのメインリストに、一つのプリセットを加えるために、すなわち、新しいプ

ロジェクトを始めるときに現れるリストは、Store New…そしてあなたの Mixer Preset ネ－ムをエンタ

－します。 

Global ボックスがチェックされると、現在のマシンの上に登録されたどんなユーザにも利用可能になるで

しよう。もし、そうしなければ新しいプリセットを制作したユーザのみが、利用可能になるでしよう。 

 

Removing Mixer Presets 
 

メインリストから一つのプリセットを取り除くために、それを選択して Remove Selected を、クリック

オンします。Remove Preset ダイアログボックスには、OK とCancel オプションがあります。 

 

Updating Mixer Presets 
 

現在のプリセットセッティングをアップデ－トするには、リストの中のそれをハイライトさせて、Update 

Selected...を選んでください。そうすれば、UpdatePreset ダイアログが現れて尋ねてきます。 

 

‘current preset’＝ 現在のプリセットをリプレ－スしたいのであれば、OK または、Cancel を選んでくだ

さい。 

Recall Selected State 

 

Saving / Loading Mixer Presets to / from files 
 

Mixer Presets は Windows folders にもストアできます。ふさわしい場所として Load from file...または



Save to file...を選択してください。Windows Explorer ウインドウは以前にセ-ブした Mixer Preset の

ロ－ドを可能にするか、または現在のMixer Preset を、どんな Windows folder にもネ－ミング、セ－ブ

できます。 

 

Settings 
 

Mixer Settings は、All Settings > Hardware > Hardware > Formats& Sync ぺ－ジの Mixer 

Settings ウインドウを開きます。 

 

Dither Settings は ReDithering ダイアログを開きます。 

どうぞご覧ください。: Dithering Options 189 ぺ－ジ                 

 

Show Distribution がオンであるときは、細長い色付けされたバーはそれぞれのインプットストリップの

底に挿入されます。これは、ストリップに供給される DSPカ－ド(マルチ-ボ－ドシステム)を示しています。 

 

Delay Compensation がオンであるときは、ミキサ－のための Delay Compensation-ディレイ補正を

可能にします。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Route Page 
Route は、直感的マトリクスルーティンググリッド環境における物理的 I/O - 入出力からすべてのルーテ

ィングを集めています。それは Strips Input ページで開きます。: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Mixer Configure Page 

 

Strips Direct Out と Masters Outputs も同様です。 

 

Making Connections 
 

カ-ソルが目標のクロス(交差した)ポイントの上にあるとき、縦と横の列は見よいようにハイライトします。 



また、マルチチャネルのストリップかバスの一部であるクロスポイントにカーソルがあるなら、グループ

の他のチャンネルは、ぼんやりとハイライトします。 

Strips Inputs では、クロスポイントをクリックすると、左手にある縦列のソースは一番上の横列におけ

るデスティネイションに送られます。 

Strips Direct Out と Masters Outputsでは、ソースは水平であり、デスティネイションは垂直です。 

クリックとドラッグにより、すばやく複数の割り当てができます。 

 

クロスポイントを右クリックすると適切なデスティネイションが表示されたオプションのコンテキストメ

ニュ－がポップ-アップします。.: 

 

 

 

 

 

Auto-Connect 
 

昇順にすべての Strip Input Channels を物理的なインプットに接続します。 

 

Disconnect All 
 

すべてのクロスポイントの割り当てを外します。 

 

Info 
 

Info ボックスには現在のハイライトされたクロスポイントの詳細を表示しています。 

 

 

Automate Page 
 

UNDER CONSTRUCTION (只今、施工中。) 

 

 

 

 

 

 



Mix ! 

Basic Mixer 

 

Simple 8 X 2 stereo mixer Window with all areas visible 

 

Expand / Collapse 
 

ミキサ－表面の右上の小さくて、灰色の + - ボックスはミキサ－をフルサイズまたは折りたたんだ状態に

切り換えます。 

それらの上にカーソルがある場合もまた、コンテキストメニュ－もポップアップします。(下を見てくださ

い)。Expand / Collapse とHide は隠れた、不必要なコントロ－ルを整理できます。これは同じミキサ－

の全てのエリアが折りたたまれた状態です。: 

 

 

 

 

 

Simple 8 X 2 stereo mixer Window with all areas hidden 



各々 + - ボックスもまた、それの上にカーソルがある時、それが取扱うミキサーの領域に関連しているメ

ニュ－をポップアップします。例えば: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Simple 8 X 2 stereo mixer + - pop-up menus 

 

 

Collapse/Hide 
 

Collapse を選ぶと、ミキサ－エリアの小さい物体は見えています。右側にあるグレ－の + ボックスがつ

いた水平棒がそれです。 

Hide は画面からエリアを完全に取り除きます。 

Mixer + - ポップアップにある Show All を選択すると復元されます。 

 

Resets 
 

また、これらのコンテキストメニューは関連セクションのすべての特別なコントロ－ル、全体のストリッ

プまたはミキサーをデフォルト状態にする、便利な方法です。 

 

 

Colors 
 

理解しやすいように Bus paths(バス パス) は色付けされています。 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Mixer with colored bus paths 

 

Hide か Show Colors はカラ－ラインを隠し復元します。Change color は変更された個々のカラ－を

示しています。Reset color は以前の状態にカラ－をレストアします。 

 

Mixer Components 
 

Input Strips 
 

トラックによって関連づけられた Mixer Input Strips (トラックの頭の薄いグリ－ンのボックス)はモニタ

－アウトプットにより供給されコントロールされます。 

The Mixer Strip Channel Live (物理的)、また Internal Return Bus インプットは関連のTrack にダ

イレクトに向かいます。ストリップにどんな関連トラックもないと、それは、Live(物理的)または、それ

にアサインされた Internal Return Bus インプットにより提供され、コントロ－ルされます。 

 

ストリップに関連するトラックがあると、トラック出力は自動的にインプットと、トランスポ－トモ－ド

でのプレイバック出力の間で、切り換えられます。トラックの頭のモニタ－セッティングと Settings > All 



Settings > Application > Playback/Record : Auto-monitoring オプション、European 

Monitoring (全てのトラックが stop のときINPUT に変わります。) または US Monitoring (Record 

Ready のみが stop のとき INPUT に変わります。) 

 

以下に 注意 してください。: ストリップチャンネルは、ストリップコントロ－ル、フェーダ、mute、

eq などの関連トラックが NONE を持っているとき、トラックインプットに与えられた信号に影響し

ます。 

Mixer Input Strips には、レベルコントロール、pan, mute 等を提供する多くの標準の調整卓のストリッ

プと同じ機能があります。 

 

以下のタイプのインプットストリップは利用できます。: 

 

•  Mono input Strips 

 

•  Stereo input Strips 

 

•  MS decoder Strips - decode a Sum and Difference signal to standard stereo format 

 

•  GPS (General Purpose Strip) 

 

Mixing/Monitoring/Aux Busses 
 

これらは、ミキサーストリップ信号が送られる合計のバスです。それぞれのバスタイプ(Mix か Aux)には、

Repro ボタンがあります。システムが再生しているときだけ、Master セクションの Repro ボタンは信号

を出力します。 

例えば、Studio のメイン・スピーカで Recording、Stopped の自動インプットに切り替えのとき、オー

ディオフィードバックを避ける(ハウリング)ために、No シグナルは Stop または Record モ－ドの中で

出力するでしょう。 

 

Mix Bus 
 

ミックスバスはミックスの完成のためのデスティネイションです。通常、ミックスバスの出力は、最終ミ

ックスのためにマスタマシンに送られます。また、Internal Return Busses を通してそれらを送ること

ができます。他の用途は別として、これらは、最終ミックスが Pyramix で可能です。 

メイン Mixing とAux Busses もまた、Monitor のなかにあります。 

Mix Busses はいくつかのフォーマットで利用可能です: 



Mono Mix 
 

シングルのモノラル出力を提供します。どんなインプットストリップもそれに送ることができます。 

 

Multiple Mono Mix 
 

数個のモノラル出力を提供します。 

どんなインプットストリップもそれらのいずれか、または、全部に送ることができます。 

 

Stereo Mix 
 

シングルのステレオ出力を提供します。どんなインプットストリップもそれに送ることができます。 

 

Multiple Stereo Mix 
 

数個のステレオ出力を提供し、どんなインプットストリップもそれらのいずれかすべてに送られるのを示

します。 

 

Surround Mix - 5.1 format 
 

Multiple Surround Mix - 数個のサラウンド出力を提供し、どんなミキサーストリップもそれらのどれかに

送るのを示します。 

 

以下に 注意 してください。: 異なっているモノラルとステレオマルチバス、複数のサラウンド

バスの ONE 5.1デスティネイション ステムにインプットストリップを送ることができるだ

けです。これは通常の使用を反映します。例えば一般的なセットアップで、Dialogue、Effects、
および Music のために 3 つのサラウンドバス ステム軸を持つでしょう。 

それぞれの Input ストリップは、Stem ‘X’ ボタンをクリックすることによって、適切なサラ

ウンドバスに送られます。 

 Monitor のモニタリングのために、すべてのサラウンドバス軸をまとめることができます。 

 

Multiple Mix Busses 
 

Mono / Stereo 
モノラルかステレオマルチミックスバスがミキサーに加えられたら、センドレベルコントロール(モノラ

ル)かパンコントロ－ル(ステレオ)のあるインプットストリップにルーティングマトリクスボックスが現



れます。 

 

 

 

 

 

 

 

 

 

 

Mix bus matrix 

 

8×8 マトリクスは最大 64 台 の出力バスへのアクセスを可能にします。ル－ティングは点灯したクロスポ

イントで示されます。 

ストリップのマトリクスをダブルクリックすると、ルーティングマトリクスウィンドウは開らきます。 

 

 

 

 

 

 

 

 

 

 

 

 

Mix bus routing matrix 

 

有効な選択はグレーで示されています。 

ウィンドウがいったん開くと、ドロップダウンリストからそれらを選択するか、ミキサーの表面の向こう

側にステップする < and > を使用することにより他のインプットチャンネルのル－トは決められます． 

 

Surround 

 



シングル Multiple Surround Mix アウトプット ストリップとして、それぞれ 6～9 個のチャンネルから

最大 16 サラウンドバスが加えられるかもしれません。 

 

これらの原則的な使用は、ステムミキシングのためです。例えば、ダイアログ、バックグラウンド、エフ

ェクト、スポットエフェクト、効果音の録音、および音楽は、別々のレコーディングとしてレコードされ

ますが、カンパケミックスとしてモニターされます。 

それぞれのサラウンドバスは数字によって特定されます。 この挿絵の、Multiple Surround Mix ストリ

ップは、3 つのサラウンドバスがあるミキサーに加えられます。 

 

 

 

 

 

 

Surround Panner の上でステムをクリックすると、利用可能なステムのリストは現れます。 

同時にストリップで 1つ以上の選択は出来ません。 

 

結合された Surround Mix 出力ストリップのルーティングは以下に示されています: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Multiple Surround Mix Output Routing 

トップ(SR1)ボックスはメータが表示しているものを示しています。それをクリックすると、各 Stem と 

Lvl を通して循環します: 



すべての Stems の合計を計量して、ボトムボックスは、XLR アイコンに関係する Stem について、表示

と選択をします。物理的アウトプットか、Internal Return Busses へのルート設定は他のバスと同様に実

行されます。すなわち、メニュ－により関連の XLR アイコンを右クリックしてください。そして、Connect 

> などを選択してください。 

 

Groups 
 

Master Group Strips - 複数ミキサ－ストリップのフェーダのグループ分けを示しています。 

VCA グル－ピングに類似しています。 

グループかグループが加えられた(ミキサーコンテキスメニュー設定から Settings > Add Strip > 

Group)、制作された各グループが、それぞれのインプットストリップ上のストリップネームボックスの

下に現れるので、1 つのグループボタンに加えてください。選択されると、On ボタンが Group ストリッ

プで点灯され、Group ストリップはグル－プにされたインプットストリップをコントロ－ルします。 

 

Channel Direct Outputs 
 

すべてのインプットストリップが、Direct Outputs を持つことができます。 

Direct Out の接続はデフォルトでは不可になっています。 

Configuration ページでストリップを選択して、DO: Off ボックスをクリックすることによってそれを

可能にできます。または、DO: On の場合、それは不可になります。 

あるいはまた、Direct Out は Strip Header をクリックして、Route ページでセットができます。 

 

Channel は、HDTDM か XDTDM バスのどんな出力にも、Direct Out を送ることができます。 

Pre か Post Fader を Direct Out に送ることができます。 

Mixer I/O セクションのトグルボタンの DO: Post ボックスをクリックしてください。 

通常、Direct Out はポストPost Effects になっています。 

マルチ‐チャンネルストリップのためにボックスの中の DO: をクリックしてください。Set Direct Out 

リストがポップアップします。: 

 

 

 

 

 

Set Direct Out 

 

必要なチャンネルがハイライトされます。これにより、Mixer Route ぺ－ジまたは Mix ぺ－ジの DO XLR



アイコンをクリックすることによりアサインされた物理的アウトプットに送られるでしょう。 

 

HDTDM の1～64 までの、または、XDTDM の1～128 までの いろいろなインプットStrips と Bussesは、

Direct Out 接続の数により制限されます。: Direct Out 接続 PLUS すべての Busチャンネルの合計は 

HDTDM の 64 か XDTDM の128 を超えることはできません。 

 

Strip & Bus Channel Types 
 

すべての Strips とBusses Channelは、Configuration ページ でマニュアルにてセットできます。 

以下がカスタムタイプです。: 

 

•   Left (L) 

 

•   Center (C) 

 

•   Right (R) 

 

•   Surround Left (Ls) 

 

•   Surround Right (Rs) 

 

•   LFE (Lfe) 

 

•   Left Center (Lc) 

 

•   Right Center (Rc) 

 

•   Surround Center (Cs) 

 

•   No particular type 

 

Mono Stripsはデフォルトではどんな特定のタイプであってもタグ付けをされません。 

 

Stereo Strips はデフォルトで L-R にタグ付けをされます。 

 

MS strips はデフォルトで L-R にタグ付けをされます。 



GPS Strip (General Purpose Strip): 

 

GPS Strips 1～８チャンネルまでもてます。 

 

Aux リタ－ンか、または、どんな種類のダイレクト Input 使用にもそれらを使用できます。たとえば、プ

リミックスまたは、マルチ‐チャンネル録音。(LCR, LCRS, etc…) 

デフォルトでは、2 チャンネル GPS Strip はL-R に初期化されます、そして、6 チャンネル GPS Strip は

LCRLsRsLfe 5.1 に初期化されます。Configuration ページでこれを変えるか、またはカスタマイズでき

ます。または、どんなバスもフィ－ドする GPS Strip(Aux or Mix)は、デフォルトで Channel Type(他

のストリップのように)によって送られます。 

しかし、Channel Routing グリッド(他のストリップのように)をクリックすることによって、マニュアル

でこのルーティングを変えることができます。 

 

Aux Busses: 
 

General Purpose Aux busses は、ヘッドホンの使用、ミュージシャン用のキュ－ミックス、またはリ

バ－ブ、ディレイ、コ－ラスなどのエフェクトにシグナルを送るために通常、使用される‘auxiliary’ミック

スの制作方法を用意します。 

Aux Busses は1～８チャンネルまでもてます。カスタムタイプの Channels が、Configuration ページ

でマニュアルにてセットできます。: 

 

•   Left (L) 

 

•   Center (C) 

 

•   Right (R) 

 

•   Surround Left (Ls) 

 

•   Surround Right (Rs) 

 

•   LFE (Lfe) 

 

•   Left Center (Lc) 

 

•   Right Center (Rc) 



•   Surround Center (Cs) 

 

Default では、2 チャンネル Aux Bus が L-R に初期化されます、そして、6チャンネル Aux Bus が5.1 

に初期化されます。Configuration ページで変更、またはカスタマイズできます。 

 

以下に 注意 してください。: 重要なのは、Aux バスが増やされた場合、Aux バスの各チャンネルの

Type が正しく確実にセットされることです。 

 

Context Menu 

 

他のバスと同様に、ミキサ－ウインドウの右端の Aux バスの小さいグレ－の       ボックスをクリック

すると、ディスプレイを Expands / Collapses します。 

ボックスの上にカーソルがあるとき、Aux Bus のポップ‐アップコンテキストメニューは開きます: 

 

 

 

 

 

 

 

 

 

Aux bus pop-up context menu 

エントリ－の大半が他のバスと同じですが、ラストの 2 つは Aux バスに特別です。 

 

Global Strip Channel Routing 

 

Aux バスの Global Channel Routing ウィンドウを開いてください。  

 

 

 

 

 

 

 

Global Channel Routing window 



このルーティンググリッドは、ミキサ－の水平に並んだ (L, R, C, ...)のすべてのインプットStrips の

Channel Types を一緒に分類します。縦に並んだチャンネルは、この Aux バスの Channel Typesです。 

 

ノードの値が編集されたとき、静止した aux はすべてのストリップのゲインを送ります。 

そのストリップは、aux バスの新しい値にアップデ－トされたチャンネルタイプをもちます。 

 

幾つかのストリップが特別なノ－ドの異なった値にセットされた場合、“---” が表示されます。 

 

Clear       グリッド全体を Mute (ミュ－ト)します。 

 

Unity       グリッド全体を Mute (ミュ－ト)します。 

 

以下に 注意 してください。: Clear か Unity どちらかを呼び出せばこの Aux Bus の全ての Strips 
Aux Sends に影響します。 

 

Apply All Strip Input Gains to Send Gain 

 

ミキサーのあらゆるストリップのインプットゲイン値は、この Aux バスにフィ－ドされるすべての Aux 

センドに加えられます。 

 

Aux Send Routing 

 
Aux バスと同じタイプの Aux Bus に送る Strip があるとき、例えばステレオストリップがフィ－ドする

Aux バス5.1、ストリップがフィ－ドする 5.1 Bus 送られる Strip’s Channels は、対応する Aux バス

Channel Type に自動的にル－ティングされます。(Left to Left, Right to Right, etc…) 
 

送られるストリップ Aux Bus のType とは違います。例えば、Stereo Strip は 5.1 Aux Bus にフィ－ド

します。ル－ティングはマニュアルで作らなくてはなりません。 

 

自動‐ル－ティングで、値を変更する場合、、同じ方法で使用されます。 

 

Static Channel Routing 

 

Aux  Send Channel Routing は、ストリップチャンネルにある Aux Bus の上のノブに隣接している小さ

いグリッドアイコンのクリックによりセットされます。 

これにより Channel Routing ウインドウが開きます。: 



 

 

 

 

 

 

 

 

 

Channel Routing window 

 

5.1 チャンネルが 5.1 Aux Bus にフィ‐ドしているのが見られます。 

Strip/Bus 交差する各ノードのために、ゲイン値を入れることができます。 

ノードをクリックしてください、そして、dB 値を入れてください。 

無(文字がない)か -144.5 を入力して、Mute にノードをリセットしてください。 

 

Clear         すべてのノードを Mute にします。 

 

Auto         セットa 1 : 1 の上に示されているフラットなルーティング 

 

Aux Buses In-Place Panning 
 
それぞれ Aux バスの In-Place パンニングは、各インプットStrip の Aux Send セクションにある IP ボタ

ンでかえられます。 

In-Place Aux Sends はパンナーが出力バスを与えている同じレベルで適切なパンナーのアウトプットを

得ます。 

 

以下に 注意 してください。: このように対応する Bus Types のみに与えられます。 

 

したがって、あなたがタイプしたセンタ－(C)を 5.1パンナ－から Mono Aux Bus にフィ－ドさ

せて、センタ－チャンネルの上に信号が全くなければ、左右の出力信号は'phantom center'が同

じであっても、信号を全くAux Bus に入れないでしょう。 

 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In-Place Panning Indicator/Selector 

 

In-Place Panning Source 
 

IP ボタンが点灯されるとき(イエロー)、Input Strip の aux リタ－ンストリップでは、チャンネルは、Aux

でストリップに返すために Aux バスが決められて送られます。 

例えば、Aux バス、Surround バスと Stereo バスがあるミキサー構成。 

 

Aux マスタフェーダの下のハイライトされたボックスをクリックすると、オプションのリストが現れます: 

 

 

 

In-Place Panning Source pop-up 

 

これらは、Aux センドがアウトプットパンナ－の 1 つまたは、インプット Strip にある Static 

ChannelAssignment セットを送るかどうかの決定です。 

例えば、Aux バス1 のために: 



Off (Use Channel Routing Grid)  Aux パンは Static Channel Routing アサインメントに従いま

す。 

SR1 (Surround Mix)       Aux パンは Surround Mix バスパンナ－に従います。 

 

ST1 (Stereo Mix)          Aux パンは Stereo Mix バスパンナ－に従います。 

 

Aux 1 が送るすべてを作るために、Mixer Strip Surround Panners に従ってください。そして、フェー

ダの下のボックスをクリックしてください。そして、SR1 (Surround Mix) を選択してください。 

 

以下に 注意 してください。:   Aux master ストリップで IP:Off  が表示された場合、すなわちno 
In-Place source の場合、インプットストリップの IP ボタンは灰色になります。 

In-Place source が選択されて、黄色い IP ボタンがその時点灯されるとき、同様に、スタティッ 

クル－ティンググリッドは、この挿絵のように灰色になり利用できません。 

 

 

 

 

 

 

 

 

 

 

 

 

 

Strip Aux sends and Channel Routing dialog 

 

3 つのストリップが、10 と、11 と、12 で示されています。IP ボタンがストリップ 10 と 11で選択され (イ

エロー)、スタティックルーティンググリッドは、灰色になり、利用できません。 

そしてストリップ 12 では、IP ボタンは除外される(暗い)。 

ノブの横のグリッドボタンをクリックすることによって、Static Channel Routing グリッドを開くこと

ができます。 

以下に 注意 してください。: aux send は最初にon のとき、IP ボタンのデフォルトはOn です。セ

ンドがミュ－ト (muted) されたなら、まもなくアンミュ－トされたときの記憶の IP ボタンの現在の

セッティングになります。Mixer 8 – 138 



Basic Strip 
                                                                                                                                                                                                                           基本的なモノチャンネルストリップは以下を含んでいます。: 

 

                                                                                                   On /Off 切り替えスイッチ。 

 

Main アウトプットバスの Pan ポット。このケ－スにおいては、まさにシング 

ルのステレオミックスバスです。 

 

もしカ－ソルがフェ－ダ－ノブの上にあるならフェ－ダ－アウトプットレヴェ 

ル値の Numeric display はフェ－ダ－ゲインを示しています。 

 

Level Bargraph Rotary Controls and Faders 
 
Rotary Controls と Fadersは、マウスとドラッギングでつかむことによって、 

調整されるでしよう。 

 

Rotary コントロ－ルは右左をドラッグして調整されます。フェ－ダ－は上下 

をドラッグして調整されます。 

 

 Fader または Rotary knob を Double-clicking すると、値がデフォルトにな 

ります。例えば、チャンネルストリップフェ－ダ－の統一ゲイン。バ－グラフ 

はピ－クレベルを示しています。 

 

Buttons 
                                            

                         メインミキサ－表面のボタンは黒で無効、‘light up’で有効です。 

 

Basic Strip   Solo  はストリップをソロにし、Mute は、ミュ－ト、Ctrl + Solo は他のすべ

ての Solos をキャンセルします。SAFE は、ストリップがほかの場所でのソロのオペレーションによって

ミュートされるのを防ぎます。Ø はチャンネルフェーズを逆にします。PF は Pre-Fader  のメ－タ－ポジ

ションをかえます。Delay は (in samples) のディレイ値をこのボックスでセットできます。Input は 

Input の上をクリックすることにより、ストリップが物理的コネクションまたは、出力バスからインプッ

トを得ているボックスをポップ‐アップします。 

 

Logical Input and Direct Output Assignment 
 



XLR アイコンの右クリックにより、指定されたドロップ‐ダウンリストをポップアップします。 

 

以下に 注意 してください。: Configure ぺ－ジでまず最初に Direct Outputs を有効にしてくだ

さい。 どうぞご覧ください。: Channel Direct Outputs 150 ぺ－ジ     
 

Stereo Strips 
 

ステレオバスをフィ－ドする Stereo Strip では、パンポットをバランスコントロ－ルに取り替えます、そ

して、シングルのバ－グラフメータをペア－に取り替えます。ステレオの Strips は左右チャンネルの両方

の Phase をリバ－スすることができます。シングルのボタンには、4 つの可能なステ－タスがあります。: 

 

Black:          No phase inversion    フェ－ズは反転しません。 

White:          Left channel inverted    左チャンネルを反転させます。 

Red:           Right channel inverted   右チャンネルを反転させます。 

Blue:          Both channels inverted   左右チャンネルを反転させます。 

 

M&S Stereo Strips 
 
          What is M&S? 

 
M&S は Middle と Side を表します。Left と Right (LR, AB または XY として知ら 

れている)の代わりにアウトプットの合計と異なったシグナル ( Sum and 

Difference ) のマイクロフォン テクニックです。 

 

しばしば、この専門用語は混乱の源になりますが、Sum と Difference シグナルは 

M&S として知られています。 

 

それまでの Left, Right ソースから Sum and Difference シグナルを作ることがで 

きます。例えば、Pyramix のプラグ‐イン、MS Encoder を利用してください。 

(どうぞご覧ください。: MS Encoder 215 ぺ－ジ ) 

 

Decoding M&S 
 
1 つの Sum and Difference か M&S デコーダが、Difference(S) シグナルを加え 

                                                                      ることによって、Left と Right を再編成します。Sum (M) シグナルは、Left を作り 

                                                                      出し、phase-reversed Difference (S) シグナルを Sum (M) シグナルに加えれば、 



 Right を作り出します。しばしばこのように、表されます。: 

 L = M + Sと R = M – S 

 

Benefit (恩恵) of M&S 

レコーディングと対照的にミキシングにおいて、Sum と Difference 領域のシグナルをマニュピュレイテ

ィングする真に現実的な恩恵は、本当にイメ－ジの幅を広げるということです。 

Pyramix では、M&S Stereo ストリップの設置の恩恵でこれらのシグナルを直接とり扱うことができます。 

 

M&S Strip controls 
 

1 つの M&S ストリップ ステレオ バス センドには、3 つのコントロ－ルがあります。 

センターノブは、Sum(M) の Left と Right アウトプットへの貢献を決定します。 

L ノブは、イン‐フェ－ズ Difference(S) の Left アウトプットへの貢献を決定します。そして、R ノブは

イン‐フェ－ズ Difference(S) の Right アウトプットへの貢献を決定します。 

L&R ノブはデフォルトで一組となります。それらを個々に動かすために、クリック、そして Ctrl キ－を押

したままドラッグしてください。 

Sum と Difference 両方のチャンネルの Phase はりバ－スできます。シングルの Ø ボタンには 4つの可能

なステ－タスがあります。: 

Black:      No phase inversion      フェ－ズは反転しません。 

White:       Sum (M) channel inverted    Sum (M) チャンネルを反転させます。 

Red:       Difference (S) channel inverted Difference (S) チャンネルを反転させます。 

Blue:       Both channels inverted      左右チャンネルを反転させます。 

 

イメ－ジのなかで、Sum と Difference どちらかを逆にすれば左右が逆さになります。 

 

以下に 注意 してください。: Input meters が一貫して S  が M より高く表示している場合、イメー

ジが非常に広く、モノラルリスナにとって互換性がありそうにはありませんし、または、M とS インプ

ットは何らかのポイントで逆にされるようになるかのどちらかです。 

 誠に残念なことに、フィルムとテレビの野外レコーディングでは、これは非常に一般的です。 

Creating and Configuring Mixers 

 

幾つかのミキサ－プリセットの 1 つはあなたのアプリケ－ションに適さないかもしれません。 

今あるミキサ－を修正するのは簡単です。 

Mixer Wizard を利用してまたは、検索してクリエ－ト、設計してください。 

Wizard はミキサ－の上、どこでもいいですから右クリックすると出てきます。そして選んでください。 



Settings > Wizard... 

 

Mixer Configuration Wizard 
 

 

 

 

 

 

 

 

 

 

 

 

 

Configuration Wizard busses dialog 

 

チェックボックスで必要なバス‐タイプと右のドロップダウンリストから必要な数を選択してください。 

注目、シングルの Mono か Stereo Mix Bus は 1- 64 のバスにより構成できます。そして、

Surround Mix Bus は 1 – 16 のマルチ‐チャンネル ステムにより構成できます。 

Aux Busses は 1 – 8 チャンネル持てます。Next ボタンをクリックして次のぺ－ジに移りましよう。 

 

 

 

 

 

 

 

 

 

 

 

 

 

Configuration Wizard strips dialog 



チェックボックスで必要なチャンネルストリップのタイプと右のドロップダウンリストから必要な数を選

択してください。Next ボタンをクリックして次のぺ－ジに移りましよう。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Configuration Wizard auto connect dialog 

 

Connect automatically as many inputs and outputs as possible をチェックしてくださ

い。チェックボックスは、Mixer Input Strips へのMykerinos ボードとTrack 出力に取り付けられた

physical I/O に Input Strips があるとき、トラックスの同じナンバ－とタイプをして、上から順に利

用可能な物理的なインプットにできるだけ多くを接続して、Busses を出力するでしょう。もちろん後で

容易にこれを再構成できます。 

 

ボックスがチェックされないと、Track 出力 が Mixer ストリップに接続されて、トラックは同様に制作

されるでしょうが、物理的な Inputs もOutputs も接続されないでしょう。 

 

Cancel をクリックすると、新しいProject は Blank Mixer Window と共に開きます。(以下をご覧くだ

さい。) 

 

I/O Busses Explained 
 

Mykerinos カードの数にかかわらず、有効出力バスの総数は、HDTDM Mode の64と XDTDM Mode の



128 です。 

また、Pyramix への論理的なインプットとアウトプットの最大数は、それぞれ 64と128 です。 

しかしながら、それは、128 以上の物理的インプットとアウトプットの Pyramix システムへの接続を完全

に可能にし、許可します。 

Pyramix への物理的なインプットとアウトプットへの物理的インプットとアウトプットのル－ティングは 

Settings > Hardware > HDTDM Routing か XDTDM ぺ－ジで作られます。 

 

例えば :  1 つのシステムには 3 つの Mykerinos ボ－ドとMADIド－タ－ボ－ドを含み、合計で192 になり

ます。これらの128 が HDTDM モードが、Pyramix の論理的なインプットまたは、アウトプット(割り当

てられた Internal Return Busses のより少ない数; 以下を見てください。)へつながれば、物理的アウ

トプットへつなぐことができます。 

 

Input Strip Types 
 

さまざまなソース Formats の作業をより楽にするために、Pyramix は Input Strip の異なったタイプの 1

つを提供します。 

これらはシングルセットのコントロ－ルから 1～8 個のチャンネルをコントロ－ルすることができます。 

 

Internal Return Busses 
 

HDTDM/XDTDM のスロットはインプットストリップへ戻す Aux か Master Output Busses を送るの

を指定できます。エフェクトの、インタ－ナル センド／リタ－ンの経路です。 

利用可能な Internal Return Busses の数を変える場合は、(もし、あれば)全ての開いている Projects を

閉じて以下に進んでください。: 

 

Settings > All Settings > HDTDM Routing か、HTDMモ－ドを使用していれば HTDM です。 

XDTDM Routing > PCM I/O routing か、XDTDM モ－ドを使用していれば PCM-HSR I/O Routing 

です。 

DXD プロジェクトで Internal Return Busses を使うなら、DXD Projects I/O Routing です。 

Internal Return Busses の数は Internal Busses のコンボ ボックスを使うことでセットできます。 

OK ボタンをクリックして、設定を記録、終了してください。 

 

ここでアサインした Internal Return Busses の数はミキサ－のチャンネル ストリップ ソ－スとして有

効になります。 

 

 



Mixer Delay Compensation 

 

Summary(要約) 

 

Mixer Delay Compensation(補正) On の状態にて:   

 

1. インプットストリップを 1 つのインプット(normal)としてセットします。: 補正なし。Delay をマニ

ュアルで作動させると、このストリップのアウトプット シグナルはその値で遅れるでしょう。 

 

4.  インプットストリップを 1 つの Aux か Bus, Internal Return としてセットします。: 他のすべての 

Output Strips は自動的に Bus 内部遅延処理と等しい量で遅れます。 

 

3. インプットストリップを一つの Aux か Bus, External Return としてセットします。: 他のすべての 

Strips が自動的に Bus 内部遅延処理と等しい量で遅れます。Delay をマニュアルで作動させると、入

力値に従って、他のすべてのアウトプット ストリップのシグナルはさらに遅れます。 

 

アウトボ－ドのミリセコンド内の標準レイテンシ－は、 2 から 5 ミリセコンドの範囲です。 

以下の図表は、アウトボ－ド設置に適切な、遅延補正値の計算の助けるかもしれません: 

 

 

Delay Chart 
 

 

 

 

 

 

 

 

 

 

 

 

 

 



Time Alignment of Recorded Clips 
 

Input として指定された Input Strips からのすべてのレコーディングが自動的に時間によって並べられま

す。例えば、生きているインプットからのレコーディングです。 

 

Recording Bus Returns 
 
Aux か Busリタ－ンをとるインプット ストリップのアウトプットをレコ－ディングするとき、たとえば 1

つのリバ－ブトラックをピタっと止める “freeze” ために、レコ－ディングメディアはもの凄く早く

Timeline 上に置かれるでしょう。 

したがって、この状況で、ノ－マル Input としてこの Aux か Busをリターンに指定するのは、レコードし

たクリップの正しい時間順列を確実にするために望ましいかもしれません。 

 

以下に 注意 してください。: Power Users さまに向けて SABR ディバック ウインドウはディ

レイ値が各々の bus / aux ノ－ドに供給し、便利であることを示しています。 

 

Delay Compensation Detail 
 

すべてのデジタル処理はある程度、処理時間がかかります。Internal Return Busses が Aux か Master 

出力バスをチャンネルインプットに送って戻すのに使用されるとき、Mixer が'時間順列'で、並べられる

のであるなら、そのように送られていない他のすべてのバスを遅らせなければなりません。(Aux か Bus 

アウトプットのためにルーティングポップアップから Internal Return Bus インプットを選択すること

によって、リタ－ンチャネルインプットとして Internal Return Bus アウトプットを選択されます。) 

すなわち、1 つの信号が  2 つのインプットに送られるなら、1番目はダイレクトに Main Output へ、2番目

はインプット(たとえば) Aux バスへ戻されます。その Aux バスは、リターン インプットストリップが

Main Output に送られます。それから、2番目は 1番目を考慮して、遅延されます。 

ミキサ－コンテキストメニュ－から、Settings > Enable Delay Compensation を選択されますと、2 

番目の経路における付加的な処理を、持ち込まれた遅延と同量に、直接 Main Output に送られた信号を遅

らせることによって、確実に両シグナルをシンクの中にとどまらせるでしよう。 

 

Input Strip Mode 

 

Pyramix が正しく必要な遅延について計算するように、Internal Return Bus のため、どのバスがソース

であるか、それを述べなければなりません。ストリップの下の Input をクリックして、XLR アイコンの上、

全てのアウトプットバスそして Input のリストをポップ‐アップします。 

Input は、デフォルトであり、ストリップが物理的なライブインプットから送られて、遅延補正は全く必要



でないことを意味します。もし、どんな Internal または External Return Bus が作動して、そして、Automatic 

Delay Compensation が働いている場合、全てのOutput busses をリタ－ンバスに返すことなく、Pyramix 

は要求されたディレイを計算し、実行します。 

 

Delay vs. Delay Compensation 

 

Input Strip Mode が Input にセットするとき、ディレイセッティングはストリップシグナルのディレイの

みに作用します。 

{どんな Bus name} Return が Input Strip Modeとして選択されるとき、ディレイセッティングは、正し

い時間‐順列を確実にするために他のすべてのアウトプットバスシグナルのディレイに影響します。 

 

Delay Compensation of External Inputs 

 

Output Bus か Aux Bus が物理的アウトプットを通して、外部のプロセッサアウトプットにフィ－ドされ

るのにどこで使用されるか、そして外部のプロセッサアウトプットは外部のライブインプットを通して 

Pyramix の中へフィ－ドバックされる、次に、Pyramix には外部のデバイスのディレイを決定する手段が

全くないので、オペレ－タ－は必要なディレイ補正を計算しなければなりません。 

しかしながら、Input Strip Mode (Input では、ポップ‐アップにメニューをクリックする)が外部のプロ

セッサ(上記にあるように)にフィ－ドさせるバスを用意する必要があり、入力チャネルディレイ設定はイ

ンプットストリップを通して単にシグナルを遅らせるよりむしろディレイ補正に影響します。 

 

 

 

 

 

 

 

Input Type pop-up 

 

イラストでは、Aux Bus Ext Rev は物理的アウトプット17 & 18 を通して外部デバイスへおくられます。 

外部デバイスのアウトプットは物理的インプット7 & 8 へコネクトされます。 

チャンネル’ Mode は Ext へセットされています。FX Return と 256 サンプルのディレイ補正。 

 

対照的に、Int FX アウトプットバスは Internal Return Busses 1 & 2 (IB1 & IB2) にフィ－ドさせます。 

2 個のチャンネルはそれらのモードが Int FX Return にセットする IB1 & IB2 アウトプットによりフィ－

ドされます。 



Determining Delay Compensation 

 

これを達成するための1つの戦略は、Aux を通して、物理的アウトプットへ、外部プロセッサ－インプット

へ直接アウトプットバスにシグナルを送ることです。 

プロセッサアウトプットは、物理的な Pyramix インプットに接続されて、インプットストリップに送られ

ます。そして、マニュアルのディレイ補正を行い易くする為、衝激音、クリック、リムショットなどを、

利用しましよう。 

 

Configuring a Blank or Existing Mixer 

Configure Page, Route ぺ－ジ によりミキサ－コントロ－ル表面のコンフィギュレ－ションは成し遂

げられます。(ぜひ、ご覧ください : Configure Page 150 ぺ－ジ and Route Page 159 ぺ－ジ )

またはコンテクスチュアル メニュウ。 

綿密なオプションは、ミキサーの上をクリックしてください。ミキサ－全体のことを望むなら、Mixer ウ

インドウ のトップバ－を右クリックしてください。 

Bus のオプションを変更するには、Bus ストリップの空白のエリアを右クリックしてください。 

チャンネルインプットストリップでは、Strip の空白のエリアを同様に右クリックしてください。 

ファンクションブロックの中を右クリックするのは特定のブロックに関連しているリストの冒頭にメニュ

－エントリを加えます。 

 

Adding Strips 
 

Faders のどこでもいいですから右クリックしてください。選択してください。Strip > Add そして適切

なストリップタイプを選択してください。選択してください。Bus > Add そして適切なバスタイプを選

択してください。 

 

Removing Strips 
 

インプットストリップをはずすのは、バスかグル－プを直接右クリックしていただいて、Strip > Remove 

(Strip,Bus または、Group) を選択してください。 

 

Mixer I/O Assignments 
 

To or from physical I/O 
 

物理的 I/O からまたは、Internal Return Busses から I/Oアサインの切り替えは、 XLR icon をクリッ



クしてください。ポップ‐アップ メニュウから Connect Input または、Connect Output を選択して、

お望みのコネクションを選んでください。 

 

 

 

 

 

 

 

 

I/O assignment pop-up 

 

マルチチャンネルストリップのコネクションは、(イラストの上にある ADAT (#11290) Optical B)の頭を

クリックしてください。連続して全てのチャンネルをコネクトします。 

 

From tracks 
 

注意、数個のトラックが同じミキサ－インプットストリップに送られる可能性に留意してください。 

トラックスは Track Header からミキサーインプットストリップに自動的またはマニュアルで割り当て

られます。ご覧ください。: Track Header Panel 17 ぺ－ジ    

 

Plug-ins 
 

Native Plug-ins 
 

通常のミキサ－チャンネルストリップに eq とdynamics が含まれています。 

Mix ! モ－ドでプラグ‐インが増やされたストリップの上を右クリックして、ネイティブ プラグ‐インを

付加できます。ストリップのエフェクト エリアを右クリックすると、Effects > Add を選択できます。 

どの場所をクリックしても、Add Effect を選択できます。 

サブ‐メニュ－から 1 つのエフェクトを選択してください。ストリップに現れます。 

 

Direct X and VST Plug-ins 
 

Direct X Plug-In, VST Plug-In または Add Direct X Plug-In, Add VST Plug-In の選択を除いて、

Direct X プラグ‐インの付加も同じ手順です。 

 



以下に 注意 してください。: DirectX Plug-ins は Input Strips のみに付加でき、または FX 
Rack で使用できます。ご覧ください。: Effects Rack     

 

Further Mixer Configuration Options 
 

Mixer Context Pop-up menu 
 

ミキサーの表面を右クリックする場所によって、このメニュ－のエントリは異なります。メニュ－の先頭

のエントリは、右クリックの場合、マウスカーソルの下で特定のミキサ－コンポ－ネントに関係がありま

す。メニュ－の次のセクションには、Strip に影響するエントリがあります。 

Mixer からメニューの終わりまでのエントリは、ミキサー全体の事象に影響して、マウスをどこで右クリ

ックしても、利用可能です。 
 

Mixer > Show 

 

Show All       全てのインプットストリップとバスを表示します。 

 

Show / Hide >     これを選択するとStrips と Busses の表示、非表示ができます。 

                                                                                                             チェックすれば、Busses またはストリップが、コンソ－ル表面に現れます。 

                                                                                                              Show とHide 双方共、同じリストに近接しています。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Mixer Show / Hide pop-up 



Minimize       チェックすると、ミキサ－ウインドウが最小になります。 

 

Automation > 

 

Isolate    これらのメニュ－はミキサ－オ－トメ－ションモ－ド全体の切り替えです。 

Play       どうぞご覧ください。: Automation Modes 266 ぺ－ジ    

Record 

Auto-write 

 

Memory >       ここを選んでいただければ、ミキサ－のプリセットはセ－ブ、ロ－ド、管理 

                                                                                                                   可能になります。 どうぞご覧ください。: Mixer Presets 191 ぺ－ジ  

Settings > 

 

General...       Mixer Settings ウインドウを開いてください。All Settings > Hardware > 

                                                                                                                    Hardware > Formats & Sync ぺ－ジにあります。 

                                                                                                                  どうぞご覧ください。: Formats and Sync 390 ぺ－ジ    

 

Enable Delay Compensation ミキサ－のディレイ補正を可能にします。 

 

Dithering       Dithering ウインドウを開いてください。どうぞご覧ください。: 

                                                                                                                  Below and Dither 280 ぺ－ジ   ディザ－の説明がしてあります。 

 

Remove        ミキサ－コンポ－ネントまたはあらゆるコンポ－ネントのグル－プを削除す 

                                                                                                                  るため、All Strips, All Busses または All を選んでください。    

 

Auto-connect     インストールされたドーターカードと Mixers Preferred Monitoring 

                                                                                                                  Outputs の利用可能なインプットとアウトプットを使用することで Mixer イ 

                                                                                                                  ンプットとアウトプットを、自動的に接続します。 

 

Wizard...        Configuration Wizard を起動させます。どうぞご覧ください。: 

                                                                                                                   Mixer  Configuration Wizard 179  ぺ－ジ    

 

Show VS3 Plug-Ins Info  VS3 Plug-Ins Information ウインドウをポップ‐プアップして下さい。 

                                                                                                                  どうぞご覧ください。:  VST Plug-Ins Information 243 ぺ－ジ  

 

Show Distribution   チェックすると、ストリップに供給される DSP カ‐ド(マルチ‐ボ－ドシス 



テム)、これがどのカ‐ドであるか、どの表示であるか示すために、各々のインプットストリップの底に 

細く色付けされた棒が挿入されます。 

 

Dithering Options 

 

 

 

 

 

 

 

 

 

 

 

 

Dithering MT-r floating Window 

 

ReDithering ウィンドウを開くには、ミキサ－の上をどこでもいいですから右クリックしてください。

Settings > Dithering...を選択してください。Dithering ウィンドウが現れるはずです。 

 

Selected Bus : 
 

コンボボックスは全ての Mixer のバスを選択可能です。 

 

Dither Type 
 

Pyramix Mixer は選択したディザ－アルゴリズムを提供します。MT-r とPOW-r はボックスをクリックし

て選択します。 

 

Word Length 
ディジタルオ－ディオデ－タのアウトプットワ－ドレングスは 8 bits から 24 bits まで変えられます。 

 

回転式ノブをクリックして左右にドラッグして値を調正してください。 

 



MT-r 
 

PDF (Probability Density Function) 
 

基本的なところでは、デジタルオ－ディオストリ－ムにディザ－シグナル(ノイズ)の加算は低レヴェルシグ

ナルの再生において、直線的に改善します。他のワ－ドでは、シグナルレヴェルを落とすために、(あたか

もフェ－ドアウトのように)ディザ－はスム－スなディケイを助けます。 

ここには 3 つのオプションがあります。: 

 

None 
 

ディザ－シグナルは加算されません。 

 

Rectangular 
 

矩形波シェイプディザ－はデ－タに付加されます。 

 

Triangular 
 

三角波シェイプディザ－はデ－タに付加されます。 

 

Noise Shaping 
 

ノイズシェィピングは量子化ノイズエネルギ－押し出すための 1 つのテクニックです。リニアディジタル

システムのなかで、オ－ディオ帯域全体 (0 Hz より上のサンプリング周波数の半分まで)を人の耳に届かな

い高い帯域に広げます。そこには 3 つのオプションがあり、供給されるカ－ブが表示されます。 

 

Off 
 

ノイズシェィピングは付加されません。 

 

Hi Pass 

 

ノイズ転移機能のため、最初にハイ‐パスフィルタ－を供給します。このタイプでは少々の計算力が必要

になります。しかしながら、人の耳を犠牲にすることなく、正確に聞き比べられます。 

 



Acoustic 
 

形成された精神的生のノイズはフィ－ドバックパスの中に FIR-filter を挿入します。できるだけ人間の耳の

特性に近接してノイズを形成します。このタイプのフィルタの、より多くのタップが耳の反応曲線により

厳密な近似を示します。しかし、各タップはもちろん要求された計算の増強を必要とします。ここで実装

されたフィルタは、9-tap FIR-filter です。そのFIR フィルタは密接に人間の耳のカーブに近似します。 

 

POW-r 
 

POW-r は 3 つの設定を選択できます。POW-r 1, POW-r 2 と POW-r 3.グラフはノイズシェィピング

の効果を示しています。 

 

 

 

 

 

 

 

 

 

 

 

 

Dithering POW-r floating Window 

Mixer Presets 

Mixer Presets はユ－ザ－フォルダ－のなかにセ－ブでき、または今のユ－ザ－、全てのユ－ザ－に、メ

イン Mixer Preset リストに付け加えることができます。 

 

Default Mixer 
 

デフォルトMixer として今の Mixer セットアップするために Mixing Console の上を右クリック、そして、 

Memory > Presets > Store > Default を選択してください。 

 

Storing New Mixer Presets 
 



利用できる Mixer プリセットのメインリストにプリセットを増やすために、例えばニュ－プロジェクト立

ち上げ時のリスト。 

 

Mixing Console の上を右クリック、Memory > Presets > Store > New…を選択して Mixer Preset 

ネ－ムをエンタ－してください。Global チェックボックスがチェックされた場合、そのマシンに登録され

ますので、プリセットはどんなユ－ザにも利用できます。 

そうでなければプリセットは新しいプリセットを制作したユ－ザ－だけが利用可能になります。 

 

Removing Mixer Presets 
 

メインリストからプリセットを削除するには Mixing Console を右クリック、Memory > Presets > 

Remove > (preset you wish to remove) を選択してください。Remove Preset ダイヤログボックス

が現れます。それには OK と Cancel オプションがあります。 

 

Saving / Loading Mixer Presets 
 

Mixer Presets は Windows folders に貯留できます。Mixing Console を右クリック、Memory >Save 

を選択してください。 

Windows Explorer ウインドウが開き、Mixer Preset のネ－ミングが可能になり、どんな Windows フォ

ルダにもセ－ブできます。同じように Memory > Load の選択はどんな Windows フォルダからもロ－ド

することができます。 

 

Mixer Surround Components 

 
Surround Bus が増やされた場合、Input Strips の上にサラウンドパンナ－が現れます。 

 

 

 

 

 

 

 

 

Strip Surround controls 

 



Speaker Controls 
 

Speaker Controls のどれかをダブルクリックすると、選択されたサラウンドチャンネルのミュ－トのオ

ンオフを切り換えます。(また、そのサラウンドチャンネル アウトプットに送られたどんなオーディオもミ

ュートします)チャンネルコントロ－ルがミュ－トされた場合、それはもう Mixer Input Strip に表示され

ません。 

 

Joystick Panner 
 

サラウンド サウンド スペースの中でソースの位置を決定します。それの位置決めのために、コントロ－ル

をシンプルにleft-click(右クリック)してください。そして、希望の位置に移動させてください。このコン

トロ－ルをダブルクリックすると、自動的に中心に置かれるでしょう。 

 

Sub Level 
 

Sub (.1) アウトプットに送られたレベルを決定します。 

 

Surround Stem select 
 

Multiple Surround Bus がミキサーに加えられれば、Stem ‘X’ はストリップの先頭に現れます。 

ボックスをクリックして、ストリップに送りたいステムを選択してください。 

 

Stereo Input Strips. 
 

 

 

 

 

 

 

 

Stereo strip surround controls 

 

Surround Sound Panner Position コントロ－ルは、Stereo Input Strip でわずかに異なって作用します。 

現在、2 つの独立している位置決めコントロ－ル、、2 つの独立している Sub センドがあることに注意し

てください。それぞれのための一つはチャンネルを入力します。 



Open Surround Control 
 

Surround Control ウィンドウは個々のInput ストリップに示されたより、はるかに多くの情報とすべて

のサラウンドパンニングパラメータ コントロ－ル情報を提供しています。 

Surround Control window 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Surround Control floating Window 

 

可能なオプションは Mixer Channel がシングルソース(モノラル)かそれとも、2 ソース(ステレオ)である

かによります。 

 

.Position/Speaker Control 
 

シングルソースが使用されているとき、緑色ドットの 5 スピーカアイコンがあるグリッドに Position 

Control を表示します。 

それぞれのスピーカアイコンは Surround Speaker Position (L, C, R, SL, SR)を表します。 

Green Dot の位置はサラウンドサウンドスペースの中でソースの位置を決定します。 

位置決めのために、シンプルに、サラウンドスペースの中でどこでも右クリックしてください。 

位置決めのために、シンプルに、コントロ－ルを左クリックしてください。そして、希望の位置にそれを

移動させるか、またはノブを使用してください。 

Green Dot の上をダブルクリックすると、それを自動的に中心に置きます。 

 



Surround Panning Algorithm 
 

ドロップダウンリストはパンニングアルゴリズムの選択を提供します。 

 

Constant Gain 
 

サラウンドパンニングは Position Control が置かれるすべてのスピ－カ－の一定のゲインが保持されま

す。 

 

Constant Power 

 

サラウンドパンニングは Position Control が置かれるすべてのスピ－カ－の一定のパワ－が保持されま

す。 

 

Level Meter 
 

Surround MeterとLevel Meter の間のメインディスプレイを切り換えます。 

これは以下を示しています。中央の right-hand(右手)セクションと右の Output メータのそれぞれのサラ

ウンドチャンネルのセンド Levels : 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Surround Control floating Window 

 



Stereo Surround Control 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Surround Control floating Window 

 

Surround Meter 
 

Display は、ボタンがそれぞれ実際の信号で明るい赤で点灯された場合、白、赤、黄色で、静止した Left, 

Right および Summed Lobes で表示できます。 

 

Link 

 

独立した赤と白いボールの上をクリックしてドラッグ、そして、コントロ－ルはボタンのクリックによっ

て Source 1と Source 2 の間で切り換えられます。 

Link オプションがコンボ ボックスから選ばれているなら、クリックしてください。そうすれば、ドラッグ

とコントロ－ルは選ばれたリンクにより両方のソースに影響するでしょう。 

 

 

 

 

 

 

Surround Control Link combo box 
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Monitor 
 

Monitor ! Window 

 

Pyramix には、専用 Monitor セクションがあります。 

この非常に強力なツールはすべてのサポートされたフォーマットのためにまとめて、ダウンミキシングを

含む包括的なモニターの設定を、提供します。 

Monitor は使用する必要はありません、そして、不可にすると、DSP パワーはセーブされるでしょう。 

また、モニタ－もアンフォ－マットの入力として Media Manager と Libraries のオーディション機能か

らオーディオ信号を出力に使用されています。 

(すなわち Surround 5.1 Speaker Set の LRC、そして、Stereo oneで LR にル－トされます。) 

デフォルトでは、Monitor ウィンドウは隠されています。View > Monitor により開かれます。 

 

または、View Toolbar の      アイコンでも構いません。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Monitor Main Monitor Window 

Monitor は、2 つのぺ－ジからなります。:ノ－マルオペレイションの Main Monitor ! そして Configure 

ぺ－ジ。 



Monitor ! page 
 

Monitor ! ウィンドウは、縦に 3 つのセクションに分かれています。 

 

Input, left-hand section: 
 

タイトルバーのボタンの左上は、Monitor を有効/不可の選択、可能にされると、イエローを点灯します。 

包括的なモニター コントロ－ルは必要でないときに、DSP パワーをセーブすることを示します。以下では、

Enable Monitoring ボタンが、ミキサーで使用されるすべてのバスのツリー画面です。そして通常、+ と 

- クリックして、ブランチを見せたり、隠したりします。Ctrl key がホ－ルドダウンされるまで、選択は

独占されます。次に、選択が累積します。それらの状況によりインプットの増減をします。 

 

Main, centre section: 
 

Input area 

 

<< Input : Input Section の Shows/Hides 見せる/かくす 

 

<<  SR1  >> : 前/後のインプットの選択。Input セクションで表示されたソースだけが利用可能です。 

 

すなわち、バスかステムのコンポーネントチャンネルが潰されているなら、このバスかステムが 1 つのユ

ニットとして切り換えられます。 

 

<<   ...   >> : まだ実装されていません。 

 

<< Surround 5.1 >> : previous/next Speaker Set を選択してください。 

 

<<   Main   >> : Configure ページで決定した previous/next Downmix を選択してください。 

 

Output area 
 

Output  >> : まだ実装されていません。(モニタリング ウィンドウのアウトプットセクションの見せる/

かくす) 

 

Main area 



それらが Configure ページで接続されないなら、スピーカは無効です(灰色)。 

 

末尾における Mode ボタンはアクティブな Speaker ボタンの機能を決定します。 

 

Mute : スピーカをクリックすると、ミュートします。選択は累積しています。 

 

Solo : スピーカをクリックすると、ソロにします。選択は累積しています。 

 

SoloX : クリックされたスピーカの上の Solo eXclusive.選択は切り替わります。 

 

Reset : すべてのスピーカを解除します。 

 

In Place/Center : Solo とSoloX、In PlaceとCenter の間の切り替え。 

センタースピーカが存在していないなら、Center は等しくCenter スピーカへソロのチャンネルを L/R ス

ピーカに送ります。In Place モードでは、正常な Solo、SoloX モードです。 

 

Output, right-hand area 
 

Monitor Level box は今のアウトプットレヴェルを Display します。 

それをクリックした後に、ボックスに出力レベルを数値で入れることができます。 

 

Volume Knob : -144.5dB から+24dB までの範囲にすべてのアウトプットゲインをセットします。ダブ

ルクリックして、0dB に設定してください。 

 

Mute : ボタンはアウトプットをミュートします。 

 

Dim : Configuration ページで設定された量に従って、ボタンは出力レベルを減少させます。 

デフォルトでは -20dB です。 

 

Speaker Sets 
 

スピーカセットは以下から成ります。: 

 

Patch : これはボードの物理的アウトプットにシグナルを接続します。 

接続の数はあなたが接続したいスピーカの数に依存するでしょう。可能なライブアウトプットの数は、選

択されたサンプルレイトによるので、パッチは1Fs, 2 Fs, 4Fs および 8 Fs により異なるでしょう。 



Main grid : このマトリクスは Mixer のバスアウトプットチャネルタイプとモニタのアウトプットチャネ

ルタイプ(その結果、モニタの物理的アウトプット)との関係を定義します。 

通常、メイングリッドは、パッチされたチャネルタイプのために対角線で示されているでしょう。 

 

Downmixes (max: 4) セットでは : 1 つのダウンミックスは、メインなグリッドと同じパッチを使用す

る代替手段グリッドです。パッチできるこのページでは、アウトプットは、dB (パッチされるチャネルの

種類だけ)でモニターして、ダウンミックスを加える/削除して、対応するグリッドを定義します。 

 

Configure page 

Configure ページは、マルチ Speaker Sets、それぞれのマルチダウンミックスが制作されて、編集され

るのを可能にします。2 つのファクトリ－Speaker Sets が Pyramix の中にインストールされます。

(Speaker Sets リストの上部の赤いバックグラウンドの上に分類されたStereoと Surround 5.1) 

それらのスピーカ Main GridのMain チャンネルと Down-Mix の指定を変えることができませんが、それ

らの Monitor スピーカから物理的アウトプットまでの Patches は変えることができます。 

どれがメイン Monitor ページで1 つの表示を決定するために、それぞれのダウンミックスを可能/不可を決

定することができます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Monitor Configure Window 



Configure ページは 3 つの領域に分割されています。; Commands (Speaker Sets とDown-Mixes), 

Available Sets, Output Patch と Main Grid and Down-Mixes. 

 

Available Sets 
 

設定を確かめるか、または変更するために既存の Speaker Set を選択するには、Available Sets リスト

の中のタイトルをクリックしてください。ラヴェルはアンダーラインを引かれるようになるでしょう。そ

して、Set’s のパラメータはグリッドに現れるでしょう。Set に既に定義された Down-Mixes があると、1

つ以上のタブが Main Grid と Down-Mixes エリアの Main Tab の横にあるでしょう。 

Two セット－Stereo と Surround 5.1 は、ファクトリ－セットで、変更できません。 

Commands を使用することで New Sets と Down-Mixes を制作、コピ－、削除できます。 

 

Dim Value 

 

Dim Level を変えるために、バリュ－ボックスをクリックし、ハイライトさせます。そして、希望の減衰

値をタイプします。そして、Enter するか、または、ほかの場所でウィンドウをクリックして、変更をセ

－ブしてください。 

以下に注意してください。: 負の数だけが入力できます。正値は 0dB に戻ります。すなわち Type 
“-15” 

 

Commands 
 

Speaker Sets 
New Set 
 

New Set をクリックすると、新しい Speaker Set が空白のマトリクス Grid で制作されて、新しいエント

リは、テキスト入力の用意のラベルがハイライトされて、Available Sets リストに加えます。: 

 

 

 

 

 

 

 

 

Monitor Configure New Speaker Set 



適切な名前をタイプします、そして、空白の領域をクリックするか、または ENTER を打って、名前を受

け付けてください。 

 

Duplicate Set 
 

セットが現在グリッドで選択して(アンダーラインが引かれます)、表示されて、同じマトリクス Grid 設定、

Down-Mixes、および設定で新しい Speaker Set を制作します。 

 

Delete Set 
 

現在選択された(アンダーラインが引かれます) Speaker Set を削除します。 

Down-Mixes 
Add Down-Mix 

 

現在選択された Speaker Set と関連した新しいDown-Mix は Main Grid とDown-Mixes セクションの

新しいタブとともに制作されます。 

 

Remove Down-Mix 

 

現在の Down-Mix を削除します。 

 

Output Patch : 
 

これは、Monitor’s Speaker Set アウトプットが物理的アウトプットにパッチされるところです。 

 

 

 

 

 

 

 

 

 

 

 

Monitor Configure Output Patch 



セルをクリックすると、すべての利用可能な物理的アウトプットがそれらのコネクタによって分類されて

いる状態で、Set Output Connection メニューはポップアップされます。 

サブメニューはグループと個々のチャンネルを示します。 

個々のチャンネルがそれを接続するか、またはグループの選択を選んでください。例えば、AES/EBU 

(#11291) Front は昇順にクリックされたセルからの全体のグループへ接続されます。 

 

以下に注意してください。: それぞれの Speaker Set で、それ自身の Output Patch を結び付

けます。これは異なったスピーカが異なったフォーマットで使用されるところで役に立ちます。1セ

ットのスピーカしかなければ、すべての Speaker Sets を同じ物理的アウトプットにパッチしてく

ださい。 

 

Double Assignment 
 

Mixer のアウトプットと Monitor のアウトプットがその時同じ物理的アウトプットに関連づけられるとき、

これらはまとめられます。そして、Mixer は警告してオレンジ色の中に接続を表示します。 

 

Saving Speaker Sets 
 

Mixer から Monitor への接続状態はプロジェクトでセ－ブされます。Monitor ! ページへ戻ってそれを残

すとき、Speaker Set  設定をセーブします。; さもなければ、変更はけっして保存されません。 
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Effects 
 

Plug-Ins 

本章は個々のエフェクトとそれらのコンポーネントについて説明します。 

 

Adding and Managing Effects 
 

どうぞご覧ください : Effect Management 153 ぺ－ジ 

 

Common Components 
 

以下のいくつかの Pyramix プラグインが一般的なコンポーネントを共有します。 

 

 

 

 

 

 

 

 

 

Channel Combo Box 
 

ウィンドウが現在コントロールしている、どのチャンネルにプラグインがあるかを示しています。 

矢印をクリックするのは、このプラグインを割り当てさせるオール・チャンネルのリストをドロップダウ

ンさせます。リストからチャンネルを選択するために名前をクリックしてください。 

コントロ－ル値は、選択されたチャンネルの上にプラグインの現状を反映するように変化するでしょう。 

 

この特徴は、特定のプラグインのすべての事象が、各チャンネルのために同じインタフェース ウィンドウ

からコントロールされるのを可能にします。ウィンドウを複数開く必要は有りません。 

 



On/Off (Bypass) Switch 
 

On/Off (バイパス)スイッチは、エフェクトを活性化、不活性にします。 

 

Bypass all Effects 
 

Shift と共にバイパス ボタンをクリックすると、ストリップのすべてのエフェクトがバイパスします。 

 

Auto Gain Compensation 
 

(関連しているところだけです。)このスイッチが点灯されるとき、Auto Gain Compensation が働きま

す。この機能は、インプットレベルとプラグインのレベルをおおよそ同じにします。 

 

Output Gain 
 

マニュアルで、プラグインのアウトプットで適用されたゲインを調整します。値は dB です。 

 

Effects Presets 
 

Plug-in ウィンドウで右クリックすると、デフォルトにリセットするメニュ－がポップアップします。 

Presets は、ライブラリーから Recalled か Stored か Removed と Imported か Exported できます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

Effects Presets context menu and recall sub-menu 

 



Choosing Presets 

 

リストからあらかじめセットされた、お望みをクリックしてください。 

プラグインのパラメータはあらかじめセットに保存された値に設定されます。 

 

Storing Presets 

 

新しいプリセットの制作は、現在の値のスナップショットを保存します。Store > New は New Preset 

Name ダイアログボックスを開きます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Effects Presets context menu and Store New... sub-menu 

 

Global ボックスがチェックされた場合、Preset はすべての将来の Projects で利用可能になるでしょう。 

 

Default 
 

Presets > Store > Default を選択すると、現在のパラメータをデフォルトにします。 

これらは新しい値または、以前にリコールしている Preset からも選択来できます。 

 

Modifying an Existing Plug-in Preset 
 

あらかじめセットされているプリセットを変更する、またはアップデートするには、エフェクトのパラメ

ータを新しく設定してください。右クリックと Presets > Store の選択、次に、アップデートするか、ま



たは変更するリストの中の Preset ネ－ムを選んでください。Store preset ダイアログボックスは、選ん

だ Preset を取り替えたいかどうか尋ねながら、現れるでしょう。受け入れ OK か拒絶の Cancel をクリ

ックしてください。新しい設定は前のプリセット・パラメータ設定を上書きするでしょう。 

 

Deleting Presets 
 

現在のプリセット削除するには、エフェクトウィンドウを、右クリックしてください。それから Presets > 

Remove を選択してそれから削除したいプリセットを選択してください。 

 

Parametric EQ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Parametric EQ floating Window 

 

Parametric Equalizer はフル 4 バンドのパラメトりック EQ です。そこには、ブ－ストとカット、周波数、

そして、それぞれのバンドワイズ(Q factor) があります。 

ウィンドウの先頭の共通コントロ－ルは、より早く輪郭を描くように作用します。 

 

イコライザは、底辺のロ－タリ－コントロ－ルを使用してオペレ－トできます。(左のノブと矢印のアイコ

ンによって見せたり/隠したり。)それは、直接ノブの下のボックスに数字のパラメータを入れるか、また

は、クリックして、4 つの着色されたノ－ドの 1 つの上にドラッグしてください。 



左クリックにより、レベルと周波数が調整されます。そして、右クリック、左右にドラッグして、Q を調

整してください。すべてのバンドがフルレンジです。最大 24dB のブ－ストとカットが利用可能です。 

0.2 (狭い)から20 (広い)の範囲で、どの部分でも Q を設定できます。 

 

                                               

このボタンはロ－タリ－ コントロ－ルを見せる、隠す、の切り替えです。 

 

Peaking / Shelving は点灯されると、最も低い(赤い)バンドはシェルビングのレスポンス 

 に切り換えられます。 

 

Peaking Shelving は点灯されると、シェルビングのレスポンスに切り換えられます。 

 このモードには、Q コントロ－ルが利用できないバンドのためにあります。 

 

10 Bands EQ 
 

10 のグラフィックイコライザが、10 バンドの一つから全てのブースト、カットを提供ます。 

1つのバンドあたり、1オクターブ、レンジは 32 Hz から16 kHz、スライダノブの上をダブルクリックす

ると、ゼロに復元します。 

 

 

 

 

 

 

 

 

 

 

10 Bands EQ floating Window 

 

 

 

 



Three Band Tone Control 
とてもシンプルな +/- 24dB のブ－スト、カットのスリ－バンド イコライザです。  

 

 

 

 

 

 

 

Tone Control floating Window 

Low LPF は 6dB/Octave のスロ－プのEQです。そして100 Hz のタ－ンオ－バ－です。Medium BPF に

は、センタ－が 2 kHz、(バンド幅)が 0.8 の Q です。High HPF は 6dB/Octave のスロ－プの EQ です。

そして 8 kHz のタ－ンオ－バ－です。 

Dynamics Processing 
包括的なダイナミックス プロセッシング モジュールです。ファンクションには、1 つのゲイト、1 つのエ

キスパンダ－、2 つのコンプレッサ－、1 つのリミッタ－とディエッサ－が存在します。各々のエフェクト

のオペレ－ションは包括的ダイナミックス プロセッサ－の中に相互に関連付けられています。ユーザイン

タフェースは、各プロセスがどこで実施するかを、作用しているダイナミックレンジに示しています。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Dynamics floating Window 



Output Level Max 
 

このボックスは、auto-gain compensation がオンになっている場合、Inactive に示しています。 

 

Thresholds 
 

スレッシュホ－ルド コントロ－ルはレベルの上下をセットします。そのプラグイン はインプット シグナル

のダイナミックスに影響を与えるでしよう。 

すべてのスレシュホールド設定はウィンドウの右にあります。下から、ゲ－ト、エキスパンダ－、コンプ

レッサ－1、コンプレッサ－2、リミッタ－、そして、インプットReference Level です。 

 

Reference Level 
 

インプット レベル リフェレンスをセットします。例えば、リフェレンス レベル –20 のセッティングは、 

-20dB のインプットレベルは単一のゲインと等しいと判断されます。 

それは、リミッティング以外のすべてのダイナミックス プロセスのためにインプット スレッシュホ－ルド

を計算する目的のためです。リフェレンスレベル値は、0dB (単一のゲイン)から  -30dB の間で変化します。 

 

Limit 
 

リミット スレシュホールド(そして上限)を設定します。 

 

Ratios / Slope 
 

無限領域なので、LimitとGate はレイシォをフィックスします。 

それぞれの Threshold コントロ－ルの左には、ExpanderとCompressors のための率設定があります。 

 

Compression Bar Graph Meter 
 

Compression のバ－グラフインディケータは、レイシォコントロ－ルを超えて総合ゲインリダクション

の総量、または入力信号への増加を示しています。変化が全くスケールの中央にありません。 

中央の上の緑 ‘leds’は、ゲインの増加、下の赤の ‘leds’はゲインリダクションを示します。 

インディケータのディスプレイ範囲は、クリックすることによって、+/-10dB, +/- 20dBと、+/-40dB の

間で切り換えることができます。 

 

Time 



このセクションのスレシュホールド設定の上下へ向かうシグナルが、どちらへ向かうか、ダイナミックプ

ロセッサが反応するスピードです。これらのパラメータの細かな設定で、ダイナミックプロセッシングは、

よりデリケ－トに、そして自然になります。 

 

Delay 
 

0.01ms から10ms の間で、メインプログラム シグナルが遅らされることを示します。 

プロセッサは高速に反応します。‘brick-wall’ リミッティングを提供します。 

 

Attack 

 

スレシュホールドレベルが 0. 1ミリセコンドから 600 ミリセコンドの範囲に達っした場合、Attack Time 

はプロセッサの応答速度を設定します。 

 

Release 

 

Release Time は、スレシュホールドが超えられなかった後に適用されたゲイン変化が 1 つに戻るレイト

を設定します。レンジは 5 ミリセコンドから 5 セコンドです。 

 

Equalizer 
 

イコライザはサイド‐チェインにあります。すなわち、それは、ダイナミックプロセッサのエフェクトの

引き金となる主要な信号にはイコライジングしますが、主信号のト－ンのバランスは変化させません。 

これは、プロセッサの応答を特定の周波数により敏感に作用するのを可能にします。 

これは、ディ－エッシングにおいて通常使用されていて、激しいシビランス音に使用されています。 

例えば、3kHz から 8kHz の周波数ブースティングは、その結果、信号にこの範囲のコンポーネントがある

とき、コンプレッサーは信号レベルを減少させて、シビランス音をより、自然に作動させます。 

 

Q 
 

Eq のバンド幅を設定します。 

 

Frequency 

 

20Hz から 20kHz の範囲に、イコライザのセンタ－周波数を設定します。24dB の Boost/Cut が利用可

能です。Test ボタンはサイドとプログラム チェインの間の EQ のアウトプットを切り換えます。 



On のときに、EQ のアウトプットは聞けます。シビランス などを特定する場合に、これは役に立ちます。 

サイドチェインの On/Off  は、イコライザのオンとオフを切り換えます。Off  であるときに、プログラム

素材はプロセッサの引き金となります。On であるときに、信号はエフェクトにあり、スプリットしてく

ださい。イコライザを通して送られた部分がトリガ－として使用されるか、ノ－マルプログラム素材のダ

イナミックプロセッサのオペレーションの ‘key’ です。 

 

X/Y Dynamics Response Display 
 

これはゲート、エキスパンダ、コンプレッサー1、コンプレッサー2、リミタプロセス、および  Dynamics 

Processor の参照レベルのためにスレシュホールドとレイシォ設定を表示しています。 

コントロ－ルハンドルがグリッドにある状態で、これらは一連の色付けされたラインとして示されていま

す。そのグリッドは、水平軸上の 1 つのゲイン(0dB)の下に dB として、インプットレベルを表しています。

そして、縦軸上の一つのゲイン (0dB)の下にdB として、インプットレベルを表しています。 

 

このディスプレイのための解説は以下の通りです: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Adjusting Dynamics Parameters 
 

グラフィックディスプレイで、コントロ－ルノブをクリックして、ドラッグ、またはコントロ－ルハンド

ルをクリックして、ドラッグすることによって、パラメータを変更できます。 

ハンドルコントロ－ルは他のパラメータ設定で影響を受けます。 



ある場合にハンドルをドラッグすると、1つ以上のパラメータが変化するでしょう。 

 

Dancing Star Real-time Response Indicator 
 

グラフィックディスプレイの中の赤い "dancing star" はプロセッサがどうプログラム素材に影響するか

に関する役に立つ表示をします。 

それは、シグナルがいつインプットに入力しているかをリアルタイムの出力レベルで示しています。 

 

Delay 
ディレイ Plug-in には、4 つのディレイベースのエフェクトがあります。 

‘Plain-vanilla’ Delay, Echo, Comb Filter と All Pass Filter です。Delay が選択されるとき、インタ

フェースはわずかに変わります。 

 

 

 

 

 

 

 

 

 

 

Delay floating Windows 

 

ダイレクトな(ディレイされていない)信号がある状態では、単一ゲインにストレート・スルーシグナルの

経路をアウトプットに使用しません。ミリセコンド、メータまたはサンプルでディレイの長さを設定でき

ます。ディレイの有効な範囲は 0～800 ミリセコンドです。 

テキストボックスで、ノブまたは、希望のディレイタイムをタイプすることによって、設定できます。 

 

Echo 

 

エコーは、ディレイのセットタイムが、それを通るシグナルに追加します。それから、ダイレクトオーデ

ィオソースと、このディレイシグナルは、ミックスされます。ディレイシグナルはいつも一つのゲインで

す。ディレイシグナルに比例したダイレクトシグナルのレベルは、0 (ダイレクトシグナルの完全な減衰)、

1 (ダイレクトシグナルの一つのゲイン)、と -1 (逆相の一つのゲイン)の間の要素として、Delay Gain コ



ントロ－ルによるセットです。 

 

Comb Filter 

 

シグナルを遅らせて、その後、その遅れたシグナルの一部をディレイのインプットへ戻します。 

Comb Filter フィルターには、Echo と同じコントロ－ルパラメタがありますが、聞きとれるエフェクト

は全く異なっています。それは、それは後方に送りを使用するよりは、むしろ前方へ送るシグナルの経路

だからです。 

後方に正方向送り信号経路よりむしろ送りを使用するので、聞きとれるエフェクトは全く異なっています。 

Comb Filter の名前はディレイタイムの半分の残りの多重波長を持つシグナルがプロセスによって取り

消されるという事実から来ます。この結果は櫛に似ている周波数レスポンス図表を示します。(ディレイタ

イムにより)いくつかの周波数がなくなった、櫛の歯の隙間のようになっています。 

 

All Pass Filter 
 

EchoとComb Filter エフェクトで使用したプロセスを結合します。その決果、フラットな周波数レスポ

ンスのある、マルチ エコ－シグナルになります。コントロ－ルパラメタは再び、EchoとComb Filter エフ

ェクトと同じです。Delay Gain には、全く異なったエフェクトがあります。それはアウトプットシグナル

の総合的なレベルに影響しません。それは最初に異なった周波数でシグナルのフェーズに影響します。 

1 に設定されるなら、インプットシグナルのフェーズを逆にします、そして、エコーが全くなくなります。 

-1 のゲインで、そこのインプットシグナルは位相ずれはありません。 

0 のゲインは、全ったく、ダイレクトシグナル成分がないことを意味しています。そして、ディレイシグ

ナルは、それらのそれぞれの周波数に依存した量に等しくなるように、フェイズ シフトされます。 

Flanger 
フランジャーは最初に、何か  2 つのコピーをプレーすることによって発生した独特の音を発生させます。

これは、シンクにもかかわらず、ひとつのコピ－のテープスプールのフランジを持つことによってテープ 

スピ－ドの変化によって発生するものです。 

 

 

 

 

 

 

 

Flanger floating Window 



Pyramix Flanger plug-in は、シグナルのタイムモデュレ－ションにより、このエフェクトをシミュレー

トします。そして、フェーズ(positive)かフェーズリバ－ス(negative) のどちらかにインプットをもどし

ます。Feedback type は Positive と Negative の間で切り変わります。 

変調の深さは、0～100% で変えることができます。 

周波数は、0.05Hz～5Hz で、そしてAmplitude モデュレ－ションは、0～100% で変えることができます。 

 

MS Encoder 
 

ブリキの上に示すように。 

 

 

 

 

 

 

 

 

 

 

 

 

MS Encoder floating Window 

 

どちらかのインプットはフェーズを逆にすることができます。インプットレベルは調整可能です。そして 

両チャンネルは左右どちらへもパンできます。 

 

Encode Levels 
 

コントロ－ルにより、極端な Left、Right、および Unity ゲインの適用された信号はこのようにコード化さ

れます: 

 

M = A + B - 3dB 

 

S = A - B - 3dB 

 



AnguDion 
 

ああ、おもしろい! Stooge, Angel と Tricky とつけられたボタン、0 – 100 のメモリのノブがあります。

いったい、なにをするのでしようか! 

 

 

 

 

 

 

 

 

 

Angudion floating Window 

 

 

AnguDion II 
 

さらに、おもしろい! 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Angudion II floating Window 



今回は、Wide、Sub ボタン、つながった Input および Output のゲインロ－タリ－です。 

Velocity とAmount ロータリーは、Stooge, Angel とTricky オプションの側面にあります。 

AnguDion II がステレオチャンネルに挿入されるとき、同軸の Wide ポットはアクティブになります。そ

して、ワイドボタンは押されます。 

AnguDion II がサラウンドストリップに挿入されるとき、サブボタンを選択できます。 

 

Mastering Peak/Vu Meters 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Meter floating Windows 

 



正確な測定器。VU (ボリュームユニットメータ)は、それが通常のウィンドウで使用されるあらゆるスト

リップのオーディオレベルを表示します。高価な外部のメ－タユニットの代わりに、マスタレベルディス

プレイとして、提供できます。プラグインは、3 つの異なったレベルディスプレイを提供し、各々、Dynamic 

レンジディスプレイのオプションを持っています。 

 

Peak-Meter 
これはオーディオ信号のピ－ク値を測ります。   

ピーク計測は、オーディオシグナルの絶対デジタルレ 

ベルをチェックするために非常に役に立ちます。 

 

 Peak メータバーは青いです。そして、それには、 

16 dB/ セコンドのデフォルトリリースタイムがあり 

ます。 

 

VU-Meter 
                                                                                                                                                                        VU (ボリュームユニット)メータは平均したアンプリ 

                                                                                                                                                                       チュ－ドレベルを表示します。 

                     

                                                                                                                                                                         VU メータは、オレンジ/黄色で表示されて、60ミリ 

                                                                                                                                                                        セコンドのデフォルト統合タイムと10 dB/ セコンド。 

リリースタイムを持っています。 

Dynamic-Meter 
 

                                                                                                                                                                                                このディスプレイはオーディオシグナルの瞬時のダ 

                                                                                                                                                                                                 イナミックレンジを測ります。 

                                                                                                                                                                                                 基本的に、これはPeak とVU２ディスプレイの違い 

                                                                                                                                                                                                 です。純粋なサイントーンがあるなら、ダイナミッ 

                                                                                                                                                                                                 クスはゼロでしょう。 

                                                                                                                                                                                                  Dynamics メータは、イエローで表示されて、12dB 

                                                                                                                                                                                                   /セコンドのデフォルトリリースタイムを持ってい ま 

                                                                                                                                                                                                  す。 

 

Activating the VU-Meter 
Peak Meter floating Window 



どんなストリップのいかなる他のプラグインのように、ミキサーストリップの中のコンテキストメニュー

から  Add Effect > VU-Meter を選ぶことによって、VU-Meter を加えることができます。他のプラグイ

ンにたとえたものとの唯一の違いは、アクティブな VU－Meter の複数の例で、シングルのウィンドウ・

フレームの中にいつもそれらを表示するということです。 

 

Display options 
 

Peak と VU メータは個々に表示できます。VU メータのウィンドウエリアの中でどこでも、マウス中ボタ

ンクリックをしてください。マウス中ボタンがある各クリックは、オプションの Peak と、VU、そして唯

一  Peak、VU を切り換えます。Dynamics ディスプレイは、メータバ－グラフのトップのスイッチをク

リックすることによって、アクティブにできます。 

マルチチャンネルメータ(ステレオストリップ、サラウンドミックスなど)の上では、ダイナミックスは一

つのバ－グラフへ一緒にまとめられます。例えば、リア チャンネルなしでサラウンドチャンネルの L, R 

と C チャンネルのダイナミックスをディスプレイすることを示しています。 

 

VU-Meter controls 
 

  

 

 

 

 

 

 

 

 

 

 

Vu-Meter Controls Timing floating Window 

 

個別に VU-meter のディスプレイパラメータの大部分を調整できます。 

 VU-meter のほとんどどんなパラメータもコントロールを示して、 VU-meter のどこでもマウスボタンを

右クリックして、ダイアログを表示してください。 

コントロ－ルウィンドウの左側はグローバル設定を含んでいます。そして、右側には 4個 の Tab パネルが

ある間、事前に設定されたプリセット数個が、あらかじめセットされます。 

 



Switch Display 

このエリアをクリックすると、VU, PEAK および BOTH を通して循環します。 

 

Double VU 

 

このボタンが点灯されるとき、ピークメータは VU の特性に切り替わります。その結果、あなたが同時に

異なった設定で 2 個の VU-meters を動かすのを可能にします。 

 

Level Mark 

 

点灯されると、これはあなたの希望の “nominal” のレベルで、グレーのバーをメータディスプレイに挿入

します。インプットシグナルがマークレベルを超えていると、バーはライトグリ－ンになるでしょう。 

 

Global settings and presets 
 

あなたのアプリケ－ションにベストフィットするパラメ－タ セットを素早くできるように、Eight プリセ

ットが用意されています。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Double VU 

 

このオプションが起動されるとき、ピークメータはVU の特性に切り替わります。その結果、あなたが同

時に異なった設定で 2 個の VU-meters を動かすのを可能にします。 



Level Mark 

 

このオプションは、これはあなたの希望の“nominal” のレベルで、グレーのバーをメータディスプレイに

マ－クをセットします。 

インプットシグナルがマークレベルを超えていると、バーはライトグリ－ンになるでしょう。 

 

Timing parameters 
 

設定面の右側の Timing Tabをクリックすることによって、これらのパラメータはアクセスされます。 

(上の画像も見てください。) 

 

Peak integration 

 

このパラメータはミリセコンド単位で上昇しているレベルを計るために、ピークメータの統合時間を調整

します。 

 

VU integration 

 

これはミリセコンド単位で上昇しているレベルのための VUメータの統合時間です。 

 

Peak Release 

 

これはレベルが減少しているときピークメータが落ちるスピードであり、dB を毎秒単位で表します。 

 

VU Release 

 

これはレベルが減少しているとき VUメータが落ちるスピードであり、dB を毎秒単位で表します。 

 

Dyn Release 

 

これはダイナミックスディスプレイが減少時間です。dB を毎秒単位で表します。 

 

Max Level Hold Time 

 

達したレベルで最も高いセグメントはレベルが減少した後も設定された時間、点灯されたままで残るでし

ょう。簡単に最大レベルを表示します。パラメータはセグメントの残りが光る時間の長さを調整します。 



Alignment parameters 
 

アライメントパラメータはピークとボリュームユニットメータのスケールに影響します。 

Align Tab をクリックすることによって、それらにアクセスできます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Vu-Meter Controls Align floating Window 

 

VU Ref 
 

このパラメータは 0 dBFS と関連して 0 VU ポイントのレベルを設定します。 

( 0 dBFS がサンプルワ－ドの最大値です。これより上のレベルはシグナルがクリップしていることを意味

します。)例えば、VU Reference レベルが -16 dBFS にセットされている場合、シグナルが -16 dBFS の

ときは、VU メ－タ－は 0 dB を示すでしよう。 

 

Peak Color A/B alignment 
 

ピークメータは表示されたレベルを大きさにより3つのカラーを使用します。A ポイントの下では、カラー

は暗いオレンジです。A と B ポイントの間では、カラーは、より軽いオレンジです、そして、B ポイント

を超えたカラーは赤です。これらの2つのパラメータが A とB ポイントのレベルを調整します。 

 

VU Color A/B alignment 



VU メータは表示されたレベルを大きさにより 3 つのカラーを使用します。A ポイントの下では、カラーは

暗いオレンジです。A と B ポイントの間では、カラーは、より軽いオレンジです、そして、B ポイントを

超えたカラーは赤です。これらの 2 つのパラメータが A と B ポイントのレベルを調整します。 

 

Scale parameters 
 

これらのアライメントパラメータはピークのルーラーに影響します。そして、VU メータと dB レンジの 

ディスプレイにも影響します。Scale Tab をクリックすることによって、それらにアクセスできます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Vu-Meter Controls Scale floating Window 

 

Rulers Max 

 

これはピークメータによって表示された最大のレベルを設定します。通常、あなたは 0dBFs に設定するで

しょう。デジタルのフルスケールレベルは、ちょうどスケールの一番上に達するようになります。 

しかし、Pyramix は Floating Point  演算を使用しています。あなたは理論上 0 dBFs の上のシグナルレベ

ルを持っているかもしれません。それは、それらの表示に役に立つようになるでしよう。 

(もちろん、ミキサーのアウトプットにおいて、こようなシグナルは欠くことのできない数として変換して

もどされます。そしてデジタルクリップをひきおこし、注意が必要です)。 

 

Rulers Min 



これは、ピークメータによって表示された最低基準を設定して、これにより、ピークと VU メータの精度

と分解能に影響を及ぼします。最低基準より少ないシグナルはメータの上では目に見えません。 

 

Height 
 

スクリーンに表示されているように、VU メータプラグインウィンドウの高さ(ピクセルで)を変更します。 

 

DSD Filtering options 

 

DSD セッションの特定のケースで、VU メータは 3 つのフィルタリングオプションを持っています。 

これらのオプションで、DSD シグナルは高周波ディザ－ノイズに関する AES の推奨に互換性があると確

信するでしよう。これらのラジオボタンにより、3 つのフィルタ－の 1 つを選択できます。それは、レベル

メ－タ－で計測される以前に DSD シグナルに提供されます。 

20k オプションは 20 kHz のローパスフィルタをシグナルに当てはめます。その結果、聞きとれるオーデ

ィオだけが存在します。20k-50k オプションは 20 kHz から 40 kHz の周波数領域があるバンドパスフィ

ルタをシグナルに当てはめます。AES 推薦によると、この周波数領域のシグナルレベルは -28 dB を超え

るべきではありません。40k-100k オプションは 50 kHz から100kHz の周波数領域があるバンドパスフ

ィルタをシグナルに当てはめます。AES 推薦によると、この周波数領域のシグナルレベルは -20 dB を超

えるべきではありません。 

 

Priority settings 
 

Priority Tab をクリックすることによって、優先順位の設定ができます。 

 

 

 

 

 

 

 

 

 

 

 

 

Vu-Meter Controls Priority floating Window 



この選択は、プラグインにより、どれほどのホスト PC の CPU 時間が消費されるか、によります。した

がって、VUメ－タ－のスピードと精度を描き直してください。 

優先度が高ければ高いほど、より多くの CPU 時間がプラグインに割り当てられます。 

 

Phase-Oscillo 

このプラグインは位相計とX/Y オシロスコープを結合します。 

 

以下に 注意 してください。: Phase-Oscillo はモノのストリップでは使えません。無理に使用

しようとすると、エラ－メッセ－ジがでます。 

 

位相計は -1 to +1 の範囲の中にステレオシグナルのフェーズを表示します。 

+1の値は、左右チャンネルが完全なフェーズにあることを意味します。 

-1の値は、左右チャンネルのフェーズが完全にアウトしていることを意味します。 

それらがモノラルシグナルへまとめられるときは、完全なキャンセルを引き起こします。 

良いステレオミックスは 0～+1 のどこかにあるべきであります。 

オシロスコープは立体音響の何らかの情報とステレオシグナルの整相をあなたに知らせます。 

完全にモノラルのシグナルは垂直線として現れます。 

右チャンネルだけがシグナルを運ぶなら、下からの45角度の直線が右上に、表示されます。 

左チャンネルだけがシグナルを運ぶなら、下からの45角度の直線が左上に、表示されます。 

左右チャンネルがフェーズアウトしているなら、水平線になるでしょう。 

通常のステレオミックスは、以下の例に示されているように垂直に形成された雲として現れるでしょう。: 

  

 

 

 

 

 

 

 

 

 

 

 

 

Phase-Oscillo floating Window 



Phase-Oscillo configuration 
 

Phase-Oscillo プラグインには、そのオペレーションを構成する数個のボタンがあります。 

 

Oscilloscope button 

 

オシロスコープディスプレイのオンとオフを切り換えます。オフ にセットするなら、位相計だけを表示し

ます。 

 

Sample interpolation 

 

このスイッチがオンのとき、より認識し易い状況で、オシロスコープの上に表示された信号のサンプルは

相互接続されています。 

 

Setup 

 

このボタンは更なるオプション セットアップパネルを開きます。 

 

Working Priority 

 

これらのスイッチの 1つを選んで、プラグインで消費される、ホスト PC の CPU タイムの量を選択して

ください。したがって、それに影響されるので、オシロスコープのスピードと精度を描き直してください。 

優先度が高ければ高いほど、より多くの CPU タイムがプラグインに割り当てられます。 

 

Drop frame display 

 

Phase-Oscillo の優先順位の選択により、絶え間なくディスプレイを描き続けることができるくらいの十

分な CPU タイムを得ることができないかもしれません。実際の Pyramix セッションのスタ－ト時から、

CPU タイムの不足のために、ドロップカウンタは描ききれないフレームの量をディスプレイします。 

 

Left and Right channel selector 

 

プラグインが2個以上のチャンネルでバスに挿入されるなら(たとえば、サラウンドバスかマルチステレオ

バス)、これらの2個のセレクタで、あなたは、プラグインの左右インプットに適切なチャンネルを選ぶこ

とができます。例えばサラウンドバスでは、Phase-Oscilloプラグインで表示される左右前部チャンネル

のを選択するかもしれません。 



Surround Meter 

これは、サラウンドサウンドフィ－ルドのエネルギ分布の表示です。大変役にたちます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

                         Surround Meter floating Window 

 

Surround Meter は、素材のレンジの広さを表示する、大変意味のあるディスプレイを持続する自動ゲイ

ンレンジングを組み込みます。調整のための設定が全くありません!。 

DC Meter 
シグナルのDC コンテンツをあわせます。 

 

 

 

 

 

 

 

 

 

 

 

 

DC Meter floating Window 



Modulometer 

 

 

 

 

 

 

 

 

Modulometer floating Window 

Modulometer は、Nagra の携帯用のTapeレコーダーに取り付けられた古典的なメータの忠実な再現で

す。一般的な操作は、レベルを合わせることです。スピ－チのレコ－ディングのとき、メ－タ－は、- 8(平

均)を指します。ある意味、これは準ピークメータとしてのモデュロメ－タ－の特性に起因します。(準と

言われる由縁は、弾道学により制作されたメカニカルメ－タ－だからです。)これは勿論、慎重な屋外の会

話のレコ－ディングで反映されます。ロストテイクは何千ドル(何十万円)もの代償をはらいますから。こ

れは、決して望ましくはありませんが、低シグナルのほうが、ピーククリップのひずみよりましだからで

す。ウィンドウのどこでもよいですから、右クリックで、コンテキストメニューがポップアップします。 

これには、Modulometer の動きをコントロールするいくつかのオプションがあります。 

 

 

 

 

 

 

 

 

Modulometer menu 

Reset 
デェフォルトの設定を修復します。 

Presets 

標準の Preset オプションを提供します。 

Display (Frame / Sec) 
ディスプレイのリフレッシュレイトを設定します。 

Release (dB / Sec) 
Release タイムを決めます。 



Acceleration (dB / Sec) 
Acceleration レイトを設定します。 

Reference (dBFS) 
Referenceレベルを DeciBels Full Scale にセットします。 

Integration (ms) 
Integration タイムをミリセコンドにセットします。 

Hide 

Modulometer を隠します。 

 

Function Generator 

 

このオシレーターは Sine 波か Pulse 波かTriangular (鋸歯)波か DC とホワイトか Pink Noise を発生さ

せることができます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Function Generator floating Windows 



Wordlength Meter 
 

Wordlength Meter (または、Bit Meter )は実際のシグナルの語長を表示します。 

 

 

 

 

 

 

Wordlength Meter floating Window 

 

ゲイン調整をする際、心に留めておいてください。例えば、(0dB 以外のフェーダの設定) 

そのシグナルは 32 ビットフロートデータになるでしょう。 

 

Plug-in Automation 

 

ダイナミックに、Pyramix のすべてのシグナルプロセッシング Plug-in パラメータは完全にオ－トマチッ

クにできます。どうぞご覧になってください。Automation Modes 266 ページ 

 

Effects Snapshots 
 

ライブラリーから / に、それらをドラッグすることによって、Effect Settings を容易に保存して、リコー

ルすることができます。 

 

Creating Effects Snapshots 

 

Alt + Shift しながら、クリックしてください。 

あなたが設定を保存したいライブラリ－へ、横棒から次の Plug-in ウィンドウの Channel コンボボック

スへドラッグしてください。それから、放します。 

ニュ－アイテムは、Mixer Snapshot タイプとしてライブラリーに保存されます。デフォルトでは、プラ

グインの名前がスナップショットになります。ニュ－アイテムは、自動的にハイライトされます。デフォ

ルトネ－ムを変えたい場合は、単に新しいネ－ムをタイプして、確実に Enter してください。 

次に、スナップショットのネ－ムはライブラリーのネ－ムの上をクリックすることによって、変えること

ができます。そして、新しいネ－ムをエンタ－します。 



以下に 注意してください。: いくつかのプラグインでの Alt + Shift のクリックとドラッグは、水平な

セクションタイトルバ－とプラグイン ウィンドウどこからでも、使用できます。その場合、カ－ソルは          

この様に変わります。 

 

 

Using Effects Snapshots 

 

カーソルが変化する所の、どこでも、ユーザライブラリからオリジナルとリリースと同じタイプのプラグ

インへ、単純にスナップショットをクリック、ドラッグしてください。 

 

スナップショットはどこへでもドロップできるわけではありません。または、スナップショットプラグイ

ンタイプが、タ－ゲットとなったプラグインにマッチしないなら、カ－ソルは      に変わります。 

Optional Plug-ins 

オプションの Pyramix プラグインの操作法に関しては、各プラグインのガイドを見てください。 

 

Merging Technologies 
 

EQ-X 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

EQ-X floating Window 



EQ-X は Pyramix EQ にビルトオンされた世界的に賞賛された品質であります。それは後方へ互換があり

ます。 

EQ-X は究極のフィルタリングを提供します。それは、サンプリング周波数のノッチのある DXD、ロ－パ

ス、ハイパス、ピ－クとシェルビングフィルタ－タイプまで利用可能です。 

この Extreme Definition Equalizer のフィルタデザインのスぺ－スは、最も高いオーディオ解像度に対処

するために明確に最適化されています。それは、可聴範囲全体を通して(また、非可聴領域でさえ)、非常

に低いノイズ& 歪み、通常は -110dB より上のTHD+N であります。 

もちろん、この新しいディジタルフィルタの位相数学は、高いサンプルレイトを念頭に設計されておりま

すので、当然のことながら付加的な恩敬と低いノイズを1FS に均等に提供します。 

しかしながら、無料のランチなんてものがないように、EQ-X は、Pyramix にある同様な「伝統的」デジ

タル EQ の例に換算すると、その DSP プロセッシングパワーのおよそ 2 倍「食べてしまいます」。 

 

EQ-X は、Filter Type をコントロ－ルするファイブバンドのフルパラメトリック EQ です。 

この Filter Type には、Gain のブ－スト、カット、周波数、各バンドの Q 因子 (バンドワイズ)があります。 

イコライザは、ロ－タリコントロ－ルでオペレ－トできます。それには、直接、数字のパラメータをノブ

の横のボックスに入れます。または、マウスカ－ソルがレスポンスグラフの上に置かれているときに現れ

る、5 つの色付けされたボックスノ－ドの 1 つの上へ、クリック、ドラッグしてください。 

左クリックでレベルと周波数を調整します。右クリック、そして左右にドラッグ、これで Q を調整します。 

すべてのバンドがフルレンジです。最大 24dB のブーストとカットが利用可能です。1.0 (wide)から100 

(narrow)の範囲で Qを設定できます。Master Gainは、総合的なレベルが、eq に合うように調整できま

す。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

EQ-X Frequency Response THD+Noise 



Solera 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Solera floating Window 

 

Solera は、Angel Class Dynamic Processors のレンジのフラッグシップです。 

それはマスタリングとリ-マスタリングアプリケーションのために主として設計されています。 

しかしながら、優れた音質とひずみの無いオペレーションにより、通常のダイナミックプロセッサとして

使用できます。 

 

Merging Technologies のために、ゲール人 Yvan Son et Développement によって開発されています。 

あらゆる Angel Class Dynamic Processor プラグインはいくつかの専門アルゴリズムを使用します。 

それは信じられないほど明確で自然な音になります。 

 

Pure シリーズは特別なダイナミックプロセッサと同じ技術を使用しています。 

 



デジタルドメインで、ダイナミックプロセッシングにベストなプラグインを与えられました。ここに、い

くつかの特色があります。: 

 

1. 計測器 のように、アナログです。ダイナミックなプロセッサをセットアップするとき、RMS 値はdBf 

より有用です。 

 

2. Angel's Share パラメータはシグナルのコンプレッサー操作において、知的な緩和を考慮に入れます。 

 

3. Hysteresis パラメータは、サウンドレベルのコンプレッシング、ディコンプレッシングをしめしま 

                  す。そして、スタンダ－ドなコンプレッションの仕組みでミックスされます。 

 

4. Auto Release は典型的なポンピングエフェクトを避けるユニークなアルゴリズムを特徴とします。 

 

5. ディレイラインは、ヌル(0)アタック・タイムをシグナル経路にインサ－トできます。 

 

6. A/B コンぺア と Morphing セクションは、超高速、厳格なオペレ－ションを可能にします。 

 

Angel Class Dynamic Processor ファミリ－は、同時に 8 チャンネルと DXD オペレーションまでサポ

ートします。 

 

以下に 注意 してください。: Solera はブドウ酒醸造テクニックです。:Solera は部分的にワインブレ

ンドの方法です。密接に、Sherry か Madeiraの酒造に関係しています。ソレラは、最も古いワインの、

古い順に積み重ねられたオークバーレルの数列から成ります。新しい物は一番上にあります。ボトルづ

めでは、古い列のワイン、約1/3を取り除きます。そして、すぐにワインを、上の列から取り替えます。

トップの列に届くまで、新しいワインで補給します。Solera の裏の概念は、年から年中、一貫してワ

インを作ることです。 

Angel's Share は、Armagnac, Cognac, Whisky に使用される用語です。;熟成の間に気化する

スピリットのことです。 

 

Angel Class Processors User Guide には、完全な操作の詳細があります。 

 

Pure Series 
 

Pure Series プラグインは、本質的には個別のプラグインとして提供された Solera のビルディング ブロ

ックです。先進的なリリースモードは Solera のみで利用可能です。 

 



Pure Compressor 
 

Pure Compressor は Solera のコンプレッサーセクションです。 

 

Pure Expander 
 

Pure Compressor は Solera のエキスパンダセクションです。 

 

Pure DCompressor 

 

Pure Compressor は Solera のディ-コンプレッサーセクションです。 

 

Pure DExpander 

 

Pure Compressor は Solera のディ-エキスパンダセクションです。 

 

Algorithmix 
 

DeNoiser 

 

DeScratcher 

 

DeNoiser + DeScratcher, Restoration Suite 

 

Nova 

 

Overview 

 

Pyramix レンダリングインタフェースへの Nova™プラグインは、クリーナーレコーディングのための戦

いで、感動的な武器であります。せき、椅子のスリ音、携帯電話でさえ、全て視認させます。 

 

Nova™ Plug-In は、周波数領域における音声データが簡単に素早く変更します。これらの変更は時間を

越えて、選択された領域の補間を含んでいます。そして / または、ゲイン変更と同様に周波数ラインも含

んでいます。また、挿入は選択された領域の中のゲインレンジに制限される場合があります。データのあ

る部分のみに処理が必要な場合は、(例えば、特定の和声の1つなど) 大変有用です。そうでなければ、選択

できません。すべての画面解像度との最適な互換に、Nova™ウィンドウは完全にリサイズ可能です。 



Arkamys 

UpMix5 

Overview 

 

UpMix 5 は 5.1マルチチャネルアウトプットにステレオソースをアップミックスする Pyramix Virtual 

Studio のためのプラグインです。ステレオシグナルの FFT 分析から、UpMix 5 はすべての 5.1 のコンポ

ーネントを区別します。UpMix 5 は、5.1 サラウンドの制作に、どんなリバ－ブ、キ－コンプレッション

も使用しません。このプラグインは、Broad Cast とPost Production アプリケーションのために、どん

なステレオ素材でも使用できるように設計されております。: 映画または音楽。 

 

UpMix 5 はオリジナルのステレオシグナルからモノラル、ステレオ、および'フェーズアウト'コンポーネ

ントを区別します。モノラルコンポーネントはセンタースピーカ (C) で再生されます。 

フェーズアウトかコンポーネントは後部スピーカ(LsRs)でプレーされます。ユーザは、最終的な前部 LR 

の幅、サラウンド LsRs シグナルの幅を選択できます。 

 

Vincent Burel 
 

Aphro V1 Reverb / Aphro V1.5 Reverb 

 

Aphro-V1.0 / Aphro V1.5 はリアルタイム Digital Effects Processors です。 

現実的な方法で、Aphro-Vx, Aphro-V1 と V1.5 と呼ばれる最高品質エフェクトプロセッサ－の要素は、

格調高いアトモスフィア－とル－ムエフェクトのシュミレ－トを特別に作るものです。取り扱い哲学を簡

単にします。そして実用的な非常に多くのプリセットに感謝します。そのプリセットは、お望みのエフェ

クトにマッチするプリセットをユ－ザ－に選択させます。その後、要求に従って、それにアジャストする

異なったインタ－フェ－スを使います。テーマによりパラメータを分類は、モジュールの、そして、人間

工学的なユーザインタフェースの制作という考えを、私たちに与えました。 

 

C-Limiter 

Stereo Manager 
Striptool 
Compresso5rs 

C10 Limiter 

EQ Pro-pack 

Tone-X 

Chorus 

GEQ 



MultiTap Delay 

VU-Meter + Cor 
Frequencies Analyzer 

Stereo Oscilloscope 

Mono-Switcher 

 

Cedar Audio Restoration Suite for Pyramix 
 

Cedar’s レストアツールの種類は、ここで序論を全く必要としません。以下のプロセスは Pyramix で利用

可能です。: 

 

Cedar dehiss for Pyramix 

Cedar declick for Pyramix 

Cedar manual declick for Pyramix 

Cedar decrackle for Pyramix 

Cedar dethump for Pyramix 

Cedar Retouch for Pyramix 

 

Prosoniq 
 

MPEX3 Timestretch and pitch change 
 

Overview 

 

ドイツをベースにしております会社 Prosoniq は、Pyramix のための、MPEX3 アルゴリズムを開発いた

しました。それらの高品質のディジタルオーディオアルゴリズムは、大変よく知られております。 

MPEX は、Minimum Perceived Loss Time Compression / Expansion の見解の元に、制作されたもの

です。この技術を Pyramix Virtual Studio に組み入れるならば、抜群の結果と使いやすさで、既存の素材

のタイミングとピッチの調整を可能にします。 

 

Algorithm 

 

Time Scalingはピッチを変えないで音か音の長さを変えるプロセスです。('Time Stretching', 'Time 

Compression / Expansion'と'Time Correction' としても、よく知られております。) 

音が異なったスピードで再生されてトランスポ－ズされたとき、例えば、テープレコーダの再生スピード

を減速させます。異なったテンポでプレイバックしますが、ピッチでもそうなるでしょう。 



ドラムループをレコ－ディングスピ－ドにあわせるとき、これはすばらしいかもしれませんが、ボ－カル

のような音程のあるサウンドは、完全に調子外れに聞こえるでしょう。したがって、デュレ－ションとピ

ッチ、双方、個別の変更を可能にするプロセスの提供は、望ましいことです。 

 

Time Stretch and Pitch Change for Film Applications 
 

Cinema タイムストレッチングとピッチチェンジリクワイアメントの 3 つのメインカテゴリがあります。: 

 

1) それらの関連ビデオかフィルムが加速、または減速しなければならないとき、オーディオの変換 

は 24～25 か 25～24 までラッシュします。主な理由は以下の通りです。 

 

a.   フィルム AND ビデオはシューティングをしたので、ラッシュの一部か他は、加速、または減速 

        させられなければなりません 。 
 

b.    編集のためにフィルムラッシュをビデオに送るテレシネプロセスは、元のスピードを、故意にま 

    たは間違って保持しませんでした。 

 

c.    シューティングは、ビデオで 25fps (故意にまたは間違って)で、撮影しに行かなければなりませ 

 ん。 

 

Pyramix はこの問題の様々な解決法を提供します。: 

 

Batch conversion 

 

全体のメディアフォルダーの一括変換。ただ、ストレッチ/スクイ－ズ/ピッチチェンジで、すべてのメデ

ィアを選択してください。そして、次のメニューを選択してください。Quick Convert > Prosoniq 

MPEX3 モジュ－ル。すべてのメディアはワンショットで処理されるでしょう。 

メディアは、参照から"Clap"を使用することによって、それらのビデオ同等物と時間軸上で再同期しなけ

ればならないでしょう。 

すべてのメディアが時間軸上で既にそれらのビデオ同等物に連動するケースで(マニュアルか、レコードし

ている間、正確にスタンプされているので)、PyramixプロジェクトでそれらのオリジナルのTimeCode 

(タイムスタンプ)にシンプルにこれらのすべてのメディアを送ってください。そして、メニュ－アイテム、

Project > Stretch / Pitch を選択してください。適切にすべてのメディアをストレッチ/スクイ－ズされ

るでしょう。そして、また、正しくそれらの位置を正しくアップデートするでしょう。そして、メディア

に新しいオリジナルのTimeCode (タイムスタンプ)の書き返すことができます。これには、次のメニュ－

アイテムを選択してください。Clips > Operations > Update Media Original TC 今、まさにこれら



のニューメディアを使用できるように、まるでそれらが新しいスピ－ドでレコード、スタンプされていく

ならば、自動でそれに従わせるか、他のTimeCode ベ－スのプロセスであることを示しています。Timeline 

のこれらのメディアに参照をつけながらクリップに保存された全情報は、(フェードのように、シンクポイ

ント、ゲインカーブ…)適切に伸ばされるか、または縮められます。オプションで、必要な部分だけを変換

するために、メディアを統合できます。 

異なったソ－ス素材のスピードのミックスが "normalized" される場合は、上で説明した  2 つのプロセス

が、必要です。全体の編集とミックスがもう片方(オリジナルラッシュ)スピ－ドに合わせて、ストレッチ

して戻されなければならないケースでは、始めからよく知られていることです。Merging はハ－ドディス

クの空きスペ－スの部分で、大変便利な解決策を提供しています。それは、変換時間と最終的にサウンド

クオリティ－においてです。 

Virtual Transport Video Player はオーディオ素材の釣り合いより、異なったスピードでビデオの編集の

プレイを考慮に入れています。(個々の例とケースの大多数)たとえば、あるビデオは 24 フレームパ－セコ

ンドで走り、それとともに走るオーディオ編集は 25 フレームパ－セコンドです。これは、オーディオの圧

縮を避けます。それによって、あまりに速く再生されるビデオとの釣り合いがとれます。(24 fps の代わ

りに 25fps )しかし、望ましくは、正しいスピード(24fps )にしたがって、オーディオとビデオを動かして

ください。 

 

Surround Post-processing 

 

フィルム配給の 24 から 25、 DVD/Video へのファィナルミックス変換または、ビデオショットと編集さ

れた映画配給のための、25 から 24 への変換。 

 

Pyramix は全体のサラウンドミックスをストレッチ、またはスクイ－ズします。それにはこのメニュ－を

選択してください。Project > Surround Post-processing そして、Prosoniq MPEX3 24/25 Time 

Stretcher module を選んでください。 

 

本機能は、新しい Prosoniq MPEX3 アルゴリズムの恩敬により、相互チャンネルフェーズ成果物なしで、

全体の 5.1ミックスをストレッチ、またはスクイ－ズします。本機能はステムによる、マルチステムサラ

ウンドミックスのプロセッシングを可能にします。現在まで、ほとんどの時間、ストレッチのアルゴリズ

ムにより、生成されたものに起因して、通常の処理は、個々に、タイムストレッチ、リミックスの後で、

ダイアログステムと音楽/エフェクト/アンビアンスステムは、切り離されるべきです。 

 

Surround ポスト-プロセッシング機能はこの方法論を認めていますが、MPEX3 モジュールの超高品位の

ため、もう、それは必要ではありません。したがって、最大の音響品質を保有しながら、1 個のパスで完全

なミックスをストレッチすることができます。 

 



Time fit 
 

与えられた時間にフィットする、オ－ディオのコンプレッション、またはエクスパンジョンは、一般にダ

イアログ、ADR、翻訳またはフォーリーです。 

Pyramix はオーディオのリージョンをストレッチ/スクィ－ズの 3 つの方法を提供します。: 

 

•    プロセスのためのリージョンまたは、クリップを選択して、拡張されるリージョン境界に最も近

い位置にカーソルを置いてください。そして、Edit > Stretch を選択してください。 

そして、ダイアログは、境界が TimeCode エントリの助けを借りて正確に調整されるのを示します。 

OK をクリックまたは、オペレ－ションの実行のため、Enter キ－を押してください。 

 

•    あなたが処理したいリージョンかクリップを選択してください、そして、それをコピーしてく

ださい。 ( Edit > Copy, または Ctrl C など ) 

 

あなたが、コピーされたリージョンに収まって欲しいリージョンを選択してください。そして、このコマ

ンドを使用してください。Edit > Fit Selection 

 

•    処理にためのリ－ジョンか、クリップを選択してください。 

Project > Render メニュ－を選んで、Prosoniq MPEX3 モジュ－ルを選択してください。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Prosoniq MPEX3 dialog 



総合的インタフェースは、その後タイムストレッチパラメータを正確に調整します。 

また、タイムストレッチングに加えて、このインタフェースは、Pitch と Formant の調整が可能になりま

す。 

 

Quick Convert 
 

また、Quick Convert 機能は Prosonique MPEX3 のプロセスにアクセスできます。 

( Media Management Tab Window, Menu Convert > Quick Convert > Prosonique MPEX3 

 

PureNotes 
 

Broadband noise removal 
 

Scopein 
 

TimeZone Time Compression 

 

 

 

VST / DirectX support 

 

Direct X Plug-ins 
 

DirectX プラグインは Mixer Input ストリップと FX Rack にも使用されるかもしれません。どうぞご覧く

ださい。: Effects Rack ぺ－ジ 

 

VST Plug-ins 
 

VST Scanner 
 

Pyramix で VSTプラグインをロ－ドするには、まず Pyramix にその場所を指定しなければいけません。 

Start > Programs > Pyramix > VST Scanner に進んでください。Cubase か、または何か標準のVST

プログラムがありましたら、VSTプログラムが、左のウィンドウに現れます。 

Pyramix の中で使用する 1 つを選択してください。(Waves、VSTとTC Powercore を含んでいます。) 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

VST - Scanner Window 

 

何も左のウィンドウに何も現れないなら、ディスクの上のどこかに、VSTプラグインファイル(それら

は.dll ファイルタイプである。)を含むフォルダーを必要とします。 

 

VST Plug-Ins Chooser ウィンドウで Change ボタンを押してください。ディスクをブラウズして、VST 

プラグインを含むフォルダーを選択します。すぐに Pyramix で表示されて、認識されるでしょう。 

 

以下に 注意 してください。: The VSTプラグイン、Direct-X プラグインなどは、ホストCPU の

力で処理されます。したがって、あなたが VSTかDX プラグインを集中して使用するつもりであるな

ら、速い Host プロセッサがお勧めです。 

 

VST Scanner は合法ツ－ルです。開発者(VB Audio)のウェブサイトに取扱説明書と最新版があります。: 

 

http://perso.wanadoo.fr/vb-audio/fr/resources/vst_scanner/vst_scanner.htm 

 

 

 

 

 

http://perso.wanadoo.fr/vb-audio/fr/resources/vst_scanner/vst_scanner.htm


VST Plug-Ins Information 
 

Mixer 右クリックコンテキストメニューはポップアップ VST Plug-Ins Information WindowT にオプ

ションがあります。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

VST - Plug-Ins Information Window 

 

このウィンドウは現在マシンにあるすべてのエフェクトを示しています。中には、Effect Name, メーカ

ー/開発者 Company Name, Category Name と Security Status  があります。 

すなわち、プラグインが認証されていると言うことです。 

External Effects 

どのような Pyramix Bus も、どのような物理的アウトプットへ送ることができます。したがって、外部

のエフェクトへの物理的アウトプットを Aux で送ることができます。外部のエフェクトのアウトプットは

物理的インプットの 1 つを通して単純に、Pyramix に返されます。しかしながら、外部のプロセッサとコ

ンバータでディレイを生じるでしょう。リターンが、他のシグナルと時間をそろえる必要があるなら、ど

うぞ見てください。: Mixer Delay Compensation 182 ぺ－ジ 
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Strip and Bus Tools 

 

Strip and Bus Tools 

 

Eq, Comp/Limiter/Expander 
 

ストリップとBus Tools はハードウェアコンソールの上で一般的にチャンネルとバスに作られた

Equalization と Dynamics (圧縮と引き伸し)機能を加える迅速で効率的な方法です。Strip と BusTools 

は DSP 利用処理能力で特に経済的です。各処理ブロックは個別の'回路'に切り換えられるかもしれません。 

ブロックは、内部の'回路'でありませんので、DSP のリソースを使用しません。 

 

Difference between Strip Tools and Bus Tools 
 

Strip と Bus Tools の間は、たった 1 つの違いしかありません。Bus Tools には Look-ahead と Delay 

Compensation を持った上品な Limiter  があり、Strip Tools のその場所には、Compressor  がありま

す。 

 

バスの Input Strip か Compressor でリミッタ－が必要な場合は、両方が Strips か Busses で自由に使用

されるかもしれません。 

 

Modules 
 

Strip と Bus Toolsプラグインはいくつかの Sections、もしくはモジュールから成ります。 

各 Section は section への On/Off スイッチを含み、先頭にタイトルバーを持っています。 

もう 1 つ、ショウ、ハイドの三角のスイッチを持っています。 

 

Display Options 
 

1つの大きいウィンドウで Bus Toolsプラグインのマルチ用例を表示します。 

プラグインのウィンドウタイトルバーを右クリックして、Strip Tools プラグインのために、いくつかの一

般的なディスプレイオプションを提供するメニューを開いてください。: 



 

 

 

 

 

 

 

 

 

 

 

 

Strip Tools - General Display Options 

このメニューで、あなたは、直接プラグインウィンドウで表示されたストリップの数を選択するか、数を

増/減させてください。Strip Tools の割り当て数によって、最大数は異なるでしょう。 

 

Linking Strip-Tools controls 
 

Strip Tools コントロ－ルのどんな選択も結びつけることができます。また、あなたがコントロ－ルのどれ

かを移働させるとき、それはリンクグル－プのメンバですが、グループの他のすべてのメンバも、移働し

ます。直線/ロ－タリ－コントロ－ルのための 48 のリンクグル－プと、スイッチのための 48 のリンクグ

ル－プがあります。コントロ－ルをリンクグル－プに追加するには、ノブの上を右クリックしてください。

または、Link Status と Automation Status ポップアップウィンドウのディスプレイボタンを右クリッ

クしてください。例えば、インプットゲインコントロ－ルのためのポップアップは以下の通りです。: 

 

 

 

 

 

 

 

 

 

 

 

Strip Tools - Link and Automation Status 



Group assignment mode buttons   
 

これらの 4 個のボタンがコントロールのリンクモードを定義します。4 つの選択が利用可能です。:  

 

None        コントロールはどんなグループのメンバでもありません。 

 

Group        コントロールは選択されたグループのメンバです。 

                                                                                                                      あなたがこのコントロールか、このグループのメンバのいかなる他のコント 

                                                                                                                    ロールを移動させるとき(または、切り替え)、グループのすべてのメンバが 

                                                                                                                    それと共に移動するでしょう。(切り替わります)。 

 

Exclusive        このモードはスイッチにのみ利用可能です。 

                                                                                                                      このスイッチがオンであるときに選択されたこのモードで、グループの他の 

                                                                                                                      すべてのメンバがスイッチオフになるでしょう。 

 

Group Exclusive    これは、Group Exclusive に設定 されるすべてのグループに優れたエフ 

                                                                                                   ェクトを持っているモードです。 

                                                                                                    Group Exclusive に設定されるグループのどれかがつけられるとき、 

                                                                                                    Group Exclusive に設定された他のすべてのグループが、スイッチオフに 

                                                                                                    なるでしょう。 

                                                                                                    分類されたコントロ－ルはコントロ－ル'ブロック'のコーナに、イエロー L 

                                                   によって示されます。 

 

 

 

 

 

 

Strip Tools - Grouped Controls 

 

Factor X Slider   連続した(ロ－タリ－、または直線) コントロ－ルだけの作業。 

                                                                                                                     それはグループの他のメンバと関連してこのコントロ－ルの適合を決定しま 

                                                                                                                      す。そして、逆もまた同様です。すなわち、ストリップツール #1 のインプ 

                                                                                                                     ットゲインとストリップツール #2 のインプットゲインが1つを分類するた 

                                                                                                                      めにともに割り当てられると仮定してください。ストリップツール #2 のゲ 

                                                                                                                     インのスケールファクタは 2 に設定されます。あなたがストリップツール #1 



                                                                                                                     のゲインを1 dB 変えるとき、すぐに、ストリップツール #2 のゲインは 2 

                                                                                                                       dB’s 変わるでしょう。 

 

Invert        連続したコントロ－ルのみに働きます。それは、このコントロールのため 

                                                                                                                     に、別のグループメンバによるエフェクトを逆にするか、逆もまた同様で 

                                                                                                                     す。例えば、ストリップツール #1 のインプットゲインとストリップツー 

                                                                                                                     ル #2 のインプットゲインを 1つのグル－プにするために、ともに割り当て 

                                                                                                                    られると仮定してください。ストリップツール #2 のゲインの逆にするボタ 

                                                                                                                     ンはオンです。今、ストリップツール #1のゲインを1 dB上げた場合、スト 

                                                                                                                    リップツール #2 は1 dB 減少するでしよう。 

 

Automation mode switches 
 

どうぞご覧ください。: Automation Modes 266 ぺ－ジ 

 

オートメーションモードの説明が、切り替わります。 

 

グル－プにされたコントロールをクリックしたとき、それらの周りに、黄色いボックスの中に、グループ

の他のすべてのメンバ－が示されます。 

 

Offset 
 

グルーピングがされているとき、コントロールがオフセットであるなら、それらはここに示されているよ

うに実行され続けられます。 

 

 

 

 

 

 

 

Strip Tools - Grouped Knobs 

 

ストリップの先頭の赤いバーは、その選択を示します。灰色のノブは、右クリックされたものです。 

 

 



Sections     上から下まで、Strip Tools は以下のセクションを含みます。: 
 

Input Level     
 

               このセクションは、インプットレベルコントロールを含んでいて、プラ

グインのこの例に割り当てられるミキサーストリップの名前を示してい

ます。 

 

Dynamics 
 

このセクションはコンプレッサーがあります。 

 

ここに示されているように、デコンプレッサーとして機能するように、

切り換えることができます。 

 

Expander 
 

これはダウンワ－ズエキスパンダです。アップワ－ズエキスパンダとし

ても切り換えることができます。 

 

Equalizer 
 

ファイブバンドのパラメトリックイコライザ－です。 

各々はハイパス、ロウパスで切り替わります。シェルビング、ピ－キン

グの特性を持っています。 

 

Output 
 

このセクションは、ストリップツールの出力レベルをコントロールし、

また、コンプレッサーのために自動でゲインの調整を致します。 

 

 

 

 

 

 



Common Features 
 

Strip と Bus Tools の各セクション、または、モジュールの多くのコントロールが共通です。 

 

Title Bar 

 

Section の機能のテキスト説明、例えば、Input, Dynamic なども、また、含んでいます。: 

 

Show/Hide triangle 

 

セクションを示すか、または隠すとき、あらゆるセクションの左上では、灰色の三角形は順番に切り変わ

ります。Shift を押しながら三角形をクリックすると、Section (もし、隠されるなら)が開いて、他のす

べてのセクションが隠れます。Ctrl を押してセクションをクリックしますと、全ての Section が開きます。 

 

以下に 注意 してください。: Sections は隠れていても、生きています。 

 

Section On/Off Button 

 

Show/Hide の三角形ボタンと Section Title の間は、Section のための On/Off ボタンです。 

 

Knobs 

 

デフォルトバリュ－にコントロールがあるとき、ポジションインジケ－タ－ドットはオレンジに点灯しま

す。白い星形は'タッチされた'最後のコントロールのスケールの左上に現れます。 

 

Input Section 
 

 

 

 

 

 

 

Color Bar 

 

選択されたストリップを示します。 



Strip Name 

 

プラグインがアサインされたストリップの名前を表示します。ストリップネ－ムの上をダブルクリックで

プラグインの名前を変えることができます。次に、名前をタイプして、Return キ－を押してください。 

このようにしてプラグインネ－ムを変えるなら、元のミキサーストリップネ－ムのその後の変化は、プラ

グインストリップネ－ムへ影響しません。元のストリップのネ－ムを回復するには、シンプルにストリッ

プ名を取り除いてください。 

 

ストリップネ－ムはプリセットと Pyramixプロジェクトの中に保存されます。 

 

Activate/deactivate plug-in 

 

このボタンは、オンかオフで全体の Strip プラグインを切り換えます。 

プラグインがオフになれば、全ったくDSP パワーを消費しないことに注意してください。 

 

Show/Hide input section 
 

Input section on/off 
 

Input level control 
 

インプットレベルを  -48 dB から +48 dB の範囲で調整します。 

 

Show/hide Routing 

 

デフォルトでは、Routing 設定ボタンは隠されています。このボタンはショウ、ハイドで Routing  設定 

Button を切り換えます。Routing は隠れていても、生きています。 

 

Routing Buttons 

 

ストリップを貫く、どのオーディオストリームが、プラグインで処理されるか決定してください。ボタン

の数はストリップによってコントロールされたステムの数に依存します。現在の、これは、モノラルイン

プットチャネルのための 1 つか、ステレオインプットチャネルのための 2 つを意味しますが、7.1インプッ

トチャネルでは、8 になります。選択されていない編成は、触れない状態でおかれるでしょう。 

 

 



Dynamics Section 
 

 

 

 

 

 

 

 

 

 

 

Show/Hide Dynamics section 
 

Dynamics Section On/Off 
 

Gain reduction display 

 

バーグラフは、Dynamics Section かExpander によって作り出されたゲインの増/減を示しています。 

バーグラフをクリックすることによって、ディスプレイの範囲を +-10 か20 dB で切り換えることができ

ます。バーグラフの右側の上の1dB 刻みの目盛の数字で、その範囲が 10 か 20 dB であるかどうか、簡単

にわかります。 

 

カラーは、コンプレッサーかエキスパンダのどちらかによって作り出されるゲインの増減を示するのに使

用されます。: 

 

•   上から下の Red は Compressor によるゲインリダクションを表示します。 

 

•   下から上の Pink は De-Compressor によるゲインの増加を表示します。 

 

•   下から上の Green は Expander (ノ－マル、逆さ)によるゲインリダクションを表示します。上か 

                                 ら下の Green はコンプレッサ－逆さのモードで、エキスパンダ－のゲインリダクションを表示し 

                                  ます。 

 

 

 



Threshold Level Control 
 

コンプレッサーが働き始めるレベルを設定します。 

インプットシグナルレベルが Threshold Level を超えているなら、ゲインはレイシォコントロ－ル設定

に比例して減少します(または、De-Compressor モードでは、増加します)。 

 

Ratio Control 
 

スレッシュホ－ルドレベルより高いシグナルのために、ゲインリダクションの割合(増加)を決定します。 

例えば、Compressor モードでは、率は 2.00:1 に設定されます。インプットレベルの上昇が、スレッシ

ュホ－ルドレベルより 2dBs 上回っていれば、アウトプットレベルは 1 dB だけ上がるでしょう。 

 

Attack Time Control 
 

インプットレベルが Threshold Level を超えているとき、コンプレッサーの反応をコントロールします。 

アタック・タイムが低ければ低いほど、反応は、より速くなります。 

 

Release and Hold Time controls 
 

これら 2 つのパラメータが同時に作動します。そして、コンプレッサーがスレッシュホ－ルドレベルより

上にインプットレベルがあるとき、反応するための時間の総量をコントロールして、落ち始めます。 

時間を保持している間、コンプレッサーのゲインは一定のままで残っています。 

保持された時間の後に、レイトセットでリリースタイムのコンプレッサーのゲインを変えます。 

リリースタイムが短ければ短いほど、反応は、より速くなります。 

De-Compress Switch 
 

コンプレッサーとディコンプレッサーを切り換えます。 

 
Compressor and De-Compressor action 



コンプレッサーモードで、インプットレベルがスレッシュホ－ルドレベルを超えているとき、レイシォコ

ントロ－ルの設定に従って、ゲインは減少します。 

ディコンプレッサーモードで、インプットレベルがスレッシュホ－ルドレベルを超えているとき、レイシ

ォコントロ－ルの設定に従って、ゲインは増強されます。 

 

Expander Section 
 
 
 
 
 

Show/hide Expander section 
Dynamics section on/off 
Threshold Level Control 
 

インプットシグナルレベルがスレッシュホ－ルドレベルの下まで下がるなら、レイシォコントロ－ルの設

定に従って、エキスパンダのゲインは減少します(または、逆さのモードでは、増加させます)。 

 

Ratio control 
 

スレッシュホ－ルドレベルより下のシグナルのために、ゲインの減少割合(増強)を決定します。 

例えば、ノ－マルモードでは、率は 2.00:1 に設定されます。インプットレベルの上昇が、スレッシュホ－

ルドレベルより 1 dB 減少すれば、アウトプットレベルは 2 dB 下がるでしょう。 

Inverse switch 

 

ノ－マルと逆さエクスパンダ－モ－ドを切り替えます。 

Expander normal mode                 Inverse mode 

 

 

 

 

 

 

 

 

Expander normal and Inverse mode action 



Attack/Release/Hold controls 

 

Expander Section は Dynamics Section の中で、タイミングのコントロールのために、

Attack/Release/Hold コントロールの設定を使用します。 

 

Equalizer section 
 

ファイブバンドのフルパラメトリックイコライザです。各バンドは 20 Hz から 20 kHz までの全体の周波

数領域をカバーします。(また、より高い領域では、プロジェクトのサンプルレイトによります。) 

ピ－キング、ハイ、ロウのシェルビングそして、ロウパス、ハイパスの特徴の間で切り換えることができ

ます。個々はオフにできます。死んでいるバンドは DSP パワーを消費しません。 

 

 

 

 

 

 

 

 

 

 

 

Show/ Hide EQ Section 

 

EQ section on/off 
 

Pre Dynamics Switch 

 

このスイッチはダイナミックセクションの前の EQ スイッチのオプションを提供します。 

デフォルトで、ダイナミックセクションの後に、EQ があります。 

 

Graphic Display Window 

 

この小さいウィンドウは青いカラーで現在選択された EQ バンドの設定を表示します。そして、グレイで、

全体の EQ セクションの結果として起こるカーブを表示します。あなたは、直接ハンドルにクリックして、

ドラッギングできます。(小さい青か、グレイポイント。) そのハンドルは、グラフウィンドウの中で EQ 



バンドの設定を変えます。ウィンドウでどこでもよいですから、ダブルクリックして、より大きいバージ

ョンを開いてください。どうぞご覧ください。The Big Graph Window 256 ページ 

 

Band Selector 

 

これらの 5 個のボタンの 1つをクリックして、Gain, Frequency と Q コントロールの下より操作されるバ

ンドを選択してください。また、それが小さいまたは、大きいグラフウィンドウで操作される場合、バン

ドは選択されます。 

 

Selected band characteristics 

 

これらの  5 個のボタンが選択された EQ バンドの特性を決定します。 

左からの選択は、High-Pass Filter, Low Shelving, Peak, High Shelving と Low-Pass Filter です。 

 

Selected Band On/Off 
 

選択された EQ バンドのオン、オフを切り換えます。 

デフォルトで、5 つのバンドがスイッチオフの場合、DSPパワーは経済的になります。 

ですから、あなたは、どうなったか聞く前に EQ バンドのスイッチを入れるのを忘れないでください。 

 

Gain Control 
 

-24 dB から +24 dB のブースト、カット。 

 

Frequency Control 
 

個々のバンドレンジは、そのプロジェクトのサンプリングレトによります。 

 

•  48 kHz までのサンプルレイトでは、それぞれのバンドの周波数レンジは、20 Hz から20 kHzです。 

 

•  96 kHz までのサンプルレイトでは、それぞれのバンドの周波数レンジは、20 Hz から 40 kHzです。 

 

•  384 kHz までのサンプルレイトでは、(すなわち、DSD mixing )それぞれのバンドの周波数レンジ 

  は、20 Hz から 80 kHz です。 

 

 



Q (bandwidth) Control 
 

Q パラメータの範囲は 0.2 から100 です。Q of 0.2 では大変広いバンドワイズです。Q of 100 ではもの

すごく狭いノッチになります。 

 

Output Section 
 

 

 

 

 

 

Show/ Hide Output section 

 

Output section on/off 
 

Output Level control 
 

アウトプットレベルを -48 dB から +48 dB の範囲で調整します。 

 

Automatic Gain Make Up switch 

 

灯されたとき、設定に従って、アウトプットゲインは、Dynamics Section で自動的に適合させられま

す。 

この場合、Output Level Control は灰色にされてアクセス不可能になるでしょう。 

 

The Big Graph Window 
 

EQ Section の中の小さいグラフウィンドウをダブルクリックするとき、大きいグラフウィンドウは開き

ます。 

 

青線で表示された、EQ バンドの現在の設定を表示します。 

その結果、EQ カーブは、グレーで覆われて表示されます。 

バンドのハンドルをマウスでクリック、ドラッグによって、それぞれの 5 つのバンドの Frequency とGain

パラメータを変更できます。選択されないバンドハンドルは、小さい、グレ－の四角になって表示されま

す。掴みとドラッグによりバンドを選択します。 



 

 

 

 

 

 

 

 

 

 

 

 

 

Big Graph floating Window 

 

周波数レスポンスディスプレイは 2 つの別々のゲインスケールを使用します。左手、青いスケールは、各々

のバンドに使用された、スケールを示しています。右手の、グレ－のスケールは総合的な EQ カーブのス

ケールを示しています。それらが供給されるカーブの設定に従って、両方のスケールは自動的にそれらの

レンジを適合させます。左のレンジと右のスケールは異なるでしよう。 

個々のバンドのためのレンジは +/- 6 dB, +/- 12 dB または、+/- 24 dB が可能ですが、総合的なカーブの

スケールは +/- 72 dB に上げられるかもしれません。 

 

Big Graph Window の上側の領域は On/Off のスイッチを提供します。 

特性を選択して、示すボタンです。(High-Pass, Low Shelf, Peak, High Shelf or Low-Pass ) 

これらのために、選択された EQ バンドは、Gain, Frequency、および Bandwidth の数値ディスプレイ

と共に組になります。 

 

Frequency and Bandwidth setting. 
 

Shortcuts 

•  ハンドルの上をダブルクリックして、このバンドのゲインを統一にリセットしてください。 

 

•  Tab キーは EQ バンドを切り換えます。 

 

•  右マウスボタンでハンドルをクリックして、ドラッグすると、このバンドのQ(バンド幅)は、変更さ 

                       れます。 



•  ゲインパラメータをロックして、周波数を変えるために、Ctrl キーを押さえたままマウス左ボタン 

                      でドラッギングしてください。 

 

•  周波数パラメータをロックして、ゲインを変えるために、Shift キーを押さえたまま、マウス左ボ 

                      タンでドラッギングしてください。 

 

 

 

 

 

 

 

Bus Tools 

 

Bus Tools は、Strip Tools と非常に似ておりますが、チャンネルよりむしろバスに挿入されるように明

確に設計されています。Bus Tools は最も頻繁に使用された'マスタリング'プロセスブロックを結合しま

す。高度なリミタ－を含むただ 1 つのプラグインで、ミキシングコンソ－ルのアウトプットバスを見つけ

ます。Strip Tools のように、1 つの大きいウィンドウで Bus Tools プラグインの、複数の使用例を表示し

ます。表示された使用例はユーザが選択可能です。 

 

IMPORTANT! Pre-Anticipation (PA) and Delay Compensation (DC) 
 

遅延補正は、事前に予測されたディレイセッティング決定しているディレイタイムを、プロセッシングの

ために選択され なかった Bus Tools プラグインを通り抜けるオール・チャンネルに追加します。 

 

PA & DC がオンな状態で、2 つ以上の Bus Tools に挿入されるなら、それぞれの Bus Tools のディレイ

タイムは全てのチャンネルのために一緒に加えるでしょう。: 

 

Sections 
 

Input, EQ,および Output セクションは、Strip Tools で見つけられたものとほとんど同じです。 

Strip Tools セクションで、余すところのない解説に関連するパラグラフを見てください。 

ちがいは、ここで処理されるということです。 

Shortcuts, Linking、および Automation 機能は、Strip Tools と同じです。 

上から下まで、Bus Tools プラグインは以下のセクションを含んでいます。: 



 

Input Level 
 

このセクションは、インプットレベルコントロールを含んでいて、プラグ

インがこの使用例に割り当てられるミキサーストリップの名前を示してい

ます。 

 

Limiter 
 

このセクションはリミタ－を含んでいますが、それまた、下のLimiter DRC 

セクションに関連して動作できます。(リミタ－は標準のリミタ－としても

作動します)。 

 

Limiter DRC 
 

このセクションは Dynamic Release Compensation (DRC)をLimiter

セクションに加えます。 

これはリミタ－のリリースタイムの究極の音楽的コントロールを可能にし

ます。 

 

Equalizer 
 

ファイブバンドのフルパラメトリックイコライザ－です。各々のバンドは、

ハイまたはロウパス、特性のシェルビングまたはピ－キングの切り替えが

できます。 

 

Output 
 

このセクションは、Bus Tool のアウトプットレベルをコントロールまた、 

 Limiter  のために自動でゲインメイクします。 

 

 

 

 

Main and Input Level Section 
 



 

 

 

 

 

 

 

 

Strip Name 

 

Activate/Deactivate Plug-in 

 

Show/Hide input Section 

 

Input Section On/Off 
 

Input level control 
 

インプットレベルを -48 dB から +48 dB の範囲で調整します。 

 

Show/hide Routing 

 

デフォルトでは、Routing  設定ボタンは隠れています。ボタンは、Showing と  Hiding で切り替わります。 

隠れていても、生きています。 

 

Routing Button Matrix 

 

ボタンは、Bus を貫くどの可聴チャンネルが、プラグインで処理されるかを決定します。 

見えるボタンの数は Bus によってコントロールされるチャネル数によります。 

複数のサラウンド Bus のケースでは、最大 64 になることも、あろうかと思われます。 

Bus Tools の 1 つの使用例は、このマトリクスから選ばれた最大 8 個のチャンネルを処理できます。 

 

5.1サラウンドバスには、6 個のボタンがあるでしょう。ボタンによって選ばれたチャンネルの順番は (左

から右)こうなります。: Left, Center, Right, Left Surround, Right Surround, Subwoofer. 

 

これは、例えばサラウンド Bus のLeft, Center および Right チャンネルが、サラウンドチャンネルから独



自に処理されるのを可能にします。それは、2 つの Bus Tools プラグインを最初に Bus とセレクティング

L, C, Rへ、そして LS と RS へと加えられることによります。 

 

Using Bus Tools on multiple surround busses 

 

Bus Tools の 1 つの用例は、8 チャンネルを処理できますが、リンクされたパラメータで、ずっと多くの

処理に複数の使用例を使用するのは、簡単です。 

例えば、4 つサラウンドBusses に、3 つの使用例を使用できました。 

それぞれの Bus のL & Rチャンネルを Bus Tools Aへ、それぞれの Bus の Centers をBus Tools B へ、

そして、それぞれの Bus のSurround Ls および、Rs を Bus Tools C へアサインしてください。 

3 つ Bus Tools は、望むように右クリックによってリンクされ、黄色いマトリクスで、コントロールグル

ープを制作することができます。 

Delay Compensation (以下を見る)が活性化された場合、Pre-Anticipation を使用するときでさえ、 

オール・チャンネルは時間によって並べられたままで残るでしょう。 

 

Delay Compensation 
 

Delay Compensation 

 

DRC セクションがアクティブのときに、プラグインは小さいディレイをオーディオシグナルに紹介します。 

ルーティングボタンを使用することで、プロセッシングのためにバスのいくつかのシグナルは選択されな

いかもしれません。これらのシグナルは遅れないでしょう。そしてバスのアウトプットには時間の位置ず

れが現れます。Delay Compensation がオンであれば、プロセッシングのために選択されているか否かに

関係なく、同じディレイはすべてのシグナルに適用されます。 

これはバスのすべてのシグナルのために正しい時間配列をもたらします。 

 

Limiter section 
 

これはシンプルなスレッシュホールドとRelease パラメータがある簡単な'brick-wall'リミターです。 

しかしながら、次のセクションで説明させていただくDRC (Dynamic Release Compensation ) 機能は、

リリースタイムの究極の音楽的コントロールを示すために活性化できます。 

ブリックウォ－ルリミターは、アウトプットレベルがスレッシュホ－ルドレベルを決して超えないことを

保証するリミターです。ノ－マルなリミターでは、非常に速いアタックがある高レベルのシグナルは、ア

ウトプットがスレッシュホ－ルドレベルより高くなることもありますが、ブリックウォ－ルリミターでは、

起こりません。保証いたします。 

 



 

 

 

 

 

Show/Hide Limiter section 

 

Limiter section on/off 
 

Gain reduction display 

 

バーグラフは、Limiter Section によって作り出されたゲインリダクションを示しています。 

バーグラフをクリックすることによって、ディスプレイの範囲を 6 か 12 dB で切り換えることができます。 

スケ－ルは、バーグラフの右手に 1dB 刻みで作られでおります。 

範囲が 6  か 12 dB であれば、すぐにわかります。 

 

Threshold control 
 

インプットシグナルレベルがスレッシュホ－ルドレベルより上昇するなら、リミターのゲインは減少しま

す。このリミターは、いかなる時もアウトプットシグナルレベルがスレッシュホールドを超えません。保

証いたします。 

 

Release control 
 

このパラメータはリミターがリリースに始める時間をコントロールします。 

すなわち、インプットレベルがスレッシュホ－ルドレベルより高い場合、ゲインをさげます。(ゲインリダ

クション) そして、落ち始めます。ホ－ルドタイムの間、コンプレッサーのゲインは一定のままで残って

います。リリースタイムが速ければ速いほど、反応は、より速くなります。 

 

Limiter DRC Section 
 

DRC は Dynamic Release Compensation です。 

 

要するに、これは、プロセッサを通して送られたシグナルのダイナミックな自然状態によって、リミター

のリリースタイムが変更されることを意味します。 

 



 

 

 

 

 

 

 

 

 

 

Show/hide DRC section 

 

DRC section on/off 
 

Release Acceleration or Modification Display 

 

インプットシグナルのダイナミックスの変化と、リリースタイムのバリエ－ションとの関係を、イラスト

のカーブに示しています。直線とパワ－機能特性の間でカーブを適合させることができます。 

(Curve Control パラメタの説明書を見てください。) また、再生中のディスプレイは、小さい赤色玉が

カーブに沿って動くのが見えます。これはアルゴリズムが動作している範囲を示しています。 

 

Gain reduction bargraph 
 

DRC 回路が生きている間､、リミターのゲインリダクションを表示します。スケールは 6 dB で固定され

ています。 

 

                           Dynamics bargraph 
 

インプットシグナルのダイナミックスを表示します。それは、は DRC アルゴリズムの礎となります。 

 

                            Velocity control 
 

DRC アルゴリズムのスピ－ドを決めます。 

値が低ければ低いほど、アルゴリズムは、より速くシグナルのダイナミックスの変化に反応します。そし

て、また、リリースタイムがさらに残り続けるダイナミックスに反応します。 

 



Offset control 
 

このパラメータは基本的に最小のリリースタイムを設定します。 

この意味で、リミターのリリースコントロールは最大のリリースタイムを定義します。それで、DRC アル

ゴリズムによって決定しているリリースタイムは、これら 2 つのタイムの間で異なるでしょう。 

 

Curve control 
 

このパラメータは、シグナルのダイナミックスと結果として起こるリリースタイムとの関係の特性をコン

トロールします。 

 

                          Pre-Anticipation (Lookahead delay) control 
 

このパラメータは、RMS 検出のための統合時間を変えて、その結果、DRC 回路のエフェクトを変えます。 

また、ここでのディレイ設定は、Delay Compensation がスイッチを 入 れられるとき、プラグインを通

り抜けるシグナルに適用されるディレイが、プロセッシングのために 選択されている ことを決定しま

す。 

 

以下に 注意 してください。: Bus Tools プラグインを通る全てのシグナルをこのパラメータはデ 

ィレイさせます。それで、プラグインがミックスバス以外の場所で使用されるとき、フェーズか他の 

タイミングエラ－が起こるかもしれません。 

 

EQ and Output Sections 
 

これらは、Strip Tools バージョンと同じです。 

 

Limiter がこの場合、ブリックウォ－ルデザインであるのでそれに注意する必要があります。 

Automatic Gain Make-up 機能は、Limiter のThreshold Control によりセットされた値と同量の補正

を行います。この決果、シグナルは、近接したものになりますが、0dBfs を決して超えません。 

Gain Make-up が Off なら、Output Level Control は'シーリング'コントロールとして機能するでし

ょう。その決果の絶対レベルの設定は、シグナルを出力します。 

 

 

 

 

 



Delay Compensation / Pre-Anticipation 
 

Example 
 

 

 

 

 

 

 

 

 

 

 

 

 

このテーブルの中では、Bus Tools 使用例 1 は、ミックスのLeftとRight チャンネルのための IN 回路です。 

Bus Tools 使用例 2 は、Left SurroundとRight Surround チャンネルのための IN 回路です。 

CenterとSub-Woofer Channels のための両 Bus Toolsは、回路の OUT です。 

しかし、Pre-AnticipationとDelay Compensation は、選ばれたチャンネルのプロセッシングのために 

スイッチを入れられます。 
適切に時間整合を確実にするために、オール・チャンネルは同じ総量で自動的にディレイされます。 

(8.71と5.8と図で表しているのは、任意です)。 

 

オール・チャンネルが Pre-Anticipation にリンクされてプロセッシングのために選ばれるなら、Delay 

Compensation を生かす必要は全くありません。 
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Automation 

 

Pyramix Virtual Studio は非常に強力なオートメーションシステムを装備しています。 

ダイナミックとレベル、パン、エフェクトなどのスナップショット・オートメーション、両方を含んでい

ます。 

Automation Modes 
 

4 つのダイナミックオートメーションモードの 1 つにミキサーのあらゆるコントロールを設定できます。 

オートメーションモードは、個々のコントロールを設定できます。チャンネルストリップ用、バス用、コ

ントロールのグループ用か、または、全体のミキサー用です。 

現モードは不在、存在、および小さいインディケータのカラーによって示されます。 

 

 

 

 

 

 

 

Dynamic automation mode indicators 

Isolate 
 

黒い三角形インディケータ。 

 

コントロールは、既に記録されたどんなオートメーション作業からも、切り離されます。 

それまでに記録したオートメーションデータにまったく影響なしで、コントロールは動かせます。 

 

Play 
 

緑 の三角形インディケータ。 

 

コントロールは、それらのために最後の記録されているオートメーションデータに従うか、または既存の



データが存在しないデフォルトのポジションを維持します。 

 

Record 
 

赤 い三角形インディケータ。 

 

Play の転送、および Write モードによる Master Automation Controls と共に、Record モードでは、

現在のすべてのコントロールの状態を、オートメーションデータとしてレコードします。 

 

Auto-Write 
 

インディケータは、ありません。(全てのコントロールのデフォルトです)。 

Play の転送、および Play か Write モードによる Master Automation Controls と共に、コントロール

は以前に記録しているオートメーションデータを再生します。 

コントロールが新しく動かされたとき、コントロールがリリースされるまで、オートメーションデータは

書かれます。コントロールがリリースされる行動、または転送が止められたとき、Automation メニュー

の選択で管理されます。  Automation > Automation Settings 

 

Automation Settings 

選択してください。All Settings > Application > Automation. 

( Automation > Automation Settingsは、Automation ぺ－ジでも同じです)。 

 

 

 

 

 

 

 

 

 

 

 

 

 

Automation Settings page 



Optimizations 

 

オートメーションを使用するとき、システムパフォーマンスをエンハンスするためのオプションの選択を

提供します。 

Keep only current version while saving をチェックすれば、システムはすべてのオートメーション

トラックの最新版をセーブするだけです。これは、セーブされたオートメーションバージョン履歴を失い

ますが、プロジェクトのためのオートメーションのセーブ時間を劇的に短くします。 

 

Limit versions to the number of Undo/Redo をチェックしたとき、システムは、メモリ－の限界バ

－ジョン数を保持するだけです。 

(Settings > All Settings >General Page で定義された Undo/Redos の数と同じです)。 

これは、履歴に保たれたオートメーションバージョンの数を減少させますが、パフォーマンスをエンハン

スします。 

 

Auto-Release Options 

 

Auto Release が有効にされると、どんなコントロールもそうするでしょう。 

リリースされるか、または転送が止められたとき、Refresh Rate は、前のオートメーションパスの値か、

または、状態へもどされるか、前のパスが全く存在しないデフォルトへもどされます。 

コントロールに 2 つの状態しかないなら、これはすぐに、起こります。(例えば、ボタン)または、コント

ロールがフェーダかノブであるなら、一定の時間の後で起こります。 

その時限はミリセコンドで、Release Time ボックスに入れられた値で決定します。 

 

Refresh Rate の設定はオートメーションなデータがレコードされたレイトを決定します。 

デフォルトでは、リフレッシュレイトは実時間のコードフレームレイト、例えば、25 fpsフレームレイト

における 40ミリセコンドと同じです。 

 

リフレッシュレイトの可能な範囲は10～100ミリセコンドです。注意してください。あなたの設定は全体

のフレームに繋がれます。したがって、有効なリフレッシュレイトは実際のフレームレイトの1倍か2倍か3

倍のどれかになるでしょう。 

リフレッシュレイトのために、より遅い設定を選ぶ 1 つの理由は、複雑なミックスの場合にオートメーシ

ョン作業についての計算に必要である処理能力を節約するだろうことからです。 

 

Automation Menu options 
 

どうぞ、ご覧ください。: Automation 266 ぺ－ジ 



Selecting Automation Modes 

 

Entire Mixer 
 

ミキサーパネルの空白のエリアを右クリックすることによって、ミキサー全体を同じモードに設定できま

す。(例えば、バスストリップの下)。それから、ポップアップメニュ－からモ－ドを選択してください。 

Mixer > Automation > Isolate 

 

 

 

 

 

 

 

Mixer context menu Mixer Automation sub-menu 

 

Block, Strip, Bus or Entire Mixer 
 

例えば、ここ、フェーダエリアに示されているようにミキサーチャンネルストリップのファンクションブ

ロックで右クリックすると、コンテックスメニューをポップアップします。 

Automation の選択は、4 つのオートメーションモードの選択を提供し、サブメニューも開きます。: 

 

 

 

 

 

 

 

 

 

 

Automation sub-menu 

 

また、このコンテックスメニューは、ストリップ全体のオートメーションモード、1台以上のバスまたは、

ミキサー全体の Strip, Bus または Mixer を選ぶことによっての設定を可能にします。 



これらの選択の 1 つは、サブメニューを開きます。最後の選択はその都度 Automation です。 

これを選択すると、更なるサブメニュー、4 つのオートメーションモードの選択を提供し、開きます。: 

 

 

 

 

 

 

 

 

Strip Automation sub-menu 

Master Automation Controls 

 

Master Automation Controls は、ツ－ルパレットにあって、デフォルトでは、メイン Pyramix ウィ

ンドウの右下にロケ－トされています。Off, Play および Write ボタンがあります。そして、もう 2 つ、

Snapshot オートメーションのカメラアイコンのボタンがあります。: 

 

 

 

Master Automation Controls dockable toolbar 

 

Off ボタンが押されるとき、どのような既存のオートメーションデータも再生されません。そして、コン

トロールが動かされても、新しいデータは全くレコードされません。 

 

Play ボタンが押されるとき、緑色 を'点灯'します。 

Play に設定されたコントロール、または Auto-Write が既存のオートメーションデータを再生します。 

さもなければ、デフォルト値を維持します。コントロールを Isolate にセットするか、または Record し

ます。しかしながら、現在の値をレコードしますが、どんな新データもレコードされません。 

 

Record ボタンが押されるとき、赤 を'点灯'します。 

Record に設定されたコントロールは、現在の値をレコードします。 

それらが動かされたときだけ、Auto-Write に設定されたコントロールは、レコードします。 

コントロールは存在するオートメーションデータ(もしあれば) の再生  Play にセットします。 

Isolate に設定されたコントロールは、それらの現在の値を維持します。 

 



 Snapshot ボタンは現在のカーソル位置にあるすべてのコントロールの状態を、レコー 

   ドするオートメーションイベント(キ－フレーム)を挿入します。 

 

    Snapshot Range button は Mark In とMark Out  カーソル位置で、すべてのコン 

   トロールのオートメーションスナップショットキーフレームを挿入します。実上、現在 

    の状態、マークによって定義された範囲中のすべてのコントロールを設定します。 

 

Display and Editing of Automation Data 

 

Timeline のどんなトラックのどんなコントロールも、レコードされたオートメーションデータを、見なが

ら、編集できます。 

Track Header の、    Show/Hide Automation ボタンをクリックすると、リプレイされて、レッ

ド・ラインで書き込まれているときに、黒い線のオートメーションデータを表示、または隠します。 

Show/Hide Automation ボタンを右クリックすると、トラックのためのオートメーションなメニューを

ポップアップします。 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

Track Automation context menu and sub-menus 

 

‘Mixer’     現在のパラメータの表示は、メニューの先頭にあります。 

 

Init       マウスでの編集のために初期設定のオートメーショントラックを制作します。初期設 

                                                                                  定のバージョンはミキシングコンソール・コントロールの現在の状態で制作されます。 



Snapshot    現在表示されたコントロールカーブのスナップショットを制作します。 

 

Snapshot Region  現在のリージョンでコントロールカーブのスナップショットを制作します。 

 

Delete Points  現在のリージョンのコントロールカーブから、すべてのオートメーションポイントを 

                                                                                  削除します。                                

Trim      以下を見てください。 

 

Auto Display 

 

Connected Strip サブメニューで表示する、選択されたミキサーのオートメーションデータコントロー 

                                                                                 ルを可能にします。 

                                                                                 この挿絵では、StripToolsプラグインのバンド2 Eq のゲインを表示しています。 

 

Mixer      Connected Stripと同じ方法で機能しますが、現在のミキサーの、どんなオートメ 

                                                                                  ーションデータコントロールのディスプレイでも可能にします。 

 

Auto Display  Auto Display がチェックされれば、表示されたオートメーションデータは、状態を 

                                                                                  変更したトラックに接続された最後のコントロールから来ます。 

 

注意されたし。コントロールが使用している Mixer の表示のために Auto Display が選択されたとき、そ

してトラックに接続されたストリップのコントロールが動かされると、使用中の Mixer のコントロールの

表示はなくなるでしょう。オートメーションデータは保有されます。この理由で、どんなコントロールも

接続ストリップに表示されないときは、通常、Auto Display はオフであります。 

 

Trim 
オートメーション Trim が求められているとき、ダイアログボックスは、現在のオートメーションポイン

トの値を、選択されたレンジで整えることを可能にします。: 

 

 

 

 

 

 

Trim Automation dialog 

Trim ボックスの数値の前で、シンプルにタイプするだけで、または、dB の数値をタイプするだけで、値



を増減できます。Fade ボックスは、ミリセコンドで値が入れられます。これは首尾で自動的に適用され

るフェードの長さを定義します。これは、オリジナルの値から値へ選択された長さです。 

 

注意をお願いいたします。: dB はレベルの変化をもたらします。オートメーションカーブが周波数を表示

していると、値はHz で示されるでしよう。 

 

Show Automation Track Versions 
 

Automation Tracks Versions ウィンドウを開いてください。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Automation Tracks Window 

Automated Controls 
 

Automated Controls パネルはツリー構造になっており、すべてのオートメーションコントロールを表

示します。書かれた最後のコントロールが、自動的に選択されます。 

Automation Tracks Versions パネルはツリー構造になっており、、すべてのオートメーションパスが

選択されたコントロールに適用するのを示しています。バージョンをダブルクリックすれば、それは現在

のものとなります。旧バージョンは、現在のものにされ、さらにオートメーションパスが書かれるならば、

結果として枝分かれが生じます。7 を超えた例では、パスは作られて、次に、バージョン 7 は、それをダ

ブルクリックすることによって、リコールされます。さらなる 2 つのパスは、7.1.1 のラベルになり、7.1.2 

のパスは、いつ書かれたかに反映された回数です。 

 



Label Current Version   選択されたコントロールかブランチのために最新版のコピーを制作します。 

                                                                                                                                バージョンツリ－に表示する名前をコピーに与えて、それ、または、それ 

                                                                                                                                らを仕舞い込んでください。与えられたものを呼び出すのは簡単です。全 

                                                                                                                                 体のミキシングコンソ－ルのオートメーションバ－ジョンの識別も、簡単 

                                                                                                                                です。警告ダイアログは、選択されたアイテムが、Mixer 以外の何かの場 

                                                                                                                                 合には、表示されます。 

 

Lock Current Version   Unlock Current Version 

 

Delete Current Version   選択したバージョンを削除します。その後のパスは必要に応じてリナンバ 

                                                                                                                                されます。 

Unlock All Versions 

 

Clean Up Versions    最新のもの以外すべてのバージョンを削除します。 

 

Clean Up All Tracks    すべてのトラックの、現在のもの以外のバージョンを削除します。 

 

Delete All Tracks      すべてのトラックの、すべてのオートメーション情報を削除します。 

 

Locked Versions 
 

Locked versions will be preserved when: 
 

•   Clean Up Versions ボタンをクリックします。 

 

•   Clean Up All Tracks ボタンをクリックします。 

 

•   Automation Settings で「現在のバージョンをセ－ブしている間、そして、ロックしたバージョ 

                                  ンだけをキ－プしてください」のオプションで、セ－ブします。 

 

•   「Undo/Redo の数への Limit バージョン」のオプションは、Automation Settings で可能になり 

                                 ます。 

 

Locked versions will NOT be preserved when: 
 

•   Delete Current Version バージョンボタンをクリックします。 



•   Delete All Versions ボタンをクリックします。 

 

•   Delete All Tracks ボタンをクリックします。 

 

Masters Controls Synchronization 
 

Auto-Ripple モードで編集するとき、コンボボックスは Track(s)かTrack Groups が Mixing コンソール

のすべての Master コントロールに影響する選択を示します。Markers や CD/SACD Markers  のように、

すべての Masters コントロールがどちらかであるかもしれません。: 

 

•   自立。(どんなトラックでも、どんな操作でも、それらに影響しないでしょう)。 

 

•   Any Track にもリンクされます。(同期を必要とするどんな編集動作も、Masters コントロールに 

                                 影響します)。 

 

•   Group なしで Any Track にもリンクされます。 

 

•   Track Group A, B, C, etc…にリンクされます。 

 

View Several Parameters 
 

トラックの 1 つ以上のオートメーションなパラメータを見るために、あなたが見たい各パラメータの

Virtual tracks を制作してください。 

是非、こちらを、ご覧になられてください。Virtual Tracks 16 ぺ－ジ 

 

Undo/Redo 
 

メニューアイテム Edit > Undo/Redo は、Automation Tracks  Window にショートカットを提供する

Automation 操作に反応します。 

 

Editing Automation data 

 

直接マウスでオートメーションデータを編集できます。マウスがオートメーションカ－ブの上の置かれた

とき、カーソルは手に変化します。オートメーションカ－ブのノードの上にマウスがいるときには、ポイ

ントの値とタイムスタンプを表示します。 



 

 

 

 

 

 

 

 

 

Dragging an automation node 

 

ノードとドラッギングをクリックすることによって、値を調整できます。 

あなたがオートメーションカーブの何処かでクリックすると、新しいノードは挿入されるでしょう。 

 

Alt キーを押したまま、オートメーションなカーブをドラッグすれば、マウスポインタは鉛筆に変わるでし

ょう。そして、カーブをフリーハンドで描くことができます。 

 

 

 

 

 

 

 

 

 

Drawing an automation curve 

 

Ctrl キーを押したままにすれば、選択されたリージョンのすべてのポイントが一緒にドラッグされます。 

例えば、セクションのオフセット。 

Ctrl + Alt が押されたまま、ポイントをクリックすると、それは消えてしまいます。 

 

すべての上記が垂直な選択にかかわらず、Shift key が放されるまで、エンベロ－プノードをクリックされ

たままのすべての Clips に供給されます。 

そして、変化はクリックされたクリップのカーブだけに適用されるでしょう。 

リージョンを選択するとき、Ctrl が放されれば、Pyramix は、オートメーションノードを先在させながら、

後方に、前方に最も近く選択を拡張します。 



Automation in editing and libraries 
 

データ(プロジェクトの間でさえ)をコピーするのに、Automation メニューの Cut/Copy/Paste 機能を使

用できます。ただリージョンを選択してください。そして、Automation > Copy Selected Points を

選択して、どのリストをコピーしたらよいかを選んでください。 

それから、別のプロジェクトに進んでください。(または、同じ)。そして、Automation > Paste Points 

to Cursor または、Paste Points to Original TC を選択してください。 

 

次のメニューアイテムを可能にするなら、Edit > Enable Automation Cut/Copy/Paste 

それから、クリップ上のどんな編集オペレーションも、すべてに関連したオートメーションデータに適用

されます。(cut/copy/paste, Auto-Ripple, etc…) 

クリップ(s)をライブラリーにドラッグするなら、そのクリップ上のすべてのオートメーションもまた、コ

ピー、ぺ－ストされます。 

 

Auto-Write And Release Modes 

 

Auto-Write とRelease Modes は、Automation > Auto-Write Mode and Automation > Release 

Mode の Globally にセットされます。触れられるか、リリースされた、あらゆるコントロールが、これら

のモードに従うでしょう。キーボード変更は、この行動を変更します。 

 

When Touching a Specific Control: 
 

Ctrl :          Write & Release Mode を強制させます。 

 

Ctrl + Alt :       Write & Hold Mode を強制させます。 

 

Ctrl + Shift :      Update & Release Mode を強制させます。 

 

Ctrl + Shift + Alt :    Update & Hold Mode を強制させます。 

 

より一般的には、Alt は現在の Write か Update Mode を強制します。 

 

Ctrl :          Snap Mode を強制させます。 

 



Shift :         Auto-Release Mode を強制させます。 

 

Control + Shift :    Write to Next Mode を強制させます。 

 

いつ、これらの組合せに加えたか、Alt は現在の Write か Update Modeのために Hold Mode を強制し

ます。 

Merging OASIS などの External Remote Controllers、または、他のものでは、Global Auto-Writeと

特定のハードウェアの有用性に依存する Release Modes を変更するために、異なったモディファ－を提

供するでしょう。(専用ボタン、既存のボタンの組合せ、特別な運動など)。 

 

Mixer and Plug-in Snapshots 

 

以下に注意してください。: ここで説明する Mixer Snapshots は、ダイナミックオート

メーションメカニズムを使用します。 

 

Mixer Snapshots 
 

ミキサー表面の全体の状態のスナップショットは、簡単に、そして高速にセーブして、リコールされるで

しよう。 

 

Saving Mixer Snapshots 

 

Mixerスナップショットをセーブするために、Alt とShift を押さえてください。 

次に、Mixer の表面どこでもClick、そして、ユ－ザ－ライブラリ－にドラッグしてください。 

Mixer Snapshot タイプの新しいアイテムは、ライブラリーに現れるでしょう。スナップショットはデフ

ォルトで Mixer Snapshot と命名されます。受け入れには、ただ Enter を打ってください。さもなけれ

ば、適当な名前をタイプしてください。そして、次に、Return を打ってください。 

 

Recalling Mixer Snapshots 

 

シンプルに、ミキサースナップショットをリコールするために、ライブラリーでそれをクリックしてくだ

さい。そして、ミキサーの表面とリリースの上でそれをドラッグしてください。 

すべてのパラメータがスナップショットで保存された値に、リセットされるでしょう。 

 

以下に注意してください。: Mixer Snapshot は、すべての Plug-in Parameters を含んで



います。 

 

Effects Snapshots 
 

エフェクト設定はライブラリーから、ライブラリーへ、保存、リコールは容易にできます。 

 

Creating Effects Snapshots 

 

Alt + Shift を保ってください。それから Plug-in ウィンドウから設定を保存したいライブラリーへ、クリ

ックとドラッグしてください。その後放します。Mixer Snapshot のタイプはライブラリーへ保存されて

います。デフォルトでは、プラグインの名前をスナップショットに与えます。 

ニュ－アイテムは自動的に強調表示されます。そう、デフォルト名の変更がお望みでしたら、シンプルに、

新しい名前をタイプしてください。そして、念のために Enter を打ってください。 

次にライブラリーの名前をクリックすることによって、スナップショットの名前を変えることができます。

新しい名前をその時入力してください。 
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Project Processes 

 

Dither 

 

ミキシング、ゲインの変更、イ－キュ－または、リバ－ブのようなディジタルオーディオシグナルがの変

更されるときはいつも、結果としてビット数の増加です。 

デリバリと相互接続規格の要求に合うように、これらの付加されたビットを取り除かなければなりません。 

ビットの深さは、単純に付加されたビット無視するすることによって(切捨て) 減少させられるか、最小の

ビットの上げ下げで丸めることでさえ、結果として起こるエラーは低シグナルレベルでさえ、聞きとれる

ほどのひずみを起こします。 

明らかに、分解能の永久的な損失を起こします。これらのエフェクトは累積しています。すなわち、シグ

ナルが繰り返して処理されるなら、そしてビットがより短い語長に減じられるなら、これは、重大であり、

僅かではあるが確実な可聴損失、そして低いレベルのサウンドとなるでしょう。 

人間の耳というものは、イメージの中で低いレベル情報を聞き分けようとするものです。 

この問題を避けるために何もしないと、音空間と清澄さに悪影響を与えるでしょう。 

 

したがって、Pyramix では、すべてのプロセッシングが 32 bit 浮動小数点で行われます。 

シグナルがこの環境の中に保たれるなら、アウトプットの最終段階までビットデプス減少の必要は全くあ

りません。切り抓め、丸めこみは望ましくないのですが、一定の低レベルを維持している間、ただ一つの'

ディザリング'ステージはビットデプスを減少させることができます。 

これは、コントロ－ルされた量の低レベルノイズをシグナルに加えることによって、成し遂げられます。 

 

ただで食える昼食なんてものは、この世の中には有りません。 

商いは、ノイズのわずかに増強されたレベルです。しかしながら、気づかれないようにノイズは'形成'さ

れます。 

 

こちらもまた、ご覧になられてください。: Dithering Options 188 ぺ－ジ 

 

ディザリングは、たった一度だけ、供給されます。重要なことです。 

 

 



Mixing Down Projects 

 

Exporting a Composition to a File 
 

一度、あなたは、Composition を編集し終えたとしましょう。完全な(完パケ)Composition か、いず

れの選択されたエリアもオーディオファイル(または、ファイル)にエクスポートすることができます。 

これは、オーディオアウトプットの代わりにファイルへ、Composition をミックスダウンするのと本当

に同じです。 

 

1.  Project > Mix Down を選んでください。Mix Down ダイアログボックスが開きます。 

 

2.  Target Settings セクションで、適切なファイルネ－ムを Record Name の下に書き込んでくだ 

          さい。; 

Media Folder コンボ ボックスから、そのファイルを保存するフォルダーを選んでください。 

                         (以前にマウントされたフォルダーだけがオプションとして利用可能になる)。; 

Resolution コンボボックスからビットデプス/ワ－ドレングスを選んでください。; 

                           One file per track box ファイルのチェックを外したままにして、シングルマルチトラックオー 

 ディオファイルを作ってください。または、それをクリックして、各 Track のために別々のオーデ 

 ィオファイルを作り出して、Format ポップアップリストから適切なエクスポートファイルタイプ 

 を選んでください。Suffix with Bus Name オプションは以下のようにファイルネ－ムを制作す 

 るでしょう。: 

 

Terminator_Final-M&E-Stem1-L.wav 

 

Terminator_Final-M&E-Stem1-C.wav 

 

Terminator_Final-M&E-Stem1-R.wav 

 

以下に 注意 してください。: Recording と Render において、これらの設定は完全に

独立しています。 

 

3.  Record セクションでは、export the Whole composition を選んでください。または、Between 

                             Marks がある In とOut Markers の間のエリア、または以前にこさえた Region with Selection 

                             のラジオボタンをクリックでもいいです。 

 



4.  エクスポートされたファイルのソースとして適切なアウトプットバスを選んでください。あなたの 

               Mixer で構成されたすべてのアウトプットバスが、Mix Source リストボックスで利用可能になる 

                            でしょう。 

5.  Mix Down ボタンをクリックしてください。プロセスがを開始されます。 

 

Archiving Projects 

メニュウ : Project > Archive 本機能はプロジェクトと使用済みメディアすべてを1 つの位置にコピーい

たします。すべてのメディアがオプションで、合同整理できます。そして、参照ライブラリーもまた、格

納保管できます。 

Consolidating Projects 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

                                                                                               

Consolidate dialog 



Consolidating a Composition は、Media ファイルによって使用される格納保管の空間を減少させるメソ

ッドです。また、別のマシンか他の記憶媒体にそれを移すための、Composition のすべての要素を集める

メソッドです。Consolidate 機能は、Compositionで、使用済みのメディアの、選択的バックアップをし

ます。その代わりに、あらゆるメディアファイル全体のバックアップは、コンポジションのクリップによ

って参照されます。Consolidate は、クリップセグメントによって参照されるメディアファイルのそれら

の部分だけバックアップします。 

 

Target Settings 
 

Radio Buttons は統合整理された Composition のために位置の選択を提供します。 

 

Use Original Files Media Folder 
 

Consolidated Composition はオリジナルファイルと同じ位置にセ－ブされるでしょう。 

 

Use Current Project Media Folder 
 

Consolidated Composition は、現在のProject Media と同じ位置にセ－ブされるでしょう。 

 

Use Custom Media Folder 
 

Consolidated Composition はユーザの選択された位置にセ－ブされるでしょう。 

 

Options 
 

Handles 

 

Consolidated Composition の更なる限定的な編集を考慮するために、フェードデュレ－ションの変更な

どを行います。付加的な素材(存在しているなら)、Composition EDL によって限定された部分を超えて、

あらゆるクリップの各エンドを維持できます。セコンドで値を入れてください。 

 

Format 
 

このドロップダウンリストは、Consolidated Composition がオリジナルと同じフォーマットでセ－ブさ

れるのを可能にします。または、どんなサポートされたフォーマットにも変換できます。 

 



Generate Waveform 

チェックされると、ウエ－ブフォ－ムファイルは、Consolidated Compositionと共に生成され、保存さ

れるでしょう。 

 

Use clip names to generate media 

 

チェックされると、オリジナルのクリップネ－ムは新たなメディアに使用されます。 

 

Don’t optimize media for overlapping clips 

 

Advanced Options 
 

Skip generation if original media already exists on target drive 

 

チェックされると、新しいメディアは、バージョンがターゲットドライブの、既に存在するところへは、

書かれないでしょう。 

 

Delete original media (Use with care!) 
 

チェックされると、統合整理が完成した後に、統合整理が削除されることによって、オリジナルメディア

ファイルは、参照されます。 N.B. Destructive! 

 

Converting Projects 

 

Changing Project Length / Pitch 
 

Projects 全体の Processes です 。 

Time Compression または、Pitch Reduction of 4% (24fps to 25fps)または、Time Expansion または、

Pitch Rise of 4.17% (25fps to 24fps) を提供します。 

 

Given an Origin Referenceとa Ratio これにより、プロジェクトのすべてのクリップは、引き伸ばさ

れて/縮められて、そしてストレッチレイシォや、オリジナル参照に従って移動させられます。 

オプションですが、クリップによって必要とされたオーディオの部分だけを処理するためにすべてのメデ

ィアを統合整理できます。本機能はこのメニューを通しても利用可能です。Project / Stretch そして、使

用を許可するキーを入力するべき Prosoniq MPEX2 です。 



Reconforming a Project 

全体のプロジェクトを処理します。既存のプロジェクトが Autoconforming 素材によって CMX EDL に制

作されたところで使用されるためです。 

 

Surround Post-Processing Projects 

Surround Source Stem は、すべての Surround バスより可能なステムのリストから選択できます。 

利用可能なプロセッシングプラグインは以下にございます。: 

 

•  Multiple File Export 

 

•  Minnetonka AC3 (Dolby Digital) Encoder (別々に購入してください)。 

 

•  MPEX3 Cinema 24fps to 25fps or 25fps to 24fps Multi-channel Time Stretcher by Prosoniq 

                      (オプション)です。 

Rendering Projects 

Renderingプラグインの一つの選択を提供しています Project > Render メニューの中で、Render 機能 

は利用可能です。 

 

 

 

 

 

 

 

 

 

 

 

 

 

Render dialog 

Rendering Process  現在使用を許可された Rendering Processes を示して、あなたが必要である 

                                                                                                               ものを選択するところであります。 



Extra Handles 

 

Before とafter のボックスは、詳細な検討のためのプロセス(適用できる部分に)によって使用済みにされ

た素材の中に含まれるべき(可能なところに) 余分な素材の記入すべき時間の値を与えます。 

 

以下に注意してください。: Render メニューで加えられたハンドルは、処理されることに

なっていません。それらは単にデータの与えられた部分の前または後に詳細な検討が必要

とされるプロセスに何らかの付加的な素材を与えるのために使用されています。 

 

Handles will NEVER be processed by any Render plug-ins. 

ハンドルはどのようなレンダ－プラグインでも、決して処理 されない でしょう。 

 
Target Settings      出力ファイルに影響します。 

 

Render Name       どんな合法的なファイル名も入れられるテキスト入力ボックスです。 

 

Media Folder       ドロップダウンリストは、マウントされた Drives /フォルダーが出力フ

ァイルのためのデスティネイションとして選定されるのを示します。 

                                                                                                                                      より多くのオプションか、新しいフォルダーが必要であるなら、隣接し 

                                                                                                                                      ている…ボタンはブラウザウィンドウを開いてください。 

 

Resolution         アウトプットファイルのための、有効なビットデプスの、すべての選択 

                                                                                                                                       があるドロップダウンリストです。 

 

One file per track      チェックされると、マルチトラックソースは別々のファイルとしてレン 

                                                                                                                                      ダリングされるでしょう。  

 

Unique filename extension チェックすると、出力ファイルにユニークな拡張子を保証します。 

 

Format          ドロップダウンリストはアウトプットフォ－マットの選択があります。 

 

Settings          オプションが選ばれたフォーマットが利用可能であるなら、このボタン 

                                                                                                                                       はそれらにアクセスします。 

                                                                                                                                       どんなオプションも利用不可の場合は、ボタンは灰色になります。 

 

Waveform         ドロップダウンリストはWaveform 生成オプションを提供します。 



None, Generate AFTER recordingまたは、Generate WHILE recording 

 

以下に 注意 してください。: Recording と Mixdown の設定とは、これらの設定は完全

に独立しています。 

 

Source        Whole composition,Between Marks, Selection または、Selection  

(Split by Groups) の間にソースの専門的な選択を互いに提供します。 

 

Selection (Split by Groups) はそれぞれの選択された Clip Group のためにタイムライン上でマルチレ

ンダリングの中に、レンダリングプロセスを分割します。 

この場合、Render Name テキストエディット・ボックスは、無視されて、すべてのレンダ－は、それぞ

れのグル－プの最初のクリップネ－ムを時間内に得ます。 

 

Process Plug-ins 

 

Effects Rack 
 

そして、最大 8 VST の連鎖が可能です。または、レンダリングプロセスとして、Direct X プラグインは使

用されます。 

 

Glitch 
 

Glitches と Pops を探します。 

 

Levelizer 
 

オプションのラウドネス分析と修正プラグイン。 

 

Nova 
 

Algorithmix によるオプションの修復一式のプラグイン。 

 

Pencil 
 

波形を加筆するためのものです。 



Prosoniq MPEX3 
 

Formant プラグインがあるオプションの Multi-channel Time Stretch / Pitch Scalingです。 

 

Cleaning Up Project media 

 

使用していない全ての Media ファイルを消し去ります。または、現在のProject により参照されます。 

N.B. このオペレーションはリバーシブルではありません。UNDO! は有りません。 

 

 

Project Notes 
 

Notes タブをクリックして、テキスト事項をプロジェクトに追加してください。テキストをエディタにタ

イプ、切って、または貼ってください。ドロップダウンリストボックスはフォントとサイズの選択があり

ます。テキストは太字、イタリック体、アンダーライン、着色できます。桁よせは、左、センターまたは

右で、できます。 

 

 

 

 

 

 

 

 

 

Notes Editor 

 

ここに入れられた事項は、プロジェクトと共に保存されます。入力された事項を見直すことができます。 

テキストをハイライト、Ctrl + C でコピーすることにより他のアプリケーションに編集、コピーができま

す。 
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CD/SACD Mastering 

 

Mastering a Composition to CD-R 

 

Pyramix は CD-R Mastering の CD Track Start, Stop, および Index Markers をセットするのに使用

されます。DiscWrite と呼ばれる別々のアプリケ－ションは、CD-R を焼、または、DDP の制作を現実

に提供されます。 

このワ－ク法の利点の1つは、複数の'virtual discs'が存在可能であるということです。 

これにより、同じ素材を使用することでいくつかの種種のバリエーションの制作が簡単になります。 

 

CD Markers 
 

CD Markers は他の User Flags かMarkers に似ています。 

 

CD Start Marker (CDトラックの始まりを示す)を設定するために適切な CD トラック Start 位置に Play 

Head を置いてください。 

そして、Cursors & Marks > Add CD Start Marker to Cursor; を選んでください。 

同様に、CD Stop Marker (CDトラックの結末を示す)を設定するために、適切な CD トラック End 位

置に、Play Head を置いてください。 

そして、Cursors & Marks > Add CD Stop Marker to Cursor を選んでください。 

命名された CD Index Marker は、Cursors & Marks > Add CD Index Marker to Cursor を使用す

ることで加えることもできます。 

これらの CD Markers は、検査でき、CD/SACD Tab ウィンドウで命名、変えることができます。 

 

Add CD Markers Automatically 
 

自動的に CD トラック Start Markers とStop Markers を Composition の Grouped Clips に加えること

ができます。これを達成するために、最初に CD/SACD Tab ウィンドウで CD を制作してください。そ

して、それを選択してください。CD トラックに対応する Clips の適切な Group を作ってください。 

CD / SACD Tab ウィンドウから、Cursors & Marks > CD Mark Group または、Cursor and Marks 



メインメニュ－から、CD Mark Groups ダイヤログを開きます。:. 

 

 

 

 

 

 

CD Mark Groups dialog 

 

唯一のオプションは、Remove existing CD Markers のチェックボックスです。 

OK をクリックすると、すべてのグル－プクリップのために自動的に CD マ－カ－をつくります。 

 

以下に注意してください。: Pyramix TimeLine のクリップ間のギャップが 1 秒未満であ

るなら、Start Markers は置かれるか、必要であります。 

(最後のクリップの後に、Stop Marker がいつもあるでしょう)。 

Stop Markers は CD を放送するとき、ピースの後に欲しくないかもしれないですが、賞

賛の拍手があるの部分で役に立つ場合があります。 

適切に備えられた CD Players は、Stop Marker を見つけたら止まるように設定できま 

す。 

 

CD/SACD Tab Window 

 

 

 

 

 

 

 

 

 

ＣＤ/SACD Tab window 

 

すべてのマスタリング機能が CD View で分類されます。; 2 つのセクションです。 

 

Left Pane では、3 つのウィンドウ Tabs です: 



Album, All Markers and Track Inspector 
 

Right パネルはトラックリストフィールドを示しています。(以下を見てください)。 

 

Album: 
 

左手のパネルは CD と SACD Albums そして、新しいディスクの扉である <New Disc> の Discs、これ

ら 3 つのツリー画面を示しています。 

右手パネルは、CD プロパティとデフォルトパラメータが選択されたディスクに設定されるのを示します。 

 

General Info 

 

•  Disc Title CD Title 

 

•  Label CD Production Label 

 

•  Date CD Date 

 

•  Customer Name 

 

•  Customer Contact Customer Contact (名前) 

 

•  Customer Phone Customer 連絡先電話 

 

 

•  Master ID Code CD 確認コード (一つが必要であるなら)。 

 

•  Ref Code CD Reference Code (一つが必要であるなら)。 

 

•  UPCEAN Code (Universal Product Code, aka EAN) CD Bar Code (13 digits) 

 

                                         このフィールドには、合法化業務があります。 

  それで、要求に応じて、あなたはバーコードに入ることができます。そして、それは自動的に 

   有効にされるでしょう。(exp. 123-123456789-1 gives 1231234567891) 

 

•  Catalog Number 



CD Disc Info 

 

(Global – CD Header) さらに、CD Track グリッドには各トラックのための同様のフィールドがありま

す。 

 

•  Title CD Title 

 

•  Performer CD General Performer 

 

•  SongWriter CD General Song Writer 

 

•  Composer CD General Composer 

 

•  Arranger CD General Arranger 

 

Markers/Tracks Relation 

 

•  Markers are linked to このフィ－ルドをクリックすると、選択の一つを表示します。 

                                         これらはMarkers Tab ウィンドウの選択と同じです: <Independent>, Any Track または、 

                  any Track without Group 

 

All Markers... 
 

すべての PQ マーカ－の編集を表示して、示します。ここで、PQ だけがオーディオ編集することなく変

更されます。CD Markers はエントリの右クリックによって標準の Marker  のように Cut / Copy / Paste 

することができます。 

CD Marker List は Disc (CD の場合)と Area(SACD の場合)にリンクされています。 

もう、CD Marker List  がTrack Group タブウィンドウか Global CD Marker List にありません。 

必要なら CD Marker List に Audio 内容を関連させるために Disc/Area の Marker List をTrack Group 

にリンクできます。 

 

Name 

 

PQ Marker のネ－ムです。マ－カ－がファンクション“CD Mark Group”で自動的に制作されるとき、ス

トップマ－カ－は、おしりにスタートマ－カ－と同じ名前 + Stop の接尾語が付きます。 

「*」は、このマ－カ－が自動で作られたことをあなたに知らせます。 



# (Number) 
 

Number of the PQ Marker (読むだけ)。ストップマ－カ－には、スタートマ－カ－と同じ数あります。 

インデックスマ－カ－は 2 の当時の Inc…で始まります。これ、Read オンリィのプロパティにすぎませ

ん。; それは他のものと関連してマ－カ－の位置によります。 

 

Type 

 

Type of the Marker. 

 

TimeCode 

 

Marker のTimeCode の位置。 

 

Offset 
 

Marker のオフセット。 

 

Use Offset 
 

Marker のオフセットの可、または不可。 

 

Track Inspector 
 

データが右手パネルで選択されたトラックに関係して、編集を示して、容認します。 

 

•  Name Track Name. 「*」は、このマ－カ－が自動で作られたことをあなたに知らせます。 

 

•  #(数) 

 

•  Pause 

 

•  Start 

 

•  End 

 



•  Length 

 

•  Start Offset 

 

•  Use Offset このフィ－ルドで Yes とNo をクリックして切り替えます。 

 

•  ISRC このフィ－ルドで ISRC コードの入力をクリックして示します。 

 

•  Copy このフィ－ルドで Yes とNo をクリックして切り替えます。 

 

•  Comment 

 

CD Text Info 
 

•  Title 

 

•  Performer 

 

•  Song Writer 

 

•  Composer 

 

•  Arranger 

 

これらのフィールドのどこかでクリックすれば、テキストの入力が可能になります。 

 

Right section 
 

右手パネルは、ビューを可能にする CD Tracks List と CD に関する内容を編集することです。;これは、

トラックによります。All modifications applied here automatically affect your edit 

例えば、トラックを変更するなら、4～6 秒止まってください。 

すべてのクリップ(選択されたトラックの最初のものから最後のトラックの最後のクリップまでの)マ－カ

－とオートメーションはポーズに 2 秒加えると右にリップルされるでしよう。 

すべてのオペレーションを元に戻すことができます。 

 

フィールドは以下の通りです。: 



Name 

 

CD Track のネ－ムです。 

 

# (Number) 
 

トラックのナンバ－です。Value をクリックして、すべての有効なトラックポジションナンバ－のあるド

ロップダウンリストを表示してください。そして、あなたはトラックのための新ロケ－ションを選択でき

ます。( 例えば、トラック 9 を 2 に送ってください。) 

 

Pause 

 

CD Track を停止します。:トラックの始まりと前のものの停止の間の時間。 

いつも最初のトラックのポーズは 0 です。(2 秒のポーズが RED Book 標準で必要とされていますので、

最終的 TOC に、それは自動的に加えられます)。Ghostトラックの場合を除いてください。 

(その他の詳細に関しては、Ghost Track のセクションを見てください)。 

 

Start 
 

Timeline上の、CD Track の始まり。 

トラックとすべてのトラックの後にリップルするこの値を変更してください。 

 

End 

 

Timeline上の、CD Track の終わり。すべてのトラックの後にリップルするこの値を変更してください。 

(同様の機能を Length に実行します)。 

 

Length 

 

CD Track の長さ。 

トラックの長さを増減させて、すべてのトラックの後にリップルするこの値を変更してください。 

 

Start Offset 
 

トラックのスタートマ－カ－のための Negative Offset です。 

 



Use Offset 
 

トラックのオフセットを可能か、不可にしてください。(始め、停止、およびインデックス)。 

個別に適用する、始めと停止とインデックス、左手のパネルの All Markers ぺ－ジに進んでください。 

 

ISRC 

 

これは、国際 Standard Recording Code です。 

このコードの完全なる説明文は、左手のパネルの CD Properties セクションにあります。ご覧ください。 

Extra Functions セクションを見て、このコードの自動制作法を確認してください。 

このフィールドには、合法ルーチンがあります。 

コードは、あなたが願っているように入力されるかもしれません。そして、自動的に合法化されるでしょ

う。(例えば、“(FR) W01 - 02 / 1” は “FRW010200001” となります。) 

 

Copy 

 

Copy Protection ビットを切り換えます。 

 

Comment 
 

汎用のコメントです。'ユ－ザ－の注意事項'のためです。 

 

CD Text fields 
 

CD Properties ページからすべての残っているフィールドをコピーできます。 

その後に、Extra functions セクションをご覧ください。: 

 

CD Text Title 
 
CD Text Performer 
 
CD Text Song Writer 
 
CD Text Composer 
 
CD Text Arranger 



CD/SACD Tab Window Menus 

Discs 
 

Delete 

 

Cut 

 

Copy 

 

Paste 

 

 

Copy Info 

 

Paste Info 

 

Validate PQ       ディスクの PQ を有効にします。 

(どうぞご覧ください。Red-Book Validation 303 ぺ－ジ ) 

 

Markers 
 

Cut 

 

Copy 

 

Paste 

 

Delete Selected Track(s) クリップ、Markers、Automation などで選択されたトラックを完全に削

除します。 

 

Clear All Markers     すべての PQ マ－カ－をクリアします。 

 

CD Mark Groups     クリップ、または、クリップグループから PQ マ－カ－を自動的に作り出 

                                                                                                                             してください。 

 



Add Start Marker     カーソル位置に Start Marker を加えてください。 

 

Add Index Marker      カーソル位置に Index Marker を加えてください。 

 

Validate name      右手のパネルの選択されたトラックに。:「*」を取り除きます。(それは、 

                                                                                                                             自動制作されたマ－カ－ネ－ムに含まれています)。 

                                                                                                                             Start Marker の名前をStop marker にコピーします。 

                                                                                                                             (それがディスクの最後のトラックであるなら) “stop” 接尾語はStop 

                                                                                                                         Markerネ－ムの終わりで加えました。 

 

Offsets 
 
Show Offset       PQ マ－カ－を移動させて、オフセットでマ－カ－の最終位置が反映され 

                                                                                                                             ます。Table of Content ページ はいつもオフセットがある最終的なPQ 

                                                                                                                             コードを表示します。; それで、本機能において、Timeline 上で実際のマ 

                                                                                                                               ーカーの位置を表示するのに有用であり、または、CDプレーヤの最終 CD 

                                                                                                                             を模さんと欲っした場合においても有用であります。 

Copy First Start     Offset before first Track の値を供給してください。 

 

Copy Last Stop      Offset after last Stop の値を供給してください。 

 

Copy Start        Offset before start の値を供給してください。 

 

Copy Stop        Offset after stop value の値を供給してください。 

 

ISRC 
 

Create          CD Properties ページの ISRC デフォルトパラメータを使用して、選択さ 

                                                                                                                             れたトラックのために ISRC を制作してください。 

                                                                                                                             選択されたトラックが一つ以上あれば、ISRCs は、最初の選択されたトラ 

                                                                                                                             ックで最初に制作されます。其の後、他のトラックを行います。 

Inc. Selection      選択されたトラックのために ISRC の指定コード部分を増加してください。 

 

Validate ISRC      ISRC コードが正しいかどうかチェックしてください。そして、だめであ 

                                                                                                                            るなら修正してください。 



CD-Text 
 

Copy All         選択されたトラック CD Text フィールドにすべてのCD Disc 情報をコピ 

                                                                                                                              ーしてください。 

 

Copy Title        選択されたトラック CD Text Title フィールドに CD Title をコピーして 

                                                                                                                              ください。 

 

Copy Performer     選択されたトラック CD Text Performer フィールドに CD Performer 

                                                                                                                              をコピーしてください。 

 

Copy Song Writer     選択されたトラックCD Text Song Writer フィールドに、 

                                                                                                                              CD Song Writer をコピーしてください。 

 

Copy Composer     選択されたトラック CD Text Composer フィールドに CD Composer 

                                                                                                                              をコピーしてください。 

 

Copy Arranger      選択されたトラック CD Text Arranger フィールドに CD Arranger 

                                                                                                                              をコピーしてください。 

 

Copy Title from Track Name 選択されたトラックのために CD Text Title に Track Name をコピー 

                                                                                                                              してください。 

View 
 

Show CD Player   CD Player の浮かび上がっているウィンドウを開きます。 

 どうぞご覧ください。:  Show CD Player 302 ぺ－ジ 

Display TOC...    Xtoc ダイヤログを開きます。左手パネルは、現在のプロジェクトの CD Album 

                                                                                                          と SACD Album のすべての Discs を示しています。 

                                                                                                           Disc をクリックして、それを選択してください。 

                                                                                                          そして、Display XTOC ボタンをクリックして、Disc  のために右手パネルの 

                                                                                                           完璧な TOC を表示してください。 

Default Settings 
CD Offset デフォルトパラメータならびに ISRC デフォルトパラメータは、こちらでセット致します。 

Settings > All Settings > Application > CD/SACD  ぺ－ジ 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

All Settings Application CD/SACD Page 

 

CD Offset default parameters 
 

PQ マーカーのオフセットがゼロに設定されるとき、これらのパラメータは使用されています。 

そして、あなたは、ボックスをチェックすることによって、それらを可能にいたします。 

 

CD Start Offset Enabled 
CD Index Offset Enabled 
CD Stop Offset Enabled 

オフセット値は、増加、減少ボタンを使用することで入力、そして/または、調整することができます。 

 

Offset before first Start 
 

マイナスのオフセットは最初のもの以外のすべての PQ Start マーカーに適用されました。 

 

Offset after stop 

 

マイナスのオフセットは最後のもの以外のすべての PQ Start マーカーに適用されました。 



Offset after last stop 

 

マイナスのオフセットは最後の PQ 停止マーカーに適用されました。 

 

Offset before Index 

 

マイナスのオフセットは、PQ インデックスマーカーに適用されました。 

 

ISRC default parameters 
 

これらのパラメータは、自動的に ISRC を制作するか、または増やされるのに使用されます。 

本機能は、ISRC > Create と ISRC > Inc Selection は、Offsets と ISRC メニューから呼び出されま

す。(右手パネルのどこでも右クリック。) 

 

これらのすべてのパラメータがプロジェクトで保存されます。あなたが値をデフォルト値と定義したいな

ら、値を右クリックしてください、そして、“Set as Default”を選択してください。 

 

Country Code 

 

二文字 (GB, SW, FR 等…) 

 

Producer 

 

三文字 (W01) 

 

Year of Reference 

 

二桁 ( 02) 

 

Designation Code 

 

五桁 (00012, 80010) 

Increment by 

 

ISRC の指定コード部分をオートインクリメントで使用されます。デフォルトは “1” です。 

 



Show CD Player 

 

 

 

 

 

 

CD Player floating Window 

 

CD 再生のシミュレーションを可能にする “always on top” の小さい CD Player を表示しています。 

(これはまるで、本物の CD プレーヤ－のようだ。) 

マーカーオフセットのあるなしにかかわらず CD をシミュレートできます。Track リストパネルのポップ

アップメニューで Show Offset を選択して、オフセットを大切に取り扱ってください。 

プレーヤーには、標準の再生機能があります。(再生、停止、次、前、探る、など…)そして幾つかの特殊

機能があります。: 

 

Preroll 
 

ナンバーボックスの中をリックすれば、値(セコンドで)の入力が許可されます。 

 

Postroll 
 

ナンバーボックスの中をリックすれば、値(セコンドで)の入力が許可されます。 

 

Track を Backward  へ飛び越させます。 

 

Track を Forward  へ飛び越させます。 

 

                                                                        停止 

 

                                                                        再生 

 

                                                                        巻き戻し 

 

 早送り 



Play Transition 前の Stop marker マイナスプレロールから、現在の Start 

                                                                                          marker プラスポストロールまで現在のトラックをプレーします。 

そして、プリとポストロールは、CD プレーヤインタフェースで直接編集できます。 

Play All Transitions は、Play Transition と同じ機能があります。しかし、CD 

                                                                                        トラック間のすべてのトランジションを再生します。 

 

                                                                                         Track 右のボタンからの 3 番目をクリックすると、4 つの異なった時間表示オプ 

                                                                                          ションで回って切り替わります。CD の始まりからの経過時間。CD の終わりから残 

                                                                                          っている時間。Track の経過時間とTrack の終わりから残っている時間。 

 

                                                                                         Frame CDフレ－ム表示のショー/ハイド。 

 

 

 Rnd 

 

 

Ghost Track 

 

通常 CD は、2 秒のブランクの後、最初のトラックが始まります。 

Pyramix はあなたにこれを変更させて、ゴーストトラックを制作させます。; 最初のトラックの前のトラ

ックです。これを達成するには、シンプルにゴーストトラックの始めに CD Index Marker を加えてくだ

さい。それは、最初のスタ－トマ－カ－の前です。また、あなたは最初のトラックのポーズを編集できて、

次に、これは、あなたのためにゴーストマーカーインデックスを制作するか、または移動させるでしょう。 

 

Multiple CDs or versions in one Project 

 

すべての CD 情報とCD Marker は "世界的" か、またはTrack Group 単位でそうすることができます。 

Destination タイプとFreeMarkers を有効にさせる各Track Group はそれ自身の CD 情報とCD Marker

を持っています。これは、アルバムのための PQ 編集の複数のバージョンが扱われて、複数の CD アルバ

ムのために同じドキュメントがあることを可能にします。 

CD Tab Window に表示された CD InfoとMarker は、現在選択されたTrack Group に続きます。 

Red-Book Validation 



Validate PQ : 本機能は、PQ が以下のチェックと修正を行うことによって Red Book 仕様に確実に従わ

せます。 

•  ポーズが 1 秒未満の場合は、ポーズを取り除きます。(オフセットは自動的にデフォルトにされてい 

                       ます)。 

•  4 秒より少ないなら、Track Length は 4 秒にセットされます。(オフセットは自動的にデフォルト 

                       にされています)。 

•  トラックカウントは 99 で抑えられます。 

 

•  不正確であるなら、ISRC は取り外されます。 

 

•  不正確であるなら、UPCEAN は取り外されます。 

本機能は、必要なら、アンドゥしてください。 

 

DDP Import 

 

あなたは DDP インポート機能を使用できます。Project > Import > DDP Import 

これにより、DDP テ－プ、ファイルと生成を新しい CDイメ－ジファイルにインポ－トできます。 

SACD Functions 

右クリックによりコンテキストメニューにアクセスされます。: 

 

lbm... 
 

 

 

 

 

 

 

 

 

 

 

 

lbm... sub-menu 



Import... / Export... 
 

SACD テキストを保存するか、またはロードするために Windows ブラウザウィンドウを開きます。 

Lbm ファイル。 

 

mts... 
 

SACD テキストを保存するか、またはロードするために Windows ブラウザウィンドウを開きます。 

mtsファイル。 

 

Exporting Projects to CD Image Files 

 

以前の Marked Composition を CD-R イメージファイルへエクスポートします。: 

 

CD/SACD Tab ウィンドウを開いてください。適切な CD-R 情報を記入してください。 

Project > Generate CD Image / SACD Edited Master を選択してください。 

これは Generate CD Image ダイヤログを開きます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Generate CD Image / SACD Edited Master 

 

左手のパネルから CD-Disc を選択してください。 



Target Settings 
 

Image Format 
 

Image Name 
 

Image Location 

 

コンボボックスにはすべてのマウントされたメディアフォルダーのリストがあるか、または、あなたが

Choose a media folder to mount ダイヤログを開くのに   ボタンを使用できます。 

 

Processing 
 

Real Time 
 

リアルタイムでの生成か、それともイメージが作り出されている間、CD を聞きたい場合、ボックスをチ

ェックしてください。 

 

Mixer Sources 
 

それらを、Ctrl + Clicking することによって、リストから、2 つの適切なバスアウトプットを選んでくだ

さい。 

 

 

 

 

 

 

 

 

 

 

Generate CD Image - Mixer Sources 

 

 

 



2 つ以上、以下選ばれると、このエラーメッセージが現れます。: 

 

 

 

 

 

Generate CD Image - Mixer Sources Error 

Dithering 
 

以下に 注意 してください。:  Mixer では、マニュアルでディザ－を不可にする必要は全く

ありません。 

 

2 つのディザ－処理装置の間には、選択があります。: 

 

Use Mixer Settings (default ) 
 

Mixer's Dither と同じ処理を供給します。(パラメータは、Mixer で選択されたものです。) 

 

Use 16 bits WLC/Noise Shaper 
 

どのような SRC も適用されていなくても、これは、V (ヴァ－ジョン) 4.2 のディザ－と同じであって、利

用可能です。コンボボックスは設定の選択を提供します。: 

 

 

 

 

 

 

 

Generate CD/SACD dialog - Dither options 

DiscWrite 

 

DiscWrite は、Pyramix Virtual Studio に、共にバンドルされた別々のアプリケーションです。 

それは、CD イメージを、CD-R ディスクか DDP イメージ・ファイルをフォルダーか DDP テープドライ

ブへ、イメージを書き上げるのに使用されます。 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

DiscWrite application window 

Source 
 

ドロップダウンリストは、ユーザが新しい CD-R か DDP ファイルのためのソースとして Pyramix CD 

Image、すべてのインストールされた光ドライブまたは U-Matic テープの間での選択を可能にします。 

 

Source - Pyramix CD Image 

 

 

 

 

 

 

 

DiscWrite Source - CD Image 



選ばれた Source が Pyramix CD Image、であるときに Source ドロップダウンリスト下の左手のボタ

ンは Open Image...になるでしょう。 

Open Image...をクリックすると、ファイルブラウザウィンドウに通じます。あなたは希望のイメージ・

ファイルへナビゲートできます。右手のボタンは Edit...になるでしょう。 

 

Edit...ボタンをクリックすると、Image Editor ダイヤログが開きます。: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

DiscWrite Image Editor Dialog 

CD-Text を自由に編集できます。 

 

Restore Original 
ダイヤログが開かれてからの、どのような変更もアンドゥできます。 

Source - CD Drive 

 

 

 

 

 

 

DiscWrite Source - CD Eject Drop-Down 



選ばれた Source が CD : ....の場合、Sourceドロップダウンリスト下の左手のボタンは、Eject と右手

にある 1 つの Settings...になるでしょう。 

 

Eject 
 

これは、選択した光ディスクドライブのロ－ディングトレイを開けます。(または、ドライブがスロットロ

ーダの場合は、ディスクをイジェクトします)。Eject ボタンの横の下向きの矢をクリックしますと、ほか

の光ディスクコマンドリストをドロップダウンします。 

 

Retract       ソ－スドライブのロ－ディングトレイを閉じます。 

 

Disk Info      ディスク情報を読んで、Results ボックスの中に、それを表示します。 

 

Drive Info      光ドライブファームウェアについて査問して、Results ボックスの中にドライブ 

                                                                                                   に関する情報を表示します。 

Info 
 

Info ボックスは光ドライブの読出しスピードか、パスのどちらかをイメージ ファイルに示します。 

 

Target 
 

ドロップダウンリストはどんなインストールされた CD-R や DDPドライブか、DDP Folder  の間での選

択を有効にします。 

 

DDP Folder 

 

DDP folder が Record ボタンの横の選択されたターゲットボタンである場合、オプションのリストをド

ロップダウンします。: 

 

 

 

 

 

 

DiscWrite Target - CD Eject Drop-Down 

 



Verify      レコーディングを確認します。 

 

Select Folder...  適切なフォルダーが選ぶための、Browser を開きます。 

 

Settings... 
 

DDP 設定情報とオプションの、ウィンドウをオ－プンします。 

 

CD-R/CD-RW 

 

CD-R(RW) が選択ターゲットである場合、Record ボタンの横の矢印は、オプションリストをドロップダ

ウンします。: 

 

 

 

 

 

 

 

 

Eject      ターゲットドライブのロ－ディングトレイをオ－プンします。 

 

Retract     ターゲットドライブのロ－ディングトレイを閉じます。 

 

Disk Info     ターゲットディスクの情報を読んで、Results ボックスの中にそれを表示します。 

 

Fix Disc     Once ディスクのTrack をCD player によって読むのに必要な、情報を書きます。 

 

Erase Disc     re-writable ディスクの内容を消します。 

 

Drive Info    光ドライブファームウェアについて調べ、Results ボックスの中にドライブの情報 

                                                                                     を表示します。 

 

Settings... 
 

適切な光ドライブかイメージ・ファイルが選択されていない場合、Settings...ボタンは灰色になります。 



利用可能な場合、Settings...をクリックすると、すべての関連設定へのアクセスダイアログを開きます。 

特にここでは、Disc-at-Once とTrack-at Once モードの選択ができます。 

最大の互換性がある、isc-at-Once を使用してください。 

 

Record 
 

Record ボタンをクリックすると、レコーディングプロセスに着手します。 

レコーディングをするとき、Results ボックスに中にプロセスの進行に関する詳細な報告を示しています。 

 

Info 
 

ターゲットドライブの Write スピ－ドかパスの表示は、DDP ファイルをフォルダーに書く場合の、表示に

なります。 

 

Status 
 

録音装置/プロセスのステータスを示しています。 

 

Progress 

 

温度計のようなバーグラフは、レコーディングの進行を示しています。 

 

Buffer 

 

他のバーグラフは、レコードバッファの状態を示しています。 

 

Results 
 

このボックスは、その時行われている様々なプロセスに関しての詳細情報を表示します。 

 

Table Of Content 
 

詳細なTOC について表示します。 

 

Print TOC... 
 



Print Options ダイヤログを開きます。 

 

利用できる実際のオプションはあなたが選択したプリンタによります。 

 

Save TOC... 
 

File Browser ダイヤログを開きます。 

ここで、TOC ファイルの名前をタイプして、それをセーブする適切なフォルダーを選ぶことができます。 

 

Select Report... 
 

TOC のレポートスタイルを選択できる File Browser ダイヤログを開きます。 

 

Design Report 
 

Report Designer アプリケーションを開きます。これで、あなたは TOCs の自身のレポ－トフォ－マッ

トをデザインできます。 

 

Optical Drives - Important Note: 
 

よくあることですが、光ドライブが動作するとき、問題に遭遇する場合がございます。しかしながら、ド

ライブの最新のファームウェアをインストールすることによって、WindowsとDiscWrite のほとんどの問

題を解決できます。これはインストール・ガイドと共にドライブメーカーのウェブサイトから利用可能で

しよう。これは、真実です。CD-Text の書込みの、書込みスピードとバッファは、CD-Import と同様です。 

 

CD Text 
 

CD-Text はいくつかの高品質 DVD-RとCD-R ドライブで首尾よくテストされています。 

しかしながら、DiscWrite とその CD-text は、市販の書出しプログラムの大部分を網羅するべきです。 

そして、ユニットのために、利用可能な最新のファームウェアのインストールを喚起すべきです。 

 

Disc Image を含む CD-Text を書くのに、non CD-Text テキスト書出しプログラムの使用を意図すると

き、警告は現れるでしょう。 

 

CD-Text との互換性は、Target エリアで確認できます。それは、確実にドライブが選択されることや、 

Recordドロップダウンメニューから、Drive Info を選ぶことによります。 



Writing CD-Text (audio, disc at once): Yes. Supported write methods 見つけられるべきです。: 

Results ウィンドウのリストのセクション。(これを見つけるために、リストをスクロールしてください)。 

 

Burning a CD-R 
 

DiscWrite を立ち上げてください。(通常、Pyramix には、DiscWrite アイコンがデスクトップにありま

す。) 以前に制作した CD イメージファイルから CD-R を焼くために。以下を見てください。: 

 

1.  Source セクションで、Open Image...ボタンをクリックしてください。次に、以前に制作した

CD Imageファイル(.img か .pmi ファイル)へ、ナビゲートして、それを選択してください。 

 

2.  Target セクションでは、ドロップダウンメニューをクリックして、CD-R デバイスを選択してく 

  ださい。DiscWrite はまた、OS 自体で認識される以前に構成された CD-R デバイスも認識します。 

 

3.  Target セクションでも、Settings...ボタンをクリックして、CD-R Settings ダイアログボック 

 スを開いてください。CD-R バ－ニングセッションのために、これらを設定してください。通常デ 

 フォルトセッティングは、素晴らしいでしょう。しかし、CD Write Method をチェックするだけ 

 の価値はあります。: エントリは、Disc At Once に設定されます。 
 

 

 

 

 

 

 

 

 

 

 

 

 

DiscWrite General and Advanced Settings 

 

4.  すべての CD-R の設定が必要に応じて調整されるとき、Target セクションの Record ボタンをク 

  リックして、CD-R を焼き始めてください。 

 



DDP Masters 

 

以下に注意してください。: 上記の例では、Pyramix は、あなたの DDP をフォルダーに

焼く作業を(Exabyte テープの代わりに)はっきりと明記しております。 

安全な FTP 接続の上にそれを送るなどのように、そこから、移され、コピーされ、転写さ

れ、チェックされ、ア－カイブされ、または、あなたがしたいことなら何でも、できます。 

 

Red Book Compatible Masters 
 

CD-R をRed Book に適合するマスタとして、使用するつもりであるなら、"Contiguous" は選択されな

ければ  なりません。 

 

CD Copy 
 

適切なハードウェアが利用可能なところでは、CD は、ソースとしてCD-ROMドライブを選択することに

よって、そしてデェスティネ－ションとしての CD-R/RW ドライブ選択することによって直接コピーされ

るかもしれません。 

 

TOCs 
 

Print TOC...現在選択されたリポ－トフォ－マットで、現在の TOC を印刷します。 

 

Save TOC...テキスト( .txt )ファイルとして現在の TOC を保存するためにファイルセーブダイヤログを

開きます。 

 

Select Report...ファイルオ－プンダイヤログを開きます。以前に設計されたどんな TOC リポ－トフォ

－マット( *.lst )もロードされるかもしれません。 

 

Design Report...Report Designer を開きます。オンラインドキュメンテーションを見てください。 
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File and Project Interchange 

 

 

Project Interchange 

 

Import と Export は InterChange によって取り扱われます。Project メニューでは、Import と Export  

が利用できる InterChange プラグインのリストが示されているウィンドウを開きます。 

 

その結果、Project > Import と Project > Export は、これらのウィンドウを開きます。: 

 

 

 

 

 

 

 

 

 

 

 

 

 

Project Interchange - Import and Export dialogs 

 

Import Options 
 

Options  のラジオボタンは、インポートしている素材がどのように現在のプロジェクトに影響するかを決

定します。: 

•  現在のプロジェクトを、すべての既存のトラック、トラックグループ、およびマーカーを取り除くこ 

                       とにより、取り替えてください。そして、インポートしているコンポジションから新しいトラック、 

                       トラックグループ、およびマーカーを制作してください。 



•  現在のプロジェクトトラックの下に、インポートしているトラックを追加してください。 

 

•  現在のプロジェクトトラックにインポートしているクリップを挿入してください。 

 

Export Options 
 

•  トラック、トラックグループ、マーカーを含む全体のコンポジションをエクスポートしてください。 

 

•  エクスポート選択専用 

 

選択が全くプロジェクトのTimeline にないと、Export selection only は、灰色になります。 

 

File Interchange with Apple Macintosh 

 

History 
 

SD2 や PT4.x、PT5.x プロジェクトファイルなどの古い Macintosh ファイルは、Mac バイナリ、または

ダブルフォーク構造になっています。よって PC では直接扱うことが出来ません。 

インターチェンジファイル、PC ファイルまたは新しい Mac ファイル(それは簡単な一列構造を運びます)

と対照的に、SD2 や PT5プロジェクトファイルは、Data フォーク(あらゆるコンピュータファイルであな

たが目にするもの)や Resource フォーク(すべてのファイルインフォメーションを保存する隠された2番

目のファイル)がベ－スとなっています。 

このバイナリの構造は実際に賢明でかなり便利な移動でしたが、半分のファイルが故意に隠されるという

事実はそれを非常にこわれやすいクロスプラットフォームメディアにします。 

リソースフォークがなくなったという確かなサインは、ファイルがジェネリックアイコンと共に現れる時、

そこにありますが、読めません。壊れているバイナリファイルは再構築できません。 

 

Problem 
 

転送が間違って完了しているなら、隠されたリソースフォークファイルは、SD2 のような Mac ファイル

フォーマットは必要ですが、Windows では、認識されていません。そして、Pyramix によって作り出し

ますが、転送でなくなります。 

 

より最近の、WAV, AIF, JPEG のような、普遍的フォーマットは、圧縮されたアーカイブと同様に、リソ

ースフォークファイルを使用しておりません。したがって、透過的に 2 つのプラットフォームの間で移し



てください。これは同じ使いやすさを SD2 ファイルに適用できるという信念に通じます。そして、これは

そうではありません。インタ－チェンジプロセスで、半分のファイルを失わないように注意するべきです。 

それは故意に隠されるので、楽な仕事ではありません。 

 

Solution 
 

On the PC 

 

SD2 と PT4.x / 5.マックファイルを適切に扱って、移行させるために、PCs へまたは、PCs  からのリソ

ースフォークファイルを要求し、MacDrive 2000 か MacDrive 5 は PC にインストールされるべきです。 

MacDrive は Mediafour 社の製品です。どうぞこちらをご覧になられてください。:- 

 

www.mediafour.com 

 

また、MacDrive はシステム付随の NTFS ウィンドウハードドライブの MacBinary ファイルを梱包して

いて、開くのに便利になります。 

 

ファイルがバイナリであるときに、PC 上で、PC CDs に書くか、USB キーをコピーするか、またはイン

ターネットを通して送ることが必要です。"MacBinary" にデータとリソースフォークのパックが、ファイ

ルの保全、保持に必要です。選択またはマルチ選択の右クリックそして、Create Mac Binary file の選

択でこれを達成できます(MacDrive がインストールされている)。  

 

Hard Drives 

 

Prohibited: 

 

FAT16 - FAT32 フォーマッティング(フラッシュメモリとUSB キーでまだ使用中の)はリソースフォー

クを破損するでしょう。 

NTFS が標準の 4KB より他のブロックサイズでフォーマットされれば、リソースを無効にするでしょう。 

それで、上のフォーマットのいずれも SD2 - PT4. x か 5.x バイナリファイルと共に動作しないでしょう。 

 

Recommended: 

 

4KB の標準のフォーマッティングがある NTFS と HFS+ハードドライブ。 

 

それで、64KB のブロック以来、フォーマッティングは、Pyramix と共に近代的な NTFS プラスハードド

www.mediafour.com


ライブから最も多くの性能を得るために強く推薦されます。PT インタ－チェンジはワークステーションの

上に作られるとき、次のセットアップは使用されるべきです。: 

 

a) NTFS ドラィブか、分割 －64KB フォーマッティング－通常定の PMFレコーディングのために。 

 

b) NTFSドラィブか、分割 －4KB フォーマッティング－か、PT インタ－チェンジのために。 

(また、MacDrive と共にフォーマットされた An HFS+ drive は動作するでしょう。) 

 

NTFS でフラッシュメモリドライブをフォーマットできます。 

"Optimize for Performance" が選ばれるなら、Properties / Policies のなかです。 

 

Over Ethernet 
 

SD2 / PT Project ファイルはイーサネットネットワーク上で安全に移されるでしょう。 

そして、それぞれのソースに関係されるすべての Hard Drive 規定と使用中のデスティネイションディス

クのために提供されるでしよう。 

 

また、アップルワークステーションがネットワークに接続されるとき、これも真実です。 

適切な AFP サービスが Windows 2003 Server で起動される場合です。(Apple マシ－ン上で起動された、

現在の SMB  割り当ては、明らかに Resource フォークにダメ－ジを与えます。だから、Apple マシ－ン

は、安全にバイナリファイルを AFP  割り当てに書き出し、読出しができるのです。) 

 

以下に 注意 してください。: ネットワークドライブはローカルにマップされるべきです。 

               ( Windows Map Network Drive 機能を使用します。)Pyramix が直接 ProTools Project 
        へ Import か Export できるためです。 

 

On the Mac 

 

インタ－チェンジのための CD かDVD が Mac 上で制作されるとき、それは Hybrid CDFS/HFS であるに

違いありません。さもなければ、リソースフォークは Mac によって MacDrive がサポートしない方法で 

"encoded"  (コード化されます)。Mac 側での、"PC disk" のいかなる他の種類のソフト(ISO9660などの)

の制作の試みは、現在のところ、リソースフォークを確実に破壊するでしょう。 

バイナリファイルが Mac 上でパックされましたが、これは、このマニュアルの範囲の外にあります。 

 

適切に制作されると、PC上のアイコンの上に可愛い Apple とともに、CD は現れるでしょう。 

そうでなければ、それを右クリックしてください。そして、MacDrive メニューの Show Mac Files オ



プションを選んでください。 

 

Finally 

 

当然ながらこのことは、重要です。ファイル渡しにかかわるすべてのソフトウェアコンポーネントの、同

じ世代のソフトウェアの改訂、または、さらなるソフトウェア改良を確実に行ってください。 

利用できる最新のソフトウェア/ファームウェア/ドライバー/システムをお願いします。 

 

真実です。: Windows OS, Mac OS, Externalドライブファームウェア、および MacDriveソフトウェア。 

このアドバイスを無視すると、予期しないデータとドライブのトラブルが発生するかもしれません。 

 

File Size Limitations 

 

SD2, WAV または BWF ファイルは最大 2GB に制限されます。そのことは、32bit 符号のアドレス指定フ

ォーマット(その結果、31 の利用可能なビット)に起因します。そのうえ、32bit 符号なしのアドレス指定 

AIF ファイルは 4GB に制限されます。これらのフォーマットを、どれかにレコードする、そして/または、

エクスポートするときには、これを必ず覚えておいてください。特に高いサンプリング周波数マルチトラ

ックファイルで動作するとき、事実上、2GB/4GB のリミットは、もっと近で起きるかもしれません。 

 

このことと比較して、Pyramix は、自身の PMF 64bit アドレス指定ファイルフォーマットのおかげで、仮

想的ではありますが、限のないサイズの PMF ファイルを作り出すことができます。 

これは、シングルファイルで制作、高いサンプルレイトでの、大きいマルチトラックプロジェクトのため

に、ファイルタイプの選択を可能にします。 

 

Hard Drive Limitations 

 

また同様に、大きいファイルの書き出しの場合も、困難で、2GB/4GB* リミットに直面します。 

PMFフォーマットでさえ、FAT32 か HFS などの古い 32bit ファイルシステムでフォーマットされた記憶

装置(メモリーカード、ハードドライブなど)でも、同様の限界が現れます。 

 

しかし、より早くの限界は、IDE ATA/ATAPIドライブでは、およそ137GB で現れます。 

これは 48bits ではなく、当初の 28bit 仕様の ATA では、システム(ドライバ－、コントロ－ラ、そして/

または、古い Windows バ－ジョン)の一部によって引き起こされる場合があります。 通常は、

Bios/Drivers/OS を新たにインスト－ル、またはアップデ－トすることによって解決されるでしよう。   

 

*公式の限界は 4GB ですが、重大なトラブルはおよそ 2GB で現れる場合があります。 



AAF 

Pyramix は AAF のプロジェクトをインポートして、エクスポートすることができます。 

(Advanced Authoring Format) 

 

Import 
 

Interchange Import ダイヤログで AAF を選択してください。適切なインポートオプションを選んでく

ださい。そして、Import をクリックしてください。 

 

Import AAF File ウィンドウが開きます。必要な AAF ファイルへナビゲートするか、または File name 

ボックスに名前をタイプしてください。そして、Open をクリックしてください。 

 

ファイルにエンヴェロ－プ情報があれば、このダイヤログは開きます。: 

 

 

 

 

 

 

Interchange - Import dialog 

 

Yes (はい)をクリックして、エンヴェロ－プ情報を適用か、No (いいえ)をクリックして、エンヴェロ－

プ情報なしで素材をインポートしてください。 

 

 

 

 

 

 

 

 

 

 

 

 



Export 
 

Interchange Export ダイヤログで AAF を選択してください。適切なエクスポートオプションを選んで

ください。そして、Export をクリックしてください。Export AAF File ダイヤログが開きます。: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Export AAF File dialog 

 

必要なドライブ/フォルダーへナビゲートしてください。 

File name テキストボックスで適当なファイル名をタイプしてください。 

 

ドロップダウンリストの Save as type から適切なファイルタイプを選んでください。 

次に、Export Settings セクションでの適切な選択にエクスポートプロセスを開始するために Save をク

リックしてください。 

エクスポートが完了されるとき、このインフォメーションボックスは現れます。: Akai DD / DR 



 

 

 

 

 

 

Interchange Export info box 

AKAI disk import 

Akai DD-Series フォーマットでレコードされたディスクを認識して、Pyramix はそれらのデータをイン

ポートすることができます。 

 

Preparing the system 

 

Akai ディスクを PC に接続してください。通常、また、これは、SCSI インタフェースを通してしますが、

Magneto-Optical または、Jaz ディスクであるかもしれません。 

 

Project > Import は、Project Interchange ダイヤログボックスを開きます。 

リストから AKAI DD/DDR を選ぶと、AKAI DD-Series File System Loader ダイアログボックスが

開らきます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Akai DD-Series File System Loader dialog 



ダイヤログが開かれるとき、Pyramix は利用可能な Akai ディスクを捜して、ダイアログボックスの左上

に表示します。マウスで選択して、使用したいディスクを選んでください。 

 

Refresh Disks ボタンは利用できる Akai ディスクの検索を再始動します。 

 

ダイアログボックスの下部に、選択した Akai ディスク上で見つけたデータを示しています。Akai ディス

クのデータ構造に従って、このパネルは、3 Tabs、Libraries、および Audio Files を Project と命名しま

す。 

 

Import Button 

 

Pyramix セッションにデータをインポートするために、シンプルに希望のデータを選択してください。そ

して、Import ボタンをクリックしてください。 ‘Quick Import’ と同じです。; 

 

すべてのファイルが、マウントされたメディアフォルダーへ、インポートされて、保存されます。Akai ラ

イブラリーがインポートされるとき、新しい Pyramix プロジェクトライブラリーが制作されるでしょう。 

 

Delete Button 

 

これが書込み保護でないなら、Akai メディアから選択したファイルを削除します。 

 

Audio File import 

 

Pyramix は直接 Akai ディスクから音声データを読むことができるので、ローカル Windows ドライブに実

際のオーディオファイルのインポートは、必要ではありません。 

したがって、Import ボタンをクリックすれば、ダイアログボックスが表示されます。: 

 

Do you want to import the Audio Files used by this/those projects? 

 (あなたは、この/これらのプロジェクトで使用されるオ－ディオファイルをインポートしたいですか?) 

答が No (いいえ)であるなら、オーディオファイルへの参照だけが実際のオーディオデータのコピーの代

わりにローカル Windows Media フォルダーで保存されるでしょう。 

 

オーディオは正しくプレーされますが、波形は全く表示されないでしょう。 

 

 

 



Closing the Akai loader dialog 

 

Akai DD-Series File System Loader を閉じようとするなら、以下のダイヤログは現れます。: 

 

 

 

 

 

 

Akai DD/DR-Series Loader dialog 

直接 Akai ファイル にアクセスし続けるのがお望みでしたら、NO (いいえ)をクリックして、ウィンドウを

最小にします。 

 

CD Import 
Pyramix には、総合的な CD インポート機能があります。 

Project > Import で Interchange Import ダイアログボックスが開きます。 

適切なデスティネイションオプションを選んでください。そして、CD Import を選んでください。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

CD Import dialog 



Device 

 

コンボボックスはマシン上に、適切なドライブすべてを示しています。 

 

Settings 

 

Settings は、特定のドライブ設定でダイアログボックスをポップアップします。これらの設定は、必要な

ら、エントリをクリックして、新しい値をボックスにタイプすることによって、変更されるかもしれませ

ん。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

CD Import Settings dialog 

 

Read TOC は、CD のTable Of Contents を読み込んで、左手パネルにトラックを記入します。 

Read ISRC, UPCEAN and CD Text がチェックされるなら、この情報が存在している場合、読まれる

でしょう。 

 

Import Options 

 



Import all contents がチェックされるなら、ディスク全体がインポートされるでしょう。 

Import selected tracks がチェックされるなら、それらのチェックボックスの中にチックがあるトラッ

クだけがインポートされるでしょう。 

 

Select All と Deselect All はその言葉どうりにします。 

 

Query Database は、トラック名を得るのにオンラインデータベースを使用します。そして、市販の CD 

の結果に関する他のデータは、ダイヤログに示されています。: 

 

 

 

 

 

 

 

 

 

CD Import Query Database results dialog 

複数のディスクエントリが示されている場合、クリックで選択してください。次に、OK (はい)をクリッ

クして、データをインポートしてください。 

ディスク名は自動的に Clip Prefix :フィ－ルドに入れられます。 

 

Database Settings で、データベースアドレスと他の設定は変化します。: 

 

 

 

 

 

 

 

 

 

 

デフォルトの設定は上に表示しています。設定を変えるには、エントリをクリックしてください。そして、

タイプしてください。OK (はい)をクリックして、変更した設定セーブしてください。 

Defaults はデフォルト設定に戻します。 



Info 

 

Status ラインはプロセスに関する役に立つ情報を示しています。Track と Disc ラインは進捗状況のメー

タです。トラック転送が続いている場合、Track はグレーのバーで示されます。そして、Disc は、選択

した全てのトラックの進捗状況を示しています。 

 

Media Options には、Destination Drive の選択のために、3 つのドロップダウンリストボックスがあ

ります。CD オーディオがキャプチャーされて、波形が作り出されるか否かに関係なく、Waveform が決

定する Format。そうだとすれば、WHILE recording か AFTER。 

テキストエントリ－ボックスには、インポートされた全てのトラックのために、Clip Prefix の用意ができ

ています。(デフォルトはCD Import です)。チェックボックスは、その結果のクリップが Timeline に置

かれるかどうか決定します。また、それは、CD Markers が Timeline に加えられて、Track Group に

加えられるか否かに関係有りません。 

 

Sampling Rate は、コンボボックスにおけるレイトの選択でコンバ－トを可能にします。 

Keep open は、インポートの終了後、CD Import ウィンドウを開いたままに、そしてタイムラインの位

置を灰色にします。  Add Track Group と Add Disc & CD markers のオプション。 

Import アイコンをクリックすると、処理を開始します。 

インポートの完了時、Keep open がチェックされない場合、ウィンドウは閉じます。 

 

CMX EDL 
 

Importing a CMX EDL 
 

Project > Import の選択で、InterChange-Import ダイヤログの CMX EDL は選択されます。 

それから、Import ボタンをクリックしてください。Open ファイルブラウザウィンドウで希望の edl ファ

イルを選択してください。CMX EDL Import Options ダイヤログは開きます。: 

 

 

 

 

 

 

 

CMX EDL Import Options dialog 



EDL Frame Rate が正しいなら、シンプルに OK ボタンをクリックしてください。 

そうでなければ、ドロップダウンリストから正しいレイトを選択してください。そして、OK ボタンをク

リックしてください。CMX EDL Import Options のメインダイヤログが開きます。 

ボックスの下の Settings Presets ボタンは、さまざまな一般的な CMX 変化のためのオプションを設定

します。あなたがインポートしたい edl がこれらの 1つにマッチするなら、シンプルに適切な Preset ボタ

ンをクリックしてください。設定はダイヤログの残りに反映されます。OK ボタンをクリックして、Import 

を始めてください。 

 

Edl が一般的な変化の 1 つでないかどうか、部分的か、再び従わせる意図があるかどうか、Import を始め

る OK ボタンをクリックする前に、ダイヤログで適切な選択をしてください。 

 

OMF 

OMF Import は OMF1 と OMF 2 フォーマットの両方をサポートします。 

10.5.3 / 11 サブコンポジションをサポートします。 

 

別のアプリケーションから OMF をエクスポートするとき、OMF ファイルの中にオーディオファイルを埋

め込むか、または外部のリンクとする選択があります。Pyramix は両方をサポートします。 

 

埋め込まれたオーディオファイルで OMFファイルをインポートするときには、Pyramix は、ユーザがメ

ディアファイルを引き出したいかどうか尋ねるでしょう。OMFファイルが、1回目だけインポートされる

というこの質問にどうぞ Yes (はい)と答えてください。 

また、OMF Media Handler は外部の Waveform (.pk) ファイルを作り出します。 

 

同じファイルがもう一度インポートされる場合、二度オーディオを引き出す必要は全くありません。 

シンプルに、OMF ファイルをインポートする前に、それが引き出されたフォルダーをマウントしてくださ

い。外部のオーディオファイルの参照(リンク) から、OMF ファイルをインポートするときには、 

OMF ファイルをインポートする前に、これらのファイルを含むフォルダーは、Pyramix にマウントされ

なければなりません。 

Avid、そして、AudioVision 区分だけは、ライブラリーとしてインポートされるかもしれません。 

ライブラリータブウィンドウで選択してください。: 

 

Library > Import OMF library (Avid bin) 

 

以下に 注意 してください。: 知られている制限 : OMF インポートは当分 24bits ファイル

をサポートしません。 



ProTools 
以下に 注意 してください。: また、見てください。: 'Pyramix 5 と Protools 5 
InterChange'という PDF ファイル。Pyramix 5.0 と併せてこのファイルをインストール

するか、または以下からダウンロードできます。:- 
 

http://www.merging.com 

 

Protools 5 InterChange with Pyramix 5.0 
 

Pyramix で Protools 5 セッションのインポート、エクスポートは、InterChange アーキテクチャで達成

できます。これは、Pyramix 4.2 以上と MacDrive 2000 か MacDrive 5 のインストールが必要です。 

MacDrive は Mediafour 社の製品であります。こちらをご覧になられてください。:- 

 

www.mediafour.com 

 

Importing a Protools session 

 

Pyramix はProtools バージョン 5.0 か 4.x をサポートします。Protools の、より最近のバージョンを使

用しているなら、まず最初に、バージョン5.0 セッションとして Protools のメニュー "Save Session 

Copy in…" でエクスポートしてください。 

これは新しいセッションに伴う SDII ファイルの 1セットを制作するでしょう。 

 

Mac HFS ディスクをマウントするか、または、適切なリーダーにカートリッジを挿入して、オーディオ

ファイルがあるセッションを Pyramix ステーションに運び込んでください。 

Windows とMacDrive は Jaz、 MO、脱着可能なハードディスク、CD-R、DVD、などのようにすべて

の SCSI ディスクかリムーバブルストレージをサポ－トします。 

 

あなたのセッションが複数の CD (または、カートリッジ)をつくなら、あなたは直接 Pyramix ワークス

テーションディスクにすべてのファイルをコピーできます。この場合、NTFS ボリュームとして PC ディ

スクをフォーマットしなければなりません。私たちは、すべてのディスクに NTFS を使用することを勧め

ます。 

Pyramix に空のプロジェクトを制作するか、または既存のものを開いてください。 

Project > Import は Interchange – Import ダイアログボックスを開きます。 

ラジオボタンを使用して、下の 3 つの選択から適切なインポートオプションを選択してください。 

これらは以下の通りです。: 

http://www.merging.com
www.mediafour.com


1.  現在のプロジェクトを、すべての既存のトラック、トラックグループとマーカーの削除により、取 

 り替えてください。次に、次に新しいトラックを制作して、インポートしているコンポジションか 

 らトラックグループとマーカーを制作してください。 

 

2.  現在のプロジェクトトラックの下にインポートしているトラックを置いてください。 

 

5.  現在のプロジェクトトラックにインポートしているトラックを挿入してください。 

 

そして、リストから ProTools モジュールを選んでください。エクスプローラ-スタイルファイルダイヤ

ログボックス Import ProTools Session が開くでしょう。ディスク内容に Protools セッションをブラ

ウズしてください。それを選択してください。そして、Open をクリックしてください。 

調整卓を制作するか、またはロ－ドしてください。トラックを接続してください。そして、セッションで

動ごかしてください。 

 

Exporting a Protools session 
 

あなたが Protools セッションとしてエクスポートしたい Pyramix プロジェクトをロードしてください。 

Project Menu から、適切な Export オプションと Protools モジュールを選択してください。そして、OK 

をクリックしてください。 

Menu : Project > Export は Interchange – Export ダイアログボックスを開きます。 

ラジオボタンを使用して、2 つの選択から下にある適切なエクスポートオプションを選択してください。 

 

これらは以下の通りです。: 

 

1.   トラック、トラックグループ、およびマーカーを含むコンポジション全体をエクスポートします。 

 

2.   エクスポート選択専用。 

 

1 つの選択か、複数の選択が、Timeline にある場合にだけ、後者の選択は利用可能になるでしょう。 

 

次に、リストから ProTools モジュールを選んでください。そして、Export をクリックしてください。 

ダイアログボックス、Export ProTools Session File が開きます。 

このダイアログボックスの上部はファイルの節約に関係があります。そして、適切な目的のフォルダの選

択、または制作を可能にします。ファイルは、入力されると、デフォルトで、セ－ブ ProTools Session 

*.* または、All files *.* の選択が与えられます。ファイルネ－ムエントリボックスは、Pyramix プロジェ

クトの名前を含んでいます。 



ダイアログボックスの下には、Export Settings の選択があります。 

ドロップダウンリストは、ProTools 5.0 か 4.* Session フォーマットと16 ビットか 24 ビットの保存の選

択があります。エクスポートのための、データ量の減少がお望みでしたら、Consolidate チェックボック

スを選択してください。これがチェックされれば、Handle テキスト入力ボックスの中に 0～999999 フレ

ームの 'ハンドル' の長さを選択できます。 

 

あなたが適切なオプションを選択して、エクスポートファイルのネ－ミング (または、デフォルトを受け

入れる)ときには、Save をクリックして、エクスポートを完了してください。 

 

こちらもご覧ください。: File Interchange with Apple Macintosh 317 ぺ－ジ 

 

AES-31 

AES-31フォーマットの直線的な Import とExport 。Genex Cuepoint ファイルをサポートします。 

.CPT ファイルが .ADLファイルの近くに存在していると、キューポイントは Pyramix マーカーに変換さ

れるでしょう。 

DDP 

DDP ファイルをインポートします。 

Edited Master 

Edited Master ファイルをインポートします。 

Sonic Solutions 

Sonic Solutions フォーマットを直線的にインポートします。 

Sonic Solutions をインポートするとき、外部のオーディオファイル、フォルダーの参照(リンク)します。 

それはインポート前の Pyramix に Mount されるべきファイルを含んでいます。 

Tascam Open TL 

Tascam Open TL フォーマットを直線的にインポートとエクスポートします。 

XML 

XML フォーマットを直線的にインポートとエクスポートします。 

SACD EDL Export 

どうぞご覧ください。: DSD / SACD ガイド。 



Report Printer 

(EDL、Markers、CD TOCレポートシートを含んでいます)。 

 

このプログラムは実際にプリンタが必要です。 

物理的にプリンタが無い場合、ここにプリンタを加える方法があります。: 

 

1. アド新プリンタウィザードを始動してください。Start > Settings > Printers > add Printer 

 

2. ウィザードで local printer を選んで、automatically detect を停止させます。 

 

3.  "Use the following port” で、File を選んでください。 

 

4. 結局のところファイルの印刷に使用するプリンタを選択してください。 

 

5. インストールの残りは標準のプリンタインストールと同じです。 

 

ページテストを印刷すると、ダイヤログが開いて、ファイルネ－ムをあなたに尋ねるでしょう。 

そして、ファイルを書くパスを入力してください。 

 

Cue Sheet Printer 
 

Cue Sheet Printer は、Timeline のグラフ描写の印刷に包括的なオプションを提供します。 

 

キュ－シ－トは、しばしば、作るには多くの時間と労力がかかった縮小した引渡すために必要な物です。 

 

Project > Export を選択してください。 

 

これにより、Project Export ダイアログボックスが開きます。 

 

Cue sheets printer を選択してください。そして、Export ボタンをクリックしてください。 

(または、シンプルに Cue sheets printer エントリをダブルクリックしてください)。 

 

CueSheet Printing ウィンドウが開きます。 

(Preview オプションが選択されて表示されます。) : 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

CueSheetPrinting Window 

Report 
 

Print 
 

このボタンをクリックして、オプションを選択して、キュー・シートを印刷してください。 

選択された Orientation が、プリンタのデフォルトと異なっていない場合、Print Options ダイアログボ

ックスが開きます。それが、Paper Orientation conflict であるなら、Select other report, Change 

Orientation,Force または Cancel の選択を提供するボタンと伴に、ダイヤログボックスが、ポップアッ



プします。Force は、プリンタに、この印刷のためのオリエンテーションを変えさせるべきです。 

いくつかのプリンタはこれを受け付けないでしょう。この場合は、以下を見てください。 

 

Print Options dialog box 

 

印刷のページと枚数の選択があります。インストールされたどのようなプリンタも選択でき、構成できま

す。Force が正しいページオリエンテーションで決果をもたらさないなら、プリンタページオリエンテー

ションは、Change のクリックにより、変えることができます。 

そして、次画面の Select は、選択したプリンタ上のオプションセットアップダイヤログに繋がるでしょう。 

 

Preview 

 

Cue-Sheet(s) のグラフィックプレビューをウィンドウの右側に追加します。 

 

Design 

 

Cue-sheets を制作した、デザインソフトウエアを開きます。どうぞ、オンラインドキュメンテーション

をご覧ください。 

 

Select 
ファイルブラウザを開きます。印刷のためにセ－ブした Cue-sheets のロ－ドができます。 

 

Sheets Arrangement 
Horizontally とVertically (たて、横)に、ページ数の増/減ボタンにより設定できます。 

また、これはタイムスケーリングをコントロールします。 

 

Orientation 

Portrait / Landscape 

縦、横のぺ－ジオリエンテーションの切り替え。 

 

Settings 
 
TimeCode Format 
 

ドロップダウンリストの選択から、キュー・シート上で使用された、TimeCode フォーマットを表示しま

す。Frames, Samples, [ms] または CD Frames 



Clip TimeCode 

 

チェックすると、Clip TimeCodes は印刷されます。 

 

Clip Name 

 

チェックすると、Clip Names は印刷されます。 

 

Color 

 

チェックすると、キュー・シートはオリジナルプロジェクトで使用されたカラーで印刷されます。 

(カラープリンタがあれば) 

 

Comments 

 

チェックすると、Comments は印刷されます。 

 

Preview 
 

Clip Borders 

チェックすると、クリップの境界は、プレビューディスプレイに示されます。 

 

Background 
 

Black / White 

 

プレビュー背景色を切り換えます。 
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Conforming and Reconforming 

 

 

Conforming 

 

Pyramix はオーディオを、CMX フォーマットEDL にマッチするよう従わせることができます。そして、

既存のプロジェクトも、CMX チェンジ EDL にマッチするよう再び従わせることができます。 

 

 

Importing a CMX EDL 
 

Project > Import を選択して、InterChange-Import ダイアログより CMX EDL を選んでください。 

 

そして、Import ボタンをクリックしてください。Open ファイルブラウザウィンドウで、希望の edl ファ

イルを選択してください。CMX EDL Import Options ダイヤログが開きます。: 

 

 

 

 

 

 

 

 

CMX EDL Import Options dialog 

 

EDL Frame Rate が正しいなら、シンプルに OK ボタンをクリックしてください。 

さもなければ、ドロップダウンリストから正しいレイトを選択してください。 

そして、OK ボタンをクリックしてください。 

 

 

 



CMX EDL Import Options のメインダイヤログは開きます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

CMX EDL Import Options dialog 

 

Common CMX Variants 
 

ボックスの下の Settings Presets ボタンは、さまざまな一般的な CMX  変化のためのオプションを設定

します。あなたがインポートしたい edl がこれらの 1つにマッチするなら、シンプルに適切な Preset ボタ

ンをクリックしてください。 

設定はダイヤログの残りに反映されます。OK ボタンをクリックして、Import を始めてください。 

 

Edl が一般的な変化の1つかどうか、部分的な機能の意図ためか、または、リコンフォ－ムするためか、OK

ボタンをクリックして、インポートする前に、ダイヤログで適切な選択をしてください。 

 

CMX EDL import Options 
 

General Options 

 



Import EDL Edits as Clips 

Import EDL Edits as Markers 

 

Edit/Clip Options 

これらのどちらからか、ネ－ミング済みのクリップを選択してください。: 

 

Using Tape/Reel Name 

Using Edit/Clip Name 

Using EDL Edit Number 

 

リンクされたメディアファイルの Using Scene & Take (if available) 。(たとえば、情報が Scene & 

Take フィールドにあるファイル、BWF PMF など。) 

 

Tracks Options 

 

Import Track        All Tracks (デフォルト)か、個別トラックのインポートの選択がある 

                                                                                                                                           ドロップダウンリストです。最初の、オーディオトラック上で編集され 

                                                                                                                                            たものだけをインポートします。これはすべてのオーディオトラックの 

                                                                                                                                            TimeCode がある MediaComposer で編集されたプロジェクトに役 

                                                                                                                                             に立ちます。しかし、Deva レコーダーからインポートされたファイル 

                                                                                                                                             からは、最初のものは失われてしまいます。 

 

Extend Edits to more tracks オリジナルのリストより多くのトラック編集の選択できます。それは、 

                                                                                                                                            ドロップダウンリストからターゲットトラックの希望のナンバーを選 

 択してください。 

 

Media Linking Options 

 

Connect EDL edits : どちらかによる編集のためのオーディオメディアを、再びリンクする方法を選択し

てください。: 

 

Using Tape/Reel Name 

Using Edit/Clip Name 

from the EDL... 

 

To Mounted Media:…どちらかにマッチさせてください。 



Matching Tape Name or FIXREEL pragma (the media original) 

Matching Media Name (the media original) 

Matching File Name (the media original) 

By TimeCode in matching Folder name (名前がReel か Edit ネ－ムにマッチするフォルダーのメ 

ディアのTimestamp) 

By TimeCode and prompting for location (the media Timestamp in a given folder) 

By TimeCode in any media folder (the media Timestamp in any mounted media folder) 

 

Ignore File Extension チェックすると、どのようなファイル拡張子もファイル名を比較している間、

無視されます。 

 

Match only X first characters チェックすると、ファイル名の頭文字のナンバーだけが比較されます。 

(Aaton Cantar か InDAW レコーダーからのファイルマッチングに便利です。) 

 

CMX EDL Format 
 

CMX Edls は、通常このように水平に並んだ、1セットです: 

 

TITLE: An example of CMX EDL 

 

001 TEST AA C     00:00:24:24 00:00:25:00 00:59:58:00 00:59:58:01 

 

AUD 3 4 

 

* Sine on all tracks 

 

002 DAT12 AA C     20:18:18:07 20:18:21:13 01:02:40:02 01:02:43:08 

 

* Introduction 

 

003 TAPE1 AA C     01:15:07:07 01:15:11:13 01:02:43:13 01:02:47:19 

 

004 TAPE1 NONE C    01:15:14:02 01:15:16:04 01:02:47:19 01:02:49:21 

 

AUD 3 4 

 



005 TAPE1 NONE C 1000Hz 01:15:14:02 01:15:16:04 01:02:47:19 01:02:49:21 

 

006 TAPE1 NONE C “A sound” 01:15:14:02 01:15:16:04 01:02:47:19 01:02:49:21 

 

Pyramix はこれらの EDL からオーディオに関するすべての情報を抜粋して、次に、1 セットのクリップを

現在の構成の Timeline に貼ります。 

 

細部が異なる多くの CMX フォーマットがあります。Pyramix にはスペースか TAB によってうまく分け

られる編集ラインフィ－ルドと同じように、それらの大部分を受け入れる十分な許容性があります。 

 

可能な限り多くのファイルをロードした後、EDL ファイルを解析している間に遭遇する、どのようなエラ

ーも保存されて、報告されます。 

非有効なラインであり、失ったメディア、または、メディアサンプルレイトミスマッチが報告されます。 

 

Media Reconnection 
 

EDL をインポートしている間に出くわすメジャーな問題は、参照をつけられたメディアに再接続されてい

ます。インポート時、Pyramix には、すべての現在のメディアの(マウントされた) 参照が必要です。 

インポート後、新たに制作されたコンポジションは、クリップとメディアの間のコネクションを、キ－プ

すべき Pyramix プロジェクトとして保存しなければ  なりません。 

 

Media Source ネ－ム(または、EDL 用語に添った Reel ネ－ム)、そして Source In と Source Out 

TimeCodes として、EDL をインポートしている間、メディアは捜されます。 

それで、再接続されるために、メディア Source と共にどのようなメディアでフォルダーがメディアファ

ィルであることがわかるクリップニーズは EDLでマッチングフィールド #2 と命名します。 

Source In と Source Out フィールドにマッチする、オリジナルの TimeCode と長さ、前の例の TEST, 

DAT12 または TAPE1 です。 

 

Source Names - FIXREEL 

 
メディアが EDL 参照箇所より異なった Source (Tape, Reel)名で作り出されることは、しばしば起こり

ます。このために、私くし共は Pyramix が EDL を解析している間に 1 つの Reel 名を別のものに取り替え

ることができる CMX 言語に特別なキーワードを追加しました。 

 

FIXREEL: DAT12 DAT012  ファイルの始めに加えられたこの序文は、現れた DAT12 というリール

名のすべてを、DAT012 に取り替えるでしょう。コメントアスタリスク(そして、スペースか TAB)が序文



の前に置かれるので、インポートにおいて、EDL は他のシステムで互換性があるままで残っています。: 

 

* FIXREEL: DAT12 DAT012 

 

また、Pyramix に告げるために、この行の終わりでキーワードの MEDIANAME, FILENAME または

FOLDERNAME を加えるのも可能です。 

Source ネ－ム(Tape, Reel)の代わりに、以下で Media ネ－ムか Media Filename の検索します。: 

 

* FIXREEL: DAT12 Ambiance43b MEDIANAME 

 

* FIXREEL: DAT12 d:¥pmxmedia¥dat12¥ambiance43b.wav FILENAME 

 

または、マウントされたメディアフォルダーの TimeCode で探すために。 

(これは、既存のデジタル化している素材の適合の種類です。) : 

 

* FIXREEL: DAT12 d:¥pmxmedia¥dat12 FOLDERNAME 

 

TimeCode に従ったキ－ワ－ドの OFFSET は、例えば、WAVE ファイルのように、参照されるべき(オ

リジナルのTimeCode、ソースTimeCode、タイムスタンプ) 原型なしで、示されたメディアのラインの

最後に加えることができます。 

 

* FIXREEL: DAT12 Ambiance43b MEDIANAME OFFSET 08:45:32:00 

 

* FIXREEL: DAT12 d:¥pmxmedia¥ambiance43b.wav FILENAME OFFSET 08:45:32:00 

 

これは、メディア再接続のほとんどのケースをカバーしていて、特殊なシステムによってエクスポートさ

れた EDLs の特別なケースの解決を助けるべきです。 

 

Media Reconnection Failure 

 

メディアが検索されていないインポートされクリップ、または現在のプロジェクトと違うサンプルレイト

のメディアは、'フェィク-偽物'メディアになるでしょう。 

 

インポートの後にメディアファイルを検索するのは、無理 です。しかし、ニューメディアファイルを標

準の方法で関連させるのは、可能でしょう。(メディアフォルダーからのメディアファイルをドラッグして

している間、コントロールキーを押してください。) 



CMX Autoconform 
 

CMX EDL がディスクの上のオーディオファイルによって伴わないとき、Autoconform が実行できます。 

Digitizing Session は、CMX EDL によって外部のマシンから参照をつけられたオーディオを捕らえる

のに使用されます。(これは、9-pin コントロールかシンプルなタイムコ-ドチェイスで操作されるかもしれ

ません。)そして、デジタル化しているメディアにリンクするために、(上で説明されるように)CMX EDL

を Editing Project の中にインポートすることができます。 

 

どうぞ、こちらもご覧下さい。: Digitizing Sessions 99 ぺ－ジ 

 

Reconform 
 

CMX Reconform 
 

Reconform 機能は、いわゆる「Change EDL」のロードによりプロジェクトに供給するための再切断を

容認します。この EDLは、「State 1 EDL」と「State 2 EDL」から作り出される標準の CMX EDLです。 

Reconform 機能は現在のプロジェクトの中で Cues を再配列します。それらは、ソースとしてオリジナ

ルの素材を使用しながらプロジェクトのすべてのトラックでの編集制作で、State 1 からState 2 までの変

化を反映するために、必要です。そして、新しいデスティネイション TimeCodes にそれらを置きます。 

 

メニュ－: Project > Reconform 

 

 

 

 

 

 

 

 

 

Project Menu - Reconform Sub-menu 

 

 

 

 



Relink to New Media 
 

CMX Import 機能と同様の、様々なオプションがある、ダイヤログを開きます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Reconform Relink to New Media Options dialog 

 

これは、すべてか、クリップの選択の 1 つの、ニューメディアへの再リンクを容認します。通常。 

これはクリップネ－ム、メディアネ－ム、Scene & Take 情報または、オリジナルのTimeCode に基づく、

24 ビットバージョン、とオーディオファイルの16 ビットバージョンの置換に使用されます。 

 

Relink Clips Media    オリジナルのクリップからひとつなぎを引き抜くためのオプションです。: 

 

Using current Media Tape Name 

Using current Media Name 

Using current Media File Name 



Using current Media Scene & Take 

Using Clip Name 

 

上記の適切な様々なオプション。: 

 

Ignore characters after finding…与えられたサブストリングが現れた後の文字列の残りを無視します。 

Ignore File Extension      最後のドット後のどのような文字も無視します。 

Match only … first characters  与えられたナンバー後のすべての文字を無視します。 

Scene & Take Separators    文字列から Scene ネ－ムとTake ネ－ムを切り離すのに使用され 

                                                                                                                                                           るための文字の選択を与えます。 

 

注意 : 注意 : Scene & Take がすでに、Media Scene & Take tag の中で、適切に切り離され

ているとき、このことは、Tape, Media および Clip Name だけに関連しています。 

 

To any other Media 検索するメディアからどの情報を使用したらよいか、見つけるためのオプショを 

                                                                                                     提供します。: 

 

Matching Media Tape Name 

Matching Media Name 

Matching Media File Name 

Matching Media Scene & Take 

 

By TimeCode in matching Folder name  名前が一致しているフォルダーで TimeCode が重なり 

                                                                                                                                                                                                         合う全てのメディア。 

 

By TimeCode and prompting for location フォルダーネ－ム/位置に入力をうながすTimeCode  

が重なり合う全てのメディア。 

 

By TimeCode in any media folder     重なり合うTimeCode がある全てのメディア。 

 

様々なオプションで。: 

 

Ignore characters after finding…  与えられたサブストリングが現れた後の文字列の残りを無視 

                                                                                                                                                                              します。 

Ignore File Extension        最後のドット後のどのような文字も無視します。 

 



Match only … first characters    与えられたナンバー後のすべての文字を無視します。 

Search In             どの Media Folder で検索するかの選択を示します。 

Search sub-folders         チェックされたのサブフォルダーが検索されたとき。 

Match Options           アルゴリズムのマッチングのためのオプションの提供。: 

 

Match exactly           両方の文字列は一致します。 

Match only minimum common available characters 

                                                                                                                                                                               Take 0001.new.01 はTake 0001 に合わせるでしょう。            

Original contains new Media    Take 0001 は 0001 に合わせるでしょう。 

New Media contains Original    0001 は Take 0001 に合わせるでしょう。 

Case insensitive          TAKE 0001 は Take 0001 に合わせるでしょう。 

Ignore characters…        例えば、/_+- が指定されると、12-A/ 0001 は12/A_0001に合 

                                                                                                                                                                               わせるでしょう。 

Ignore TimeCodes         Original TimeCodes (タイムスタンプ)でチェックをしませ 

                                                                                                                                                                                ん。これは、誤っているか、失ったタイムスタンプを持ったメ 

                                                                                                                                                                               ディアが、正しいものに取り替えられるのを容認します。そし 

                                                                                                                                                                               て、逆もまた同様です。 

Other Options 

 

Extend Edits to more tracks  複数トラックを参照するクリップを 1 つのクリップに一致させる場 

                                                                                                                                                      合、これら、すべてのトラックのために、参照するモノラルメディ 

                                                                                                                                                      アファィルに、新しいクリップ(同じフェードを含む、など…)を加 

                                                                                                                                                      えます。 

 

注意 :  一致させるオペレーションが複数のパスのケ－スでは、その後、このメニューアイテムで本機能

を実行できます。Tracks > Extend これは、タイムラインのトラックの 1 つかそれ以上のクリップ、

各々すべての Media チャンネルを適応させるために自動的にトラックのナンバーを拡張します。 

 

Color Clips that successfully relinked in Green 

ノーコメント 

 

Color Clips that failed relinking in Red 

ノーコメント 

Load Change EDL 
 

Reconform... ダイヤログを開いてください。: 



 

 

 

 

 

 

 

Reconform... dialog 

 

Reconforming プロセスの間、オートメーションの変更は元に戻すことができません。 

この理由で、コピーを保存、そして、それをリコンフォ－ムしてください。 

OK ボタンをクリックすると、“changes” EDL ファイルの選択を可能にするファイルブラウザウィンドウ

が開らきます。 

OK をクリックすると、CMX EDL Import Options, Confirm Frame Rate ダイアログが開らきます。 

 

 

 

 

 

 

 

 

Frame Rate が不正確であるなら、ドロップダウンリストから正しいものを選んでください。 

OK をクリックすると、リコンフォ－ムプロセスが開始されます。 
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Customizing Pyramix 

 

Customizing the User Interface 

 

Pyramix Virtual Studio は、ユーザインタフェースの相当量のカスタマイゼーションを可能にします。 

通常の Windows インタフェースの実現性は別として、Pyramix は Interface Editors 、ユーザが定義す

る Workspaces、カスタマイズ可能な Keyboard Shortcuts、およびユーザ定義の Macros を持って

います。 

Desktop Layout, TimeLine Layout、および Track Headers Layout は、Settings > All Settings 

> Application の中で、デザインされています。 

 

Workspaces 

ワークスペースは、Pyramix Project Editing Panel セッティングの多くをセーブするメソッドです。特

に Track Header の切り替えです。 

いったんセーブすると、今後の使用のために Workspace を素早くリコールすることができます。 

Pyramix Virtual Studio Window ツールバーの上のプルダウンメニュ－、または、Project Management 

Panel Tab を通してワークスペースにアクセスできます。 

‘Click here to add a new Workspace’(ここをクリックして、新しいワークスペースを加えてください。)

というTab Window の始めの台詞をクリックすることによって、新しい Workspaces を加えることがで

きます。 

テキスト入力ボックスは、あなたが新しい Workspace のための名前をタイプするために開きます。 

Return をヒットすれば、リストの最後に新しい Workspace を置きます。 

Workspaces は、名前をクリックすることによって、改名出来ます。 

選択して、'Delete’ key を押すことによって、Workspaces を削除できます。 

Workspace アイコンの名前の左をダブルクリックすることによって、Workspace は適用されます。 

または、メニュ－アイテム Workspaces > Recall > Recall Workspace (X) を選択しても適用されま

す。 

Workspaces によって覚えているパラメータは、適切なカラムをクリックすることによって、Workspace 

単位で選択可能です。 

‘Update on change’ カラムを設定するなら、‘Yes’(はい)と答えてください。別の Workspace が選択さ



れるとき、現在のすべての選択されたパラメータの状態は、現在の Workspace にセ－ブされます。 

 

Customizing Keyboard Shortcuts 

 

我々は、あなたに、デフォルトの Pyramix キーボードショートカットを学ぶよう、強く勧めております。 

これらは、10年以上もの間、オーディオ専門家達により編集、機材コントロ－ルにおいて使用されており、

強力で、迅速でもっとも効率的であります。 

しかしながら、既に別のスタイルのオーディオかビデオ編集になじみ深いのでありますなら、あなたは、

様々な Pyramix トランスポ－トと編集機能に、あなた自身の Keyboard Shortcuts の制作をお望みにな

っているかもしれません。 

 

あなた自身の Keyboard Shortcuts を定義するためには: 

 

1.  Toolbar より View > Customize > Keyboard Shortcuts を選んでください。 

 

2.  すべてのメニュー Commands はこのウィンドウの Tabs で一緒に分類されます。 

Command Functions グル－プのどのTab 選択しても、キーアサインを加えるか、または変えるこ

とができます。 

3.  適切な Command をクリックしてください。ハイライトします。 

 

4.  Press new shortcut key ボックスの中をクリックしてください。カーソルは点滅しているバーに 

なります。 

 

5.  今度は、Key とショ－トカット (例えば、Ctrl, Shift, Alt など)の希望の Key の組合せを押してくだ 

さい。これらはPress new shortcut key ボックスの中に現れます。選んだ Key の組合せが既に別 

の機能に割り当てられているかどうか、Pyramix の警告に注意してください。 

 

6.  Assign ボタンをクリックしてください。 

 

7.  ご納得ゆくまで Keys をCommands に割り当て続けてください。 

 

8.  Preset としてユーザに定義された Keyboard Shortcuts はどんなセットであれセ－ブ可能です。 

 そのためには、Save Preset ボタンをクリックしてください。次に Preset をネ－ミングしてくださ 

  い。同様に、以前にセーブした Preset をリコールするには、Presets ボックスの中をクリックして、 

  ポップアップリストから選択してください。数個の一般的な Presets が、Pyramix Virtual Studio 



  と共に出荷されていることに注意してください。Table は現在ログインしているユーザのシステムで 

 セ－ブされて、いかなる他のユーザにも影響を与えないでしょう。 

 

9. テーブルは、ファイルを Saved か Loaded することができ、他のシステムにおいてもそれができま

す。ただ Save Table か Load Table ボタンをクリックしてください。 

 

10. テ－ブルは、コマンドに関していくつかのコメントを持ったText File として、エキスポ－トできま 

 す。あなた自身のキーボードショートカットのコマンドリファレンスガイドとして印刷できるので、 

 これは非常に役に立ちます。 

 

Example: 
 

ビデオの編集バックグラウンドの多くのユーザは、J, K および Lキーに割り当てた、それぞれ Reverse、

Play、Stop そして Play になじみ深くなるでしょう。 

 

これらの割り当てを制作するには。: 

 

1. Settings > Keyboard Shortcut Editor または、View > Customize > Keyboard Shortcut  

Editor を選択してください。 

 

2.  Active Machine Tab を選択してください。 

 

3.  それを選択するために、Play Reverse Command をクリックしてください。 

 

4.  Press new shortcut key ボックスの中をクリックしてください。 

 

5.  J とタイプする。(注意、J は、どのような割り当ても、現代的では、有りません。) 

 

6.    Assign をクリックしてください。 

 

7.  Stop Command をクリックして、それを選択してください。 

 

8.  Press new shortcut key ボックスの中の J をダブルクリックすると、ハイライトします。 

 

9.  K をタイプしてください。 

 



10.  Assign をクリックしてください。 

 

11.  Play と L を代入するステップ 7～10 を繰り返してください。 

 

12.  Preset をセーブしてください。即座にアクティブになります。 

 

User Macros 

 

マクロは、シングルキープレスかコンビネ－ションで呼び出すことができる連続したコマンドです。 

マクロは音楽生産性への、非常に強力な武器になるかもしれません。 

 

ニュ－Macro の設定。: 

 

1.  Settings > Macro Editor か View > Customize > Macro Editor を選択してください。 

                        これはにより、Macros ウィンドウが開きます。 

 

1.  New Macro ボタンをクリックしてください、そして、次に、Macro をネ－ミングしてください。 

 

2.  様々なメニュー Command 機能は Tabs に一緒に分類されます。Command Functions のどのグ 

ループに Macro を加えたいか、その中の Tab を選択してください。 

 

3.  適切な Command をクリックしてください。ハイライトします。 

 

4.  << ボタンを押してください。Macro にコマンドを追加します。 

 

5.  ステップ  3～5 を繰り返して、完全になるまで、さらに Commands を Macro に割り当ててくだ 

                          さい。Keyboard Shortcuts を割り当てるために、前項で指示に従ってください。この場合、 

                           Keyboard Shortcut ウィンドウの中で Macro Tab を選んでください。あなたの新しい Macro 

                           は、オプションとしてこのウィンドウに現れるでしょう。 
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Applications 

Project Templates 
 

Pyramix は、様々なアプリケーションのための、多くの Templates をユーザに提供します。 

Template は完全な Pyramix Project です。活動の詳細なタイプにふさわしく構成され、どのようなオ－

ディオにも関連しません。Pyramix の外観は別として、また、テンプレートは、トラックレイアウトとミ

キサーデザイン、活動に合うよう、重要な最適化を含んでいます。 

特に、Pyramix Project は、少しの関連オーディオなしで特定のタイプの活動に合うよう構成しました。 

 

どうぞ、ご覧になられてください。: Optimizing Pyramix 381 ぺ－ジ 

 

また、これらのテンプレートは、あなた自身のカストマイズしているテンプレート制作のための絶好の出

発点を提供します。テンプレートを使用して、新プロジェクトを始めるために、Project > New from 

Template を選択すると、Select a Template ファイルブラウザが開きます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Select a Template dialog 



テンプレートが開けられるとき、ニュ－プロジェクトの、ユーザが求める Media Folder の選択をするダ

イアログボックスが現れます。プロジェクトが Save As オプションで保存されないと、初めてセーブす

るとき、Save As ダイヤログが現れるでしょう。 

 

さらに、それらは成長しているので、Templates は加えられるでしょう。 

新しい Template をセ－ブするために、File > Save as Template を選択して、ネ－ミィング、セ－ブ

してください。 

Virtual Multi-track 

マルチトラックレコーディングに適した多くの Templates を Pyramix に提供します。 

これらの Templates は既に、適所にすべての必要な設定があります。まさに、供給された Templates の

いずれも、あなたのタスクに適していないと、それは時間を節約するでしょう。 

あなたのニーズの最も近いものとして修正して、今後の使用のためのTemplate としてそれセーブします。 

 

Settings for Multi-track recording 
 

マルチトラックレコーディングは、ディスクパフォーマンス、DSP、およびホスト CPU 上で、過酷であ

る場合があります。目的のために Pyramix を最適化します。供給された Templates の 1 つを使用するの

でなければ、以下の設定が Record Page のなかに、作られているべきである。 

 

•  Track Numbers を平らにしてください。: OFF 

 

•  作成に失敗したなら、静かにしてください。: ON 

 

•  レコードの終わりに名前の入力をうながしてください。: OFF 

 

•  デフォルトのライブラリーにキ－プしてください。: OFF (いつもOFF であるべきです。) 

 

Suggested Settings 

 

•  レコードしたクリップをグループにしてください。: ON 

 

•  テイクナンバーを増やします。: ON 

 

•  トラックネ－ム名に接頭辞を付けてください。: ON 

 



まるでテープマシンであるかのように、直接、Project  のTracks にオーディオをレコードするために、 

Pyramix Virtual Studio を使用します。: 
 

1. Destination Drive, Resolution と Format をセットしてください。 

 

2. レコードしたい各 Track をア－ム(Arm)してください。この場合、各Trackを Record Ready モー 

                  ドに設定してください。(シンプルな Red Dot ) 

 

3. Mixer を使用して、インプットレベルをチェックしてください。そして、適宜調整してください。 

 

4.  Composition の録音を始めたい位置に Play Head Cursor を置いてください。 

 

5.  Transport Strip か Transport Window の中の赤い Master Record ボタンをクリックしてくだ 

さい。レコーディングが始まります。レコーディングに装備したそれらの Tracks に赤いバーが表示 

されるでしょう。 

6.  Transport Strip または、Transport Window で Stop (停止)ボタンを押して、レコーディングを

止めてください。Record Name ダイヤログボックスが現れるでしょう。 

 

満足したレコーディングができれば、Record Name ボックスに適切な名前をタイプしてください。 

そして、Good Take ボタンをクリックしてください。これは選択されたタイプのオーディオの Media 

File を選択された Media Drive へセ－ブするでしょう。それは、まさに選択したネ－ムであり、Timeline 

の位置に clip が置かれ、また、同じネ－ムです。レコーディングに不満足の場合は、Delete Take ボタ

ンをクリックしてください。そうすれば、レコーディングはセーブされないでしょう。 

3番目のオプションは Bad Takeです。Bad Take はセ－ブされます。そして、クリップはまさしくGood 

Take のようにTimeline に置かれます。しかし、clip のカラーは特定のカラーに設定されます。 

( Settings > All Settings > Application > TimeLine Layout  ぺ－ジで定義可能です。) 

そして、このような方法でナンバリングされます。: Take 1, Take 2, Take 3 (Bad 1), Take 3 (Bad 2), 

Take 3 (Bad 3), Take 3, Take 4, Take 5 (Bad1), Take 5, など。これは、ミステイクの場所のマネ－ジ

メントを助けます。ユーザはとにかくそれらをキ－プしたがりますので。 

あたかも、パンチイン能力を持ったテープマシンであるかのように、Pyramix Virtual Studio を使用

することにより直接オ－ディオを Project の Tracks へ Punch In できます。: 
 

1. 上の Destination Drive, Resolution および Format を設定してください。 

 

2. パンチインしたい Track を装備してください。この場合、各 Track を Record Punch In モ－ドに 

  設定してください。( Red Dot with 2 vertical bars  2 つの平行なバ－で挟まれた、赤い丸。) 



 (トラックへッダ－の丸い rec/play ボタンの上を alt-click してください。 

3. Mixer を使用して、インプットレベルをチェックしてください。そして、適宜調整してください。 

 

4. パンチインレコ－ドで In とOut のポイントをマークしてください。Track 上の選択した領域をマー 

 クするか、Time Scale バーの上に Mark In と Mark Out の設定をすることにより、それはなされま 

  す。選択領域を Track に示す最も簡単な方法は、Track をクリックして、ドラックすることです。: 

 より暗いグレ－の長方形は選択された領域を示しています。Time Scale バーの Shift-click には 

Mark In を設定する最も簡単な方法があります。:可動な赤い三角と垂直線はマークMark In を示し 

                 ます。Time Scale バーの Ctrl-click には Mark Out の最も簡単な方法があります。:可動な緑の三 

 角と垂直線はマークMark Out を示します。選択はパンチインのために Mark InとOut に優先します。 

 

5. マ－ク In ポイントか Selection 領域の前に Play Head Cursor を置いてください。 

 

6. Transport Strip かTransport Window で赤いマスタ Record ボタンを押してください。 

 Play Head は Composition を通して移動し始めるでしょう。そして、Tracks は再生を始めるで 

し ょう。再生中に選択領域か Mark In ポイントに達するとすぐに、レコ－ディングはア－ミングされ 

                  た Tracks で始まるでしょう。レコード中のそれらの Tracks は赤いバーで表わされます。 

 

7. 選択したアウトか Mark Out ポイントに達っすれば、レコーディングは自動的に止まるでしょう。 

  Composition の間、Play Head Cursor は再生し続けるでしょう。 

 

8. Transport Strip かTransport Window で Stop ボタンを押して、再生を止めてください。 

                     通常のレコーディングと同じオプションの Record Name ダイヤログボックスがあらわれます。 

 

Player/Recorder Mode 
 

Settings > All Settings > Project > Mixer > DSP Saving : Special modes セクション。 

 

このモードで、大きい構成(48 x 48チャンネルなどの)は単一のボードで動がすことができます。 

Player/Recorder Mode モードは、外部のハードウェアコンソールの使用のために意図されています。 

このモードがアクティブの場合、Pyramix ミキサーはシグナルルータの役割に追放されます。 

レベルコントロール、パン、プラグイン、およびインサートが全くありません。 

このオプションはマルチモノラルミックスバス構成だけで利用可能です。 

 

Pyramix Direct Out の機能性は同様の DSP セ－ビング代替の、そして、より多くのユーザが構成可能な

メソッドを提供します。どうぞご覧ください。: Channel Direct Outputs 168 ぺ－ジ 



Multitrack Editing 
 

Pyramix は理想的にマルチトラック録音を編集するのに適しています。 

すべてのトラックを越えて、クリップの分類は、レコーディングの編集決定に使用されます。 

結果として起こる編集でシングルか数個のトラックを聞いている間、編集変化はグループのすべてのクリ

ップに反映されます。トラック Grouping 機能は、あなたに合う方法で動作するのを可能にします。 

Source – Destination 編集モデルは、まさに 1つの可能性です。 

 

これらのセクションを どうぞご覧ください。: 

 

Grouping Clips on page     

 

Track Groups on page     

 

Source - Destination Editing on page     

 

Editing with Limited Hardware 
 

多くのトラックがあるマルチトラックレコーディング(たとえば、48 トラック 96kHz 24 ビットの音楽レ

コーディング)は、トラックのこのナンバーをサポートできないハードウェア上で編集できます。 

(例えば、ラップトップ。)シンプルに、聞く必要がないトラックをミュートしてください。 

 

Track Header の   ボタン。トラックスがここでミュートされて、むしろ、ミキサーの中でなく、デ

ィスクにアクセスしないでください。提供する Multitrack レコーディングの Clips は、すべてのトラック

を越えて、分類されます。そして、また、編集ガイド音に使用されるトラックで行われたどのような編集

変更も、ミュートしているトラックに反映されるでしょう。 

LTC sync 

EXAMPLE - where a cinema projector must be the master 
 

• シネマプロジェクタ－はメインに(クリスタルコントロールされます。) に続いて、二層性シグナル 

             を Biphase –LTC コンバ－タ－へ送ります。(例えば、Rosendahl BIF) 

 

• コンバータの LTC アウトプットは直接 Pyramix LTC インプットにおくられます。 

 

• Pyramix は "LTC sync" モードの用意ができています。そして、自身の内部クロックを LTC シンク 



          に適合させるでしょう。Pyramix がロックするように設定されて、外部の LTC が約 1 x 前方スピ－ 

            ドで再生されるのを認識されます。 

 

• Pyramix は Wordclock を通してDA-88(または、A/D コンバータとして使用される同様のマシン) 

             にそれの自己のクロックを提供します。 

 

• DA-88 (または、同等物)は外部の Wordclock と同期するように設定ができています。 

 

• DA-88 は順番に Pyramix TDIFドータカードインプットにディジタルオーディオデータを提供しま 

              す。 

 

Pyramix ソフトウェアのすべての LTC シンク弾道学は、ともに大きいロッキング範囲( -7 to +5%)を容

認するように入念に設計されています。まだ非常に低い瞬間のジッタを示している間、そして、より重要

に、コントロ－ルされた最高のスピードは、1ミリ秒あたり約 25 PPM (25 Parts Per Million/ミリ秒)よ

りマイナスにスロープを変えます。Wordclock アウトプットに接続された他のディジタルオーディオ設備

は、スムーズにクロックスピードを変化(どんな突然の速度変化も自由です。)できるよう提供されます。 

DA-88 などのTascam のデジタルマルチトラックと共に使用されると、完全なシステムが実際のマスタス

ピ－ド変化に従っている間、これで、Pyramix のTDIFインプット復号化サーキットリーは、分裂なしでデ

ィジタルオーディオデータをいつも順番に適切に解読できます。 

 

多分、DA-88 の LTCアウトプットを Pyramix がドライブするのはいくつかの状況で可能です。 

しかし、上の説明のようにあなたが正確に推奨のセットアップに従うならば、起こるべきでない、いくつ

かの制限をデモンストレーションするでしょう。DA-88 は、瞬時に1000 PPM (0.1%)の速度変化を示し

て、これは、もう一方の最後、適切に TDIF がデコ－ドするのを禁止することを覚えておいてください。 

Dubbing Mode 

主にフィルム再レコーディングに、このモードを使用します。レコードしている間のトラックア－ミング、

非ア－ミングを容認します。 

Dubbing Mode はこれらにより選択されます。  All Settings > Settings > Project > Record 

 

Enable Dubbing 
 
チェックすると、Dubbing Mode が作動します。 

 

Confirm Track Arming 

 



隣接しているチェックボックスの中で Dubbing Mode が選択されると、利用可能になるだけです。 

このボックスのチェックはこれらを意味します。レコードしている間のトラックア－ミングのどのような

変化も、新しい Record コマンドで確認しなければなりません。 

 

Example 
 

ステムでファイラルミックス記録するときには(例えば、Dialogue, Effects および Music)、確実なポイ

ントになるまで、以前のテイク、いわゆる Effects を残しておきたいだろうと言います。 

Dialogue と Music、Track Groups、転送の再生、希望のポイントでのパンチインレコ－ドのア－ミング

によってこれを達成できます。 

一旦、記録の中で、Effects Track Group は、シンプルにそれをア－ミングすることによって、適切な時

期にストレ－トに記録されます。または、Confirm Track Arming ボックスがチェックされ、それがア

－ミングされた場合、レコ－ディングを開始したいとき、セコンドレコ－ドコマンドを供給します。 

 (スクリーンの上、または、MMC, 9-pin などを通して) 

 

Virtual Tape Mode 
 

このメディアフォーマットタイプ/モードは、BWF ファイルの中に直接作られる、レアルな破壊的なパン

チであることを容認します。 

 

Virtual Tape Format 
 

別々のアプリケーションは、Virtual Tape が準備されるのを容認します。 

 

Start > All Programs > Pyramix > Virtual Tape Format 

 

アプリケーションを実行する前に、直接後で、Mac か NTFS にディスクのプラグを差し込むのがお望みで

したら、10’000 RPM SCSI ディスク使用 FAT32 をフォーマットしてください。 

あなたがセッションの終わりに、別のディスクにファイルをコピーするつもりであるなら。 

 

ディスクをフォーマットするときには、Sector Allocation Unit Size として 64K を使用してください。 

 

Virtual Tape Format アプリケーションを発進させてください。そして、これらのパラメータに希望の設

定をしてください。: 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

Virtual Tape Format Application Window 

 

Sampling Rate 

Bit Rate 

Number of Tracks 

TimeCode In (Original TimeCode / TimeStamp) 

Length of the tape 

 

Check the ‘NTSC Non-Drop’ box 1001/1000 で(仮想的に)動くテープを動かしたいのであれば、

(これはただ、TimeStamp とLength が確実に正しくなるようにします。) 

Choose a location in the SCSI drive where you wish to create the tape 

Click Format New Tape 

 

1セットの(わずかにエンハンスされています)の BWF ファイルは、ターゲットフォルダー( 1ラックあたり

1つ)で制作されるでしょう。 

 

1フォルダーあたり、one Virtual Tape しか出来ません。 

アプリケーションは、フォルダーに1つが既に存在する 2番目のテープの制作を拒否するでしょう。 

これは、Virtual Tape Format によって作られたディスクの上で、ブロックインターリービングを抑え込

むでしょう。したがって、一度制作されたテープを移したり、またはコピーを試みないでください。 

別のディスクからの “template tape” (テンプレートテープ)のコピーを感じても、より迅速でしょう。そ

して、それは適切にディスクブロックにテープブロックを並べないでしょう。 

 

結果としてのファイルは、標準の BWF ファイルであり、いかなる他のアプリケーションでもそういうも



のとして認識されるでしょう。 

 

Pyramix だけがそれらを Virtual Tapes であるとみなします。将来、私たちは、ダビングセッションが終

わったとき、彼らを編集するのを容認するために Pyramix にそれらをTapes の代わりの BWF ファイルと

みなすことを決めさせる方法を見つけるつもりです。 

(一時的な解決に関して、以下の Known Limitations を見てください。) 

 

Pyramix Settings for Virtual Tape Mode 
 

Pyramix を開いて、Settings > All Settings > Application > Playback/Record ぺ－ジの中に進ん

でください。 

 

• Playback Buffer Size エントリボックスに ‘262144’ の値を入力して、‘Set’ をクリックしてくだ 

            さい。 

 

• Record Block Size ボックスで 96 KB を選択してください。 

 

• Jog/Chase ページで、あなたは‘Silent Chasing’ のチェックを外すべきです。チェックしてもこ 

             の設定はロッキングタイムを減少させるでしょう。Record する前、Pyramix がロックされた後に 

              Virtual Tape バッファがいっぱいになるのを、まだ待たなければならないでしょう。 

 

• Uncheck ‘Generate waveform automatically at clip insertion’ Layout ページで Uncheck 

                     してください。 

 

• Virtual-TapeFormat アプリケーションで指定したトラックと同じナンバーで、Pyramix レコーデ 

            ィングプロジェクトを制作してください。 

 

• 確実に'テープ'に対応する、正しいサンプルレイトを選択してください。 

 

• テープを制作されたフォルダーをマウントしてください。 

 

• テープを選択して Media Manager メニューで Edit > Place を選択してください。 

 ‘Place at Original TimeCode on Original Track’ を選択して、OK をクリックしてください。 

 

• メニューアイテム View > Zoom > Fit in Window を選択してください。 

                     あなたのテープは Timeline の適切な位置にあるはずです。 



• さあ、Project > Information & Settings : Record Settings Page: に進みましょう。 

 

• あなたのテープが存在する Media Folder を選択してください。 

 

• テープに指定した Resolution を選択してください。 

 

• Formatボックスの中で ‘Virtual Tape’を選択してください。 

 

• Dubbing Mode をEnable に。 

• One file per track をチェック。 

• Flatten track numbers をアンチェック。 

• Don’t create Playlistsをチェック。 

• Name is Scene & Take をアンチェック。 

いつもの通り、現在、Pyramix を使用できます。 

 

Note the Following: 
 

• どのようなパンチインもVirtual Tape に破壊的に実行されるでしょう。アンドゥが全くありません! 

 

        • どんな新しいクリップも、各パンチインにより制作されて、基礎となっているテープだけが変更され 

                     るだけでしょう。 

 

• テープのアウトサイドでの、どのようなパンチインも失敗するでしょう。 

 

Known limitations: 
 

• テープの新鮮な部分で(まだ無音で静か)でのパンチインは、パンチインポイントに小さいクリックを 

              生じるかもしれません。Virtual Tape Mode のパンチ-イン関するフェードはすぐ、実行されるでし 

              ょう。 

• 当分、波形サポートが全くありません。 

 

Discontinuous TimeCode 

Auto-Punchモードで、不連続なTimeCode があるテープ全体は自動的にレコードされます。 

 

• 望むトラック全てをオートパンチモードに設定してください。 



• 00:00:00:00 に Mark In を置き、23:59:59:24 に Mark Out を置いてください。(新プロジェクトの 

  デフォルト値)。 

• Pyramix へ、テープマシンからの LTC Out を差し込んでください。 

• Chase モードを HARD CHASE にセットしてください。 

• テープを巻き戻してください。 

• テープマシンの Play を押してください。 

 

有効な TC に遭遇するたびに、Pyramix はロックして、新しいクリップをレコードし始めるでしょう。 

その後、タイムコードがジャンプするときに、止まります。 

別々のメディアファイルは、テープ上の、それぞれ連続したタイムコードにより制作されるでしょう。 

Metronome / Click Track 

Metronome か Click-Track を入手するには、最初に、以下に行って、Bars & Beats ルーラーを手に

入れてください。:View > Scales / Toolbars そして Bars & Beats をクリック。 

(あるいはまた、キーボードショートカット ALT + B を使用します。)同様に、Bars & Beats Settings 

ダイヤログを開いてください。サブメニューの View > Scales / Toolbars 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Bars & Beats Settings dialog 



新しいものを加えることによって、適切に必要な Tempo をセットアップしてください。 

まず最初に、Tempo と Smoothing 値を選んでください。そして、次に、Start とEnd  回数を小節とビ

ートにはめ込んでください。Add Tempo ボタンをクリックして、新しい Tempo をリストに加えてくだ

さい。あなたは何か他のものの削除を望んでいるかもしれません。 

 

ヒント: View > Scales / Toolbars > Tempo Map を選択して Timeline の新しいTempo 

を確かめてください。 

 

Tempo (bpm)  あなたがドロップダウンリストの共通の値からテンポを選ぶことができます。 

1bpm ステップの上下のボタンを使用して増、減させ、または直接ボックスに値をタ

イプしてください。 

Smoothing    Note と 1/64 の間の値で選択が可能です。(または、OFF) 

Start 
End 

インフォメ－ションパネルは現在、決めたすべて Tempos を表示しています。 

Tempo, Smoothing, Start ならびに End フィールドは強調表示された(選択された)テンポの値を反映

します。 

Add Tempo   他のテンポを加えます。 

Remove Tempo リストから強調表示された(選択された)テンポを削除します。 

次に、Metronome Settings... ボタンをクリックしてください。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Metronome Settings dialog 



ドロップダウンリストからの Metronome 音のコンソールストリップを選んでください。 

 

Bars, Beats および Grid 音に、どんなオーディオファイルも使用できます。デフォルトでは、いくつか

の適切な WAV ファイルが Pyramix と共にあなたが Pyramix ソフトウェアをインストールしたのと同じ

位置にインストールされます。デフォルトでは、 これは以下の通りになるでしょう。: 

 

C:¥Program Files¥Merging Technologies¥Pyramix Virtual Studio¥Metronome Bars.wav 

etc. 

 

Attack Offset パラメータは、タイミングの調整を可能にします。、そして、Level データ入力フィール

ドの値は、選択された音の再生レベルを決定します。 

 

Midi Files Import / Export 

Load 

Save 

 

両方のボタンは、ロードするファイルか、保存する位置へのナビゲーションを可能にするために Browser 

Window を開きます。 

 

現在のところ、type 2  のミディファイルがインポートされるとき、トラック1 のテンポ地図と

シグネチャだけがインポートされます。 

 

Reconforming to Original Media from Avid &/or OMF 

 

以下で説明します、手続きに関する詳細設定のための、どのような特別な規則も存在しません。 

それはユーザからユーザ、プロジェクトからプロジェクトなどに、変化するかもしれません。 

本当に、オリジナルのレコーディングのネ－ミングを含む特定のワークフローを定義するのは、ユーザ次

第です。ステレオ/オリジナルバージョンを Avid にインポートして、Video Editor が正しいネーミング、

メタデータなどのトラックを確実にキ－プします。メソッドが一度、適切に定義されて、そして、ワ－キ

ング、規則はその後与えられたプロジェクトにかかわるすべての人々にその意思をはっきりと伝えるべき

です。 

 

Philosophical Point 
 

New Media への再構築は、いつも Relink to New Media ダイヤログでいくつかのデリケートで汚い実



験を必要とします。通常、これは Pyramix Media Manager で Clip Properties とMedia インフォメ－シ

ョンにおける、Clip 情報の比較を必要とします。かつてのネーミング構造の中に、ある種の一致を見つけ

ることができます。全体の突然の処理は、驚くほどシンプルになります。TimeLine 全体は、ハッピ－グ

リ－ンのクリップになり、個人的な驚くほどの達成感は、いつまでも、あなたのものです。 

 

以下の例は、判断できて、あなたの特定のニーズと要件にマッチするように自由自在に解釈されるべきで

す。 

Procedure 
 

• Avid から OMF をインポートしてください。(Avid メディアがなくても、それは必要ではありません。) 

 

• オリジナル Multitrack セッションメディアをマウントしてください。 

 

• Project > Reconform > Relink to New Media を選択してください。 

 

• 現在の困難な部分: 試みてください。OMF からインポートされた Clips で、また、オリジナルのメディ 

             アプロパティの中で、どのようなマッチしている情報(Clip Properties の)も見つけることができます。 

 

• 例えば、Clip Names が Original Media File Names にマッチするのがわかるでしょう。しかし、Clip 

         Names は事実上、Scene & Takes であり、むしろOriginal Media Scene & Take などにマッチす 

            ることを、非常にうまく見つけることができます。 

 

( OMF が CMX より一層、Clip Names、Metadata、Time-Codes などの情報を含むことができます。) 

 

それは最終的にオリジナルのメディアが(BWFメタデータ)をレコードしている間、どのように記録されて

いるか、そして、Video Editor とMedia “Ingester” がどのように Media とClips を Avid に記録したかに

すべてよります。 

 

再び申しますが、前述のとおり、規則が全くありません。そして、それがユーザからユーザ、プロジェク

トからプロジェクトに変化するかもしれません。 

 

Suggested procedure for managing a workflow 
 

• BWF の TimeCode がある Original Media をレコードしてください。それらを Take1, Take2,Take3 

             などとネ－ミングしてください。または、容易に理解できて、検索できる名前にしてください。 

 



• オリジナルとして、 Multitrack レコーディングファイル、WITH THE SAME NAME の BWF 16ビッ 

            ト Stereo Render を制作してください。 

 

• これらのファイルを Avid にインポートしてください。確実に、すべてのクリップが、Media Name か 

              File Name をキ－プするこれらの Media から制作されます。 

 

• ビデオ編集から OMF をエクスポートしてください。そして、Pyramix (メディアのない)でそれをイ 

             ンポートしてください。 

 

• その後、Original Media File Name に OMF Clip Name にマッチするべきです。または少なくとも、 

              Video Editor が Clip Names、Original Media Name または File Name を持った OMF－ 

          Media Names によりゴチャゴチャにされた場合にです。 

 

• 一度、Relink 手続きは首尾よく達成されたことがあります。- とします。すべての Clips にOriginal 

          Media の最初のトラックに参照をつけさせるべきです。 

 

• - そして次に Tracks > Extend に進んでください。拡張したいトラックを選んで Auto-Detect を選 

              択してください。オリジナルマルチトラックレコ－ディングのトラックのナンバーに応じて、すべて 

              のクリップを拡張するでしょう。 

 

Summary 
 

Reconform が何かうまくいかないなら、(認識されなかった SD2 ファイルは別として、どうぞご覧くだ

さい。: File Interchange with Apple Macintosh 317 ぺ－ジ) 
Clips とMedia の間のある種のタイミングかワ－ディングミスマッチを探してください。 

そして、あなたのトポロジーにマッチする THE ONE を見つけるまで、ご遠慮なく、Relink to New 

Media Dialog でのいくつかの異なった設定を試してください。 

 

Broadcast WAV file Tips. 
 

File Types 
 

BWF ファイルには 2 つのタイプがあります。: 

 

BWF P はポリフォニックの -> マルチトラックを意味します。 



BWF M は 1トラックあたり 1 個のファイルのモノフォニック -> モノフォニックを意味します。 

 

Avid の人々の中には Cantar ロケ－ションレコーダーが、BWF-M ファイルだけを作り出して、BWF-P

が欲しい人もいます。BWF M BWF P を変換するために、Media Manager でファイルをマウントしま

す。その後、Convert > Quick Export を選択して、One file per Track オプションを チェックしな

いで ください。 (必要なら、チェックを外します。) 

また、オリジナル BWF ファイルの現在のすべての SceneとTakes 情報は結果として BWF-P ファイルで

エクスポートされるでしょう。 

 

Metadata 
 

BWF ファイルはメタデータを含むファイルに特別なチャンクを持っています。；これは BEXT チャンク

か Broadcast Wave File メタデータと呼ばれます。 

 

このチャンクの最初のフィールドは解説です。これは私たちがファイルネ－ムの代わりに、BWF ファイ

ルのための Name カラムに表示するフィールドです。私たちは PMFとOMF のために同じようにします。 

私たちはメタデータを全く持っていない、Wave、AIFF および SDII のために本当のファイル名を表示す

るだけです。 

v4.2.6 以上では、また、すべてのファイルの本当のファイルネ－ムを表示するために、 FileName カラム

を加えることができます。  (Media Manager window View > Options : Columns tab) 

 

Media Manager で一度両方をリネ－ム改します。 BWF ファイルの Description フィールドとファイル

ネ－ムをアップデートするべきです。 

 

Digitizing a Tape with Discontinuous TimeCode 

 

Pyramix は自動的に、TimeCode が連続していないテープ全体をレコードすることができます。: 

 

• Auto-Punch モードに望むすべてのトラックをセットしてください。 

 

•  Mark In を 00:00:00:00 にそして Mark Out を 23:59:59:24 に置いてください。(これらはニュ－プ 

                 ロジェクトのデフォルトです。) 

 

•  Pyramix へテープマシンからの LTC Out を挿入してください。 

 



•  Chase モードを HARD CHASE にセットしてください。(Settings > All Settings > 

              Jog/Chase : Chase Settings -Chase Mode ) 

 

•  テープを巻き戻してください。 

 

•  テープマシンの Play を押してください。 

 

•  有効な TC に遭遇するたびに Pyramix はロックして新しいクリップをレコードし始めるでしょう。 

                  TimeCode がジャンプすれば、止まります。その結果、別々のメディアはテープ上のそれぞれの連続 

                 したTimeCode で制作されるでしょう。 

 

Loop Recording with simultaneous Playlist Creation 

 

•  Settings > All Settings Project > Record Page の Create an Empty Playlist for each 

             Recording オプションをチェックしてください。 

 

•  Auto Punch モードに必要なトラックを入れてください。(トラックア－ミングを Alt + click、トラ 

                  ックア－ミングボタンは    で表示されます。) 

 

•  レコードするリージョンの周りに Mark In と Mark Out を置いてください。 

 

•  Chase Mode (望ましくは Hard Chase)に Pyramix を入れてください。そして、LTC インプット 

                 をチェイスしてください。 

 

•  Mark In の少し前にスタ－トする、およそ 2 つの境界のル－ピングを Pyramix にフィ－ドする 

                  TimeCode を持ってください。そして、Mark out の少し後、ストップしてください。 

                (Preroll Postroll を作るために。これらは Pyramix が適切に同期できるくらい大きいはずです。入 

                 って来る TimeCode へのロックします。) 

 

•  Pyramix は次に、各ループのために同期して、ロックするでしょう。Mark In で録音に入り、そして、 

                  Mark Out で止めてください。そして、それぞれのループ反復のために新しい PlayList を制作してく 

                  ださい。 

 
注意せよ。これは、外部の TimeCode ソース/ジェネレータが、参照 TC ループを作り出すのに使用され

るのに必要とします。 



TimeCode Midnight 

 
ディバリアに近い、または越えるプロジェクトのTimeCode にシンク/チェイスする必要なユ－ザ－のた

めに(それを Zero か 24 hours にしてください。)  

Pyramix では、Settings > All Settings > Application > Jog/Chase ページの Allow chasing 

across midnight オプションを用意しています。 

 
この設定がアンチェックのままであるなら(デフォルト)、Pyramix カーソルはいつも正確な与えられた

Time-Code に続くでしょう。したがって、厳密に Pyramix タイムラインの「ゼロ日目」のままになりま

す。よりセキュリティと安心のために、真夜中のバリアを越えている間、ロック(locked)された状態に 

Pyramix  があるなら、次に、この設定がアンチェックの状態でさえ、シンクしてプレー、または、レコー

ドしている間、真夜中からのゼロまで即座のジャンプはありえないでしょう。Out of-lock ステータスが認

識されるまで、プレ－、若しくはレコーディングは、シームレスで、とぎれないままで残っていて、デェ

イバリアを越えるでしょう。再チェィスは、現在入って来る TimeCode によりトリガ－されるだけです。 

 

Editing Multitrack Recordings 

 
トラックを全部聞かないで、Multitrack レコーディングの編集するには、まさしく Mute して Hide して 

ください。それでも、残って目に見えているものに実行されたすべての編集は、すべての他のものに起こ

るでしょう。そして、目に見えるオーディオだけがモニタリングのために再生されるでしょう。(例えば、

ステレオガイドミックス) 

 

Film 24 to NTSC Sync 

 
ここに、NTSC Sync への Film 24 の最も一般的な Scenarios のいくつかの設定があります。 

プリセットを全てはここにあります。Settings > All Settings > Hardware > Formats & Sync 

Mix/Editing for TV shot in NTSC and 48 kHz and edited in sync with NTSC 
equipment: 
 
• Frame Rate を NTSC Drop に設定してください。 

 

• Video Format を NTSC に設定してください。 

 



• Sampling Rate を 48 kHz に設定してください。 
 
• Varispeed を Nominal に設定してください。 
 
Result: FR = 29.97 SR = 48000 Video Input = 29.97 (Standard for TV, Audio at 48kHz in sync 

with 29.97 while Shooting, Post and Diffusion) 

 
Mix/Editing for Film shot at 24 fps and 48kHz but edited in sync with NTSC 
equipment: 
 
• Frame Rate を Film (24 fps) に設定してください。 
 
• Video Format を NTSC に設定してください。 
 
• Sampling Rate を 48 kHz に設定してください。 
 
• Varispeed を Pull-Down に設定してください。 
 
Result: FR = 23.98 SR = 47952 Video Input = 29.97 (Standard for Film, Audio at 48kHz in sync 

with Film 24fps for Shooting and Diffusion, but at 47952 in sync with 29.97 for the Post with Film 

24 running at 23.98) 

 
Mix/Editing for Film shot at 24 but converted 3:2 to 30 frames and edited in sync 
with NTSC equipment: 
 
• Frame Rate を SMPTE Non-Drop に設定してください。 
 
• Video Format を NTSC に設定してください。 
 
• Sampling Rate を 48 kHz に設定してください。 
 
• Varispeed を Pull-Down に設定してください。 
 
Result: FR = 29.97 SR = 47952 Video Input = 29.97 (Standard for Film, Audio at 48kHz in sync 

with Film 24fps for Shooting and Diffusion, but at 47952 in sync with 29.97 for the Post with Film 

converted to 30 running at 29.97) 



Special case: 
 
Mix/Editing for Film shot in High Def at 23.98 fps and 48kHz and edited in sync 
with HD NTSC equipment like D5 or other: 
 
• Frame Rate を 23.98 に設定してください。 
 
• Video Format を Trilevel 24/1.001 に設定してください。 
 
• Sampling Rate を 48 kHz に設定してください。 
 
• Varispeed を Nominal に設定してください。 
 
Result: FR = 23.98 SR = 48000 Video Input = 23.98 (For Film shot in HD 23.98, Audio at 48 kHz 

sync with Film 23.98 while Shooting and Post. Caution: The Audio needs a Pull-Up to run in 

sync with the Film if printed a real Roll) 

 

Checking AC3 encoded files in Pyramix 

AC3 の 2 タイプのエンコ－ドされたファイルは、Pyramix でプレーバックできます。: 

 

ファイルが .ac3 ファイルとして作り出されたなら、その後、Pyramix  は即座に自動的にデコ－ドし、オ

ーディオの 6 チャンネルをプレーバックします。 

ファイルが wav ファイルとして作り出されたなら、その後、Pyramix は、ファイルが Wave であるとみ

なすでしょう。そして Pyramix は、外部のデコーダを与えるために、そのアウトプット(デジタル)をデジ

タルエンコード化された AC3 の 2 個のチャンネルで再生します。 

 

大部分の AC3 エンコーダはエンコーディングしている間、簡単に再生するために、Wave ファイルの中に

エンコードしたシグナルを埋め込むことを容認します。 

例えば、Minnetonka SurCode はこの特徴を提供します。 

 

Working with External Machines 

 

Use Auto-chase 
 



Auto-Chase は便利です。Internal Machine、例えば Pyramix と External Machine かその他のマシン

群との間で、頻繁にコントロ－ルの切り替え行うわずらわしい状況でそれをボタンワンプッシュで解決し

ます。 

すべてを可能にするなら、マシンは Auto-Chase に設定してください。 

マシンの間で Ctrl が切り替えられるとき、Active Machine は自動的に Chase モードから取り出されま

す。そして以前の Active Machine は自動的に Chase モードに入ります。 

すべての外部のマシンを Auto-Chase で使用開始するには、以下のメニュー・セットを可能にしてくださ

い。: 

Machines > External Machine > Auto-Chase 

 

そして内部のマシンを Auto-Chase にするために、以下のメニュー・セットを可能にしてください。: 

Machines > Internal machine > Auto-Chase 

 

Using Freeze Mode 
 

•  画像のサウンドワ－クに Pyramix を使用しているなら、Freeze Mode は非常に強力なツールです。 

                  例えば、同期していない車のドアのバタンゴトンという音の配置には、以下の操作をしてください。: 

 

•  すべてのマシンがドアがばたんと閉まるところにポイントの画像を置くためにオンライン Transport 

コントロールを使用してください。 

 

•  Freeze ボタンを押して、外部のマシンをフリ－ズしてください。 

 

• ドアのバタンゴトン音を持っているクリップを選択してください。 

 

• 衝撃の頭に Clip Sync Point を置いてください。 (Clip Sync Point をクリックアンドドラッグ、 

                  または Playhead Cursor を置いてください。そして、Clips > Set Sync Point to Cursor を選択 

                    してください。) (Ctrl + M) 

 

•  Freeze を押してください。そうすれば、Playhead Cursor は Freeze がアクチブにされたポイント 

                  までジャンプするでしょう。 

 

•  さあ、Clips > Send Sync Point to Cursor (Ctrl + Alt + M) を選択してください。そうすればク 

                  リップは、Sync Point が Playhead Cursor の位置に移動し、バタンゴトンという物音は画像とピッ 

                  タリ同期します。 

 



Creating tracks via paste 
 

これはトラック制作の近道です。 

 

クリップが Media Management か Library からトラックが全く存在しない TimeLine の空白の領域にド

ラッグ、ドロップ、コピー、またはぺ－ストされるなら、十分な数のトラックは、クリップのチャネル数

に適応する最後に存在するトラックの下で制作されるでしょう。 
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Remote Control 

 

Pyramix はコントロール、そして、さまざまな外部のハードウェアによりコントロールすることができま

す。 

Control of External Device 

Pyramix が別のマシンをコントロールしているなら、(GPO コントロールを除いた) External Machine 

としてこのデバイスをセットアップしなければなりません。 

 

External Machines 

 

9-pin (Sony P2 protocol) 

 

9-pin Control of External Machine 

 
Pyramix から 9-pin のスレイブマシンをコントロールするのがお望みでしたら、外部のマシンとしてター

ゲットマシンをセットアップしなければなりません。外部の 9-pin コントローラー/シンクロナイザ－から

スレーブとして Pyramix をコントロールするのがお望みでしたら、Remote Controller として Pyramix 

に外部のコントローラーを設定しなければなりません。 

どうぞご覧になってください。: Control by External Device 377 ぺ－ジ 

 
以下に注意してください。: VT クライアントが 9-pin コントロールを必要とし、使用するために

のみ、Virtual Transport の 9-pin ドライバーは用意されています。 

         現在のところ、STAND ALONE として使用されているとき、これは VT Video Player だけを意 

          味します。 

 

Connection for the Sony 9-Pin protocol 
 

どうぞご覧になってください。: Appendix IV 9 - Pin connection       

 

外部マシンの PC's COM ポートと RS-422 コネクタの物理的コネクションの説明のためのぺ－ジです。 



Setting up an external machine 
 

• Settings > All Settings Remote Control > Machine ページを選択してください。 

 

• Add ボタンをクリックしてください。 

 

• Nameフィールドの中に"Betacam" などのように外部マシンにふさわしいネ－ムを入力してください。 

 

• ドロップダウンリストからマシンの Driver を選んでください。Sony 9-pin 

 

• Enable フィ－ルドをチェックしてください。 

 

• Driver Properties を調整してください。あなたのニーズに従った Port Properties と設定。 

 

どうぞご覧になってください。: Sony 9-Pin Protocol Configuration (Machine) 441 ぺ－ジ 

 
• OK をクリックして、すべてのエントリを確認して、新しいマシンをリストに加えてください。 

 

Chase Synchronizer 

 
このオプションを持つ、Pyramix は、外部の 9-pin (Sony P2 protocol)のマシンを連動させることがで

きます。それは TimeCode をチェイスできません。 

 
Pyramix への要求からマシンへの TimeCode はコネクトされません。 

Chase Synchronizer は必要な位置と共に外部のマシンから来る TimeCode を比較します。 

(もしあれば、オフセットを含んでいます。)そして、マシンを連動させるように転送命令を送ります。 

 

Practical Machine Control 
 
Machine コントロールは、しばしば混乱の源です。 

Oasis Protocol などの Pyramix の特徴は極シームレスで外部のマシンのコントロールを作ります。 

 

 

 



Hardware Control Surfaces 
 

ハードウェアリモートコントロールは Merging Technologies Oasis プロトコルで実行されます。 

それは、固有のプロトコル、MIDI または 9-pin (Sony P2 protocol)。 

いくつかのポピュラーなコントローラーにテンプレートを供給するか、または、あなた自身の MIDI コン

トロールサ－フェスを Pyramix にマッピングできます。 

 
以下のコントローラーとデジタルミキサーはサポ－トしています。(または、するでしょう。) 

(適切な Pyramix オプションキーズが存在しているなら。) : 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



サポートされたコントローラー/コンソールに関するこのテーブルとダウンローダブルな User Guide 

ドキュメントの最新版は、以下にございます。 

 

www.merging.com 

 
次にこちらを選択してください。: Pyramix : Download : Documentation : Controllers 

そして、ダウンロードのために必要なドキュメントを選んでください。 

コントローラーとコンソールメーカーとのリンクに関しては、以下にございます。 

 

www.merging.com 

 
次にこちらを選択してください。: Pyramix : Controllers そして、関連メーカーリンクを選んでくだ

さい。 

Control by External Device 

 
Pyramix が別のデバイスによってコントロールされるのであるなら、 

これらは、Settings > All Settings Remote Control Controller によりインストールされます。 

そして、適切であるところでは、Pyramix の機能は、以下によりコントローラーにマッピングされます。 

Settings > All Settings > Project > Controller Mapping ページ 

 

9-pin Control of Pyramix by an External Machine 

 
スレーブとして外部の 9-pin コントローラー/シンクロナイザーから Pyramix をコントロールするのがお

望みでしたら、次に、Controller として Pyramix に外部のコントローラーを設定しなければなりません。 

Pyramix が 9-pin コントローラーとして動作するのがお望みでしたら、例えば、次に、オーディオかビデ

オテープレコーダがターゲットマシンとしてコントロールする External Machine としてセットアップし

なければなりません。 

どうぞご覧になってください。: Machine      

 

以下に注意してください。: VT クライアントが 9-pin コントロールを必要とし、使用のためだけに、

Virtual Transport の 9-pin ドライバーは用意されています。 

現在のところ、STAND ALONE として使用されているとき、これは VT Video Player だけを意 

味します。すなわち、同じマシンの上を Pyramix は、走りません。 

 

http://www.merging.com
http://www.merging.com


GPI / GPO Support 

GPI/O サポートはRemote Controller モジュールとして利用可能です。 

 
以下に 注意 してください。 : 現在のところ、opto-electronic インプットとリレーアウトプットが 

SealOドライバーによってサポートされている状態で、このモジュールは USB と PCI ボードを含む 

Jworks とSealevel モジュールから GPI/O アダプターに USB をサポートするだけです。 

 
http://www.j-works.com 

 
http://www.sealevel.com 

 

j-works デバイスのための Windows XP/2000ドライバーはMerging Technologies から利用可能です。: 

 

http://www.merging.com 

 
以下に 注意 してください。  : SealOドライバーは Pyramix の前に必ずインストールしなければな

りません。 

 

Using the GPI/O controller 

Add a GPI/O Controller 
 
Pyramix がアダプターを使用可能になる前に、それをセットアップしなければなりません。 

Settings > All Settings > Remote Control > Controller ぺ－ジを選択してください。 

 
Add ボタンをクリックしてください。Controller Properties ダイヤログが開きます。 

Controller のための名前をタイプしてください。そして、Driver ドロップダウンリストから GPI/GPO を

選択してください。OK をクリックして、ダイヤログを閉じて、次に OK をクリックして、Pyramix 

Settings ウィンドウを閉じてください。 

 

以下に 注意 してください。 : 一度以上しないでください。(Only one) 1つの GPI/GPO コントロー

ラーだけが容認されます。しかしながら、これは 1つ以上の物理的 GPI/GPO USB Module をコン

トロールすることができます。 

 
Enable/Disable 

 

http://www.j-works.com
http://www.sealevel.com
http://www.merging.com


GPI/GPO コントローラーは、Controller Properties Dialog で Enable ボックスのチェックを外すこ

とによって、不可されるかもしれません。Driver コンボボックスの右の Properties ボタンをクリックす

ることによって、いくつかの GPI/GPO USB Modules を個別に有効、または不可することができます。 

 
Configuring the GPI/O controller for a specific project 
Settings > All Settings > Project > Controller Mapping ページを開いてください。 

GPI/O コントローラーを選択してください。そして、Properties をクリックしてください。 

GPI/O Controller Configuration Window が現れるでしょう。; 

左に、あなたは Remotes リストをブラウズできます。その横に、GPI/O Controllers リストがあります。 

GPI/O Input か Output ピンにRemote をマッピングするには、ただ Controller ピンに Remote をドラッ

グしてください。; 

右手パネルはすべての現在マッピングしている Controller ピンのリストです。 

Mapping Options カラムをクリックすることによって、ピンがどう働くかを構成できます。 

 
OK をクリックして、GPI/O 構成、または中止(キャンセル)への変更を受け付けてください。 

 

GPI/O Remote types 

 
GPI/O Input そして/または Output ピンとして使用される Remote の 5 つの異なったタイプがありす。: 

 

• Toggle はインプットとアウトプットピンの両方を結び付けることができます。 

 

• Range はインプットとアウトプットピンの両方を結び付けることができます。そして、toggle 0 =off, 

             other = on のように作動します。 

 

• Event はインプットピンのみを結び付けることができます。 

 
• Event-Status はインプット、と/または、アウトプットピンを結び付けることができます。; 

 
• Status はアウトプットピンのみを結び付けることができます。 

 
他の Remotes は GPI/O ピンにマッピングをすることはできません。 

 

GPI/O Input and Output Pin Configuration 

 
• Toggle か Range リモートへマッピングされたインプットピンは以下のように構成できます。: 



• Normal Input 

 

• Inverted Input 

 

• Rising Event 

 

• Falling Event 

 

Event かEvent-Status リモートへマッピングされたインプットピンは以下のように構成できます。: 
 
• Rising Event 

 

• Falling Event 

 
Toggle か Range リモートへマッピングされたアウトプットピンは以下のように構成できます。: 
 
• Normal Status 

 

• Inverted Status 

 
Status か Event-Status リモートへマッピングされたアウトプットピンは以下のように構成できます。: 
 
• Normal Status 

 

• Inverted Status 
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Productivity 

 

Optimizing Pyramix 

 

Use Templates 

 
供給されたTemplates にはそれらの目的に適切な設定があります。この設定は、Pyramix を最適化する最

も速い方法です。しかしながら、以下の情報は、あなた自身のプロジェクトとテンプレートを制作すると

き、どんな設定を使用したらよいかを決めるのを助けます。 

 

Pyramix File Format .PMF 

 
私たちは様々な意味でネイティブ. PMFフォーマットの使用を強く推薦します。 

 
まず、最初の問題点は WAV ファイル フォーマットと BWF フォーマットのサイズ制限です。 

これらは設計によりサイズが LIMITED TO 2 GB です。 

(31 Bytes アドレス可能な =正確には 2'147'483'648 Bytes のパワーに 2 を与える合計 32 bit 符号付きを

使用します。)2GB あれば十分に感じるかもしれません。しかしながら、現実の世界が在る限り、マルチ

トラックレコーディングにより高いサンプリングレイトとビットデプスを使用しますので、ちょっとした

初等算数によりこの限界をこえるのは簡単です。 

 
AIFFは、"only" LIMITED TO 4 GB という意味においてわずかに有利です。 

(32 Bytes アドレス可能な =正確には 4'294'967'296 Bytes のパワーに 2 を与える合計 32 bit 符号なしを

使用します。) 
 
PMF は128トラックが、およそ約 1万年間レコードできる 64ビットアドレス指定を使用しています。 

(あなたがディスクを都合することができるなら!) 実用に十二分であります。 

 

大きいマルチトラックプロジェクトのための Pyramix File Format の 2 つ目の利点はこれです。 

それは「サンプルインタ－リ－ブド」ではなく、「ブロックインタ－リ－ブド」です。 

ディスク上にレコード (WAV, BWF および AIFF のように)の代わりにどれがそれを意味しますか。 



チャンネル 1の 1つのサンプル、次に、チャンネル 2 の 1 つのサンプルチャンネル n の 1 つのサンプルへの

など。 .pmf  は、次々に各チャンネルのためにサンプルのかなり大きいブロックをレコードすることに

よってディスクアクセスを最適化するように開発当初から設計されました。通常チャンネル 1 の 64 kB、

次にチャンネル 2 の 64 kB、など、最終的にチャンネル n  の 64 kB 。 

 
この設定、(デフォルト、64 kB )は、All Settings > Settings > Application の Playback/Record ペ

ージ、Record Block Size セクションで、4 つの選択値の 1つによって替えることができます。 

しかしながら、代替手段は疑う余地なく本当に、RAID と Network-Attached-Storage セットアップに適

用できます。そして、かなりの知識と経験が必要となります。したがって、既定の設定が良かろうと思わ

れます。 

 

One File Per Track option 
 

All Settings > Settings > Project > Record ページの中にある、レコーディングの 2トラック以上が

意図されるときはいつも、One file per track オプションは通常選ばれるべきです(チェックされます)。 

そこには、幾分、ハイポテンシャルパフォーマンスに不利な条件がある場合があり、また、マルチチャン

ネルレコーディングのすべてのトラックが、 Timeline でそれらのオリジナルのシンク関係で使用されない、

またプレーされない場合、すべてのサンプルインタ－リ－ブドファイル形式(例えば、WAVと AIFF)が再

生中で、それは、起こる可能性があるからです。 

たとえ、そのファイルの1 か 2 トラックだけが時間軸に与えられたポイントに使用されても、これはハー

ドディスクヘッドが他の、そして、インタ－リ－ブドフォーマットですべてのチャンネルのすべてのビッ

トを通らなければならないからです。 

 

Reducing Unnecessary Disk Access 

 

Track and Mixer Muting 

 
Track Output (Track Header にある           ボタン)をミュートするのと、同じシグナルインをミュートす

るのでは、微妙な違いがあります。それは、ミキサーインプットストリップに関係します。 

トラックをミュートすると、トラックのディスクアクセスは止まります。(再生バッファが空にされている

間、音が止まる前にディレイがあります。) 

ミキサーストリップのミュートは、ディスクアクセスに影響しません。シンプルにストリップをミュート

します。(したがって、ミュートは即座です。) 

トラックアウトプットのミュートは、多くのトラックを持つマルチトラックレコーディングで可能です。 

(例えば、48トラックレコーディング) 

このトラック数をサポートできないハードウェアの上での編集のためです。(例えば、ラップトップ) 



また、Clips がすべてのトラックグル－プにされると、編集のガイドに使用されるトラックで行われたどの

ような編集変更であっても、ミュートしているトラックに反映されるでしょう。 

オペレーションをより簡単でより便利にする Track Grouping を使用できます。 

 

DSP optimization 

 
Mykerinos カードのコアには、非常に強力なTrimedia VLIW (まさしくVery Long Instruction Word)プ

ロセッサがあります。DSP チップとしての本機能、そして、かなり大きいリアルタイムオ－ディオミキサ

－位相数学の実行を含む大変多くのことができます。 

しかしながら、この非常に強力なチップさえ限界があります。 

そして、それが実現で十二分に適切であるのは、16 出力バス構成で 48 インプットであると述べられてお

ります。それが、完全に独立した複数の 64 のアウトプットでたとえば、64 インプットの完全な「マトリ

クスミキサー」を実装することは期待できません。 

または、64 x 64 = 4096 ノードであったならそれぞれのマトリクスノードの上に個々にディレイを加えて

ください。超ロウジッタで外部クロックにロックしているように、ほかの全家事仕事の世話をしてる間に、

タイムコ－ドを管理して、ストリームを録音、再生します。勿論、EQ, Dynamics, Reverb などのような 

FX は言うまでもございません。 

したがって、Pyramix は、All Settings > Settings > Project > Mixer > DSP Power Saving ぺ－ジ

で、いくつかの DSP 節約モードを提供しています。: 

 

Player / Recorder mode 

 

ミキサーの完全なノーダルのマトリクストポロジーを "diagonal" (対角線)のトポロジーに変えます。 

直接パスだけが計算されます。(すなわち Input 1 to Output 1, Input 2 to Output 2, Input n to Output n) 

 

人が予想するかもしれないように、そのようなミキサートポロジ最適化は、64 x 64 の大きさで分けられ

たミキサーの複雑さを、4096 のノーダルの計算からちょうど 64 の計算まで減少させます。 

そこは、ダイナミックな DSPプロセッシング節約機能であり、Pyramix が非常に大きいプレーヤー/レコ

ーダートラックカウントに適応していることを指し示しております。 

Multiple Mono Mix バスと共にそれを使用しなければ なりません。 さらに Version 5 においては、チ

ャンネルカウントを最大128 に増強しております。 

 

Disable Punch in / Punch Out 
 
これは、セ－ビング機能の別の DSP プロセッシングです。名前は示されます。パンチレコーディングは全

くプロジェクトライフのある段階の間、必要でないときはいつも、同時録音のストリームマネジメントを



不可にします。これで、もう 2、3 %  の DSP ロ－ド負荷をセーブするかもしれません。 

 
Disable Mixdown 

 
これを上記と同様に不可にしてください。同時に出力される Master アウトプットがミックスダウンとし

てレコードされる可能性がある付加的なパスを不可にします。 

 

DSP Allocation 

 
VS3 コントロールパネルアプリケーションには DSP 割り当ての、ユーザコントロールがあります。 

Start > All Programs> Pyramix > VS3 Control Panel 

目的にかなった選択は、DSP 処理ブロックが行います。: 

 

Fx Out 
 

• すべてのアウトプットバスです。 

 

• すべての VS3 プラグインをアウトプットでバスに挿入します。 

 
• すべてのアクティブアウトプットを繋ぎます。 
 

以下に 注意 してください。: すべての Fx Out の計算は本来タスクをまとめて行います。したが

って、同じカードで処理されることが必要です。--1 枚のカードしか使用できないということです。 

 

Mixer 

 
すべての内部の計算は、バックグラウンドで行われます。Ins が OUT バスに送られるのを容認します。 

それを内部マトリクスと考えることができます。 

 
Pyramix ユーザインタ－フェ－スの中では、これは OUTs に送られた Ins のナンバーによって反映される

だけです。プラグイン、インプットストリップまたはアウトプットバスもここで計算されません。 

 
ミキサーは、1 つの DSP で計算でき、または Fx In か Fx Out とDSP を共有できます。 

 

Fx In 

 



• すべてのインプットストリップです。 

 
• すべての VS3プラグインは Input ストリップに挿入されます。 

 
• すべてのアクティブ Input を繋ぎます。 
 
Fx-Ins は複数の DSP カードを通して広げることができます。(このステ－ジでは、まとめる必要がないの

で。) 

DSP  割り当ては VS3 Settings Control Panel で設定されます。 

すべての "On Bus" カードの利用のために: 

 

1. Video/TC カードを選んでください。通常最も強力なカードです。そして、Video/TC がのすべてのタ 

 イムコ－ド/ビデオref/ヘッドホンジャック接続のために選択される Card です。 

  このカードは自動的に Fx-Out に専念します。 

 

2. Mixer に割り当てられるカードを選択してください。これは、そのカ－ドのMixer ボタンをクリック 

  することによってできます。 

 

3. 残りのカードは自動的に Fx In に専念します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

                                                                                     
Mykerinos VS3 Control Panel Settings Window 



以下に 注意 してください。: DSP パワーの大部分が Input ストリップに必要であるなら、また、

同時に同じカードの上の Fx Out と共に割り当てることができます。: 
 

 

 

 

 

 

 

 
 
 

 

 
 
 
 
 

Mykerinos VS3 Control Panel Settings Window 

 

DSP ルーティングは I/O ルーティングから完全に独立しています。HDTDM / XDTDM により、バスのた

めに設計されています。(ヘッドホンアウトは別です。) 

 
All Settings > Settings > Hardware > HDTDM(XDTDM) PCM I/O Routing のなかで Physical I/O 

ルーティングは可能です。そして、プロジェクトオープンが全くないとき、Pyramix がランニングしてい

る状態で、変えることができます。 

 

Use Work Spaces 

 
ワークスペースは Project Editing Panel (特に Track Header Panel スイッチ)の多くのパラメータの状

態を保存してリコールする強力な手法を提供しています。事実上、Workspace は、オペレ－タ－がさま

ざまな共通タスクのためのセットアップを高速に切り換えるのを可能にするスナップショットです。 

 
• Tab Window の最初のラインをクリックして、新しい Workspaces を加えることができます。そして 

            ネ－ムをタイプしてください。 
 



• 選択して、‘Delete’キーを押すことによって、ワークスペースを削除できます。 

 
• Workspace の適用は、そのアイコンの上をダブルクリックすることによって、できます。 

 
• Workspaces によって記憶されたパラメータは、適切なカラムをクリックすることによって、 

             Workspace 単位で選択可能です。      

 
最後のカラムは、別ものに切り換える以前に保存された Workspace が、現在の値に自動的にアップデー

トされるのを容認します。 
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Settings 

 

Overview 

 
Pyramix はさまざまなアプリケーションと個人の好みの適応に膨大な構成が可能です。 

広大なパラメータ数を処理しやすくするために、Pyramix には、直感的な設定ダイヤログウィンドウがあ

ります。Keyboard Shortcut Editor と Macro Editor は別として、Pyramix Settings ダイヤログウ

ィンドウはすべての Pyramix 設定をまとめます。Settings メニューから両方にアクセスできます。 

このドキュメント以外の場所、個々のページでも情報を見つけられますが、all the Settings ページ、本章

は詳細です。Tool Bar アイコンから Settings にアクセスできます。Settings > All Settings メニュー

または Alt + G 

Configuration - The Settings Dialog Window 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Pyramix Settings Window - No folder open 



ウィンドウの左辺は、すべての設定がフォルダーで分類されています。フォルダー・アイコンをクリック

すれば、、フォルダーが潰れるか、展開します。デフォルトでは、それらのネ－ムを含む設定ページを表

示して、すべてのフォルダーが開いています。設定ページをクリックすると、それはビューイングと編集

のためのウィンドウが右側に開きます。 

Settings Buttons 

 

Apply changes to ... 
Settingsフォルダーツリーでは、最初の大きいボタンの機能が見られます。そしてラベルは現在のオ－プ

ンセッティングページ(もしあれば)を反映するように変化します。Apply changes to ...は、Settings フ

ァイルへの変更はセーブしないで行います。今後の使用のために設定を選択的または全体としてセーブで

きます。 

Save 
all settings をセーブするには、:  Saveボタンをクリックしてください。 Save As ブラウザウィンドウ 

が開きます。必要なら、ファイルの適設な位置へ、ナビゲートしてください。 

File name: ボックスにふさわしいネ－ムをタイプしてください。Save ボタンをクリックしてブラウザウ

ィンドウを閉じてください。 

Load 
Load は、Profile (*.pms) ファイルの設定位置を可能にする Browser ウィンドウを開きます。 

必要なファイルが見つけられ、Open ボタンをクリックすれば、ファイルをロードして、Load Settings 

ダイヤログを開きます。 

 

 

 

 

 

 

 

 
 
 
 
 
 
 
 

Load Settings dialog 



Loading Settings Selectively 

 
Load Settings は作動するボックスの設定だけロ－ドします。 

Load Settings ダイヤログオ－トは現在選択されているページを選択します。 

フォルダーチェックボックスをクリックすると、すべてのサブフォルダーのボックスとそれらを含んでい

るぺ－ジをチェックします。したがって、クリック All Settings はすべてのボックスをチェックします。 

 
OK 
これは、どのような設定の変更もセーブし、Pyramix Settings ウィンドウをぬけます。 

Cancel 
いずれの変更のキャンセルは Pyramix Settings ウィンドウをぬけます。 

Hardware 

Formats and Sync 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

All Settings Hardware Formats & Sync Page 



Preset 
 
このセクションはユーザがこのページのすべてのパラメータの Save と ReLoad か Delete Presets す

るのを容認します。さまざまな一般的なシナリオが供給された Presets でカバーされています。: 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 

All Settings Hardware Formats & Sync Preset List 

 
Sampling Rate 

 
このプロジェクトが制作された、またはデフォルトのロ－ドされた Mixer プリセットのセットレ－トを表

示します。Sampling Rateドロップダウンリストによりこれを変えることができます。 

 

Board 

 
マルチボ－ドシステムでは、ドロップダウンリストを使用して、あなたが設定を確認、または変更したい

ドーターカードを選択してください。 

 

Master 
マルチボ－ドシステムでは、このチェックボックスは、どのボードがディジタルオーディオシンクのソ－

スであるかを決定します。 



Sync 
 

Source 

これは全体の Pyramix システムのサンプルクロックソースを決定します。外部のソースが選択されて、有

効なシグナルが検出されない場合、外部信号が復元されるまで、システムは Internal に戻ります。 

以下の選択は利用可能です。: 

 

Internal 
 
クロックマスタとしてボードの内部のオシレーターを選定します。 

 
Video 

 
参照として外部のビデオインプットを選定します。カードは、ワ－ドクロックをビデオシンクレイトから

得ます。有効な映像信号を Mykerinos ボードに接続しなければなりません。VS3 コントロールパネルで 

Video / TC マスタ－として選択してください。 

 
Word Clock 

 
参照として外部のワ－ドクロックソースを選定します。ワ－ドクロックは Mykerinos ボードに接続しなけ

ればなりません。VS3 コントロールパネルで Video / TC マスタ－として選択してください。 
どんな有効なソースも接続されなければ、このオプションは灰色になります。 

 
LTC 

 
特別な状況で、このオプションは、ワ－ドクロックが Linear TimeCode から得られるのを可能にします。 

 
Audio Input 
 
Pyramix がドータカード現在のいずれかに関連づけられた外部のオーディオソースからクロックを得るに

はこのオプションを選択してください。 
 

Input 
 
Format 
入力フォーマットの選択を提供します。これは、変化します。どの Mykerinos Daughter カードが現在の 



Boardドロップダウンメニューによって選択されるかによります。 

 

Range 

 

 Boardドロップダウンメニューを選択した現在の Mykerinos Daughter カードにより利用可能なシステ

ム入力のナンバーを示しています。 

 

Output 
Mode 

 
出力フォ－マット選択を提供します。これは、変化します。考慮すべき事柄としての Mykerinos Daughter

カードによります。 
 

Monitoring 
 
Preferred Outputs 

ここで定義されたモニターアウトプットは、以下のシステム機能によって使用されるでしょう。: 

 

• Auto-Connect 機能。 

 

• Media Libraries で、モニタリング。 

 

• Digitizing Session モニタリング。 

 
ビデオシンクの Pyramix の特徴である入出力を使用すれば、ビデオ標準かフォーマット(例えば、NTSC, 

PAL またはサポートされた HD フォーマットの 1つ)を構成するために Video Tab を選択してください。 

また、標準の PAL / NTSC フォーマットのために Pyramix ビデオ出力上に目に見えるタイムコ－ドのバ

ーンインウィンドウを可能にするか、または不可することができます。 

 

Varispeed 

 
サンプルレイトを適合させることによって、Varispeed モードでプルアップ/プルダウンサンプルレイト

の選択か、Varispeed モードで作動している Pyramix のどちらかを容認します。 

 
Important! 典型的である、アナログか、アナログからデジタルコンバータへは、(例えば、Merging 

Technologies Sphynx または、DUAII、これは +/- 0.15 ‰ (150 ppm) を超えて作動しませんが)



したがって、どのような Varispeed モードであっても、ミュートしてしまいます。 

それは、外部のリアルタイムのサンプリングレ－ト変換サーキットリーを通して Mykerinos ディジ

タル I/O’s に送るか、またはビルトインのプルアップ、ダウンサポ－トがある適切な外部のコンバー

タを使用するために提案されています。 

 

以下に 注意 してください。: 外部の NTSC ビデオ参照にロックするのは名目上の制限があります。

サンプルレイトはプルダウンされます。 

 

Nominal 
 

‘Normal’モード。Sampling Rate プルダウンメニューで設定されるように名目上のサンプルレイトを使 

  用します。 

 

Pull-Up 

 

サンプルレイトを 0.1% 増強します。30 fpsと29.97 fps の NTSC フレームレ－トの間で、互換性の理由

のためにオーディオポストプロダクションでしばしば使用されています。 

 

Pull-Down 

 

サンプルレイトを 0.1% 減少させます。30 fpsと29.97 fps の NTSC フレームレ－トの間で、互換性の理

由のためにオーディオポストプロダクションでしばしば使用されています。 

 

Varispeed 

 

-12.5% から +12.5% の範囲の中でオーディオの再生スピードを変えることができます。 

このオプションを選択してください。そして、必要な速度変化をエンタ－してください。 

隣のエントリフィールドは、パ－セントの10 分の 1 の変化です。容認している範囲以外の値は、容認して

いる範囲に制限されるでしょう。例えば、1500 が入力されれば、値は1125 に設定されるでしょう。 

 
Resulting Sampling Rate 

 
プルアップ、または、ダウン、または、Varispeed 設定のサンプルレイトを表示します。 

 

以下に 注意 してください。: また、Status Bar のサンプルレイトディスプレイは、結果としての

サンプルレイトを表示します。 



I/O Interfaces 
 

ADAT(#11290) 
(Mykerinos Daughter Card Settings) 
 

これらの設定は現在インストールされている Mykerinos ドーターカードにハードウェアの特定の構成を

供給します。カードが書類に載っていますので、見てください。 

 

XDTDM / HDTDM Routing 
 

数個のルーティングページがあります。現在適切に選択されたモードのページだけ、HDTDM か XDTDM 

がツリーで利用可能であるか示されています。以下の挿絵では、Pyramix はHDTDM モードと PCM I/O 

Routing だけです。そして、PCM-HSR (High Sampling Rate)が利用可能になっています。 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

All Settings Hardware HDTDM PCM I/O Routing Page 



PCM I/O Routing 

 
XDTDM モードによる1 FS (32k, 44k1 および 48kHz)での PCM プロジェクトのために使用されます。 

合計 128 のロジカルインプットと128 のロジカルアウトプットは、どのような内部のバスも含んでいます。 

HDTDM モードには、それぞれの 64 があります。 

 

PCM-HSR I/O Routing 

 
2, 4 または、8 FS での PCM プロジェクトのために使用されます。このルーティングページは 2 FS とし

て I/O を表示しています。I/O の数は、4 FS で 2、8 FS で 4 に分配されることを忘れないでください。 

AES/EBUドーターカードが存在しているとき、このルーティングページは、HighSamplingRate の設

定説明を書いています。 

(AES/EBU (# ’card number’)ページから)対応するドータカードの 12 AES チャンネルか、24 AES チ

ャンネルのル－トをを可能にするためです。 

 

DSD Projects I/O routing 

 
これは、DSD プロジェクト用です。 

 

DSD Mapping がセットされている状態で、AES/EBU ページにある AES/EBU ドーターカードの DSD 

Mapping を変えることができます。 

MADI によって送られたオ－ディオデータフォーマットは、MADI (# ‘card number’) ページで選択され

ます。 (I/O Audio Data Format 設定) 

 

以下に 注意 してください。: DSD Projects はただ、DSD フォーマットをサポートするだけ

です。 

 

DSD Projects I/O routing 
これは、DXD Editing プロジェクト用です。 

 

これはサポ－トされた DXD オーディオデータフォーマット以外の DSD Projects I/O Routing 設定ペ

ージと同じです。 

 

Internal Busses 

 
コンボボックスにインタ－ナルバスの必要数を入れてください。 



Routing Physical I/O to Logical I/O 

 
プロジェクトオープンが全くないときだけ、ルート設定ができます。Reset はすべてのパッチを取り外し

ます。Autoroute は昇順にすべての利用可能なインプットとアウトプットを接続します。 

 
Manual Routing 

 
左手のフレームのフォルダーをダブルクリックすると、それらは、別々の物理的なコネクタを表示します。 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

XDTDM PCM I/O Routing 

 
パッチのために、個々のコネクタか、全体のフォルダーを右手パネル上にドラッグして、ドロップできま

す。XDTDM / HDTDM Slot パネルでのダブルクリックエントリはパッチを削除します。 

 

 

 

 

 

 

 

 



TimeCode 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

All Settings Hardware TimeCode Page 

 
Pyramix のTimeCode インプット/アウトプット特徴を使用しているなら TimeCode ページを選択して、

システムを構成してください。  Time code Format, Reference and Source. 

外部のタイムコ－ドソースが、物理的に Pyramixリニアタイムコードかビデオインプットに接続された場

合、LTC か VITC Reader 登録の現在値を見るべきです。 

 
General 
 



これらはすべて他のタイムコード・パラメータに基づいている一般的な設定です。 

TC Source コンボボックスは Auto, LTC, VITC または External の選択を提供しています。 

Auto は、すべてのソースを見て、オーダーによりそれらを使用します。: LTC > STC > VITC 

 

Format 
 

ドロップダウンリストから選び抜いた現在の TimeCode フォーマットを示しています。 

Pyramix は以下のフォーマットをサポートしております。: 

Film 23.98 fps, Film 23.98 fps Drop, Film 24 fps, PAL 25 fps, NTSC 29.97 FPS, NTSC 29.97 fps 

Drop, SMPTE 30 fps, SMPTE 30 fps Drop 

 

Reference 

 

TimeCode がディジタルオーディオ Sync Source として選定されるとき、Referenceドロップダウンメ

ニューはタイムコ－ドソースを設定します。Settings > Mixer Settings : I/O ぺ－ジ Sync Source 

 
Reference プルダウンリストは、オーディオボードのタイムコ－ドジェネレータチップから得られた

Internal 参照に、システムのオーディオエンジンの時間の計測、または、オプションの Video/TC インタ

フェースのタイムコ－ドインプットポートから得られたクロックの間の選択を考慮に入れています。 

ディジタルオーディオワ－ドクロックソースを設定するには、Virtual Studio Settings ウィンドウで I/O 

パネルをご覧ください。 

 
TC Source 
 

オーディオファイルがデジタル化されるとき、Pyramix の再生を連動させるか、またはタイムスタンプを

作り出すのに使用されるタイムコ－ドのソースを示しています。 

ドロップダウンリストは以下の選択を提供しています。: 

 

Internal はオーディオボードの上のインプットタイムコードチップからコードを使用します。 

 

VITC はオプションの Video/TC インタフェース、ブラケット/ブレイクアウトケーブル上の Vertical 

Interval Time Code (VITC) インプットからのコードを使用します。 

 
LTC は Video/TC インタフェースブラケットで派生する Linear Time Code (LTC) インプットを使用し

ます。 

 



Auto Pyramix はInternal, VITC, LTC または Externallタイムコ－ドソースからどんな有効なタイムコ

－ド位置の参照も自動的に使用します。 

 
External は External TC reader ソースからコードを使用します。 

 
External TC reader 

 
External Time Code リーダーの現在値を表示しています。 

ドロップダウンリストは、Virtual Transport とインストールされた外部のマシンの選択を提供していま

す。  Settings > All Settings > Remote Control > Machine ページで可能になります。 
 
LTC reader 

 
Linear Time Code (LTC)リーダーチップの現在値を表示しています。すなわち、外部 LTCインプット。 

 

LTC Generator 

 
Mykerinos ボードには、Linear Time Code ジェネレータがあります。 

 
Output Level (dBV) 
 
これは、dBV で現在の LTC アウトプットレベルを表示します。 

ドロップダウンリストは –24 dBV から +9 dBV までのアウトプットレベルの選択を 3 dBV インクリメン

トで提供します。または、電源オフになります。 

 

Off when stopped 

 

ストップしたとき、ここにチェックを入れていれば、Pyramix は LTC アウトプットをミュ－トします。 

チェックされていないなら、その実際の停止位置を出力し続けます。(スタティックTimeCode) 

あるビデオとオーディオのマシンはスタティック TimeCode を扱うことができません。 

 

VITC Reader 

 

Mykerinos ボードは映像信号のラインでコード化された Vertical Interval Time Code を読むことができ

ます。VITC には、ビデオが静止しているときでさえ、正確で読み込み可能である利点があります。 

 



Video Input 

 

これらのチェックボタンは、2 つのビデオインプットのどれが VITC シグナルに使用されるかの選択を容認

します。 

 

Line 

 

これは、どのラインがデコ－ドされるかを示しています。VITC コードはシングルラインに収まりますが、 

通常、リードエラーの冗長性減少を提供するためにコピーされます。 

ドロップダウンリストは、どのような  2 つのラインが選ばれるのを容認します。 

異なった組のラインはしばしば異なったコードを運びます。例えば、時刻と Absolute タイム。 

 

VITC Generator 
 

Mykerinos ボードには、a Vertical Interval Time Code ジェネレータがあります。 

 
Enable 

 
チェックすると、VITC ジェネレータのアウトプットは On です。 

 
Video Output 
 
これらのチェックボタンは 2 個のビデオ出力のどれが VITC に使用されるかの選択をを容認します。 

 
Line 

 
どのラインが VITC を含むかを示してください。 

 

General 
 
これらのコントロールは、Video Sync 信号の一般形式を設定するものです。 

 
Format 
 
現在のビデオフォーマットを示しています。ドロップダウンリストは、PAL の選択、NTSC、およびさま

ざまな Tri-Level HD(ハイデフィニッション) フォーマットを提供しています。 



Burn-in Window 

 
Mykerinos ボードは、Time-code ディスプレイ・ウィンドウを合成ビデオインプットシグナルの中へ、

焼き入れることができます。 
 
Enable 

 
チェックすると、TimeCode オーバレイを表示します。 

 

Color 

 
現在のディスプレイ体系を示しています。ドロップダウンリストは以下の選択を提供しております。 

 
•  White on Black 

 

•  Black on White 

 

•  Black on Background 

 

•  White on Background 

 

Large 

 
チェックすると、TimeCode ディスプレイは 2 サイズで、大きくなるでしょう。 

 
Head Switch Filter 

 
チェックすると、クランプ回路はヘッドスイッチの垂直なフロントポーチの前に最後の 6～7 のラインの間

の一時的な横方向の同期を無視します。さもなければ、クランプ回路はいつものように反応します。 

 

Burn-in Location 

 

シンプルに、カラ－バ－スクリーンの中の希望の位置にビデオバーンインウィンドウをドラッグしてくだ

さい。 

 

 



Project 

General 
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General Page には、現在のプロジェクトに関する情報を表示して、また入力するためのフィールドがあ

ります。この情報は、Project に特定であり、ディスプレイ中、いつも利用可能です。 

Project Media Folder 

 
Project が制作済みのときに、Project > New または Project > New From Template のどちらか、お



よび、制作された、または選択された Media Folder、Project Media Folder, Record : Target 

settings Media Folder,Project > Render : Target Settings Media Folder および、Project > Mix 

Down : Target Settings Media Folder すべてが同じフォルダーを示します。 

コンボボックスにはすべてのマウントされた Media Folders のリストがあります。そして、      ボタン

は、Choose a Media Folder to Mount ダイヤログを開きます。 

そこでは、いかなる他の Media Folder もブラウズして、マウント、制作、またはマウントできます。 

どうぞご覧ください。: Housekeeping 31 ページ 
Project オペレーションが新しい Media Files を作り出すとき、コンボボックスの下のラジオボタンはどち

らかの選択を提供します。: 

•  Project Media Folder に新しい Media を作ってください。 

•  それらの Original Folder に新しい Media を作ってください。 

 

Record 
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Target Settings 

 
Take Name 
 

ここで'シ－ド'ネ－ムをタイプしてください。 

これは、新しいレコーディングネ－ムを始めるのに使用されます。たとえば、"Vocal" とタイプすると、ト

ラックの次のレコーディングは、"Vocal" と呼ばれるでしょう。 

このフィールド "Increment take number" という機能に関連して動作します。(以下を見てください。) 

空白の状態でこのフィールドをぬけると、Pyramix はデフォルトとして、"Untitled"ネ－ムを適用するで

しょう。 

 
Prefix with Track Name 

 
チェックすると、レコーディングネ－ムは以下のようにそれがレコードされたトラックのネ－ムによって

前に置かれるでしょう。 

 
Guitar-Take 001_##001##_.wav 

 

Guitar-Take 002_##001##_.wav 

 
Suffix with Strip Name 

 
チェックすると、タイプされたソースの Multitrack レコーディングであることを容認します。 

通常記録 Film ステムのために、または Mixes / Dubs の Render のためです。: 

 

1セットのマルチチャンネルストリップ(GPS ストリップ)が適切に命名されて、タイプにされているので 

Suffix with Strip Name オプションは以下のように指定されたファイルを制作するでしょう。 

 

Episode3-M&E-Ls.wav 

 

Episode3-M&E-Rs.wav 

 

Episode3-LtRt-L.wav 

 

Episode3-LtRt-R.wav 

 



Name is Scene & Take 

 

チェックすると、Pyramix でレコードされたテイクネ－ムは、適切なタグセットがある BWF と PMF オ

ーディオファイルで、Scene と Take フィールドのソースとして使用されるでしょう。Take ナンバーと、

どんな前の文字も Scene ネ－ムとして使用されるとき、名前の最後の下数値は使用されています。 

 

たとえば、203/5 003 は SCENE = 203/5 TAKE = 003 として解釈されるでしょう。 

 
Media Folder 
 
レコーディングのために選択された Media Folder を表示します。 

隣接しているボタンをクリックすると、Choose a Media Folder to Mount ウィンドウが開きます。 

これは、フォルダーが制作されて、マウントされて、管理されるのを可能にします。 

どうぞご覧ください。: Housekeeping 31 ぺ－ジ 

 
Resolution 

 
ドロップダウンリストよりレコーディングのために、利用可能な選択から 1 サンプルあたりのビット数を

表示します。(16bps, 24bps or 32bps) 

 

Format 
 
ドロップダウンリストで利用可能な選択から現在の記録形式を表示します。(PMF, SD2, AIFF, AVI, 

WAVE, BWF, CD Image またはOMF) 

 
Waveform 

 
ドロップダウンリストで利用可能な選択から現在の Waveform ジェネレ－ションモードを表示します。 

(None,Generate AFTER レコ－ディングまたは Generate While Recording) 

 

Source Name 

 

このフィールドで、あなたは、Pyramix にレコードされた素材のソ－スを示すために名前を付けることが

できます。例えば、あなたが"Reel #1"と入力したものは、最初のソ－スリ－ルかもしれません。など。 

MediaType フィールド(以下を見る)が "None" に設定されると、Source Name フィールドは、灰色にな

り利用可能ではなくなるでしょう。 



Media Type 

 
ドロップダウンリストから選ばれた、ソ－ス素材のメディアのタイプを表示します。 

EDIT ボタンをクリックすると、既存の名前の編集、または新しいものの制作を容認します。 

メディアファイルが新しいレコーディングにより制作されている状態で、ここで選ばれたメディアタイプ

と前のフィールドで与えられたソ－スネ－ムをセーブします。 

そして、クリップを選択して、Properties ページを表示させて、この情報を見ることができます。 

 

Dubbing Mode 

 
どうぞこちらもご覧ください。: Dubbing Mode 357 ぺ－ジ 

 
主にフィルム再レコーディングにこのモードを提供しています。それは、トラックがア－ムドされている

ことを容認します。または、レコーディングが差し替えられている間、ア－ムドされていないことを容認

します。 

 
Enable Dubbing 

 
チェックすると、Dubbing Mode になります。 

 
Confirm Track Arming 

 
Dubbing Mode が隣接しているチェックボックスの中で選択されると、利用可能になるだけです。 

エフェクトをかける前に新しい Record コマンドでレコーディングを確認しなければなりませんが、この

ボックスチェックは、トラックア－ミングモ－ドの変更を意味します。 

 

Media option 
 
One file per track 

チェックすると、マルチトラックレコーディングの各トラックにおける各レコーディングは別々のファイ

ルの中にレコードされます。このオプションがオフになっているとき、(デフォルトです。)すべてのトラ

ックを含むただ 1 つのメディアファイルに制作されます。 

 
Flatten track numbers 

 
トラックでレコーディングをするとき、Pyramix はいつもメディアナンバーをそれに加えます。 



チェックがオンのまま(デフォルト)では、Pyramix は 1 つ 1 つ数えながらスタ－トします。 
たとえば、マルチトラックセッションのトラック 5 と 9 で同録するなら、メディアナンバーは、1 と 2 に

なるでしょう。このオプションがオフになっているとき、Pyramix は本当のトラック番号をメディアに加

えます。上記の例では、 5 と 9 でしょう。 

 

Unique filename extension 

 
チェックすると、Pyramix は、重複ファイルネ－ムを避けるためにそれぞれの新しいレコーディングネ－

ムに乱数を追加するでしょう。 

 
Quiet if creation failed 

 
このボックスがチェックされない場合、メディアファイルの制作に失敗した時は、Pyramix はエラーメッ

セージがあるダイヤログを表示します。Pyramix がリモ－トコントロールされているなら、これは煩わし

い場合があります。ボックスをチェックすると、エラーメッセージは抑え込まれます。 

 

Post Processing 

 
それぞれのレコーディングが終わった後にこれらのオプションは、Pyramix が何をするかを決定します。 

Prompt for name after recording 

チェックすると、レコーディングが終わって、プレイバック終了後、ただちに、Record Name ダイヤロ

グボックスが開きます｡ 

 

 

 

 

 

Record Name dialog box 

 
Take Name フィールド(上を見てください。) の中にネ－ムが入力されると、上のような表示が自動的に 

Record Name ダイヤログボックスの中に現れます。 

あなたは、既存のネ－ムを変更するか、またはそれを新しいネ－ムに完全に取り替えることができます。 

 

Keep in default library 

 
チェックすると、新しいレコーディングは現在の Project の Default ライブラリーに自動的に現れるでし



ょう。 

 
Increment take number 

 
チェックすると、それぞれの連続したレコーディングはそれに適用された Take Name フィールドにネ－

ムを持つでしょう。 

それぞれの新しいレコーディングに従ってナンバーが増加します。たとえば、最初のレコーディングが

"Take" と命名されると、次のレコーディングは自動的に "Take 2 " と命名されるでしょう。 

 
Place on new tracks 

 
チェックすると、Pyramix は新たにレコードしているクリップを新しいトラックに置き代わります。 

パンチイン/アウトの後プレイバックがストップするやいなや、Project Editor に新しいトラックは加えら

れるでしょう。最初に制作された場合、これらのトラックはミキサーチャンネルに割り当てられません。 

よって、それらを出力するには、それらの割り当てが、必要です。 

このアイテムがチェックされないと、新しいクリップは(s)がそれらをレコードするように設定したトラッ

クに置き代わるでしょう。 

 

Clean up Media after recording 

以下に 注意 してください。: Project が開かれたとき、このオプションは自動的に OFF に設定さ

れます。 

 

このモードは Pyramix をアナログや DASH マルチトラックのように働かせます。 

すなわち、すべてのパンチインは、highly destructive !! (非常に破壊的なのであります。) 

現代的な大きいハードドライブでは、我々は、以下を推薦いたします。: 

 

View > Used Media > Invert selection > Delete media (グッドな archive/consolidate/back-up

をした後)または : 

b) Project > clean-up media など。 

 

これらのすべての機能がハードドライブ上のメディアを破壊します。 

しかし、b & c は永久に削除されることで、より多くのコントロールを提供します。 

 

Group Recorded Clips 

 

チェックすると、マルチトラックレコーディングのクリップは自動的にグル－プにされます。 



Auto Cross-fade 

 

チェックすると、クロスフェイドが、パンチイン、アウト時に自動的に適用されます。 

現在のフェード形は、ドロップダウンリストで利用可能に選択されたものを表示しています。(Power, 

Linear, dB, Cosine または、Root-Cosine)どのボックスが選択されるかによって、フレーム、サンプル

またはミリセコンドでデュレ－ションを設定できます。 

 

Playlists 
 

これらのボタンは 3 つの選択の間で順番に切り変わります。: 

 

Don’t create Playlist 
 
Create an empty Playlist for each recording 
 
Create a copy Playlist for each recording 

 

どうぞご覧ください。: Playlists 123 ぺ－ジ 

 

Controller Mapping 
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特定のコントローラーに関しては、Guides をご覧になられてください。たとえば、Merging Technologies 

ISIS 

Mixer 

Level Meter 
このページは、Mixer と track Headers のレベルメータの外観と働きを決定します。 
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これらの設定は現在の Mixer だけに適用されるものです。 

これにより、各 Mixer が自身のカスタム GeneralとLevel Meter 設定を持つことができます。 

設定を変えるためには、左か右のボタンをクリックするか、または水平なスクロールバーをドラッグして、

選択されたパラメータを増加、または減少させてください。あるいはまた、ナンバーフィ－ルドへ各パラ

メータを直接数値入力してください。 

(これらのフィールドは許された範囲内で各パラメータの数値を受け付けるだけです。) 

 

レベルメータのカラーグラフィックディスプレイは、Headroom と Alignment パラメータ変化の効果を

示すためにすぐに反応します。 

 



Level Meter 

 
このページは、Mixer と track Headers のレベルメータの外観と働きを決定します。 
これらの設定は現在の Mixer だけに適用されるものです。 

これにより、各 Mixer が自身のカスタム General と Level Meter 設定を持つことができます。 

 
設定を変えるためには、左か右のボタンをクリックするか、または水平なスクロールバーをドラッグして、

選択されたパラメータを増加、または減少させてください。 

あるいはまた、ナンバーフィ－ルドへ各パラメータを直接数値入力してください。 
(これらのフィールドは許された範囲内で各パラメータの数値を受け付けるだけです。) 

レベルメータのカラーグラフィックディスプレイは、Headroom と Alignment パラメータ変化の効果を

示すためにすぐに反応します。 
 

Headroom 

 
クリップの前、赤いメータセグメントとして表示されたへッドル－ムの量をセットします。 

 

Alignment 
 

アライメントレベルをセットします。暗いオレンジのセグメントで始まるスケールのポイントにより、表

示します。 

 

Peak and Overload Hold Time 
 

光ったまま残っているレベルメ－タのピ－クセグメントまたは、オ－バ－ロ－ドセグメント(頂点は赤色セ

グメント)は秒で設定されます。 

 

Permanent Overload 

 

ボックスをチェックすると、トラック上の赤色 Overload LED は点灯されたままで残ります。 

再生がストップしても残ります。クリア－するには、それをダブルクリックしてください。 

チェックしませんと、Overload LED は、数秒後、自動的にクリアして、次の過負荷出現までオフのまま

です。 

 

以下に 注意 してください。: オーバ－ロ－ド LED はワンサンプルの後に最大のレベルと共に先へ進

みます。 



Permanent Peak 

 

このパラメータは、Peak Level Display に関連して動作します。これがオンでは(チェックすると)、 

Peak Level ポップアップディスプレイは最高水準の値とその位置を示します。 

メータをクリックしたとき、時間までにトラックで達した最高水準のレベルです。 

レベルディスプレイは、再生が止められて、再たび再生される次回まで、アップデートしません。 

それがオンでない場合(チェックしてない)、Popup Display が動く(再生が続きますが) 最後の回から 

Peak Level Popup Display はそのトラックで達した最高レベル値を示すでしょう。 

例えば、再生している間、チャンネルのメータをクリックすると、Peak Level Popup は表示されるでし

ょう。それは、今までのところ達しているピークレベル(そして、その位置)を示すでしょう。 

Popup から遠くでクリックしてください。そうすれば、それは見えなくなるでしょう。 

もう一度そのメータをクリックしてください。そうすれば、Popup は再び現れます。 

前回の Popup を表示したとき以来、今回は、達したピークレベル/位置を示しています。 

 

Decay integration time 
 

このパラメータはレベルが最新のピークの後にレベルメータディスプレイがディケイするレイトの設定し

ます。デシベル(ms/dB)あたりのミリ秒でディケイのスロープをきめます。 

 

Peak level indicator 

 
Show After 

ボックスがチェックされれば、それぞれのミキサーストリップのフェーダ上に位置する Fader/Input 

Level ディスプレイは、対応するミキサーストリップを通して、シグナルのピークレベルを表示します。 

間隔設定でチェックボックスの下のスライダで値をアップデートします。 

チェックボックス Show After がオフなら Fader/Input Level ディスプレイは、いつもそれらの対応す

るフェ－ダ－の設定を示しています。DSD Peak Filter 

 

このドロップダウンリストが選択を提供する DSD プロジェクトのために、その選択は、レベルメータに

より計測される以前に DSD シグナルに適用される 2 つのフィルタリングオプションです。 

 

これは、あなたが、DSD シグナルが高周波ディザ－ノイズコンテンツに関する AES 推薦との互換性を確

かなものに保証し可能にするのを手助けします。 

 
 
 



20k 

 
シグナルへの 20 kHz のローパスフィルタを適用します。その結果、聞きとれるオーディオコンテンツの

みが計測されます。 

 
40k-100k 

 
40 kHz から100 kHz の周波数領域があるバンドパスフィルタをシグナルに適用します。 

AES 推奨によれば、この周波数領域の信号レベルは -20 dB を超えてはならないと言うことです。 

 

DSP Power Saving 
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DSP Time Saving 

Disable the Punch in/out 
ボックスがチェックされれば、パンチインとアウトは出来ません。 
 

Important! 重要!です。Pyramix はそれでも、あなたがトラックをア－ミングして、レコーディン 

グプロセスを始めるのを容認してしまいます。しかし、結果としてメディアファイルはデジタル ヌル 

                 を含むでしょう。 

 



Disable Mix Down 

このボックスがチェックされると、デジタルミックスダウン機能は、こちらのメニューコマンドが生きま

す。  Project->Mix Down を不可に。 

Important! 重要!です。Pyramix はそれでも、あなたがミックスダウンプロセスを開始するのを容

認してしまいます。しかし、結果としてメディアファイルはデジタル ヌルを含むでしょう。 

Special Modes 

Player/Recorder Mode 

このモードは大きい構成を容認します。(48 x 48 チャンネルなどの) シングルボ－ドで走ります。 

Player/Recorder Mode は外部ハードウェアコンソールの使用のために意図しております。 

このモードが活されれば、Pyramix ミキサーはシグナルルータの役割に追放されます。 

レベルコントロールも、パンも、プラグインも、インサートも全くありません。 

このオプションはマルチモノラルミックスバスで構成で利用可能なだけです。 

Pyramix Direct Out の機能性は代替手段を提供します。同様の DSP セ－ビングを達成する、より多くの

ユーザの構成可能なメソッドです。 

どうぞご覧ください。: Channel Direct Outputs 151 ページ 

Application 

General 
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Platform 

 
Audio processing 

 
ドロップダウンリストは、Pyramix と共にどのオーディオ機器を使用するかの選択を提供しています。 

利用可能な選択は、Mykerinos Card または、Native Processing です。すなわち、コンピュータのホ

ストプロセッサとサウンドカード。あなたがこのオプションを購入した場合ですけど。 

 

Undo 
 
Number of Undo / Redo 
 

Number of Undo / Redo の回数を設定します。オートメーションなタブオプション、Optimization : 

Limit versions to the number of Undo/Redo が可能になっている場合もまた、オートメーションバ

ージョン数が保たれるように設定します。デフォルトは 32 です。 

 
以下に 注意 してください。: この値を増やすと、より多くの RAM が必要になります。 

 

Project Opening : 
 

Rescan and Mount all Media Folders for that project 
 
非常に大きい Media Folders がある場合、開くのに時間がかかる場合があります。 

 
Quick Mount all Media Folders for that project 
 
デフォルトです。結果、オ－プンが通常最も速いです。 
 
Do not try Mounting any Media or Folders 

 

マニュアルでメディアをマウントしなければなりません。 

 
Search for missing Media 
 

チェックすると、Pyramix は、プロジェクトが開かれるとき、アンマウントされたメディア、または無く

したメディアを自動的に探します。 



Auto-Saving 
 

Pyramix は自動的に一定の間隔を置いて、すべての開いているプロジェクトのセーブを実行するように設

定ができるようにできます。値より多くの1 が Auto-Backup Versions に入れられない場合、これはバ

ックアップを作りません。(以下を見てください。) 
 
Enable 

 
チェックすると、現在の Project は、間隔セット、以下によって:自動的にセ－ブされるでしょう。 

 
Auto-Saving. Frequency 

 
1～60 分の間でセーブの間隔時間を決めます。 

 
Auto-Backup Versions 

 
いくつの旧バージョンがキ－プされるかを決定します。これは、あらゆる Save オペレーションを確実に

します。(Automatic または Manual) それらが、最終で保存した状態でセ－ブされている、どのような

プロジェクトバージョンの最小限の 1 つを維持します。ユーザは保存する以前にセーブされたバージョン

のナンバーを設定できます。上で述べておりますように、最小限は one です。 

 

Alternate Backup 
 

Enable 

 
これを可能にすると、セーブした(自動的またはマニュアルで)すべてのプロジェクトは、選ばれた代りの

位置にセーブされます。Backup Versions は代りの位置には保存されません。 

別のドライブかネットワークドライブが選ばれているなら、それはセキュリティの強化になります。 

 
以下に 注意 してください。: プロジェクトファイルだけがメディアファイルではなく、このディレ

クトリの中に保存されます。 

 

Location 

 
代りの位置を表示して、設定いたします。Browse ボタンは適切な位置へナビゲートする Browser ウィ

ンドウを開きます。 



Editing 
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Nudge settings 

 
これらの設定は、左右の Arrow キーを使用する場合、カーソルかクリップがナッジされる量をコントロー

ルします。5 Nudge Settings を保存できます。現在のナッジ設定をこれらのうち 1 つを選択して使用しま

す。 

Clips > Nudge > Current Setting または Cursors&Marks > Current Nudge Setting 

 



Nudge #1~Nudge #5 

 
ナッジプリセットに関しては、数値を入力してください。そして、適切なチェックボックスをクリックし

てください。フレーム、サンプル、ミリセコンド、CDフレームまたは現在の Bars & Beats grid の区切り

の設定です。 

 

Audition after Nudge 
 

これらのオプションは選択した操作に、自動 Audition オンを設定します。 

 
To 

 
チェックすると、これに達っしたとき、再生は、選択されたオプションの前に始まり、止まるでしょう。 

(カーソル、マークイン、またはマークアウト) 

 
From 

 
チェックすると、リハーサルは、選択されたオプションから、実行されるでしょう。 

(カーソル、マークイン、またはマークアウト) 
別々のTo と From オプションを Gate In と Gate Out に提供します。 

 

Drag & Drop 

 
Auto-Crossfade by default - Control key for Drag & Drop 

 
チェックすると、選択かクリップをドラッグすると、別のものの上でクロスフェ－ドをもたらします。 

( X がある手の形へのカーソル変化。) 

さもなければ、別のものの上で選択かクリップをドラッグすると、上書きされます。(カーソルは手です。) 

ドラッギングするとき、コントロールキーを押すと、代替機能が選択されます。 

 

Fade library location 

 
これはフェードライブラリーのパスです。Browse ボタンはどんな局所的やネットワーク経路も設定され

るのを容認する Explorer ウィンドウが開きます。 

 

Time Stretch Tool 



Selected 選択  : どのキーがインストールされるかによりますが、コンボボックスは Time Stretch アル

ゴリズムの選択を提供します。 

 

Playback/Record 
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Pre/Post Roll Settings 

 
値が Default でセットされ、PreとPost-roll の 2 つの切り替え設定を容認します。 

 

Fixed Cursor Settings 
 

選択された固定カーソルあるTimeline がスクロールしているとき、スクリーンの Playhead カーソルの位

置のためにドロップダウンリストは 9 つの可能な位置を提供しています。 

(View > Fixed Cursor while playing) 

 



Playback Stall 
チェックすると、再生の中断はメッセージボックスをポップアップします。 

Playback Buffer 
Buffer サイズは、値をタイプ、またはスライダをクリックしてドラッグすることによって、設定されます。 

新しい値の Set をクリック、またはデフォルト値に戻るために Reset をクリックしてください。 

Record Block Size 
4 つの選択可能な値を提供します。デフォルト 64kB のままにしておくべきです。 

Automatic Deglitching (Removes glitches at start / end of Clips) 
Enable がチェックされれば、短いフェードはあらゆるクリップの始めと終わりに適用されます。 

Ramp Length はフェードデュレ－ションを設定します。 

Auto-Monitoring 
2 つのオプションを切り替えます。 

European Monitoring (All tracks turn to INPUT on stop) 

または、 
US Monitoring (Only Record Ready tracks turn to INPUT on stop) 

Jog/Chase 
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Chase Settings 
 
Chase Mode 

ラジオボタンは Chase Mode の選択を与えます。 

 
None   Pyramix は外部のTimeCode をチェイスしません。 

 
Hard    Hard Chase がアクティブの場合、Pyramix は TimeCode インプットポ－トより選ばれた 

有効な TimeCode を検出し再生だけします。 

入って来る TimeCode にジャンプがあれば、Pyramix は新しいTimeCode に適応するでし

ょう。新しいTimeCode の位置から再同期して、再生を始めます。タイムコ－ドにドロップ

アウトがあれば、Pyramix は最大 1フレームで自身の内部 TimeCodeで作動します。どんな

有効な TimeCode もそれ以後検出出来ないと、再生は止まります。 

 

Soft    Soft Chase がアクティブの場合、Pyramix は TimeCode インプットポ－トより選ばれた 

有効な TimeCode を検出し再生だけします。入って来る TimeCode にジャンプがあれば、 

Pyramix は新しい TimeCode に適応しません。しかし、入って来るTimeCode の位置から 

オフセットを持って、再生を続けます。タイムコ－ドにドロップアウトがあれば、Pyramix は 

最大 1フレームで自身の内部 TimeCode で作動します。その後、どんな有効な TimeCode も 

それ以後、検出できないと、再生は止まります。 

 

Vari    Vari Chase がアクティブの場合、Pyramix は Varispeed になります。すなわち、外部の 

                                                       TimeCode の変動に従って、サンプルレイトを変更します。(後方に、前へ、減速、加速、 

                                                      ノ－マル再生、または、リバ－ス再生、ノ－マルスピ－ドの8xまで)でプレイバック(録音で 

                                                      は出来ません。) 

 

Stabilization period before locking 

 

Pyramix は 3 - 4フレームの範囲中に入って来る TimeCode にロックできますが、より長い待ち時間があ

れば、より安定した同期が得られます。これはいくつかの外部のデバイスが再生を開始し、スピードが安

定するには、それなりの時間がかかるからです。Pyramix が TimeCode をチェイスし始める前に、この

パラメータは、待ち時間が定義されるのを容認します。 

あなたが外部のマシンとの課題を経験するなら、30 フレームが良い出発点です。 

 
Silent Chasing (helps large projects to lock) 
 



チェックすると、チェイスしている間、Pyramix は大きいプロジェクトをただちにロックさせます。 

このモードのロッキングタイムは、トラックの数には依存致しません。 

唯一の欠点はと申しますと、ロックした後、1 秒後に発声することだけです。 

 
Stay in record until stop pressed 

 
このボックスをチェックすると、Pyramix Stop ボタンが押されるまで、コード(信号)の混乱/不連続にか

かわらず、Pyramix は録音中のままです。(一度適切に TimeCode にロックします。) 

 

Allow chasing across midnight 
 

このオプションがアンチェックの場合は、Chase エンジンはいつも固定されます。 

それは、00:00:00:00 と Day 0 の 23:59:59:2X との間にです。 

 

このオプションをチェックした場合、Chase エンジンは、Pyramix タイムラインのどこでもロックするの

を容認します。(-1000 days から +1000 days) 
エンジンは、現在のカーソル位置へ最も近い位置になるように入って来るタイムコードを判断します。 

その結果、タイムラインのいつ、いかなる日の真夜中であっても、チェイスすることを容認致します。 

 
さらなる安心と安らぎのために、真夜中のバリアを越えている間に、Pyramix が(ロックされた)状態にあ

るなら、そして、このセットがアンチェックであっても、シンクしてプレーまたはレコードしている間、

即座に真夜中からのゼロまでジャンプしないでしょう。再生かレコーディングがシームレスのままで残る

でしょう。再生は中断しませんし、ロックがはずれるのが認識されるまでデイバリアを越えます。 

そして、再チェイスは、その時、入って来る Timecode 値が、そのポイントにあることが引き金になって

引き起こされるだけです。 

 

Sony 9-pin Chase Mode 

 

None, Hard, Soft と Varispeed の選択を提供します。 
Varispeed は varispeeding によって外部のTimeCode のチェイスを可能にします。 

 

Redirect Remote Controllers commands to the External Machine when chasing 

 

チェックすると、Internal Machine が以下のようにチェイスモードである場合、外部のハードウェアコン

トローラーによって作り出されるどのような転送コマンドも、アクティブな External Machine にリダイ

レクトされるでしょう。: 



Internal Machine がチェイスしていて、External Machine が選択されるとき(Active Machine)、その後 

Play,Rewind, Fast Forward, Stop と Goto コマンドは、External Machine にリダイレクトされる 

Remote Controllers (Sony 9-Pinまたは、MIDI) により転送されます。 

 

Record とTrack Arming コマンドはリダイレクトされません。 

 

Auto-Jog が可能な場合、すべてのJog Commands は、わずかに異なった方法で処理されます。 

Pyramix  は Goto コマンドを External Machine に送る間、チェイスするのを一時止めて、ジョギングを

始めます。したがって、オーディオは完全にスクラブされます、そして、外部のマシンはオーディオにで

きるだけ従います。ユーザが Jogging を止めるとき、Pyramix は自動的に、チェイスモードに戻ります。 

 

利用可能な次のメニューで Auto-Chase External Machine オプションに関連してこのオプションを使

用することは最も良いです。これは、チェイスし続けている間、容易な Internal と External Machine 転

送の切り換えを考慮しております。 

 

Jog Wheel Settings 
 

Preset 
コンボボックスは Merging Technologies ISIS を含むハードウェアコントローラープリセットの選択を

提供します。リストからユ－ザコントローラーを選んでください。または、そうでなければ User Defined 

に示されています。 

 

Auto Jog on move 

 

作動させると、ジョグホイールの動きにより、Jog モードになります。 

 

Auto-Solo Selection 

 

作動させると、現在の選択におけるすべてのトラックは、ジョギングをするとき Solo’d になるでしょう。 

 

Speed ceiling 

 

1X, 2X, 4X または 8Xプレースピードの選択からジョグスピードの最高値を設定します。 

 

Smoothing Filter 
 



スクラビングを始めて、終わるとき、Smoothing Filter  パラメータは「フェイドイン」と「フェイドアウ

ト」の長さを決めます。 

 
Flywheel inertia 

 
Low はジョグホイールで送るように実際の動きに従います。 

High はスム－シングフィルタを通して実際の動きをパスします。 

それで、スライダが Low に設定されるとき、Smoothing Filter パラメータは効き目がありません。 

画像ワ－クのサウンドは、画像にタイトシンクしなければ、なりませんので、Low で基本設定してくださ

い。よりはっきりしたフライホイ－ル効果には、Higher 設定を選んでください。 

Middle ポジションは良い出発ポイントです。 

 

Transient response accelerator 

 

Pyramix のジョグの動きを最適化します。設定範囲は、Smooth から Accurate までです。 

スライダを Accurate にアプローチするとき、いくつかの奇妙な望ましくないエフェクトがあるかもしれ

ません。 

 

Jog - sensitivity - second(s) per revolution 

 

ジョグホイールの 1 回転で移動する時間を決めます。必要な値をボックスにタイプしてください。 

 

Shuttle - sensitivity - revolution(s) for nominal speed 

 

ノ－マルスピ－ドの維持に必要な回転の割合か回転数をセットします。例えば、0.25 の入力は、ノ－マル

スピ－ドを達成するために、時計回りの四分の一の回転を要求するでしょう。 

 

Navigate - sensitivity - revolution(s) to traverse the timeline 

 
ナビゲートは、サイレンとジョグモードです。ジョグホイ－ルの回転数の設定は、目に見えるタイムライ

ンを横切る必要があります。すなわち、ズーム値に従って、実際のスピードは異なります。 

 

Mouse Scrubbing Settings 

 
Scrubbing Mode 

Analog Tape Mode はアナログテープマシンの上で( reel-rocking )への同様の応答を与えます。 



Limit to Speed Ceiling をチェックすると、リミットは Speed Ceiling の下のバリュ－セットにより、

スクラブスピードを制限します。スピードが Speed Ceiling の下でバリュ－セットを超えているとき、

Silent Locate オーディオなしで引き受けられるためのスクラブを可能にします。 

Repeat Loop Mode は、カーソル位置で始まるループを絶え間なく繰り返します。 

 

Scrub Settings 

 
Audio Quality 

Standard, Improved または、Best の選択を提供しています。選んだ品質が、高ければ高いほど、CPU-

中央処理装置の荷重は、大きくなります。デフォルトは Standard です。そして、Improved は利用可能

です、そして、Best は今後の使用のためのものです。システムリソースの項において、Improved モー

ドは、よりきびしいです。Max simultaneous tracksフィ－ルドの特定のナンバーより多くのトラック

が同時にスクラブされたなら、この設定は自動的に Standard モードに上書きされるでしょう。 

 

CD/SACD 
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どうぞご覧ください。: CD/SACD Default Settings 299 ぺ－ジ 



Desktop Layout 
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これは、Menus と Toolbars に関する内容をカスタム設計できるところです。そして Menu Status と 

Toolbar Status セルをクリックすると、Present かブランク(不在)をそれぞれ切り換えます。 

特定のタスクかオペレ－タ－のためのユーザインタフェースを仕立てるためにこれを使用できます。 

Tab Windows 

Status セルの中でクリックは、Present かブランク(不在)のエントリのそれぞれの Tab Window を切

り換えます。 

Options 



Big Toolbar Buttons  チェックすると、Toolbar ボタンのサイズが倍になります。 

 

Remove All Buttons    言っておきます。--細心の注意を払って、使用してください。 

 

Remove all Buttons and Menus さらに、欠くことのできないメニューエントリのナンバー制限はそ 

                                                                                                                      のままです。 

Presets        コンボボックスは以前にセーブした Presets の選択を提供します。 

 

Save Preset      シンプルな Save Preset ダイヤログをポップアップします。 

 

Delete Preset     上記の Presets コンボボックスに表示されている現在のプリセットを削除 

                                                                                                                      します。 

TimeLine layout 
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すべてのカラーオプションのために、色づけされたブロックをクリックすると、定義されたカラーリスト

がポップアップします。リストの末尾で、More Color... の選択は完全な Color ピッカ－ダイヤログを開

きます。 

 
General 
 
Display Timeline on Top of Tab Windows     示している言葉どうりです。 

Display Timeline on the Right of Tab Windows  デュアルモニタのグッドな使用を容認します。 

1個のスクリーン上に Timeline を表示、片方にすべてのTab Windows を表示するのを可能にするデュア

ルモニタセットアップの使用の場合は、このボックスにチェックを入れてください。 

 

Clips & Waveforms 
 
Default Clip Background Color 

 

Default Clip Waveform Color 

 

Bad Take Background Color 

 

Bad Take Waveform Color 

 

Waveform follows Fades 

 

チェックすると、フェードとクロスフェードの間、ウエ－ブフォ－ムディスプレイは高さでスケーリング

されます。オリジナルウエ－ブフォ－ムは、灰色で表示されます。 

 

Waveform follows Gain 

 

チェックすると、供給されたゲイン調整に比例して、ウエ－ブフォ－ムディスプレイは高さでスケーリン

グされます。 

Generate waveform automatically at clip insertion 

 

チェックすると、ウエ－ブフォ－ムファイルは Timeline に置かれるとき、どんなクリップのためにもバッ

クグラウンドで自動的に作り出されます。ウエ－ブフォ－ムをまったく持たないどんなクリップでもです。 

 
 



Clips Text 
 
Clip Text Font Size  ラジオボタンは Large, Medium または Small の選択を提供します。そして、 

チェックボックスは、太く(emBoldens )なります。 

 
Selected Clip Text Color 

 
Display Clip Text   コンボボックスは Above, Below, In Front Of または Behind the 

Waveform の選択を提供します。 

 
Compose Clip Text out of : 表示されたクリップテキストは、5 つのコンボボックスから選ばれた最大 

5 つの要素から構成できます。Separator ボックスにタイプされた文字で、分けられます。: 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 

Compose Clip Text out of : combo box 

Tracks 
 
Tracks Background Color 

 

Tracks Separator Color 

 

Other 

 



Absolute Sources in EDL view 

Settings > All Settings > Application > TimeLine Layout ぺ－ジの Absolute Sources in EDL 

View をチェックすると、オリジナルの Source In, Source Out、および Sync Point タイムは EDL 

View の Absolute Time に表示されています。Absolute タイムは、オーディオキャプチャ－でレコード

され入って来るTimeCode です。このモードが使用不可のとき、キャプチャ－されたクリップのための 

TimeCode のデフォルトスタ－トタイムは 00:00:00:00 です。 

 

Track Headers Layout 
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ここで、ユーザは Track Header に現れるアイテムを決定できます。 



Track Header の'ビルディングブロック'のどれかをクリックすると、ブロックは選択されます。 

正方形の赤いアウトラインで、示されます。ブロックはクリックとドラッギングによって Track Header の

どこでも置けます。Track Header からブロックを取り外すには、それをダブルクリックしてください。 

ブロックは、Interface Editor の Track Headers から見えなくなって、末尾の' Pool'に現れます。 

Pool のブロックをダブルクリックすると、それは Track Header と置き代わります。 

Load Defaults   ともにセ－ブされた、デフォルトの Track Header デザインをロ－ドします。 

 

Save Defaults   デフォルトとして現在のデザインを保存します。 

 

Reset to Factory  Factory デフォルトに Track Header Layout をリセットします。 

Keys 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

All Settings Application Keys Page 

インフォメ－ション専用。ここで何も変えることができません。有効にされた Keys とそれらが有効にさ

れた日付を示しています。 



Location 
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Default Projects Location 

 
新しい Project Workspace が制作されたときに、このパスは設定されます。 

ここでボックスの中にパスをタイプするか、または、Browse ボタンを使用することで Windows ファイ

リングシステムをブラウズすることによって、それを変えることができます。 

 

Default Templates Location 

 
Pyramix がインストールされたとき、このパスは設定されます。それはここで、上に述べられた方法で変



更できるかもしれません。 

 

Permanently Mounted Media Folders 

 
すべてのプロジェクトに利用可能な Media Folders のリストを表示しています。 

Add をクリックすると、Choose a Media Folder to Mount のウィンドウが開きます。 

ここで、あなたは、Folders をブラウズするか、または新しいものを制作することができます。 

 
それらのリストエントリを強調表示させて、Remove ボタンをクリックして、フォルダーを取り除きます。 

 

Automation 
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Optimizations 

 
Keep only current version while saving  これをチェックすると、示しているように、します。 

 



Limit versions to the number of Undo/Redo これをチェックすると、示しているように、します。 

 

Undo/Redos の回数が設定されるのは、Settings > All Settings > Application General ページです。 

 

Auto-Release Options 

 

Refresh Rate 

 

Auto Release が有効にされると、リリースされるか、または転送が止められたとき、どのようなコント

ロールであってもその値に戻るか、または前のオートメーションパスの状態か前のパスが全くどこに存在

しないデフォルトの状態に戻るでしょう。これはすぐに、起こります。コントロールが  2 つのステ－トし

かない場合(例えば、1 つのボタン)または、コントロールがフェーダかノブの場合です。 

時限はミリセコンドで、Release Time ボックスに入れられた値で決定します。 

 
Refresh Rate 
 

Quick 10[ms] Slow 100[ms] スライダにより、Refresh レイトの変更を容認します。 

(または、ボックスに値をタイプしてください。) 

 

Refresh Rate 設定はオートメーションデータが記録されるレイトを決定します。デフォルトで、リフレ

ッシュレイトは実のタイムコードフレームレイトと同じです。例えば、25 fpsフレームレイトにおける 40 

ms。再生率の範囲は10～100ミリセコンドです。注意してください。 

この設定はフレーム全体にわたります。有効なリフレッシュレイトがどちらかになるように、実際のフレ

ームレイトの 2 倍か 3 倍にしてください。 

リフレッシュレイトの、より遅い設定を選ぶ 1つの理由は、複雑なミックスの場合にオートメーションム－

ブメントの計算に必要である処理能力を節約するためです。 

 

 

 

 

 

 

 

 

 

 



Time Stretch 
 

TimeZone Settings 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

All Settings Application Time Stretch Timezone Settings Page 

 
Preset 
ドロップダウンリストは様々な音のタイプにアルゴリズムプリセットの選択を提供しています。 

Quality 

スライダは High Qualityと Fast プロセッシングの間での選択を提供しています。 

Stereo Processing 

Enabled ボックスをチェックした場合、ステレオメディアのチャンネルの選択は、分析のために使用され

るでしょう。 

 

Advanced Settings 



Blocklength 

ユーザに使用される処理のブロックの長さの決定を容認します。それは、テキストボックスの中に 32 から 

2048 の間で値を入力するか、またはスライダを動かすことによってできます。 

Cross fading 

ユーザがスライダを動かすことによって、ブロックの間のクロスフェ－ドの長さの変更を容認します。 

Energy Detection 

Enable ボックスをチェックした場合、ユーザは、-70dB と 0dB の間の値をテキストボックスに入れるか、

またはスライダを動かすことによって、スレッシュホールドの値を設定できます。これらのパラメータは

サウンドの質とキャラクタ－に影響します。そして、プロセスの微調正を特定の素材に合わせてください。 

Prosoniq MPEX3 Settings 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

All Settings Application Time Stretch Prosoniq MPEX3 Settings Page 



コンボボックスで Quality ModeとFormant Type から適切な選択をすることによって、MPEX3 

Settings を最適化してください。 

Quality Mode 

Single Instrument Fast 

                                                                                                                              Single Instrument Best 

                                                                                                                              Polyphonic Fast 

                                                                                                                              Polyphonic Good 

                                                                                                                              Polyphonic Best 

Formant Type 

                                                                                                                              Sung Voice 

                                                                                                                              Spoken Voice 

Remote Control 
Machine 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

All Settings Remote Control Machine Page 



The following machines are installed: 
 
すべての取付機材リストを表示します。 

このリストの中のマシンは Transport Control でのマシン選択として利用可能になるでしょう。 

Add 

Add ボタンをクリックすると、Machine Properties ダイアログボックスが開きます。 

(以下を見てください。) 

Remove 

マシンがリストの中で選択されるなら、(強調表示されます。)Remove をクリックすると、マシンをアン

インストールして、リストから取り除きます。 

Properties 

Properties ボタンをクリックすると、Machine Properties ダイアログボックスが開きます。 

(以下を見てください。) 

OK 

OK をクリックして、変更を受け入れて(もしあれば)、Machines ページを閉じてください。 

Cancel 
キャンセルをクリックして、変化を拒絶して(もしあれば)、Machines ページを閉じてください。 

Apply 

Machines ページを閉じないで、Apply をクリックして、変化を適用してください。 

Machine Properties 
 

 
 
 
 
 
 
 
 
 
 
 
                                                                                 

Machine Properties dialog 

 
Machine Properties ダイヤログが Add ボタンによって開かれるとき、Name, Protocol および Port



ディスプレイは空白です。ダイヤログが Properties ボタンによって開かれるとき、ディスプレイは名前

などを反映します。選択されたマシンのためです。 

 
Name 

 
現在の選択されたマシンの名前を表示します。 

新しいマシンを加えるときには、ここで適切な名前をタイプしてください。 

 
Driver 

 
ドロップダウンリストの、現在のインタフェースプロトコル Sony (9-pin P2プロトコル)をディスプレイ

します。 

 
Driver - Properties 

 
SONY が選択されたとき。Sony 9 - Pin Protocol Configuration ダイヤログボックスを開いてくださ

い。(以下を見てください。) 現在、MMC のオプションが全くありません。 

 

Settings 

 
Inhibit Video Record 

 
チェックすると、偶然にビデオが上書きされないよう、ビデオア－ミングのレコ－ドを拒否します。 

 
Pre Roll 
 
外部のマシンのための現在の Pre Roll タイム時間を示しています。 

ボックスをタイプして、値を変えてください。 

 
Post Roll 
 
外部のマシンのための現在の Post Roll タイム時間を示しています。 
ボックスをタイプして、値を変えてください。 

 

Driver Properties 

 



Sony 9-Pin Protocol Configuration (Machine) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Sony 9-Pin Protocol Configuration dialog 

 
このダイヤログは、Monitoring Options on Stop, Monitoring Options on Pause/Jog, Preset 

Channel Options,TimeCode Request のタイプ、In/Out Preset options を取り決めます。 

そして、Serial Port コンフィギュレ－ションダイヤログへアクセスできます。 

 

Serial Port 
 
Configure 

 
Configure ボタンをクリックすると、COMM422 Configuration ダイアログボックスが開らきます。: 

 

 

 

 
 

COMM422 Configuration dialog 

Serial Port 
ドロップダウンリストから選択した現在の Serial Port が表示されています。今だ強調表示されないなら、

希望のシリアル COM ポートを選択してください。標準の選択は、COM1 か COM2 のどちらかです。 



OK をクリックして、選択を確認してください。 

これは Sony 9-pin 通信プロトコルの適切なパラメータの自動的に選択された COM ポートを設定します。 

 

Monitoring options on Stop 

 
Stop コマンドの後に、以下のコマンドが現れます。: 

 

•    Stop Only 

•    Stop + Full EE Off 

•    Stop + Full EE On 

•    Stop + Select EE On 

 

Monitoring Options on Pause/Jog(0) 

 
Pause/Jog コマンドの後に、以下のコマンドが現れます。: 
 
•    Pause/Jog(0) Only 

•    Pause/Jog(0) + Full EE Off 

•    Pause/Jog(0) + Full EE On 

•    Pause/Jog(0) + Select EE On 

 

Edit Preset channel options 

 
必要なら、Track Arming コマンドの無視を可能にします。 

 
•    Send Analog Edit Preset (A1..A2) 

•    Send Digital Edit Preset (D1..D8) 

この特徴は、コンソールかサードパーティレコ－ド/モニタリングコントローラーがレコードコマンドに使

用される大部分に関連しています。 

 

TimeCode Request 
 
ラジオボタンは外部のマシンからの TimeCode の source を選択します。通常、Sony マシンはすべての

要求に応じます。それで、Auto 設定はおおよそ適切にセッティングされるでしょう。 

必要なら、例えば、テープに数個の異なった TimeCodes があるとします。オ－トマチック設定を上書き

するために TimeCode ソースを指定できます。U-Matic マシンはすべての要求に応じません。したがって、



Time Code ソースを指定しなければなりません。 

 

Send In/Out Preset options 

 
In/Out ポイントが Transport Control パネルで設定されるとき、デフォルトで、Pyramix は Edit Video 

In/Out と Edit Audio In/Out ポイントを送ります。 

必要なら、これらのオプションは、だんだんと知られるこれらのコマンドを可能にします。 

 

•    Filter In/Out Preset (video) 

•    Filter Audio In/Out Preset 

 

Controller 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

All Settings Remote Control Controller Page 

Controller ページは、現在インストールされている外部のコントローラーすべてのリストを示しています。 



Properties 

 
選択したコントローラーのコンフィギュアウィンドウをポップアップします。 

詳しい明細については、どうぞご覧ください。: Control by External Device 374 ページ 

 

Sony 9 - Pin Protocol Configuration 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Sony 9-Pin Configuration dialog 

 

Device Request Settings 

 
Sony 9-pin P2 プロトコルは、マシンを確認するためにコードを送ります。 

それらが識別コードを認識しない場合、いくつかのマシンコントローラーは、何もしないか、または異常

な行動を示すでしょう。 

したがって、Pyramix は別のデバイスのふりをすることができます。 

デバイス識別は、次の長い一覧表から選択できます。Show the system as a : コンボボックス。 

 



Jog/Var/Shuttle Still Settings 

 
ラジオボタンは Pyramix の行動を決定します。When receiving Jog/Var/Shuttle with speed = 0 

コマンド: 

 

•   Jog/Var/Shuttle with Speed = 0 (default) 

 

•   Stop 

 
以下に 注意 してください。: ジョグホイールがあるコントローラーを使用するときには、

Jog/Var/Shuttle ... Speed = 0 デフォルトの設定をキ－プしてください。 

 

Monitoring 

 
Filter Monitoring Commands (EE On/Off) をオン、オフしたとき、E から E への On とオフコマンド

はだんだんと知られます。 

 

Print Masters Track Banks 
 

8 tracks の選択されたバンクは、どんな OTHERトラックもア－ミングされているとき、レコードするた

めにア－ミングされます。ステムと同時に Print Master か Masters をレコードするとき、これは主とし

て役に立ちます。例えば、Dialogue,Music および Effects ステムをレコードしているなら、それは、1 個

のステムだけで要素をアップデートする一般的な方法です。 

しかしながら、最終的なミックス Print Master であり、同時に、どれがすべてのステムの合計であるかア

ップデートしなければなりません。Print Masterトラックは、Print Masterトラックのア－ミングについ

て忘れるユ－ザ－を容認します。そして、ステムに集めます。 

 

Filter Arming of Print Masters Tracks 

 

動かした場合、Print Master トラックをア－ミングするのは他の Print Master トラックをア－ミングしな

いでしょう。 

 

No Tallies for Print Masters Tracks 
 

動かした場合、レコ－ドが記録するコマンドは、Print Mastersトラックに、無視されます。 

 



Serial Port 
 
Configure 

 
COMM422 Configuration ダイヤログを開きます。 

 
どうぞご覧ください。: Serial Port 441 ぺ－ジ 

 

Transport Commands Filtering 

 
•  Filter Transport Commands Except Edit On/Off 作動させると、すべての転送コマンドは、 

                       Edit On か Edit Off は別として無視されます。 

 

•  Process Stop Anyway 

 

いくつかのコントローラーが Stop のための Chase Off コマンドを送ります。 

Transport Commands をフィルターにかけるとき、あなたがこのコマンドを必要とすると、ボックスの

チェックは、それは通ることを許すでしょう。 

 

以下に注意してください。: これらのフィルタ設定は、マルチコントローラーが使用されるところで

主に関連しています。例えば、Mixing 卓がコントロ－ルするモニタリングとレコ－ディングです。 

 

Edit On/Off Frame Alignment and Delay 

 
Edit On と Edit Off ボックスは、ディレイ(ミリセコンド)が入力出来ます。 

 
以下に 注意 してください。:  0 = Immediate Punch, 1 = Align to next Frame 

boundary(境 

界線) ,2 or more = Align to the given following Frame boundary 

 

Edit Preset (Track Arming) Mapping 

 
Map Track # コンボボックスで、以下から 2 番目のコンボボックスでマッピングされる選択 1と 96 の間

のトラックを選択できます。: 

 

•   Default 



 

•   No change 

 

•   Always Off 

 

•   Always On 

または、1～96 のいずれのトラックから。 

 

1 つ以上の Pyramix が同じコントローラーによってコントロールされるのであるなら、本機能は役に立ち

ます。例えば、2 つのマシンで、各々32トラックのレコードのセットアップ。Pyramix one を 1 – 1 から 

32 – 32 でマッピングそして Pyramix two を 1 – 33 から 32 – 64 でマッピング。 

 

Virtual Transport 
 

 

 

 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

All Settings Remote Control Virtual Transport Page 



General 
 
Enable Virtual Transport Communication 

 
チェックすると、Pyramix Client は Clock Master としてセットされます。すなわち、Pyramix はすべて

の Clients のマスタクロック照会(親)です。 

 

Automatically Set as TimeCode Master 

 
チェックすると、Pyramix Client は Clock Master としてセットされます。すなわち、Pyramix はすべて

の Clients のマスタ TimeCode (親)です。 
 

Chasing 

Chase Mode - None - Hard - Soft 
 
これらのラジオボタンは Pyramix Chase Mode を切り換えます。 

 
Force TimeCode Source to External / Virtual Transport 
 
チェックすると、TimeCodeソースは External / Virtual Transport です。 

 

Clients State Saving 
下記の間を切り替えます。 

 
Don’t Save 
 
Save Client’s State on Local Server 
 
Save Client’s State on all Servers 

 

Editing 

 
チェックすると、 

Synchronize Virtual Transport with Editing Moves 
 
Send Song Position and Tempo to Virtual Transport 
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Menus 

Pyramix Default Menus 

Menus は Pyramix を超高性能に構成します。コマンドは、隠す、増やす、または全体のメニューを示し

たり、隠したりできます。 

コマンドを見つけることができないなら、それが関連タブのページに隠されるなら、チェックしてくださ

い。 関連タブのページ。 Settings >All Settings > Application > Desktop Layout 

多くの Pyramix メニューエントリは、メニューそのものが解説です。ここで、これらはシンプルに示され

ます。他のメニューエントリは、このマニュアルのここか、でなければ他の場所で説明されています。 

メニューオプションが Toolbar Icon 代替手段を持っているどこでも、これらは、メニュースクリ－ンショ

ットに示されています。 

Project 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Project menu 



New        新しい Editing Project か Digitizing セッションを制作してください。(型紙) 

 

New from Template 1 つのTemplate(型紙)を基本にして新しい Project を制作してください。 

 

Open        既存の Editing Project か Digitizing セッションを開いてください。 

 

Save        現在の Project をセ－ブしておいてください。プロジェクトが一度も保存された 

                                                                                                    ことがないと、Save As "別名で保存"ダイアログボックスが現れるでしょう。 

 

Save As       新しい名前で現在の Project をセ－ブします。 

 

Save as Template  1 つの Template として現在の Project をセ－ブします。 

 
Save as Version 4.3 互換性のために。 

 

Close        現在の Project を閉じます。最終セ－ブ以来ファイルが変更されているなら、こ 

                                                                                                      の Save ダイアログボックスが現れます。 

 

Information & Settings Information Panel には、現在のプロジェクトに関連する情報記入のための 

                                                                                                     フィールドがあります。 

 

Import...       Inter Change Import Manager を開きます。 

 
Export...       Inter Change Export Manager を開きます。 

 

Import from Tape (Capture) 外部のデバイス上のメディアが現在の Project にキャプチャーされる 

                                                                                                      のを容認します。 

 

Export to Tape (Auto Edit) 現在の制作物が外部のデバイスにエクスポートされるのを容認します。 

 

Archive       すべての関連メディアでもう 1 つの位置に現在のプロジェクトのコピーを制作 

                                                                                                     します。 

 

Consolidate     現在のプロジェクトのために最適化されたメディアのセットを制作します。 

 

Convert       他のサンプルレイトにプロジェクト全体を変換します。または、 



Stretch / Pitch    プロジェクト全体の Stretch または、Pitch の変更をします。 

                                                                                                       24fps から 25fps (4% の時間圧縮かピッチ減少) または、25fps から 24fps 

                                                                                                     (4.17% の時間引き伸しかピッチの上昇)です。 

 

Resample      リ-サンプラ－を開きます。 

 

Reconform > 

 

Relink to New Media CMX Import 機能と同様の、様々なオプションを提供するダイヤログを開きま 

                                                                                                      す。 これは、再リンクが、すべてか、1 つのクリップの選択をニューメディア 

                                                                                                      に容認します。通常、クリップネ－ム、メディアネ－ム、Scene & Take 情報 

                                                                                                      または、オリジナル TimeCode に基づいて、24 ビットバージョンがあるオー 

                                                                                                      ディオファイルと16 ビットバージョンの置換に使用されます。 

 

Load Change EDL  ロードするために、“State 1 EDL” と“State 2 EDL” から作り出されるいわゆ 

                                                                                                     る“Change EDL” がロードされるのを容認します。Cues は、State 1 から 

                                                                                                      State 2 までの変化を反映するように、現在のプロジェクトの中で再配列されま 

                                                                                                      す。 

 

Render       プロジェクトか現在の選択を新しい Media File にレンダ－します。 

 

Mix Down      調整卓を通してプロジェクトか、現在の選択を新しい Media File にミックスし 

                                                                                                      てください。  

Generate CD Image / SACD Edited Master Generate CD Image / SACD Edited Master Dialog 

                                                                                                     を開きます。: DSD オプションは DSD Projects のみに利用可能です。 

 

Surround Post-processing 現在のコンポジションが、AC3 か DTS などの異なった Surround フォ 

                                                                                                       ーマットでコード化されるのを可能にします。 

(適切なオプションのエンコーダプラグインがインストールされている場合。) 

“1 surround monitor.pmx” etc. 最も最近開いた Projectsをこの位置に示します。エントリをクリッ 

                                                                                                     クすると、その Project  が開きます。 

 

Exit         アプリケーションを終了するには、File メニューから Exit を選んでください。 

                                                                                                     プロジェクトを最後の保存して以来、変更されているなら、システムは、変更を 

                                                                                                      セーブするよう、うながすでしょう。 

 



以下に 注意 してください。: Stretch / Pitch メニューの選択はオプションの Prosoniq MPEX 

が必要です。 

Edit 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Pyramix の Edit メニューは従来の Delete を含んでいます。Cut、Copy コマンド、および Paste サブメ

ニュー、また、Pyramix Composition Editor の中にある以前の編集オペレーションの Undo と Redo の

ためのオプションと、クリップの配置ための特別なエディットコマンドです。 
 
Undo clip(s) move  Undo コマンドは、最後の編集動作の表示を変更し、それが選択されると、取り

消します。 

 

Undo history >   元に戻すことができる以前の編集動作すべてのリストがあるサブメニューに通じ 

                                                                                                  ます。 

 

Redo clip(s) move リドゥコマンドは、最後の元に戻された操作の表示を変更し、それが選択される 

                                                                                                   と、取り消します。 

 

Delete       現在選択されたクリップ/選択を削除します。 

 

Cut        プロジェクトから現在の選択をカットして、Clipboard にそれセーブします。 

 

Copy        プロジェクトから現在の選択をコピーして、Clipboard にそれセーブします。 

 
Paste > 

 
Paste to Cursor   現在のカーソル位置に Clipboard 上にあるものを挿入します。 

 

Paste & Place    このコマンドは、より広範囲にわたる位置決めオプションを考慮する 

 Placement Tool を開きます。    

Paste to Original TimeCode クリップのオリジナルソ－スタイムコードポジションへ、ぺ－スト 

                                     された、 Clipboard 上にあるものを挿入します。 

Paste to End of Selection  現在選択されたエンドポイントにClipboard 上にあるものを挿入 

                                                                                                                                         します。 

 
Fill Selection    このコマンドは、Clipboard 内容を選択したクリップかリージョンの代わりに用 

                                                                                                  いるでしょう。 

 

Replace Selection  このコマンドは、Clipboard 内容を選択したクリップかリージョンの代わりに用 



                                                                                                  いるでしょう。そして、それらの長さに差があれば、次のクリップをリップルし 

                                                                                                  ます。 

Loop Selection   このコマンドは、Clipboard 内容のル－プを選択したクリップまたは、トラック 

                                                                                                  でシンクの変更のないリージョンの代わりに用いるでしょう。 

 

Fit Selection    このコマンドは、インサ－トされたクリップが、Timeline 上の指定領域に組み込 

                                                                                                  まれるのを容認します。これは、Timezone Time コンプレッション/Expansion 

                                                                                                  プラグインを必要とします。 

 

Delete and Ripple  現在選択されたクリップ/選択を削除します。リップルを起こします。 

 

Cut and Ripple   プロジェクトから現在の選択をカットします。そして、Clipboard でそれセーブ 

                                                                                                  します。リップルを起こします。 

 

Paste and Ripple  現在のカーソル位置に Clipboard にあるものを挿入します。リップルを起こしま 

                                                                                                   す。 

Insert Silence    これは現在の選択に(無音) スペースをインサートします。 

 

Delete and Join   現在選択したクリップ/選択を削除して、クリップの端をリップルします。 

 

Cut and Join    現在選択したクリップ/選択をクリップボードへカット、セ－ブして、クリップ 

                                                                                                   の端をリップルします。    

 

Delete and Ripple to Black 現在選択したクリップ/選択を削除します。そして、接合、クロスフェ－ド 

                                                                                                  されたすべてのクリップに続いてリップルします。 

 

Cut and Ripple to Black 現在選択したクリップ/選択をクリップボードへカット、セ－ブして、接合、 

                                                                                                  クロスフェ－ドされたすべてのクリップに続いてリップルします。 

 

Split        このコマンドは選択したクリップをそのポイントであたかも髭剃りの刃のように、 

                                                                                                    2 つへ分かつのに使用します。プレーカーソルは選択されたクリップに交差して 

 います。 

 

Unsplit       Split, Cut または Crossfaded されてあるクリップはただちに結合し返すとが 

                                                                                                   できます。それらがいまだシンク中で、同じメディアに関係中であることを提供 

                                                                                                  します。 



Trim        クリップの残りに比例してヘッドかテールを動かすことによって、Trim ハンドル 

                                                                                                  で、クリップの長さを短くするか、または引き伸ばします。 

Trim In to Cursor 

 

Trim Out to Cursor 

 

Stretch       クリップが引き伸ばしされるか、または縮められることを示しています。 

 

Reverse      クリップが Timeline での選択に取り付けられるのを容認します。Timezone プラ 

                                                                                                 グインの値が選択領域にクリップが合うように自動的に設定されるでしょう。 

 

Normalize      ノーマライズプロセスを選択したクリップに適用します。 

 

Consolidate    Consolidate 機能は Composition の中でメディアセグメントの選択的バックア 

                                                                                                   ップを作るでしょう。 

 

Spread       このコマンドは、スペース(無音)が選択されたクリップの間に挿入されるのを容 

                                                                                                  認します。 

 

Abut to selected  このコマンドは同じトラックでトラックの Mark In と Mark Out の間のすべての 

                                                                                                 クリップをマークの間の選択されたクリップに隣接させます。 

 

Automatic Silence Removal このコマンドは Automatic Silence Removal ダイアログボックスを 

                                                                                                  開らきます。 

 

Delete with Media  コンポジションから現在の選択されたクリップを取り除いて、結び付いているメ 

                                                                                                  ディアファイルも削除します。 

 

Update Media Original TC コンポジションにおけるそれらの TimeCode の位置があるすべての選択 

                                                                                                 されたクリップのために Media Original TC をアップデートします。M edia を 

                                                                                                  修正するこのオペレーションは、リバーシブルではありません。 

 
Source-Destination > 

 

                    Auto-Edit Source to Destination 

 



                                        適切な Source/Destination 2, 3 または、ゲーツステータスによるオペレーションを編集するポ 

                                        イントを創作します。 

 

Overwrite Source to Destination 

Source Track Group Gates の間には、内容がある状態で、Destination Track Group Gates 

の間の内容を上書きします。 

 

Insert Source to Destination DestinationTrack Group Gates へ Source Track Group 

               Gates の間の内容をインサ－トします。 

 

Replace Source to Destination 

                                      Destination Track Group Gates の間の内容を Source Track Group Gates の間の内容に 

                                        Destination をリップルすることによって、取り替えます。 

 

Fit Source to Destination Source を伸ばすことによって、Destination Track Group Gates の 

                    間の内容を Source Track Group Gates の間の内容に取り替えます。 

 

Auto Set Destination Gate In after Editこのオプションをチェックすると(可能)、Destination 

                    Gate In ポイントはどのような Source-Destination オペレーションの後においても自動的に、 

                    現在の Gate Out ポイントに設定されます。 

 

Auto Select Destination after Edit   このオプションをチェックすると(可能)、Destination 

                    Track Group はどのような Source-Destination オペレーションの後であっても自動的に選択 

                    されます。 

 

Limit 1 Gate Sources to End/Beginning of Clip  このオプションをチェックすると(可能)、 

                    全体のトラックの代わりに、Source Gate とGate の下のクリップの端の間に、Source 素材は、 

                     Destination にコピーされます。 

 
3 Gates Auto-Edit does Overwrite   このオプションがチェックされ (可能)、2 Gates が 

                    Source で用意されると、その後 1 は Destination、次に、AutoEdit は Overwrite オペレーシ 

                    ョンを実行します。 

 

3 Gates Auto-Edit does Insert  このオプションがチェックされ (可能)、2 Gates が Source 

                    で用意されると、その後 1 は Destination、次に、AutoEdit は Insert オペレーションを実行し 

                    ます。 



Jog-Wheel Editing 

 
多くの編集動作が、選択されたクリップか、外部のハードウェアコントローラーでジョグホイー

ルを使用するクリップグループで引き受けられるかもしれません。 

まず最初に、Clip か、Clips グループを選択してください。そして、以下の選択から希望の 

 Jog-Wheel Editing Mode を選んでください。 

 
Move 

 
Trim In 

Trim Out 

Trim Fade Out 

Tim Fade In 

Trim Fade In Symmetrically 

Trim Fade Out Symmetrically 

Trim Sync Point 

                                                      Slip In 

                                                  Slip Out 

 

 Slide Media 

 

今度は、Move, Trim, Slip または、Slide the Clip(s) にジョグホイールをシンプルに動かして

ください。Spacebar か Enter を押すと、change(s)、Esc キャンセルは確認されます。 

 

Editing Modes > Insert Mode > 

 
Overwrite    チェックすると、どのようなクリップであっても、配置されます。既存のクリッ 

                                                                              プは、二つのオ－バ－ラップであるそのクリップの部分に上書きされます。 

 

Insert Track  チェックすると、どのようなクリップであっても、トラックに配置されます。そ 

                                                                               してトラックに挿入されるでしょう。つぎに、時間の中で(右へ)、挿入されたク 

                                                                               リップの長さにより、トラックのすべての他の素材をリップルするでしょう。 

 

Editing Modes > Remove Mode > 

 

Remove    チェックすると、選択されたどんな素材もTimeline からシンプルに取り除かれる 



                                                                                 でしょう。他の何もかもが、完全にそのままで、場所も同じでしょう。 

 

Remove and Ripple チェックすると、選択されたどんな素材もTimeline から取り除かれるでし 

                                                                                 ょう。取り除かれた素材はそれによって、右にスペ－スができるために、左(より 

                                                                                  早く)へリップルされるでしょう。 

 

Editing Modes > Snap Mode > 

 

Don’t Snap   スナップモードは、セットされません。このモードはトラックに置かれたオブジ 

                                                                                  ェクトの動きに影響を与えません。行動は既存の Insert とRemove モードに従 

                                                                                  います。 

 

Head to End   このモードで、トラックに置かれたどんなクリップの始まりも、トラックの最後 

                                                                                 のクリップの端までスナップされるでしょう。新しいクリップのヘッドを最後の 

                                                                                 クリップの端(テール)まで隣接させます。 

 

Tail to Beginning このモードで、トラックに置かれたどんなクリップも、トラックで最初のクリッ 

                                                                                 プの始まりまでスナップされるでしょう。最初のクリップのヘッドに新しいクリ 

                                                                                  ップのテールを隣接させます。 

 

Head to Nearest このモードで、トラックに置かれたどんなクリップも、トラックで最も近い編集 

                                                                                  ポイントかマークにクリップのヘッドをスナップされるでしょう。これは、トラ 

                                                                                  ック上でヘッドまたは存在するクリップのテールを含んでいます。Play Head － 

                                                                                  Cursor, Mark In, Mark Out,Named Markers,または、CD Markも同様です。 

                                                                                   Insert Mode 設定に従った既存のクリップに、クリップは相互作  用するでしょ 

                                                                                  う。 

Tail to Nearest  このモードで、トラックに置かれたどんなクリップも、トラックでの最も近い 

                                                                                  編集ポイントかマークにクリップのテールをスナップするでしょう。これは、 

                                                                                 トラック上でヘッドまたは存在するクリップのテールを含んでいます。 

                                                                                  Play Head Cursor, Mark In, Mark Out,Named Markers,または、CD Marks 

                                         も同様です。 Insert Mode 設定に従った既存のクリップに、クリップは相互作用 

                                                                                  するでしょう。 

Snap to Original TimeCode このモードで、トラックに置かれたどんなクリップも、クリップの 

                                                                                  オリジナルのTimeCode によって再び表された時間位置にクリップのヘッドを 

                                                                                  スナップするでしょう。Insert Mode 設定に従った既存のクリップに、クリップ 

                                                                                  は相互作用するでしょう。 



Auto-Ripple  このオプションがチェックされた場合(可能)、すべての Insert か Remove オペレー 

                                                                              ションがトラックの残りをリップルします。 

 

Auto-Crossfade このオプションがチェックされた場合(可能)、デフォルトクロスフェイド、(Fade  

                                                                              Editor Tab Window で定義されている)は、どのような Paste または、 

                                                                              Source-Destination オペレーションに適用されます。 

 

Enable Automation Cut/Copy/Paste 

                                                                             また、このオプションがチェックされた場合(可能)、すべてのCut / Copy / Paste オ 

                                                                              ペレーションはオートメーショントラックを含んでいます。 

 

Update Original TC on Move このオプションをチェックした場合(可能)、どんなコピーされた/移動 

                                                                             した選択のオリジナル TimeCode スタンプも現在の移動の前にそれが中にあった位 

                                                                              置にアップデートします。 

Snap > 

 
Snap Off   このオプションがチェックされた場合(可能)、Snap モードは出来ません。 

Snap to Edits このオプションがチェックされた場合(可能)、Snap モードは Edits に設定されま 

す。 

Snap to Scale このオプションがチェックされた場合(可能)、Snap モードは Scale に設定されま 

す。 

Snap to Feet Scale このオプションがチェックされた場合(可能)、Snap モードは Feet Scale に 

設定されます。 

Snap to Bars & Beats Grid このオプションがチェックされた場合(可能)、Snap モードは Bars 

                                                                       & Beats に設定されます。 

Snap Cursor このオプションがチェックされた場合(可能)、また、現在のモードに従って、Cursor 

はスナップされます。 

Snap Region Selection このオプションがチェックされた場合(可能)、また、現在のモードに従 

って、Selection はスナップされます。 

Snap Selection Head このオプションがチェックされた場合(可能)、Snap モードは選択される 

Head に設定されます。 
Snap Selection Tail  このオプションがチェックされた場合(可能)、Snap モードは選択される 

                                                                      Tail に設定されます。 

Snap Selection Sync Point このオプションがチェックされた場合(可能)、Snap モードは選択 

される Sync Point に設定されます。 
 



View Menu 

 
 
 
 
 
 
 
 
 
 
 
 
 

View menu 

 
Fixed Cursor while playing チェックした場合(可能)、Playhead Cursor は、再生している間、静

止していたままで残っています。その位置は、the Settings > All Settings > Playback/Record 

ページで設定され、Tracks は右から左へスクロールします。 

 

Free Cursor while playing チェックした場合(可能)、スクリーン境界に達したとき、すなわち、 

                             Timeline は再び描かれません。 

 
Cursor Auto-Return after playing 

                            チェックした場合(可能)、再生が止まったとき、Playhead Cursor はスタ－ト位置に戻ります。 

 
Set Focus to the Timeline キーボードショートカットのマッピングは非常に利用価値が高いです。 

                            フロ－ティング Tab か他のウィンドウが開かれたとき、それは、フォーカスを保って、いくつかの 

                            コマンドを独占します。通常 Space Bar とこのコマンドを呼び出す Cursor ボタンは、フォーカス 

                            を復元するために Timeline をダイレクトにクリックするのと等しいです。しかし、マウスを握る 

                            のを避け、どのような選択の解き放ちも避けます。 

Show Ghosts  チェックした場合(可能)、関連する仮想トラックにクリップのゴーストを表示します。 

 
Show Media   チェックした場合(可能)、選択されたクリップのためにレッド・ラインとしてトラッ 

                                                                                  クに、基本的なデジタル・メディアの完全なエクステントを示します。そのラインは 



これがオンであるときに、灰色にされたウエ－ブフォ－ムイメ－ジを持った選択されたクリップの上下に 

あります。 

TimeCode Resolution > 

 
Frames  1 秒あたりの Cursor TimeCode がディスプレイするフレームのレゾリュ－ションを設 

                                                    定します。 

Samples 1 秒あたりの Cursor TimeCode がディスプレイするサンプル数を設定します。 

 

[ms]   1 秒あたりの Cursor TimeCode がミリセコンドでディスプレイするよう設定します。 

 

CD frames 1 秒あたりの Cursor TimeCode が CDフレ－ムでディスプレイするよう設定します。 
 

Display as CD time TimeCode ディスプレイを CD Track 経過時間に設定します。 

(CD Markers があるときだけ利用できます。) 

 
Waveform Display > 

 
Larger  現在のウエ－ブフォ－ムディスプレイサイズを大きくします。 

 

Smaller  現在のウエ－ブフォ－ムディスプレイサイズを小さくします。 

 

x1     現在のウエ－ブフォ－ムディスプレイの拡大係数を1x に設定します。 

 

x2     現在のウエ－ブフォ－ムディスプレイの拡大係数を2x に設定します。 

 

x4     現在のウエ－ブフォ－ムディスプレイの拡大係数を4x に設定します。 

 
x8     現在のウエ－ブフォ－ムディスプレイの拡大係数を8x に設定します。 

 
DB    現在のウエ－ブフォ－ムディスプレイをデシベル に設定します。 

 
Auto-Scale Waveform 現在のウエ－ブフォ－ムディスプレイを自動的に最適波形で表示するよ 

                                                    うに設定します。 

 

Show Full Waveform 現在のウエ－ブフォ－ムディスプレイにサンプルレベルでさえ完全に着色 

                                                    される波形を表示するように設定します。(ピークディスプレイように。) 



Show Waveform Origin  現在のウエ－ブフォ－ムディスプレイを 0dB 基点で表示するように設定 

                                                                        します。 
Show Dynamic Waveform 現在のウエ－ブフォ－ムディスプレイを 各ピクセルのためのダイナミッ 

                                                                         クレンジで示している波形を表示するように設定します。 

Hide Clip Name when Waveform Shown 

                                                                         波形を表示するとき、クリップネ－ムを隠します。 

 
Zoom > 

 
Fit in window selected clip か region に合うように(fit)、Project Editor パネルの水平な倍率(ズー 

ムレベル)を調整します。 

 
Previous zoom   前のズーム分解能と位置に Project Editor Panel 画面を復元します。 

 
Zoom In   2x の要素で、画像を徐々に拡大します。Project Editor Panel の中央の中心に置かれま

す。 

Zoom Out  2x の要素で、画像を徐々に縮小します。Project Editor Panel の中央の中心に置かれま

す。 
Recall Preset > 

 
Zoom 1   Recall Preset Zoom 1 

 

Zoom 2   Recall Preset Zoom 2 

 

Zoom 3   Recall Preset Zoom 3 

 

Zoom 4   Recall Preset Zoom 4 

 

Zoom 5   Recall Preset Zoom 5 

 
Auto Zoom Selection  Project Editor Panel はTimeline で作られたどのような選択へも自動的に

ズームインを表示します。 

Tracks > 
 
Show all Tracks  すべてのトラックスを表示して(Unhide)、すべてのTrack Groups を Expand し  

ます。(Uncollapse) 



Hide Tracks without selection  選択していないすべてのトラックを隠します。 

 
Fit View to > 

 
Fit View to 1 Track    Fit current View to 1 Track 

 

Fit View to 2 Tracks   Fit current View to 2 Tracks 

 

Fit View to 4 Tracks   Fit current View to 4 Tracks 

 

Fit View to 8 Tracks   Fit current View to 8 Tracks 

 

Fit View to 16 Tracks  Fit current View to 16 Tracks 

 

Fit View to All Tracks  Fit current View to All Tracks 

 
Enlarge Track Size     Enlarge (拡大) current Track Size 

 

Reduce Track Size     Reduce (縮小) current Track Size 

 

Scroll Timeline      Timeline 全体を左にスクロールします。 

 
Scroll Timeline Right    Timeline 全体を右にスクロールします。 

 

Scroll Timeline Up      Timeline 全体を上にスクロールします。 

 

Scroll Timeline Down    Timeline 全体を下にスクロールします。  

 

Scales / Toolbars >   

 

TimeCode Toolbar     メイン TimeCode ツールバーを表示/非表示にします。 

 

Feet           Time ルーラーの下に、Feet でメモられた、ルーラーを加えます。(存在 

                                                                                                                                   しているなら) 

 

Feet Settings       Feet Settings ダイアログボックスを開きます。 



Bars&Beats        Time ルーラーの下に、Bars&Beats でメモられた、ルーラーを加えます。 

                                                                                                                                  (存在しているなら) 

Bars&Beats Settings   Bars&Beats Settings ダイアログボックスを開きます。 

 

Tempo Map        Time ルーラーの下に、Tempo マップを加えます。(存在しているなら) 

 

Source – Destination 

 

Transport Toolbar     Transport Toolbar を表示/非表示にします。 

 
Automation Toolbar    Automation Toolbar を表示/非表示にします。 
 
Windows / Tools > 

 
Transport     Transport Large Control を表示します。 
 
Mixer       Mixer を表示します。 

 
Monitor      Monitor を表示します。 

 
Media Management    Media Management フォルダーを表示します。 

 
Global libraries   Global libraries を表示します。 

 
Fade Library    Fade Library を表示します。 

 
 
Information     Information Window を表示します。 

 

On the Air     On the Air Window を表示します。 

 

I/O Status     I/O Status Window を表示します。 

 

Editor Tabs > 

 

Overview     Overview Tab ウィンドウを開きます。 



EDL        EDL Tab ウィンドウを開きます。 

 
Document Libraries  Document Libraries Tab ウィンドウを開きます。 

 
Tracks       Tracks Tab ウィンドウを開きます。 

 
Track Groups    Track Groups Tab ウィンドウを開きます。 

 

Playlists      Playlists Tab ウィンドウを開きます。 

 
Workspaces    Workspaces Tab ウィンドウを開きます。 

 

Selection      Selection Tab ウィンドウを開きます。 
 
Fade Editor    Fade Editor Tab ウィンドウを開きます。 

 
Markers      Markers Tab ウィンドウを開きます。 

 
CD         CD Tab ウィンドウを開きます。 

 
Notes       Notes Tab ウィンドウを開きます。 

 
Machines     Machines Tab ウィンドウを開きます。 

 
Media Management  Media Management Tab ウィンドウを開きます。 

 
Global Libraries  Global Libraries Tab ウィンドウを開きます。 

 
Customize > 

 

Keyboard Shortcut Editor  Keyboard Shortcuts ウィンドウを開きます。 

(ショートカット作成とマネジメント) 

 
Macro Editor    Macros ウィンドウを開きます。(マクロ作成とマネジメント。) 

 

All Settings     All Settings ウィンドウを開きます。 



Clips 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Clips menu 

Select > 

Select All       Timeline 上のすべてのクリップを選択してください。 

 

Select All to Mark In   現在の Mark In Point に、Timeline 上のすべてのクリップを選択してくださ 

                                                                                                                    い。 

Select All between Marks 現在の In/Out Marks の間で、Timeline 上のすべてのクリップを選択し 

                                                                                                                    てください。 

Select All from Mark Out 現在の Mark Out Point から、Timeline 上のすべてのクリップを選択して 

                                                                                                                    ください。 

Select Source     現在のオーディオトラック上のすべてのクリップを選択します。 

 

Deselect All      すべての現在選択されたクリップを開放します。 

 

Select Previous Clip  現在選択されたクリップの左のクリップを選択します。 



Select Next Clip     現在選択されたクリップの右のクリップを選択します。 

 

Add Previous Clip to Selection 

                                                                                                                    現在選択されたクリップの左の選択を供給します。 

 

Add Next Clip to Selection 

                                                                                                                    現在選択されたクリップの右の選択を供給します。 

 

Add all Preceding Clips to Selection 

                                                                                                                    現在選択されたクリップに先行するすべてのクリップに選択を供給します。 

 

Add all Following Clips to Selection 

                                                                                                                    現在選択されたクリップに続いて、すべてのクリップに選択を供給します。 

Nudge > 

 

Nudge to Previous Edit エディタ－でトラックの前の編集ポイントかマークへ左(時間で初期の)に選 

                                                                                                                    択されたクリップをナッジします。 

Nudge to Next Edit   エディタ－でトラックの次の編集ポイントかマークへ右(時間で後の)に選択 

                                                                                                                   されたクリップをナッジします。 

Nudge to Left     現在の Nudge 設定と等しい量で、左(時間で初期の)に選択されたクリップを 

                                                                                                                    ナッジします。 

Nudge to Right     現在の Nudge 設定と等しい量で、右(時間で後の)に選択されたクリップをナ 

                                                                                                                   ッジします。 

Nudge to Left Custom  Keyboard で入力した量で、左(時間で初期の)に選択されたクリップをナッ 

                                                                                                                   ジします。 

Nudge to Right Custom Keyboard で入力した量で、右(時間で後の)に選択されたクリップをナッジ 

                                                                                                                   します。 

Nudge to Left Custom in Bars/Beats 

                                                                                                                    Keyboard で Bars/Beats を入力した量で、左(時間で初期の)に選択された 

                                                                                                                    クリップをナッジします。 
Nudge to Right Custom in Bars/Beats 

                                                                                                                    Keyboard で Bars/Beats を入力した量で、右(時間内に、後で)に選択され 

                                                                                                                     たクリップをナッジします。 

Nudge In to Left  (Pressing Control は、マウスでの移動と同じくらいの作用をさせます。)  

 
Nudge In to Right (Pressing Control は、マウスでの移動と同じくらいの作用をさせます。) 



Nudge Out to Left (Pressing Control は、マウスでの移動と同じくらいの作用をさせます。) 

 
Nudge Out to Right (Pressing Control は、マウスでの移動と同じくらいの作用をさせます。) 

 
Nudge Media to Left 

 
Nudge Media to Right 

 
Move Up     選択したクリップか、隣接しているトラックの上まで、リージョンを移動します。 

 

Move Down   選択したクリップか、隣接しているトラックの下まで、リージョンを移動します。 

 
Move Up with Fade 選択したクリップか、隣接しているトラックの上まで、リージョンを移動します。 

                                                                                       その位置に隣接している別のクリップがあれば、それは、クロスフェ－ドすることに 

                                                                                       よって、それとやり取りするでしょう。 

 

Move Down with Fade 選択したクリップか、隣接しているトラックの上まで、リージョンを移動しま 

                                                                                        す。その位置に隣接している別のクリップがあれば、それは、クロスフェ－ドする 

                                                                                       ことによって、それとやり取りをするでしょう。 

Current Setting > 

Nudge Setting 1   Apply Nudge Setting 1 

 

Nudge Setting 2   Apply Nudge Setting 2 

 

Nudge Setting 3   Apply Nudge Setting 3 

 

Nudge Setting 4   Apply Nudge Setting 4 

 

Nudge Setting 5   Apply Nudge Setting 5 

 
Set Sync Point to Cursor  現在のカーソル位置に選択されたクリップの Sync Point を設定します。 

 

Send Sync Point to Cursor Sync Point が Play Cursor の現在の位置に並べられるように、現在選 

                                                                                                                                           択されたクリップを送ります(移動します)。 

Group           Timeline で選択したクリップすべてを一緒にグループにします。 

 



Ungroup          Timeline で選択したグループクリップをアングループメンバにします。 

 

Lock            Timeline で編集できない、移動させることができないように、選択し 

                                                                                                                                           たクリップをロックします。 

 

Unlock           再びそれらを編集できるように、ロックしたクリップを外します。 

 

Lock Horizontal Drag    可能にすると、水平にクリップをドラッグすることができません。 

                                                                                                                                          (右から左) 

 

Clip Gain           選択したクリップにオーディオレベルを設定するためにオーディオフ 

                                                                                                                                           ェーダを表示します 

 

Mute Clip          選択したクリップをミュ－トします。 

 

Rename          Rename Clips ダイヤログで選ばる様々な結合可能オプションがある、 

                                                                                                                                           クリップのリネ－ムを可能にします。 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Rename Clips dialog 



Options 

 
Keep Current Name     チェックすると、現在の名前は保持されます。 

しかし、キ－ピングの選択、または、かっこ内の現在のトラック番号

を取り除くことが必要です。 

 

Remove Track Number    Clip Name から Track Number を取り除きます。 

 
Prefix            すべてのクリップの自動リネ－ムと自動リナンバするカスタム接頭 

                                                                                                                                                  辞と接尾辞テキストを加える、新しいカスタム Prefix が加えられるテ 

                                                                                                                                                 キスト入力ボックスです。 

 
Track Name 

 

Track Number – X 

 

Media Scene & Take (可能であるなら) 

 

Media Name 

 

Media Track Number (X) 

 

Media Tape Name 

 

Media File Name 

 

Ignore File Extension 

 

Include Full Path 

 

Suffix            新しいカスタム Suffix が加えられるかもしれないテキスト入力ボッ 

                                                                                                                                                クスです。 

Auto number clips      チェックすると、クリップは以下の値から始まる付番をされます。: 

 

Starting Numbering at: 

 



Items Separator       新しいカスタム Separator が加えられるかもしれないテキスト入ボ 

                                                                                                                                                ックスです。 

Edit Fade near Cursor    編集レディ状態の現在の Playhead カーソルポジション近くにロケ－ 

                                                                                                                                                トされたオ－ディオフェ－ドがある Fade Editor を開きます。 

 

Edit Fade near Mouse     編集レディ状態の現在のマウス カーソルポジション近くにロケ－ト 

                                                                                                                                                 されたオ－ディオフェ－ドがある Fade Editor を開きます。 

 
Fade In > 

 

Fade Out > 

 

X Fade > 

 
以下に 注意 してください。: サブメニューオプションはこれらに向けてです。Fade In, Fade 
Out, および X Fade は同じです。 

簡潔さにより、Fade In サブメニューオプションだけが示されます。 

 

Fade In New     新しいフェ－ドインを供給します。 
 
Fade In Edit 

 
Default >       フェ－ドインを編集します。 
 

Fade In Default       デフォルトのフェ－ドインを供給します。 
 

Fade In Default Curve    デフォルトカーブのフェ－ドインを供給します。 
 
Fade In Standard > 

 
Fade In Power Linear     Power Linear のフェ－ドインを供給します。 

 
Fade In Tension Linear    Tension Linear のフェ－ドインを供給します。 

 
Fade In dB Linear      dB Linear のフェ－ドインを供給します。 

 



Fade In Cosine        Cosine のフェ－ドインを供給します。 

 
Fade In Root Cosine     Root Cosine のフェ－ドインを供給します。 

 
Envelope > 

 

Envelope Reset       全体の選択のためにゲインエンベロープをリセットします。 

                                                                                                                                              Reset が選択された場合、マウスカーソルの下の選択したトラ 

                                                                                                                                              ックのみの中に、すべてのオートメーションなノードを削除す 

                                                                                                                                              ることによります。 

 

Envelope Reset Selection  全体の選択のために選択の中ですべてのオートメーションノー 

                                                                                                                                             ドを削除することによって、ゲインエンベロープをリセットし 

                                                                                                                                              ます。 

 

Envelope Copy to Selection Selection へのコピーが選択における他のすべてのトラックに 

                                                                                                                                              選ばれた場合、マウスカーソルの下のトラックから選択の中の 

                                                                                                                                              すべてのオートメーションなノードの値をコピーします。 

 

Envelope Punch       Punch が選ばれている場合、マウスカーソルの下のトラックで 

                                                                                                                                              選択の限界である 4 つの新しいオートメーションノを配置しま 

                                                                                                                                              す。そして Punch Envelope ダイアログボックスが開きます。 

 

Envelope Punch Selection  Punchと同じオペレーションを行いますが、現在のSelection 

                                                                                                                                              のすべてのトラックに行います。 

 

Waveform > 

 

Waveform follow Track    クリップのウエ－ブフォ－ムディスプレイは、いつもTrack 

                                                                                                                                          information and Settings panel で、全体のトラックのため 

                                                                                                                                             の設定に対応するでしょう。 

 

Waveform force Waveform  クリップはトラックのウエーブフォームディスプレイ設定にか 

                                                                                                                                             かわらず、いつもウエーブフォームディスプレイを表示します。 

 

Waveform force Name    クリップはトラックのためのウエーブフォームディスプレイ設 



                                                                                                                                            定にかかわらずいつもクリップネ－ムを表示します。 

 

Generate Waveform     選択されたクリップのためにバックグラウンドにおけるウエー 

                                                                                                                                            ブフォームデータを作り出してください。 

 

Selection Properties     Selection Properties ディスプレイ・ウィンドウを開きます。 

                                                                                                                                            そこは、現在の選択に関する詳細を示しています。 

 

Properties         Selection Properties ディスプレイ・ウィンドウを開きます。 

                                                                                                                                            そこは、現在選択されたクリップに関する詳細を示しています。 

 

Tracks 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Tracks menu 

New Audio Track     新しいオーディオトラックが Composition Editor で制作されるのを容認 

                                                                                                                                します。 



New Virtual Track     新しい仮想のトラックが Composition Editor で制作されるのを容認しま

す。 

Delete          コンポジションエディタから現在選択されたトラックを取り除きます。 

 
Delete to Last       現在選択されたトラックの間のトラックすべてを Composition Editor の 

                                                                                                                                上の最後のトラックまで削除します。 

Auto-connect       自動的にあらゆる利用可能なミキサーインプットに、すべてのトラックを 

                                                                                                                                連続して関連づけます。 

Select Previous Track Group 現在選択されたトラックグループを超えてトラックグループを選択し 

                                                                                                                               ます。 

Select Next Track Group 現在選択されたトラックグループの下でトラックグループを選択します。 

 
Duplicate Selected Track Group 現在選択されたトラックグループを複製します。 

 
Auto Create/Delete Track Groups 可能にされた場合、Track Groups は自動的に制作されます。 

                                                                                                                                クリップインサーションは、トラックの新規作成を必要とします。 

 

Select Previous Track   現在選択されたトラックの上でオーディオトラックを選択します。 

 

Select Next Track     現在選択されたトラックの下でオーディオトラックを選択します。 

 

Deselect Track      現在選択されたオーディオトラックの選択を外します。 

 

Auto Select Tracks    オーディオトラックは内容におけるどんなクリック/移動のときにも自動 

                                                                                                                                的に選択されます。 

 

Synchronize Tracks & Strips オーディオトラックとその関連する調整卓ストリップはいつも一緒に 

                                                                                                                                選択されます。 

Select All Clips      このコマンドは、選択されたトラックのすべてのクリップを選択、ハイラ 

                                                                                                                               イトさせます。 

Select All Clips to Mark In  マークインまでのコンポジションの始まりからトラックのすべてのク 

                                                                                                                              リップを選択します。 

Select All Clips between Marks  Mark In とMark Out の間のトラックのすべてのクリップを選択 

                                                                                                                              します。 

Select All Clips from Mark Out   Mark Out からコンポジションの終わりまでトラックのすべて 

                                                                                                                                のクリップを選択します。 



Deselect All Clips     選択されたトラックのすべてのクリップの選択を外します。 

 

Ripple          Ripple Tracks ダイアログボックスを発動します。 

 
Extend          自動的に、それぞれの 1タイムライントラック以上のクリップのすべての 

                                                                 Media チャンネルを収容するためにトラック数を拡張します。 

Cursors & Marks 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Cursors & Marks menu 



Nudge Cursor > 

 
Nudge Cursor to Previous Edit     前の編集にカーソルをナッジします。 

 
Nudge Cursor to Next Edit       次の編集にカーソルをナッジします。 
 
Nudge Cursor to Previous Clip     前のクリップにカーソルをナッジします。 

 
Nudge Cursor to Next Clip       次のクリップにカーソルをナッジします。 
 
Nudge Cursor to Previous Clip Fade   前のクリップフェードにカーソルをナッジします。 
 
Nudge Cursor to Next Clip Fade       次のクリップフェードにカーソルをナッジします。 
 
Nudge Cursor to Previous Marker    前のマーカーにカーソルをナッジします。 

 
Nudge Cursor to Next Marker      次のマーカーにカーソルをナッジします。 
 
Nudge Cursor to Previous CD Marker  前の CD マーカーにカーソルをナッジします。 
 
Nudge Cursor to Next CD Marker    次の CD マーカーにカーソルをナッジします。 
 
Nudge Cursor to Left          左にカーソルをナッジします。 

 
Nudge Cursor to Right         右にカーソルをナッジします。 
 
Nudge Cursor to Left with Region    左にカーソルをナッジします。そして、このロケ－ショ 

                                                                                                                                                                                                  ンの境界に最も近い選択をアップデートします。 

Nudge Cursor to Right with Region   右にカーソルをナッジします。そして、このロケ－ショ 

                                                                                                                                                                                                  ンの境界に最も近い選択をアップデートします。 

Nudge Cursor to Left Custom      Keyboard によって入力された量に従って、左にカーソル 

                                                                                                                                                                                                  をナッジします。 

Nudge Cursor to Right Custom     Keyboard によって入力された量に従って、右にカーソル 

                                                                                                                                                                                                  をナッジします。 
Nudge Cursor to Left Custom in Bars/Beats Keyboard によって入力された Bars/Beats の長さに 

                                                                                                                                                                                                   従って、右にカーソルをナッジします。 



Nudge Cursor to Previous Foot     前の Foot にカーソルをナッジします。 

 

Nudge Cursor to Next Foot       次の Foot にカーソルをナッジします。 

 
Nudge Cursor to Previous Foot Frame  前の Foot フレーム にカーソルをナッジします。 

 
Nudge Cursor to Next Foot Frame    次の Foot フレーム にカーソルをナッジします。 

 
Nudge Cursor to Previous Bar     前の Bar にカーソルをナッジします。 

 

Nudge Cursor to Next Bar        次の Bar にカーソルをナッジします。 

 
Nudge Cursor to Previous Beat     前の Beat にカーソルをナッジします。 

 
Nudge Cursor to Next Beat        次の  Beat にカーソルをナッジします。 

 
Nudge Cursor to Previous Grid Step   前のグリッドステップにカーソルをナッジします。 

 

Nudge Cursor to Next Beat Grid Step  次の  グリッドステップにカーソルをナッジします。 
 
Nudge Marks > 

Nudge Mark In to Left           左にマークインをナッジします。 

 

Nudge Mark In to Right          右にマークインをナッジします。 

 

Nudge Mark In to Left Custom       Keyboard により入力された量に従って、マークイン 

                                                                                                                                                                                                            を左にナッジします。 

 

Nudge Mark In to Right Custom      Keyboard により入力された量に従って、マークイン 

                                                                                                                                                                                                            を右にナッジします。 

 

Nudge Mark In to Left Custom in Bars/Beats Keyboard により入力された Bars/Beats の長さに 

                                                                                                                                                                                                             従って、マークインを左にナッジします。 

 

Nudge Mark In to Right Custom in Bars/Beats Keyboard により入力された Bars/Beats の長さ 

                                                                                                                                                                                                             に従って、マークインを右にナッジします。 



Nudge Mark Out to Left          左へマークアウトをナッジします。 

 

Nudge Mark Out to Right         右へマークアウトをナッジします。 

 
Nudge Mark Out to Left Custom      Keyboard により入力された量に従って、マークアウ 

                                                                                                                                                                                                            トを左にナッジします。 

Nudge Mark Out to Right Custom     Keyboard により入力された量に従って、マークアウ

トを右にナッジします。 
Nudge Mark Out to Left Custom in Bars/Beats Keyboard により入力された Bars/Beats の長さ 

                                                                                                                                                                                                             に従って、マークアウトを左にナッジします。 
Nudge Mark Out to Right Custom in Bars/Beats Keyboard により入力された Bars/Beats の長 

                                                                                                                                                                                                             さに従って、マークアウトを右にナッジします。 
Nudge Gates > 

Nudge Gate In to Left            ゲートインを左にナッジします。 

 

Nudge Gate In to Right           ゲートインを右にナッジします。 

 
Nudge Gate Out to Left           ゲートアウトを左にナッジします。 

 
Nudge Gate Out to Right           ゲートアウトを右にナッジします。 

 
Current Nudge Setting 

 

Nudge Setting 1 

 

Nudge Setting 2 

 

Nudge Setting 3 

 

Nudge Setting 4 

 

Nudge Setting 5 

 

Goto TimeCode             Goto TimeCode ダイアログボックスを開きます。そ 

                                                                                                                                                                                                            こは、特定のTimeCode 位置に置かれるべき Play 

                                                                                                                                                                                                         Cursor を容認します。 



Goto Foot                Play Cursor が特定の Footage に置かれるのを容認 

                                                                                                                                                                                                             します。 

Goto Beat                Play Cursor が特定の Beat に置かれるのを容認しま 

                                                                                                                                                                                                             す 
Cursor to Mark In             Play Cursor をマークインに移動させます。 

 

Cursor to Mark Out            Play Cursor をマークアウトに移動させます。 

 
Cursor to Gate In             Play Cursor を選択したトラックグル－プゲ－トイン 

                                                                                                                                                                                                             に移動させます。 

Cursor to Gate Out            Play Cursor を選択したトラックグル－プゲ－トアウ 

                                                                                                                                                                                                           トに移動させます。 
Cursor to Selected Marker        Play Cursor を Selected Marker に移動させます。 

 
Cursor to Start of Selected Track     選択されたトラックで最初のクリップのスタート位置 

                                                                                                                                                                                                             に Play Cursor を移動させます。 

Cursor to End of Selected Track      選択されたトラックで最初のクリップのエンド位置に 

                                                                                                                                                                                                             Play Cursor を移動させます。 

Auto Center on Goto           可能にした場合、Goto TimeCode コマンドが使用さ 

                                                                                                                                                                                                             れているならば、Project Editor は自動的に新しい 

                                                                                                                                                                                                            Play Cursor 位置の中心にディスプレイを置くでしょ 

                                                                                                                                                                                                            う。 

Mark In to Cursor            プレーカーソルの位置にマークインを移動させます。 

 

Mark Out to Cursor            プレーカーソルの位置にマークアウトを移動させます。 

 
Gate In to Cursor             選択したトラックゲ－トインの位置に Play Cursor 

                                                                                                                                                                                                   を移動させます。 
Gate Out to Cursor            選択したトラックゲ－トアウトの位置にPlay Cursor 

                                                                                                                                                                                                            を移動させます。 
Marks to Selection            現在の選択にマークアウトを移動させます。 

 

Lock Marks               Mark In/Out ポイントは変えられません。 

 

Hide Marks               Mark In/Out カーソルを取り除いてしまいます。 

 



Add Marker to Cursor           現在の Play Cursor Position に新しい Marker を加え 

                                                                                                                                                                                                            ます。 

Prompt for Marker Name at insertion     作動させた場合、新しいマーカーが挿入されるとき、 

Add New Marker ダイヤログがオープンします。 

 
Delete Selected Marker           現在選択されている Marker を削除します。 

 
Move Selected Marker to Cursor       現在の Play Cursor Position に選択された 

 Marker を移動させます。 

Set > 

Set Marker 1       Marker #1を現在の Play Cursor Position に設定してください。 

 
以下に 注意 してください。: Set Markers 2 – 10 は表示されません。 

 

Goto Marker 1      Marker #1 に Play Cursor 位置を設定してください。 

 

以下に 注意 してください。: Goto Markers 2 – 10 は表示されません。 

 
Select Previous Marker  現在選択された Marker の前の Marker (左)を選択します。 

 
Select Next Marker    現在選択された Marker の次の Marker (右)を選択します。 
 
Show Cursor       自動的に、Project Editor のディスプレイを Play Cursor の中心に置きま 

                                                                                                                             す。 

Show Mark In      自動的に、Project Editor のディスプレイをMark In の現在位置の中心に置 

                                                                                                                             きます。 

Show Mark Out      自動的に、Project Editor のディスプレイをMark Out の現在位置の中心に 

                                                                                                                             置きます。 
Show Gate In       自動的に、Project Editor のディスプレイを選択したトラックグル－プ 

                                                                                                                     Gate In の中心に置きます。 
Show Gate Out      自動的に、Project Editor のディスプレイを選択されたトラックグループ 

                                                                                                                            Gate Out の中心に置きます。 

Show Selected Marker  自動的に、Project Editor のディスプレイを現在選択された Marker の中 

                                                                                                                             心に置きます。 

 



Add CD Start Marker to Cursor  Play Cursor 位置へ CD Start マーカーを追加します。 

 

Add CD Stop Marker to Cursor   Play Cursor 位置へ CD Stop マーカーを追加します。 

 

Add CD Index Marker to Cursor   Play Cursor 位置へ CD Index マーカーを追加します。 

 

Delete Selected CD Marker     現在選択された CD Marker を削除します。 

 

CD Mark Groups         Project Editor で CD Markers Groups の自動新規作成を可能 

                                                                                                                                                                     にします。 

Selection 

 
 
 
 
 
 
 
 
 
 
 
Nudge > 

 
Nudge to Left    左に選択をナッジします。 

 

Nudge to Right    右に選択をナッジします。 

 

Nudge Start to Left  左の選択の始めにナッジします。 

 

Nudge Start to Right 右の選択の始めにナッジします。 

 

Nudge End to Left  左の選択のエンドにナッジします。 

 
Nudge End to Right  右の選択のエンドにナッジします。 



Move Selection Up  現在位置の上のトラックに現在の選択を移動させます。 

 

Move Selection Down 現在位置の下のトラックに現在の選択を移動させます。 

 

Grow Selection Up  現在位置の上のトラックに現在の選択を供給します。 

 

Grow Selection Down 現在位置の下のトラックに現在の選択を供給します。 

 

Narrow Selection Up 現在位置の上のトラックから現在の選択を取り除きます。 

 
Narrow Selection Down 現在位置の下のトラックから現在の選択を取り除きます。 

 
Set Cursor to Selection Start 現在の選択のスタートポイントに Play Cursor を置きます。 

 
Set Cursor to Selection Start with Preroll  現在の選択のスタ－トポイントへ Play Cursor を置 

                                                                                                                                                                                                                     きます。そして、設定されている Preroll 値を追加し 

                                                                                                                                                                                                                     ます。 

 

Set Cursor to Selection Start with Preroll #2 現在の選択のスタ－トポイントへ Play Cursor を置 

                                                                                                                                                                                                                     きます。そして、設定されている Preroll #2 値を追 

                                                                                                                                                                                                                      加します。 

 
Set Cursor to Selection Start with Preroll #3 現在の選択のスタ－トポイントへ Play Cursor を置 

                                                                                                                                                                                                                      きます。そして、設定されている Preroll #3 値を追 

                                                                                                                                                                                                                      加します。 

 
Set Cursor to Selection End   現在の選択のエンドポイントに Play Cursor を置きます。 

 

Set Selection Start to Cursor   現在の選択のスタートポイントを Play Cursor 位置に置きます。 

 

Set Selection End to Cursor   現在の選択のエンドポイントを Play Cursor 位置に置きます。 

 

Select between Gates      選択したトラックグル－プ Gates の間の選択を設定します。 

 

Gates to Selection        現在の選択の先端に Gates を移動させます。 

 



Select Clip(s) under Cursor    現在、Playhead Cursor に接触しているクリップを選択します。 

 

Undo Selection         最後の選択コマンドを取り消します。 

 

Redo Selection         最後の Undo Selection コマンドを中止します(再行為)。 

 

Undo / Redo Selection      最後の Undo / Redo Selection コマンドの間で切り替えます。 

Fade Editor 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fade Editor menu 

Open Editor       Fade Editor ウィンドウを開きます。 

 

Accept & Close Editor  フェードの変更を認めます。そして、Fade Editor ウィンドウを閉じます。 

 

Restore & Close Editor  フェードをオリジナルの状態に復元します。そして、Fade Editor ウィン 

                                                                                                                              ドウを閉じます。 

Restore Fade       フェードをオリジナルの状態に復元します。 

 

Undo Fade Change    最後のパラメータの変更を元に戻します。 

 

Previous Fade      前のフェードを選択するか、編集します。 

Next Fade        最終のフェードを選択するか、編集してください。 



Xify           標準の Power X フェードに現在のフェードをリセットします。 

 

Show Faders & Control  Faders と Fade Editor の Control Section を表示します。 

 

Show Parameters & Options Fade Editor の Parameters と Options のセクションを表示します。 

 

Display & Zoom > 

 

Fit Fade         現在の Fade の周りをズームします。(Reset Zoom) 

 

Zoom In         グラフィックディスプレイで画像を徐々に拡大します。 

 

Zoom Out        グラフィックディスプレイの画像を徐々に縮小します。 

 

Display & Zoom Options > 

 
No Auto-Center         Auto-Centering off 

Auto-Center Fade         Auto-Centering on 

Auto-Center Reference Point   Auto Center on Reference Point 

 

Free Zoom        Zoom リセット、In、と Out だけに従います。 

 
Auto-Zoom    自動的にいくつかのオペレーションの後の現在の Fade の周りをZoomします。 

 

Auto-Zoom/Free 自動的に現在の Fade の周りを Zoom します。しかし、その後 Fade Editor を入力 

                                                                                          するときだけ、Zoom は Free です。 

 

Timeline Zoom      Timeline Zoom 要素に従います。 

 

Zoom Preset 1      Recall Preset Zoom #1 

Zoom Preset 2      Recall Preset Zoom #2 

Zoom Preset 3      Recall Preset Zoom #3 

Zoom Preset 4      Recall Preset Zoom #4 

Zoom Preset 5      Recall Preset Zoom #5 

 
Faders & Control > 



Nudge Out Gain Less 

Nudge Out Gain More 

Nudge In Gain Less 

Nudge In Gain More 

 

Nudge Intercept Less 

Nudge Intercept More 

Nudge Asymmetry Less 

Nudge Asymmetry More 

 
Nudge Out Length Less 

Nudge Out Length More 

Nudge In Length Less 

Nudge In Length More 

 
Nudge Out Position Left 

Nudge Out Position Right 

Nudge In Position Left 

Nudge In Position Right 

 
Nudge In Media Left 

Nudge In Media Right 

Nudge Out Media Left 

Nudge Out Media Right 

 
Faders & Control Options > 

 

Link Length    Fade Out & In の長さをリンクします。 

 

Mirror Length    対称的に Fade Out と In の長さを変えます。(中心に置かれます) 

 

Link Position    position of Fade Out & Inをリンクします。 

 
Fade Safe 現在のフェードを編集している間、(編集される 1つの右へ)続くフェードすべて、確かに完 

全なままにされます。 

Force Safe 



Audition > 

Audition X Fade 

Audition X Fade with Ref 

 
Audition Out with Curve 

Audition Out without Curve 

Audition Out after Fade 

Audition Out with Curve with Ref 

Audition Out without Curve with Ref 

Audition Out after Fade with Ref 

Audition Out Original Material 

 
Audition In with Curve 

Audition In without Curve 

Audition In before Fade 

Audition In with Curve with Ref 

Audition In without Curve with Ref 

Audition In before Fade with Ref 

Audition In Original Material 

Audition Options > 

 
Audition Pre-Roll 1 

Audition Pre-Roll 2 

Audition Pre-Roll 3 

Audition Post-Roll 1 

Audition Post-Roll 2 

Audition Post-Roll 3 

Audition Speed 100% 

Audition Speed 50% 

Audition Speed 25% 

Audition Solo 

Audition Loop 

Audition After Nudge 

 
Memory > 

Set Memory 1 



Set Memory 2 

Set Memory 3 

Set Memory 4 

Set Memory 5 

Recall Memory 1 

Recall Memory 2 

Recall Memory 3 

Recall Memory 4 

Recall Memory 5 

 
Presets > 

Load Default X Curve 

Load Default X Preset 

Save Default X Preset 

Load Default Out Curve 

Load Default Out Preset 

Save Default Out Preset 

Load Default In Curve 

Load Default In Preset 

Save Default In Preset 

 

Media 

 
 
 
 
 
 
 
 
 
 
 

Media menu    

 



Search Media  Query (質問)ページがある the Media Search Tool を開きます。(User Manual 

をご覧ください。: 詳細のための Media Management Chapter) 

 
Mount Referenced Media 現在の Project でまだ、マウントされていない、使用されていないすべて 

のメディアをマウントします。 

 

Auto-Mount Media  選択された場合、Offline ライブラリーからの参照が現在の Project に置かれる 

                                                                                                           ときはいつも、Media は自動的にマウントされます。 

 

Select Online Clips  現在マウントされている Media ファイルの Timeline にあるすべての Clipsを 

選択します。 

 

Select Offline Clips  現在マウントされていない Media ファイルの Timeline にあるすべての Clips 

                                                                                                           を選択します。 

 
Select Used Media  現在の Project で使用したすべてのメディアを含むフロ－ティング Media 

                                                                                                            Manager ウィンドウを開きます。 

 
Select Media present on Project Default Folder  選択した(強調表示) Project Default フォル 

                                                                               ダーにおけるすべてのメディアが表されているフロ－ティング Composition Library 

                                                                               ウィンドウを開きます。 

 

Select Media NOT present on Project Default Folder  選択した(強調表示)Project Default フ

ォルダーにおけるすべてのメディアがまったく表されていないフロ－ティング

Composition Library ウィンドウを開きます。 

 
Collect Media to current Project Default Folder  現在のプロジェクトで使用したすべてのメデ

ィアファィルをコピーします。 

  (示されているように、前の Select Media not present…は、現在の Project Default 

    Folder へ呼び出されます。 

Clean-Up Media は、Choose a Media Folder to Clean-Up ウィンドウを開きま 

 す。リストからフォルダーを選んでください。そして、OK をクリックしてください。 

現在の Project によって参照されていないすべてのメディアは、選択されたフォルダ

ー から永久に取り除かれます。 

 



Automation 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Automation menu 

 
Automation Off   オ－トメ－ションシステムは不可になります。 

 
Automation Play  オ－トメ－ションシステムは、以前に記録しているどのようなオートメーション 

データも再生するために設定します。 

Automation Write  オ－トメ－ションシステムは、以前に記録しているどのようなオートメーション 

データも再生するために設定します。そして、すべての可能なコントロールため 

の新しいオートメーションデータを記録します。 

 
Automation Snapshot  現在のカーソル位置でオートメーションキ－フレームを制作します。 

すべての現在ア－ミングしているオートメーションコントロールのためです。 

 
Automation Snapshot Range   現在の決定された In / Out カーソルの位置でオートメーション 

キ－フレームを制作します。すべての現在ア－ミングしているオートメーションコントロールのためです。 



Delete Selected Points 選択されたリージョンに含まれたすべてのオートメーションポイントを削除 

                                                                                                                     します。 

Cut Selected Points   選択されたリージョンを含むすべてのオートメーションポイントをカットし 

ます。 

Copy Selected Points  選択されたリージョンを含むすべてのオートメーションポイントをコピ－し 

ます。 
Paste Points to Cursor 選択したトラックのカーソルのあるコピ－された、またはカットしたオート 

                                                                                                                     メーションポイントをぺ－ストします。 

Paste Points to Original TC  選択したトラックのカーソルのあるコピ－された、またはカットした 

                                                                                                                      オートメーションポイントをぺ－ストします。 

Auto-Write Mode - Write & Release オートメーションは、コントロールを触って、書き込みを始め

ます。コントロールがリリ－スされたとき、書き込みをストップします。 

Auto-Write Mode - Write & Hold  オートメーションは、コントロールを触って、書き込みを始め

ますが、リリ－スしてもそのままです。ストップするのは、マシ－ンがストップした

ときだけです。 
Auto-Write Mode - Update & Release  オートメーションはコントロールを触って、現在のパスを

アップデートし始めます。コントロールがリリースされるとき、アップデートをスト

ップします。 

Auto-Write Mode - Update & Hold  オートメーションはコントロールを触って、アップデートし 

                                                                                 始めます。しかし、リリ－スしてもそのままです。ストップするのは、マシ－ンがス 

                                                                                トップしたときだけです。 
 
Release Mode – Snap  前のパスに書かれた最後のポイントからストレートジャンプは作られます。 

Release Mode - Auto-Release  補間は最後に書かれたポイントから前のパスまで制作されます。 

このリリースラインの長さは Automation Settings > Auto-Release Time で決められます。 

 

Release Mode - Write to Next  次のポイントが前のパスで見つけられるまで、同じ値は最後に書か 

                                                                                                                       れたポイントの後に保たれます。 

Release Mode - Write to End  オートメーションパスの端の最後に書かれたポイントの後ですべて

のポイントを取り除きます。 

Release Auto-Writing  現在のオートメーションを記録するすべてのコントロールをリリースします。 

Automation Tracks   Automation Tracks ウィンドウを開きます。この画面は特定のコントロー 

ルを表示するためにのオートメーションバージョンを容認します。一度、希 

望のコントロールはツリー画面でロケートしたことがあります。シンプルに 

                                                                    コントロ－ルの上をダブルクリックすれば、Automation Track ウィンドウ 

がアップデートします。 



Automation Settings  Settings > All Settings > Application > Automation ページを開いて 

                                                                                                                      ください。そこには、オートメーションパラメータと決める設定があります。 

 

Workspaces 

 
 
 
 
 

Workspaces menu 

 
Save > 

Save Workspace 1  Save Workspace 1 

 
以下に 注意 してください。: Workspace 2～10 は省略してセーブされます。 

 

Update Current Workspace  現在の設定で現在の Workspace をアップデートします。 

 
Recall > 

 
Recall Workspace 1  Workspace 1 をリコールします。 
 

以下に 注意 してください。: Workspace 2～10 は省略してリコールされま

す。 
Recall Previous Workspace  利用可能な Workspaces のリストを通して後方に切り替えます。 

 
Recall Next Workspace    利用可能な Workspaces のリストを通して前方に切り替えます。 
 

Machines 

 
 
 
 

Machines menu 



Active machine > 

 
以下に 注意 してください。: Active マシン Sub - メニューは現在アクティブマシンとして選ばれ

ているマシンに反映するでしょう。 

 

Toggle machines  インストールされているマシンを切り替えます。 
Stop        停止 

Pause       一時停止 
Play        再生 

Play Special > 

Play Reverse     逆再生 

Play 1/2        速度1/2再生 

Play 1/2 Reverse   速度1/2逆再生 

Play 1/4       速度1/4再生 
Play 1/4 Reverse   速度1/4逆再生 

Play 1/16      速度1/16再生 

Play 1/16 Reverse  速度1/16逆再生 

Play 2x        速度2x再生 

Play 2x Reverse   速度2x逆再生 

Play 4x        速度4x再生 

Play 4x Reverse   速度4x逆再生 

 

Toggle Play/ Stop   再生/停止の切り替え 

Toggle Play/ Pause  再生/一時停止の切り替え 

Toggle Play/Record 再生/録音の切り替え 

 

Record       録音 

Fast Forward     早送り 

Fast Rewind      早戻し 

Scan Forward         前方検索 

Scan Rewind          後方検索スタ－ト地点へ 

Start         スタ－トへ 

End         終わりへ 

 
Goto TimeCode   TimeCode へ 

 



Nudge +1 frame 

Nudge -1 frame 

 
Set Loop In 

Set Loop Out 

 
Goto Loop In 

Goto Loop Out 

 
Chase 

Store Chase Offset 

 
Jog Wheel Mode – Jog 

Jog Wheel Mode – Shuttle 

Jog Wheel Mode – Loop 

Jog Wheel Mode – Jump 

Jog Wheel Mode - Off 

 

Internal Machine 

 
Stop         停止 

Pause        一時停止 

Play         再生 

Play Special > 

Play Reverse    逆再生 

Play 1/2         速度1/2再生 

Play 1/2 Reverse   速度1/2逆再生 

Play 1/4       速度1/4再生 
Play 1/4 Reverse   速度1/4逆再生 

Play 1/16       速度1/16再生 

Play 1/16 Reverse   速度1/16逆再生 
Play 2x        速度2x再生 

Play 2x Reverse   速度2x逆再生 

Play 4x       速度4x再生 

Play 4x Reverse   速度4x逆再生 

 



Toggle Play/Stop   再生/停止の切り替え 

Toggle Play/Pause  再生/一時停止の切り替え 

Toggle Play/Record  再生/録音の切り替え 
Toggle Stop/Record Safe 

 
以下に 注意 してください。: このコマンドは Play と Stop の間で(または、他の状態)順番に切り

変わります。しかしながら、レコ－ディング中は効きません。 

この場合、レコーディングをストップさせるためには、本当の Stop コマンドを命じねばなりません。 

 

Play with Preroll 

Play with Preroll #2 

Play with Preroll #3 

 
Record        録音 

Fast Forward     早送り 

Fast Rewind     早戻し 

Scan Forward     前方検索 

Scan Rewind     後方検索スタ－ト地点へ 

Start         スタ－トへ 

End         終わりへ 

 
Punch > 

 
Punch Selection        パンチ選択 

Punch Selection with Preroll  プリロ－ルのあるパンチ選択 

Punch Selection with Preroll #2 プリロ－ル #2 のあるパンチ選択 

Punch Selection with Preroll #3 プリロ－ル #3 のあるパンチ選択 

 

Auto-punch with Preroll     プリロ－ルのあるオ－トパンチ選択 
Auto-punch with Preroll #2    プリロ－ル #2 のあるオ－トパンチ選択 

Auto-punch with Preroll #3   プリロ－ル #3 のあるオ－トパンチ選択 

 

Remake last Punch (In only)   最後の Punch オペレーションを繰り返します。(Punch In 専用) 

Remake last Punch (In - Out)   最後の Punch オペレーションを繰り返します。 

 
 



Play Selection    再生選択ル－プ 

Loop Selection    ル－プ選択 

Play between Marks  マ－クの間を再生 

Loop between Marks マ－クの間をル－プ 

Play between Gates  選択されたトラックグループの Gates の間でプレー 

Loop between Gates 選択されたトラックグループの Gates の間でル－プ 
 
Audition > 

Audition Pre          前試聴 

Audition Pre (Preroll #2)     前試聴(プリロール #2) 

Audition Pre (Preroll #3)     前試聴(プリロール #3) 

Audition           試聴 

Audition (Pre/Postroll #2)    試聴(プリ/ポストロール #2) 

Audition (Pre/Postroll #3)    試聴(プリ/ポストロール #3) 

Audition Post          試聴ポスト 

Audition Post (Postroll #2)    試聴ポスト(ポストロール #2) 

Audition Post (Postroll #3)    試聴ポスト(ポストロール #3) 
 
Audition Gate In Pre      選択したトラックグループ Gate In Pre を試聴します。 

Audition Gate In Pre (Preroll #2) 選択したトラックグループ Gate In Pre (Preroll #2) を試聴します。 

Audition Gate In Pre (Preroll #3) 選択したトラックグループ Gate In Pre (Preroll #3) を試聴します。 

Audition Gate In        選択したトラックグループ Gate In を試聴します。 

Audition Gate In (Pre/Postroll #2)選択したトラックグループ Gate In (Pre Preroll #2) を試聴します。 

Audition Gate In (Pre/Postroll #3)選択したトラックグループ Gate In (Pre  Post roll #3) を試聴し 

    ます。 

Audition Gate In Post      選択したトラックグループ Gate In Post を試聴します。 

Audition Gate In Post (Postroll #2)選択したトラックグループ Gate In Post (Post roll #2) を試聴し 

                                                                                                                                                                 ます。 

Audition Gate In Post (Postroll #3)選択したトラックグループ Gate In Post (Post roll #2) を試聴し 

    ます。 

Audition Gate Out Pre      選択したトラックグループ Gate Out Pre を試聴します。 

Audition Gate Out Pre (Preroll #2) 選択したトラックグループ Gate Out Pre  (Preroll #2)を試聴し 

                                                                                                                                                 ます。 

Audition Gate Out Pre (Preroll #3) 選択したトラックグループ Gate Out Pre  (Preroll #3)を試聴し 

 ます。 



Audition Gate Out        選択したトラックグループ Gate Out を試聴します。 
Audition Gate Out (Pre/Postroll #2)選択したトラックグループ Gate Out  (Pre/Postroll #2)を試聴 

 します。 
Audition Gate Out (Pre/Postroll #3)選択したトラックグループ Gate Out  (Pre/Postroll #3)を試聴 

                                                                                                                                                                    します。 

Audition Gate Out Post      選択したトラックグループ Gate Out  Post を試聴します。 

Audition Gate Out Post (Postroll #2)選択したトラックグループ Gate Out  Post (Postroll #2)を試聴 

                                                                                                                                                                    します。 

Audition Gate Out Post (Postroll #3)選択したトラックグループ Gate Out  Post (Postroll #3) を試聴 

                                                                                                                                                                    します。 

 

Goto TimeCode         TimeCode へ 

 
Nudge +1 frame 

Nudge -1 frame 

 
Set Loop In 

Set Loop Out 

 
Goto Loop In 

Goto Loop Out 

 
Loop On/Off           Loop On/Off 

 

Chase              Hard Chase 

Store Chase Offset        Chase Offset のストア 

Auto Chase 

 
Freeze External Machines 

Cursor Auto-Return after playing Auto Return On/Off 

 

External Machine 
 

Stop      停止 

Pause     一時停止 

Play      再生 



Play Special > 

 

Play Reverse     逆再生 

Play 1/2        速度1/2再生 

Play 1/2 Reverse    速度1/2逆再生 

Play 1/4        速度1/4再生 
Play 1/4 Reverse    速度1/4逆再生 

Play 1/16       速度1/16再生 

Play 1/16 Reverse   速度1/16逆再生 
Play 2x        速度2x再生 

Play 2x Reverse    速度2x逆再生 

Play 4x        速度4x再生 

Play 4x Reverse    速度4x逆再生 

 
Toggle Play/Stop    再生/停止の切り替え 

Toggle Play/Pause   再生/一時停止の切り替え 

Toggle Play/Record  再生/録音の切り替え 

 
Record        録音 

Fast Forward     早送り 

Fast Rewind      早戻し 

Scan Forward     前方検索 

Scan Rewind      後方検索スタ－ト地点へ 

Start         スタ－トへ 

End          終わりへ 

 

Goto TimeCode    TimeCode へ 

Nudge +1 frame    Nudge +1 フレ－ム 

Nudge -1 frame     Nudge -1 フレ－ム 

Set Loop In      Loop In の設定 

Set Loop Out     Loop Out の設定 

Goto Loop In      Loop In へ 

Goto Loop Out     Loop Out へ 

 
Chase 

Store Chase Offset 



Auto-Chase 

 
Eject           取り出し 

 

Chase Cursor On/Off    Chase Cursor On/Off の切り替え 

Enable Record On/Off    Record On/Off を可能に 

 

Record Ready > 

 

Record Ready V1      Record Ready V1 

Record Ready A1      Record Ready A1 

 Record Ready A2 - A7 omitted 

Record Ready A8      Record Ready A8 

 

Locator > 

Goto Locator 1       Goto Locator 1 

Note Goto Locator 2 to 9 omitted 

Goto Locator 10      Goto Locator 10 

 

Set Locator 1        Set Locator 1 

Set locator 2 to 9 omitted 

Set Locator 10       Set Locator 10 

Macros 

 
 
 
 
 
 
 
 
 
 
 
 



Macro メニューは多くのあらかじめプログラムされた Macros へアクセスします。 

Macro Editor も同様です。どうぞご覧ください。User Macros 351 ぺ－ジ 

 

Settings 

 
 
 
 
 
Settings メニューはメイン All Settings ウィンドウ、Keyboard Shortcut Editor および macro 

Editor へのアクセスを集めています。 

 

Window 

 
 
 
 
 
 
 
Window メニューは、それらの間を切り換えながら、オ－プンプロジェクトとエネイブルのリストを維持

します。 

また、それは、マルチオ－プンプロジェクトウィンドウがスクリーンに、Tiled または Cascaded に配置

されるのを可能にします 

Help 

 
 
 
 
 
この Help Menu はこのマニュアルと他のものへの迅速なオンラインアクセスを提供します。 

About は、Pyramix ロゴがある Window そして、登録したユーザとソフトウェアバージョンに関する詳

細をポップアップします。 



Numerics 
 
9-pin (Sony P2 protocol) 374 
9-pin Control of External Machine 374 
9-Pin Monitoring Options 442 
 
A 
 
AAF 321 
Absolute Sources in EDL View 132 
Absolute Sources in EDL view 431 
Absolute Time 431 
AC3 encoded files 371 
Active Machine 88 
ADAT Daughterboard 5 
ADAT Daughterboard and XDTDM     
ADAT Optical I/O     
Add Bars 71 
Adding Strips 152 
AES-31 332 
Akai DD / DR 323 
AKAI disk import 323 
Allow chasing across midnight 423 
Alternate Backup 417 
Alternate Time Scale Bar 66 
Angudion 216 
Apple Macintosh, File interchange 317 
Archiving Projects 282 
Arithmetic Timecode Entry 10 
Assumptions 4 
Audio current sample rate & sync source 8 
Audio Engine Drops Warning  
Audition after Nudge settings 419 
Audition Play 31 
Auto Cross-fade 410 
Auto Crossfade Mode 117 

Auto Deglitching 111 
Auto Edit 86 
Auto Jog on move 78 
Auto Silence Removal 130 
Auto-chase 69, 371 
Autoconforming 101 
Auto-Crossfade 419 
Auto-Crossfade By Default 118 
Automatic Deglitching 421 
Automation 266 
Auto-Release Options 268 
Off  
Play  
Write  
Automation in editing and libraries 277 
Automation Menu 489 
Automation Modes 266 
Auto-Write 267 
Isolate 266 
Play 266 
Record 267 
Automation Settings 267 
Automation Track Versions 273 
Automation Trim 272 
Auto-Monitoring 421 
Auto-Mount Media 36, 488 
AutoPunch Mode 96 
AutoPunch Ready enable/disable 18 
Auto-Release Options 268 
Auto-Ripple 120 
Auto-Saving 417 
AUX Buses In-Place Panning 173 
Aux Busses 170 
Aux Send Routing 172 

 
 



B 
 
Bars & Beats Settings 362 
Basic Strip 176 
Bios     
Broadcast WAV file Tips 366 
Burn-in Window 402 
Burning a CD-R 314 
Bus Returns    

Recording 183 
Bus Tools 258 
Bus Tools Sections 258 
Buses Repro button 164 
Buttons 176 
BWF 406 
Bypass all Effects 205 

 
C 
 
CD 290 

Album 291 
CD Import 325 
CD Markers 289 
CD Red-Book Validation 303 
CD Text 299 
CD Text fields 296 
CD Writer drivers 313 
CD/SACD Tab Window Menus 297 
Channel Direct Outputs 168 
Chase 80 
Chase Mode 83, 422 

Hard 83, 422 
Soft 83, 422 
Vari 83, 422 

Chase Settings 422 
Chase Synchronizer 375 

Check Sync 92 
Checking AC3 encoded files 371 
Clean up Media after recording 409 
Cleaning Up Project media 288 
Clean-Up Media 37, 488 

Click Track 362 
Click-Track 362 
Clip 

Editing 107 
Fade Handles 105 
Gain 106 
Head 104 
Name 105 
Sync Point 105 
Tail 104 
Trim Handle 105 
Waveform Display 105 

Clip Display Problems     
Clip Fade Commands 118 
Clip Information Only Fields 111 
Media Offset 111 
Original TimeCode 111 
Peak Level 112 
Clip Properties 108 
Clip Selection 114 
Clips 

Default start time of captured Clips 431 
Red 118 

Clips and Compositions 103 
Clips in a Composition 103 
Clips Menu 466 
CMX Autoconform 343 
CMX EDL 337 
CMX EDL Format 340 
CMX Variants 338 
Collect Media to current Project Default 



Folder 36, 488 
Composition Information and Settings 

Toolbar 74 
Composition Library 

Libraries 

Composition 33 
Configuration 388 
Conforming and Reconforming 337 

CMX Autoconform 343 
CMX EDL Format 340 
CMX EDL import Options 338 
CMX Reconform 343 
Common CMX Variants 338 
Load Change EDL 346 
Relink to New Media 344 

Consolidating Projects 282 
Control by External Device 377 
Control of External Device 374 
Control Points 104 
Controller 

Sony 9 - Pin Protocol Configuration 441 
Controllers 

Automatically set offline88 
Controllers Online 80 
Controllers Online/Offline 80 
Conventions 4 
Conversion processes 50 
Convert 48 

Converting Projects 284 
Copy 125 
Copy and Paste 115 

Clip 115 
Creating and Configuring Mixers 178 
Creating Effects Snapshots 279 
Creating tracks via paste 11, 373 
Crossfade 118 

Cue Sequencer     
Cue Sequencer Control      
Cue Sheet Printer 333 
Cuepoint 332 
Cursors & Marks Menu 475 
Customizing the User Interface 348 
Cut 125 
Cut and Ripple 127 
Cutter 122 
 

D 
 
Daughter Card Settings 395 
DC Meter 227 
DC Removal 56 
DDP 332 
DDP Import 304 
Debug Menu 401 
Default Clock Source 93 
Default Library 33 
Default Menus 449 
Default Mixer 191 
Default Projects Location 433 
Default Templates Location 433 
Delay 176, 213 
Delay Compensation 258, 261 
Delay Compensation of External Inputs 184 
Delay vs Delay Compensation 184 
Destination Wordlength 57 
Determining Delay Compensation 184 
Digitizing a Tape with Discontinuous 

TimeCode 367 
Digitizing Sessions 99 
Direct Output 176 
Direct Outputs 150 
Direct X Plug-ins 186, 241 



Disable Mix Down 415 
Disable Punch in/out 414 
Discontinuous TimeCode 96, 361 
DiscWrite 307 
Display and Editing of Automation Data 271 
Display Blocks 19 
Display Envelope 20 
Display Waveform 19 
Dither 280 
Dither Type 189 
Dithering 57 
Dithering Window 189 

Don’t Snap 121 
Dragging Clips into a Composition 115 
Drivers     
DSD Peak Filter 413 
DSD Project     
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DSP Allocation 384 
DSP load and latency8 
DSP Time Saving 414 
DST Encoder 57 
DST Estimator 57 
Dual Monitors 9 
Dubbing Mode 357, 407 
Duplicate Selection 122 
DXD Mixing Project     
DXD projects I/O routing 396 
Dynamic-Meter 218 
Dynamics 209 
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Edit Commands 124 
Edit Menu 452 
Edit menu 452 

Edit Modes Context Menu 120 
Editing 103 

Clip & Selection 107 
Editing Automation data 275 
Editing Modes 119 
Editing Multitrack Recordings 369 
Effects Snapshots 230, 279 
EQ-X 231 
Error Messages     
Ethernet Connection & Settings     
European Monitoring 421 
Exapand / Collapse 161 
Exit 451 
Export to a File 281 
Exporting Projects to CD Image Files 305 
Extend Tracks 475 
External Edit 

Review Edit 86 
External Effects 184 
External Machine 

Auto Edit 86 
Fast Forward 86 
Play 84 
Preview Edit 86 
Properties 439 
Record button 86 
Rewind 85 

External machine 

Stop 80 
External Machine panel - Specific Features 

82 
External Machines 374 
External TC reader 400 
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Fade Editor 139 
Faders & Control Section 142 
Parameters & Options Section 143 

Fade Editor Menu 483 
Fade handles 105 
Fade In 118 
Fade library location 419 
Fade Out 118 
Fader 176 
Fast Forward 80, 84 
File Format and Disk Limitations 93 
Fill Selection 126 
Film 24 to NTSC Sync 369 
Film Feet Scale Bar 68 
Filter 45 
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Fixed Cursor Settings 420 
Fixed or Moving Playhead Cursor 73 
FIXREEL 341 
Flanger 214 
Flatten track numbers 407 
Flywheel Inertia 425 
Focus to Timeline 460 
Foot Type 69 
Free Disk 8 
Freeze Mode 87 

Using 372 
Function Generator 229 
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Gain Window 107 
Gain window 107 
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General Tab 448 
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Folder 404 
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404 
Ghost Track 303 
Glitch and Pops finder 287 
Global Libraries 33 
GPI/O controller 378 
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379 
GPI/O Remote types 379 
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Graphic EQ 208 
Group Normalize 55 
Group Recorded Clips 409 
Grouping Clips 106 
Groups 168 
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Head to End 121 
Head to Nearest 121 
Help Menu     
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I/O Busses 180 
I/O Status      
I/O Status Window 92 
Importing a CMX EDL 328 
Importing Audio Files 96 
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Increment take number 409 
In-Place Aux Panning Source 174 
Input Assignment 176 
Input Format 392 
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Input Strip Types 181 
Input Strips 163, 185 
Insert Silence 127 
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Internal Machine panel - Specific Features 84 
Internal Return Busses 181 
Introduction 2 
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Auto Jog 78 
Jog Speed ceiling 424 
Jog Wheel Mode 89 
Jog Wheel Sensitivity 425 
Jog Wheel Settings 424 
Jog-Wheel Editing 123 
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Keep in default library 408 
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Keeping Up To Date     
Keyboard Shortcuts 349 
Knobs 249 
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Length / Pitch, Changing 284 
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Levelizer 287 
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Default 26 
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Project 26 
Shelves 26 
Updating 49 
User 26 

Library Maintenance 34 
Library Menus 40 

Library, Tools 38 
Limit versions to the number of Undo/Redo 

268 
Load Change EDL 346, 451 
Locking Clips 106 
Loop Play 80, 85 
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Creation 368 
Loop Selection 126 
LTC Generator 400 
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LTC sync 356 
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Macintosh File Interchange 317 
Macro Menu 498 
Macros 498 
Managing Media Folders 58 
Manual Digitizing 100 
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Master Automation Controls 270 
Mastering Peak/Vu Meters 217 
Mastering to CD-R 289 
Media Browser 37 

Menu 57 



Media Folder 

Browse... 59 
Mount / Create 60 
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Quick Mount 59 
Recursive 59 
Reset List 59 

Media Folder Menu 47 
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Author 112 
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File Location 113 
File Name 113 
File Size 113 
Format 112 
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Name 112 
Notes 113 
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Peak 112 
Sample Rate 112 
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Take 113 
Tape 113 
Tracks 112 
UBITS 113 
Word Length 112 

Media Management 31 
Media Management, tools 38 
Media Menu 34, 487 
Media Offset 111 

Media option 407 
Media reconnection 341 
Media Target Settings 31 
Media Track Information Only Fields 113 

File Name 113 

Media Type 407 
Menus 

Automation 489 
Clips 466 
Cursors & Marks 475 
Default 449 
Edit 452 
Fade Editor 483 
Help 499 
Machines 491 
Macro 498 
Media 487 
Project 449 
Selection 481 
Settings 499 
Tracks 473 
View 460 
Window 499 
Workspaces 491 

Meter Alignment level 412 
Meter Decay integration time 413 
Meter Headroom setting 412 
Meter Permanent Overload 412 
Meter Permanent Peak 412 
Metronome 362 
Metronome Settings... 71, 362 
MIDI Files Import / Export 70, 364 
Mix ! 161 
Mix Bus 164 
Mixdown - Disable 384 
Mixer and Plug-in Snapshots 278 
Mixer Components 163 
Mixer Configuration Further Options 187 
Mixer Configure 150 
Mixer Context Pop-up menu 187 
Mixer Pages 149 



Mixer Presets 191 
Mixer Snapshots 278 

Recalling 278 
Saving 278 

Mixer Surround Components 192 
Mixing/Monitoring/Aux Buses 164 
Modulometer 228 
Monitor ! 197 
Monitor Configure page 200 
Monitoring 393 
Mono Mix 165 
Motherboards     
Mount Referenced Media 36, 488 
Mounting Media Drives 90 
Mounting Rules 47, 60 

Mouse Modifier Keys     
Mouse Scrubbing Settings 78, 426 
MS Encoder 215 
Multi-channel Audio Files     
Multiple CDs or versions in one Project 303 
Multiple Mix Busses 165 
Multiple Stereo Mix 165 
Multiple Surround Mix 166 
Multi-track Editing 356 
Mykerinos 315 
Mykerinos Daughter Card Settings 395 
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Native Plug-ins 186 
Navigation 65 
Network Adapters     
Network Connections     
No Sound on Live Inputs    
Noise Shaping 57, 190 
Normalize 128 

according to the selection peak 128 
Nova 235,287 
Nudge 8 
Nudge settings 418 
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Offline / Reference Libraries 62 
OMF 329 
Operating System     
Optical Drive drivers 313 
Optional Plug-ins 231 
Original Timecode 111 
orphaned media 34 
Output assignment shown in orange 203 
Output Mode 393 
Overview 91 
Overwrite 120 
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Parametric EQ 207 
Paste 125 
Paste & Place 126 
Paste and Ripple 127 
Paste Sync Point to Cursor 126 
Paste Tail to Cursor 125 
Paste to Cursor 125 
Paste to Original TC 126 
Paste to Selection 126 
PCI Bus Too Slow     
PCM I/O Routing 396 
PCM-HSR I/O Routing 396 
PDF (Probability Density Function) 190 
Peak and Overload Hold Time 412 



Peak level indicator 413 

Peak Meter in Track Header 20 
Peak/Vu Meters 217 
Peak-Meter 218 
Pencil Tool 287 
Permanently Mounted Media Folders 434 
Phase Invert 110 
Phase-Oscillo 225 
Ping     
Place on new tracks 409 
Placement Tool 132 
Play 21, 80, 84, 95 
Play Head Position 73 
Play Special 497 
Playback Buffer Meter 8 
Playback Buffer setting 421 
Playback Stall indication 421 
Playback Stalls Warning     
Player / Recorder mode 383 
Player/Recorder Mode 355, 415 
Playhead Cursor 74 
Playlist 20 
Playlists 410 
Plug-in Automation 230 
Plug-Ins 204 
Plug-ins 186 

Common Components 204 
Position/Speaker Control 194 
Post Processing 408 
POW-r 191 
Practical Machine Control 375 
Pre/Post Roll Settings 420 
Pre-Anticipation 258, 265 
Preferred Outputs 393 
Profiling Window     
Program and Project Settings 388 

Program Window 6 
Project Editing Panel 7 
Project Interchange 316 
Project Libraries 32 
Project Management Panel 9 
Project Media Folder 403 
Project Menu 449 
Project Notes 288 
Project Window 7 
Prompt for name after recording 95 
Prosoniq MPEX2 Properties 56 
Prosoniq MPEX3 Properties 52 
ProTools Interchange 330 
Pull-Down 394 
Pull-Up 394 
Punch in / Punch Out - Disable 383 
Pure Series plug-ins 234 
Pyramix audio file format 94 
Pyramix Guides 3 
Pyramix Virtual Studio Overview 5 
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Query Page 34 
Quick Convert 49, 50 
Quick Export 48 
Quick Import 48 
Quiet if creation failed 408 
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RAID     
Reconforming a Project 285 
Reconforming to Original Media from Avid 

&/or OMF 364 
Record Block Size 421 



Record button 80, 84 
Record Name 95, 408 
Record Punch In (Auto) 21, 95 
Record Ready (Manual) 21, 95 
Recording Audio into a Pyramix Virtual Studio 

Project 94 
Recording Bus Returns 183 
Recording from a Tape with Discontinuous 

TimeCode 96 
Redirect Remote Controllers commands to 

the External 

Machine when chasing 423 
Region Selection 114 
Regions 33 
Rel. box 107 
Relative TimeCode Entry 10 
Relaunch After Improper Exit     
Relink to New Media 344, 451 
Remove 120 
Remove and Ripple 120 
Remove Bars 71 
Removing Mixer Presets 192 
Removing Strips 185 
Rename Clips 469 
Renaming Clips 108 
Rendering 285 
Replace 16 bit with 24 bit 451 
Replace Selection 126 
Report Printer 333 
Repro button 164 
Reverse 49 
Rewind 79, 84 
Rotary Controls 176 
Routing Physical I/O to Logical I/O 397 
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SACD EDL Export 332 
SACD Media Management Menu 57 
SACD Production Guide 4 
Sample Rate Conversion 98 
Samplerate Converter Properties 52 
Sampling Rate 391 
Sampling Rate Mismatch 93 
Save Fade 147 

Save X Fade 146 
Saving / Loading Mixer Presets 192 
Scene & Take 406 
Scroll Wheel 90 
Scrub 

Analog Tape Mode 78 
Middle Mouse button 78 
Repeat Loop Mode 78 

Scrub Audio Quality 426 
Scrub Settings 426 

Audio quality 79 
Scrubbing Mode 425 
Search 44 
Search Library 44 
Search Media 34, 488 
Search Media Tool 

Query Page 35 
Search Results 35 
Sel. box 107 
Select Media NOT present on Project Default 

Folder 36,488 
Select Media present on Project Default 

Folder 36, 488 
Select Offline Clips 36, 488 
Select Online Clips 36, 488 
Selecting a Clip 116 
Selecting Automation Modes 269 
Selection 



Track Groups 30 
Selection and Clip Modifiable Fields 110 

Auto Deglitching 111 
Comment 110 
Level 110 
Mute 111 
Name 110 
Phase Invert 110 

Selection Menu 481 
Selection Operations 114 
Selection Tab Window 109 
Selection, adjusting 122 
Selection, moving 122 
Selection, splitting 121 
Selections and Region Selections 114 
Set Focus to the Timeline 460 
Settings 388 

Application 415 
Hardware 390 
Project 403 
Remote Control 438 

Settings Menu 499 
Shelves 32 
Show Automation Track Versions 273 
Show CD Player 302 
Show Used Media 36, 488 
Shuttle 77 
Shuttle Control 80 

Shuttle sensitivity 425 
Silent Chasing 422 
Silent Jog - sensitivity 425 
Slip Clip Mode 117 
Slip Media Mode 117 
Smoothing Filter 424 
Snap to Original TimeCode 121 
Snapshot 270 

Snapshot Range 270 
Solera 233 
Sonic Solutions 332 
Sony 9 - Pin connection  
Sony 9-pin Chase Mode 423 
sound effects libraries 48 
Source - Destination Editing 133 
Source - Destination environment 133 
Source Names - FIXREEL 341 
Speaker Sets 199 
Special Modes 415 
Splitting Clips 121 
Splitting Clips and Regions 121 
Status Bar 7 
stem mixing 166 
Stereo Mix 165 
Stop 80, 84 
Storing and Recalling Mixer Presets 192 
Storing New Mixer Presets 191 
Stretch 127 
Strip & Bus Types 169 
Strip and Bus Tools 244 

Automation mode switches 247 
Display Options 244 
Group assignment mode buttons 246 
Linking Strip-Tools controls 245 
Modules 244 
Sections 248 

Surround Components (Mixer) 192 
Joystick Panner 193 
Speaker Controls 193 
Stereo Input Strips Surround Panner 193 
Sub Level 193 
Surround Stem select 193 

Surround Control 194 
Surround Control window 194 



Level Meter 195 
Link 196 
Stereo Surround Control 196 
Surround Meter 196 
Surround Panning Algorithm 195 

Surround Meter 227 
Surround Mix - 5.1 165 
Surround Post-Processing 285 
Sync 392 
Sync & Format Preset 391 
Synchroniser 80 
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Tail to Beginning 121 
Tail to Nearest 121 
Target Settings 405 
Tascam Open TL 332 
TASCAM TDIF I/O Option     
TC Source 398 
Templates 381 
Time Scale Bars 65 
Time Scale Zoom and Pan 89 
Time Stretch and Pitch Change for Film 

Applications 238 
TimeCode 398 
TimeCode Entry 10 
TimeCode Frame rate and reference source 

8 
TimeCode Midnight 369 
TimeCode midnight 423 
TimeLine layout 428 
TimeZone Properties 53 
TOC 315 
Toggle Stop/Record Safe 494 
Tone Control 209 

Track and Mixer Muting 382 
Track Column Fields 24 

Always Visible 25 
Background Color26 
Collapsed 25 
Display Mode25 
Group 24 
Hidden 25 
Input Connection 24 
Monitoring25 
Mute 24 
Name 24 
Record Ready 25 
Recording Media Folder 26 
Repro Connection 24 
Show Automation 25 
Show Peak-Meter 25 
Size 26 
Solo 24 
Waveform Color26 

Track Group Column Fields 27 
Auto Collapse 29 
Auto Hide 29 
Auto Mute 29 
Auto Record Ready 29 
Auto Solo 29 
Collapsed 28 
Collapsed Display 28 
Exclusive Show 30 
Free Markers 29 
Free Zoom 28 
Keep Cursor 28 
Markers Locked 29 
Name 27 
No Selection 29 
Show Scale 30 



Type 27 
Track Groups 26 
Track Height Zoom 90 
Track Record Modes 32, 94 
Track Types 14 
Tracks 11 

Changing Repro or Input connections 23 
Creating via paste or drag and drop 11, 
373 
Making Settings Changes to Multiple Tracks 

23 
Tracks Menu 473 
Tracks Tab pop-up 22 
Tracks Tab window 22 
Tracks, Adding 11 
Tracks, Deleting 15 
Transient response accelerator 425 
Transport Control Panel 81 

Controllers Section 88 
Transport Controls 79 
Trim Handles 104 
Trimmer 38 

Select/de-select tracks for playback 39 
Trimmer Menu 48 
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Undo / Redo 416 
Unique filename extension 408 
Updating Libraries 

Adding new files 64 
Orphaned Entries 64 
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User Libraries 33 
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Varispeed 393, 394 
View Automation 18 
View Menu 460 
Virtual Multi-track 353 
Virtual Tape Format 358 
Virtual Tape Mode 358 
Virtual Tracks 16 
VITC Generator 401 
VITC Reader 400 
VST Plug-ins 241 
VST Scanner 241 
VU-Meter 218 
VU-Meter controls 219 
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Warnings  
Waveform Display 105 
Window Menu 499 
Word Length 189 
Wordlength Converter Properties 56 
Work Spaces 386 

Workspaces 384 
Workspaces Menu 491 
 
X 
 
X Fade 118 
Xify 140 
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